Accounts Receivable Guide

INTRODUCTION ...................................................... 1

Standard Modules ................................................ 3
Optional Modules .................................................. 4
Accounts Receivable Documentation ............................. 6
User’s Guide Format ................................................ 7
Online Help .......................................................... 9
Additional Resources ............................................. 10
Quick Startup ....................................................... 11

SYSTEM BASICS .................................................... 13

Navigating in Accounts Receivable ............................... 14
Common Screens ................................................... 19
Using the Calculator ................................................ 22
Using the Calendar .................................................. 23
Accessing Lookup Tables ......................................... 24
Tabs ................................................................. 25
Exporting to Excel .................................................. 25
Setting Preferences .................................................. 27
Grouping Records in Queries ..................................... 27
Sorting Grid Information .......................................... 28
Getting Started ..................................................... 28

CONFIGURATION ................................................... 29

Organization Settings .............................................. 30
Preferences ........................................................ 31
Tables and Table Entries ......................................... 34
Attributes Tab ...................................................... 39
Products Tab ........................................................ 41
Aging Information Tab ............................................. 46
Statements Tab ...................................................... 47
Terms Tab .......................................................... 49
Sales Tax Tab ...................................................... 50
Interfund Tab ....................................................... 53
General Ledger Tab ............................................... 61
International Tab .................................................. 65
Distributions Tab .................................................. 66
Default Account Tab .............................................. 70
Setting Debit Memo Defaults ............................................................. 189

BANK ACCOUNTS ........................................................................... 191
Bank Account Access .................................................................. 193
Bank Account Records ................................................................. 194
Account Management .................................................................. 199

QUERY AND EXPORT ..................................................................... 211
Query Types .................................................................................. 213
Query Format ............................................................................... 213
Query Criteria Operators ............................................................. 213
Accessing Query and Export ......................................................... 216
Creating Queries ......................................................................... 217
Using and Editing Queries ............................................................ 221
Merging Queries .......................................................................... 225
Exporting Queries ....................................................................... 227
Printing Queries .......................................................................... 227
Properties .................................................................................... 228
Favorites ...................................................................................... 230
Preferences ................................................................................ 230

MAIL ................................................................................................. 239
Calculating Balances ................................................................... 240
Processing Attributes .................................................................. 241
Mail Basics .................................................................................. 241
Accessing Mail ............................................................................ 243

REPORTS .......................................................................................... 289
Main Report Screen ..................................................................... 291
Accounts Receivable Reports ....................................................... 292
Reports Procedures ..................................................................... 293
Getting Started .......................................................................... 293
Creating Reports ........................................................................ 296
Creating an Output Query ........................................................... 362
Reference ..................................................................................... 364
Sample Reports .......................................................................... 376

IMPORT ........................................................................................... 383
Import Main Screen ..................................................................... 385
Import Parameter Files ................................................................. 386
Line Item Information .................................................................. 414
Revenue Account Distribution Information ................................ 415
Required Import Fields ............................................................... 415
Import Field Code Names ............................................................ 419

GLOBAL CHANGE ......................................................................... 429
Introduction

In This Chapter

Standard Modules ........................................................... 3
Optional Modules ............................................................ 4
General Ledger Optional Modules ....................................... 5
Accounts Receivable Documentation ................................. 6
User’s Guide ................................................................. 6
Administrator’s Guide ..................................................... 7
Online Manual and Help ............................................... 7
User’s Guide Format ...................................................... 7
Chapter Format ........................................................... 7
Text Format ................................................................. 8
Special Keys ............................................................... 8
Online Help ................................................................. 9
Additional Resources ......................................................
Quick Start up ............................................................... 10
Bank Accounts ............................................................ 11
Configuration .............................................................. 11
Customers ................................................................. 11
Security ................................................................. 11
Welcome to *Accounts Receivable for Windows*. This comprehensive billing and customer information program helps you manage your receivables and plan your cash flow. Along with customer account management, you can use the features of this program for billing and payment applications, creating invoices, statements, and correspondence, as well as producing reports as you need them.

*Accounts Receivable* is a component of Blackbaud’s integrated software system, Accounting for Nonprofits, which means information transfers seamlessly among programs. You can, for example, post your receivables directly to *General Ledger for Windows*.

Customer management features in this program are comprehensive. They include storage of address and contact information, setting customer account credit limits, defining statement cycles, and defining terms regarding payments and shipping. You can review a complete history of your transactions for a particular customer, or filter this information to view only invoices, credit memos, debit memos, payments, etc. You can reverse a transaction as a credit memo or sales return. With the click of a button, you can instantly view a summary of a customer’s account, including current balance and available credit. Account summaries can be used to compare totals for last year, this year to date, and a lifetime history. Notes can be added to customer records via convenient note pad format.

This program allows easy data entry, whether you are adding line items to an invoice, entering credit memos to adjust debits and invoices, or entering debit memos to adjust credits and payments. You can view all payments and credits applied to an invoice and automatically apply payments to outstanding invoices. You can also enter invoice templates for generating recurring invoices for those customers who make fixed, regular payments.

With *Accounts Receivable*, you can give customers the option of paying by cash, credit card, check, money order, COD’s, or bank drafts. If you want to offer prompt payment discounts, the program automatically generates a credit memo for the discounted amount if an invoice is paid ahead of schedule. You can also handle advance deposits or prepayments and apply these to invoices later. You also have the option of printing a bank deposit slip.

The reporting function of this program offers many reports to choose from, including transaction and customer reports, such as Customer Account Activity, Cash Receipts Journal, Product Sales Analysis, Product Lists, and a General Ledger Reconciliation Report. With the addition of the *Crystal Reports for Blackbaud* report writer, you can create an endless variety of custom reports using any information in *Accounts Receivable*.

You can configure the program to automatically calculate finance and late charges for you. With this flexibility, you can base charges on overdue balance or on individual invoices, choose between applying a fixed-amount late fee or applying a percentage charge based on an annual rate. All finance or late charges you apply appear as separate line items on your customers’ statements.

Similarly, *Accounts Receivable* enables you to establish any number of tax categories that may represent particular tax entities, such as geographic regions or industry-specific tariffs. Of course, you can use this feature for more than just sales tax – a local option tax, levied in addition to a state sales tax, is just as easily calculated and applied to a line item.

*Accounts Receivable* enables you to maintain a complete list of your products and stores the information you need to make automatic line item calculation and invoice totaling an easy task. You can establish a cost schedule for ranges of quantities purchased. For example, you define costs at $5 per unit for up to 20 units, then $4 for 21 or more units. This variance could also be used for setting an hourly rate or by-the-job price for services your organization provides.
You can designate the accounts you want credited with the revenue from specific sales. If you have Blackbaud’s *General Ledger*, you can use a search window to locate the account you want to use. In addition, if you have *Project, Grant, and Endowment Management*, you can specify particular projects to receive the revenue.

As you become familiar with the program, you may find that creating a query of particular definition can be useful for future application. You can segment your data based on information in any field in the program. The use of queries also simplifies processing in *Accounts Receivable*. With a query, you can segment the information you want to filter by to determine which records to process. For example, you can create a query group made up of customers in a certain ZIP Code who purchase more than $500 in goods or services from you annually. Then you can use the query in *Mail* to produce labels and send customers an announcement about a special promotion.

*Accounts Receivable* is an advanced password-managed program that controls user access and determines what information users can view, add, change, or delete. You can define user access by module and by function.

As with every Blackbaud product, *Accounts Receivable* includes context-sensitive Help, which recognizes where you are in the program, and can instruct you accordingly. Help offers simple step-by-step instructions to guide you through a procedure, or to assist you in understanding the full impact of a particular function.

This chapter introduces you to the program modules, documentation, and other resources available to you throughout *Accounts Receivable*.

**Standard Modules**

*Accounts Receivable* is composed of eleven separate but interdependent modules. *Configuration, Customers, Query and Export,* and *Utilities and Housekeeping* are specific to the *Accounts Receivable* program group. *Bank Accounts, Cash Receipts, Global Change, Mail, Reports, Import,* and *Security* are shared modules, common to all Blackbaud programs present.

- **Bank Accounts:** This module is used to add, edit, and delete bank account information, and establish references between bank accounts. Because it is a shared Blackbaud component, you can use this module to store bank account information for all your integrated Blackbaud applications.

- **Cash Receipts:** This module enables you to add all deposits and receipts. You can enter deposit records, payments, and advance deposits. You can also print individual receipts for payers. *Cash Receipts* also facilitates generation of automatic payments, electronic funds transfer, and printing deposit tickets.

- **Configuration:** This module is used to customize your program by defining basic information about your organization. Here you can define systemwide preferences and create tables to ease error-free data entry. This is also where you define your products and services, and establish your defaults for various functions, including posting journal references.
• **Customers:** This module is used to maintain customer biographical information, set up recurring invoices, and calculate finance or late charges. This module is the core of the *Accounts Receivable* program. From here, you can generate invoices and credit memos and initiate automatic calculation of discounts and due dates based on specific client criteria. *Customers* offers you a view of customer activity in summary or as a comparison between time periods. You can also maintain notes about your customers using the handy note pad feature.

• **Global Change:** Use this module to add, change, or delete information (for example, Area Code, Salesperson, and Industry) on groups of records. In *Global Change* you can add, replace, partial replace, delete, increase, decrease, copy, swap, or move selected fields in the database.

• **Import:** This module is used to import data into Blackbaud’s Windows programs. The strength of *Import* is the interface’s ability to virtually eliminate any guesswork on your part. *Import* allows you to set up and save import parameter files that can be used repeatedly, define field mappings with the ease of drag-and-drop, use separate header files to identify field mappings, browse field examples to eliminate confusion when importing, and inspect the raw import data before running the import process.

• **Mail:** This module is used to print invoices, statements, letters, labels, cards, and envelopes.

• **Query and Export:** This module is used to identify and group customer records in your database according to criteria you define. You can establish groups of records to produce reports, and then use the grouped records in other procedures and functions of *Accounts Receivable*. You can export data to other programs, including word processing, spreadsheet, and *Crystal Reports*.

• **Reports:** This module is used to generate a variety of ready-made reports that assist you in organizing and presenting your data. Using advanced report formatting tools, you can define parameters that shape the report to fit your organization’s needs, and save the defined templates for future use. You can also export any report to your word processor or spreadsheet for further manipulation, or e-mail a copy to a staff member or customer.

• **Security:** This module is used to protect your sensitive data. *Accounts Receivable* operates with a secure password management system that controls user access to view, add, change, or delete information in your database. Users can be assigned both individual rights and rights based upon groups to which they belong.

• **Utilities and Housekeeping:** This module is used to run database utilities, including System Statistics, Post to General Ledger, and Print Setup.

## Optional Modules

Most of the topics discussed in the documentation relate to the basic *Accounts Receivable* package. However, there are some references to optional modules such as *Accounting Queue*, *Bank Account Reconciliation*, *Electronic Funds Transfer*, *Purchase Orders*, and other programs with which *Accounts Receivable* can interface, such as Blackbaud’s *General Ledger*.

**Accounting Queue:** This optional module allows you to schedule a sequence of tasks that can be executed automatically and unattended. Using this optional module can save you time with many of the repetitive functions performed by the Accounting for Nonprofits programs.
Because you can set up a queue to run overnight or while you are at lunch, using queues can save you time on almost all of the tasks the Accounting for Nonprofits software performs.

For example, you can schedule a queue of financial reports, a queue of mailings, and a queue of statistical reports to run overnight. This frees up your workstation and printer for other tasks during normal working hours.

For detailed information about this module, please refer to the Accounting Queue User’s Guide.

**Bank Account Reconciliation:** This optional module enhances the Bank Accounts module of your Blackbaud programs. With Bank Account Reconciliation, you can reconcile your bank account, track the account balance, and review in-depth details about individual transactions. The module displays all transactions affecting a single bank and lets you view information from The Raiser’s Edge for Windows.

Bank Account Reconciliation can be added to these Windows programs: Accounts Payable, Accounts Receivable, Miscellaneous Cash Receipts, Payroll, and Student Billing; and it works with General Ledger for Windows and Raiser’s Edge for Windows.

Additional options become available in Bank Accounts when you install Bank Account Reconciliation. These options include a Setup Wizard feature that helps you establish the beginning balance for your bank account. Reconciliation can be done manually or electronically, and you can add adjustments, such as service fees, during reconciliation. These adjustment transactions can then be posted to General Ledger.

### General Ledger Optional Modules

If you have General Ledger installed, additional optional modules are available:

**Budget Management:** This optional module enhances and expands your budget development capabilities within General Ledger.

Once you install Budget Management, you can create a new budget using current or previous budget information. You can save data entry time by copying a budget from another year, increase or decrease a budget using amounts or percentages, and create multiple budget distribution tables.

With Budget Management you can define the budget of one account as a percentage of another account’s budget, as well as project remaining actual amounts based on year-to-date results or the annual budget.

This module also helps you track budget details by allowing you to enter notes about the budget of each account. You can also record budget adjustments and report on the original or the adjusted budget.

For detailed information about this module, please refer to the Budget Management User’s Guide.

**Project, Grant, and Endowment Management:** This optional module allows you to track all income statement transactions against a project or project distribution. It provides General Ledger with an extra level of tracking and makes it easy to report on activity for a variety of endeavors, including projects, grants, endowments, scholarships, investments and special events.
With this module, you can associate financial transactions with each project, grant, or other sub-category for complete reporting at the project level. Tracking projects at the transaction level allows you to keep your chart of accounts concise and manageable. For example, all restricted contribution income for your projects or grants can be recorded to a single ledger account, without requiring a separate income account for each project. You can also report on contributions for one or any combination of projects.

*Project, Grant, and Endowment Management* also allows you to define your own project types. An unlimited number of user-defined fields (called attributes) allow you to monitor information about due dates, reporting frequency, personnel responsibilities, or any additional information specific to your needs. Project budgeting is also available with this module, if you have the optional *Budget Management* module. With both modules installed, you can create, forecast, increase, and decrease project budgets, as well as copy budgets from fiscal years.

For detailed information about this module, please refer to the *Project, Grant, and Endowment Management User’s Guide*.

**Interest Income Allocation:** Nonprofit organizations often invest money from many different funds and endowments in one or more investment accounts, even though the money from each of these funds must be tracked separately in their ledger. When the organization receives a statement for this type of pooled investment account, it must calculate the amount of the total earnings (or losses) allocated to each fund in the investment pool. This time-consuming calculation is accomplished by computing the asset balance for each fund, adding these numbers to get the total asset balance of the entire account, and then determining each fund’s percentage of the total. Journal entries must then be created to post the appropriate entries to the ledger for each fund.

*Interest Income Allocation* is an optional module for Blackbaud’s *General Ledger* that automates the process described above. *Interest Income Allocation* allows you to define “pools” of projects for investment purposes. After creating the pool of projects, you simply enter earnings information for the pool. The Calculate Income facility automatically computes each project’s share of the earnings (or losses), creates a batch of journal entries, and posts this batch to your ledger. The Calculate Fees feature also automatically calculates fees (fixed amount and/or percentage) for each project in a pool, and posts this information to *General Ledger*.

For detailed information about this module, please refer to the *Interest Income Allocation User’s Guide*.

**Accounts Receivable Documentation**

The documentation for *Accounts Receivable* consists of this user’s guide, the *Accounting for Nonprofits Administrator’s Guide*, an online manual, and online help.

**User’s Guide**

The user’s guide is organized based on setup, data entry, and data manipulation. Chapters 2 through 5 include information about how to set up and maintain *Accounts Receivable*. These chapters include information about *Configuration, Security*, and *Utilities and Housekeeping*.
Chapters 6 through 12 address data entry and record maintenance for such items as adding or editing a customer record; adding a charge, credit memo, debit memo, sales return, cash receipts, finance/late charges, and payments; creating invoices; bank account management; and viewing customer transaction activity.

Chapters 13 through 16 tell you how to manipulate your database to produce queries (a group of records), reports, mailings (statements or labels), and import and export information.

**Administrator’s Guide**

The *Accounting for Nonprofits Administrator’s Guide* provides the information needed to install and set up your Blackbaud accounting programs. This guide provides information essential to establishing and maintaining *Accounts Receivable*.

**Online Manual and Help**

We also encourage you to use the online manual and online help. The online manual consists of a series of PDF (Portable Document Format) files that you can install on your computer during the program installation process. The online manual can also be accessed from the *Accounts Receivable* installation CD.

**User’s Guide Format**

This guide follows a standard format to help you locate and identify information you need to make the most of *Accounts Receivable*. The two tables below explain our User’s Guide format.

**Chapter Format**

Most chapters consist of the following basic sections:

<table>
<thead>
<tr>
<th>Format</th>
<th>Denotes</th>
</tr>
</thead>
<tbody>
<tr>
<td>In This Chapter:</td>
<td>A listing of the contents of the chapter.</td>
</tr>
<tr>
<td>Overview:</td>
<td>A brief description of the chapter.</td>
</tr>
<tr>
<td>Reference:</td>
<td>A brief overview of each screen, as well as field-by-field descriptions.</td>
</tr>
</tbody>
</table>
We invite you to use the extra space provided in the notes column to write information or notes you find important or to mark items that are specific to your organization’s use of *Accounts Receivable*.

## Text Format

The table below explains the conventions the manual uses as visual cues for fields, program names, notes, tips, or warnings.

<table>
<thead>
<tr>
<th>Format</th>
<th>Denotes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bold Italics</td>
<td>Bold, italicized text indicates a Blackbaud program name, for example, <em>Accounts Receivable</em>.</td>
</tr>
<tr>
<td>Italics</td>
<td>Italicized text indicates a Blackbaud module name, for example, <em>Utilities and Housekeeping</em>.</td>
</tr>
<tr>
<td>Bold</td>
<td>Bold text indicates the name of a field or button, for example, <strong>Delete</strong> refers to a button on the screen. “Press <strong>DELETE</strong>,” refers to the key on your keyboard.</td>
</tr>
<tr>
<td>SMALL CAPS</td>
<td>Small caps refer to a key on your keyboard. “Press <strong>DELETE</strong>,” refers to the key on your keyboard. “Click <strong>Delete</strong>,” refers to an on screen button.</td>
</tr>
<tr>
<td>KEY+KEY</td>
<td>Two keys joined by a plus sign indicate you must press the keys simultaneously to execute the command. For example, if you are instructed to “Press <strong>CTRL</strong> + <strong>F</strong>” you must press the <strong>CONTROL</strong> key, hold it, then press the key.</td>
</tr>
<tr>
<td>KEY, KEY</td>
<td>Two keys separated by a comma indicate you must press the keys in the order in which they appear. For example, if you are instructed to press <strong>ALT</strong>, <strong>F</strong>, you must press the <strong>ALT</strong> key, release it, then press the <strong>F</strong> key.</td>
</tr>
</tbody>
</table>

- The arrow indicates the beginning of a procedure.
- The traffic light symbol indicates a cautionary note. Generally this indicates a step may have unwanted results.
- The note symbol designates a note or tip related to the information in the main text column.
- The clock symbol designates a shortcut or timesaving action.

## Special Keys

Throughout *Accounts Receivable* there are special shortcut keys and shortcut methods to help you with data entry. Function keys are the primary source for shortcuts. When a shortcut is available, the status bar at the bottom of the screen tells you which function key to press.

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ENTER</strong></td>
<td>The <strong>ENTER</strong> key (sometimes called the <strong>RETURN</strong> key) signals the computer that entry of a command, field, or data is complete.</td>
</tr>
</tbody>
</table>
## Introduction

| **TAB** | The **TAB** key signals the computer that entry of a command, field, or data is complete. Pressing this key moves the cursor forward to the next field. |
| **SHIFT** | The **SHIFT** key allows you to select consecutive items from a grid. To select consecutive items, highlight the first item, then press and hold **SHIFT** while selecting the last item. |
| **BACKSPACE** | The **BACKSPACE** key moves the cursor back one character, deleting the character. |
| **HOME** | The **HOME** key places the cursor at the beginning of the field. |
| **END** | The **END** key places the cursor at the end of a field. |
| **DELETE** | The **DELETE** key removes the highlighted characters, or entry. |
| **CONTROL** | The **CONTROL** key allows you to select more than one item in a list. To select items not in consecutive order, select the first item, press **CONTROL**, hold the key down, and select the second item. |
| **F1** | The **F1** key activates online help. Press this key at any time to access context-sensitive Help. |
| **F3** | In date fields, the **F3** key inserts the current date. **F3** also inserts the default value of a field if one is available. A message appears on the status bar if a default value is available. |
| **F7** | The primary function of the **F7** key is activating Table Lookups; however, this key also activates a calendar in date fields and a calculator in currency fields. In addition, **F7** provides access to the Search screen where linking of records is available. |

### Online Help

The *Accounts Receivable* online Help file provides access to many different kinds of help: overview information, reference information, procedures, online manual, contact information, and user-defined notes.

You can access online help in three ways:

- selecting **Help** from the menu bar
- clicking ![Help](image) from the toolbar
- pressing **F1** from most screens in the program

Online Help contains concise information about specific processes and tasks within *Accounts Receivable*. Selecting **Help**, or clicking ![Help](image), allows you to search for help topics, view online documentation, and connect to Blackbaud’s home page. Pressing **F1** takes you to information about the part of the program you are using.

Select **Help** and **Blackbaud on the Web** to display the drop-down menu shown below.
Accounts Receivable Help Topics opens the online Help file. Here you find procedures to perform essential program tasks such as creating a customer record.

Online Documentation opens a PDF (Portable Document Format) file in Acrobat Reader. If the Acrobat Reader is not installed, you can install it from your installation CD, or you can download it, without charge, from the Adobe web page: http://www.adobe.com/.

You can view the user’s guide on your computer’s monitor. Bookmarks in the left and right pane enable you to jump from topic to topic.

Contacting Support provides information about contacting Blackbaud’s support staff and other resources.

Blackbaud on the Web provides links to Online Support and the Blackbaud Home Page.

About Accounts Receivable provides serial number, version number, and copyright information. This information is important if you need to contact Customer Support.

Additional Resources

If you need resources beyond online Help, you can open the online manual by clicking Start, Programs, Blackbaud Accounts Receivable, Accounts Receivable Online Manual. You can also access the online manual by selecting Online Documentation from the Help menu. If you choose not to install the online manual, you can open the PDF files from your installation CD.

The Table of Contents contains bookmarks that link to individual chapters, the glossary and index, as well as other User Guides in your system.

We also provide files for your user-defined notes, accessed by clicking Notes on the Help file toolbar. These files (arnotes.doc and arnotes.txt) are located in your Blackbaud folder. Depending on your word processor, you can use either the Microsoft Word document or the text file. This gives you a handy place to store information specific to your organization’s needs. The big advantage of the notes file over the Annotate feature in the Help file is you can maintain one notes file for everyone in your organization. To share your notes/tips with your coworkers, copy the notes file to the Blackbaud folder on their hard drive.

If you do not have Microsoft Word, delete arnotes.doc in the \Blackbaud directory on your hard drive (or on the drive where your program resides). Once you delete arnotes.doc, the Notes button can access arnotes.txt using Notepad.
Quick Startup

Bank Accounts

Define one or more bank accounts for use with *Accounts Receivable* in *Bank Accounts*.
Define your Cash, Suspense, and Discounts Taken accounts for each bank account.
Define a Default Project, if the optional *Project, Grant, and Endowment Management* module is present.

Configuration

General tab: Enter organization information.
Tables tab: Add, edit, delete any table entries you want.
Attributes tab: Set up attributes you want to use to define customers and documents.
Products tab: Enter descriptions of all your products and services for which you will be billing customers.
Aging Information tab: Set up aging buckets you want to use for calculating charges.
Statement tab: Define your statement descriptions for Invoices, Credit Memos, Debit Memos, Sales Returns, and Payments.
Terms tab: Define your invoice payment terms.
Sales Tax tab: Define the tax entities and percentages for your system.
General Ledger tab: Define General Ledger information for transaction reference used in posting.
International tab: Add, edit, delete country information as needed.
Default Acct tab: Select the default receivables account.
Select a default Project, if the optional *Project, Grant, and Endowment Management* module is present.

Customers

Enter biographical and address information.
Define tax status, credit limit, and terms for the customer.
Enter attributes you want to associate with this customer.

Security

Define new password for “Supervisor”.
Establish groups and group access rights.
Assign user passwords and group memberships.
System Basics

In This Chapter

Navigating in Accounts Receivable .............................................. 14
Parts of the Accounts Receivable Screen ........................................ 14
  Title Bar ............................................................................. 14
  Menu Bar ............................................................................. 14
  Toolbar ................................................................................ 15
  Status Bar .......................................................................... 15
  Toolbar Buttons ................................................................... 15
  Toolbar Buttons with Drop-Down Menus ................................. 16
  Save/New and Save/Close ..................................................... 18
  Standard Screen Buttons ....................................................... 18
Using Shortcut Menus .................................................................. 19

Common Screens ...................................................................... 19
Print Setup Screen .................................................................... 20
Change Password Screen ............................................................ 20
Select a Directory Screen ............................................................ 21
Search Screen ......................................................................... 21
Exclusive Processes .................................................................. 22
Using the Calculator ................................................................ 22
Using the Calendar .................................................................. 23
Accessing Lookup Tables ........................................................... 24
Tabs ....................................................................................... 25
Exporting to Excel ................................................................... 25
Setting Preferences .................................................................. 26
Grouping Records in Queries ..................................................... 26
Sorting Grid Information ............................................................. 27
Getting Started ....................................................................... 27
This chapter familiarizes you with the screens, buttons, and terms used throughout *Accounts Receivable*. This chapter addresses standard items such as the parts of a screen, toolbar buttons, standard buttons, and common screens. These items appear throughout the program. By reading *System Basics*, you can acquire solid foundation skills that you can apply while working in any of the program modules.

More detailed information and step-by-step procedures are presented in the individual topic chapters.

# Navigating in Accounts Receivable

## Parts of the Accounts Receivable Screen

To navigate through *Accounts Receivable*, it is important to understand the parts of the various screens. The main *Customers* screen, for example, appears below.

### Title Bar

The title bar, across the top of the screen, states the title of the program. This is standard in all current Windows packages, including *Accounts Receivable*. The title bar also contains, in the upper right corner, the buttons for minimizing, maximizing, and closing the window.
Menu Bar
The menu bar, below the title bar across the top of the window, houses the commands for all *Accounts Receivable* functions. *Accounts Receivable* has basic menu options available from most program modules: File, Edit, View, Window, and Help. Some *Accounts Receivable* modules have additional menu options. To access a command on the menu bar, either:

- Position the pointer over the desired command and click the left mouse button
- Press Alt + the underlined letter. For example, to access File, press Alt + F.

Toolbar
The toolbar contains buttons representing common commands used within *Accounts Receivable*. You can use the mouse to click any of these buttons.

Status Bar
The status bar, across the bottom of the window, acts as your guide throughout *Accounts Receivable*. As you move through the program, messages such as available shortcut keys are displayed on the status bar. For example, when you are in a date field, the message **Press F3 for Today's Date, F7 for Calendar** is displayed.

Toolbar Buttons
The toolbar contains buttons representing common commands used within *Accounts Receivable*. By clicking these buttons, you can easily perform a function, such as saving, without using the menu bar. Some of the buttons listed below are only enabled when an account record is open.

<table>
<thead>
<tr>
<th><img src="image1.png" alt="Bank account list" /></th>
<th><img src="image2.png" alt="Reconciliation" /></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image3.png" alt="Bank summary" /></td>
<td><img src="image4.png" alt="Bank information" /></td>
</tr>
<tr>
<td><img src="image5.png" alt="Print checks" /></td>
<td><img src="image6.png" alt="Bank draft" /></td>
</tr>
<tr>
<td><img src="image7.png" alt="Direct disbursement" /></td>
<td><img src="image8.png" alt="Manual check" /></td>
</tr>
<tr>
<td><img src="image9.png" alt="New record" /></td>
<td><img src="image10.png" alt="Save" /></td>
</tr>
<tr>
<td><img src="image11.png" alt="Open an existing record" /></td>
<td><img src="image12.png" alt="Close" /></td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Set legend colors</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Run Import process</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Print data</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Preferences</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Print setup</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Preview data prior to printing</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Run query</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Export data</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Delete</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Export to Excel</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Go to the first record</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Go to the previous record</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Go to the next record</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Go to the last record</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Add bookmark</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Restore bookmark</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Run import</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Open help topics</td>
</tr>
<tr>
<td>![Icon]</td>
<td>View properties</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Add to favorites</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Annotate</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Search for data</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Form view</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Grid view</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Display large icons</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Display small icons</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Display list view</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Display detail view</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Add a new group</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Add a new user</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Up one level</td>
</tr>
<tr>
<td>![Icon]</td>
<td>E-mail data</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Generate recurring invoice</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Calculate Finance/Late charges</td>
</tr>
</tbody>
</table>
Toolbar Buttons with Drop-Down Menus

*Accounts Receivable* contains some toolbar buttons with drop-down menus that display various options.

**Bank Accounts Module**

On the *Bank Accounts* toolbar, one of the following buttons displays, depending on the last type of record you added.

- **New Bank Account**: By default when *Bank Accounts* opens, or if the last record you created was for a bank account. Click the button to create a new bank account. Click the down arrow to select an adjustment record.

- **New Adjustment**: If the last record you created was for an adjustment. Click the button to create a new adjustment. Click the down arrow to select another record type.

**Customers Module**

On the *Customers* toolbar, one of the following buttons displays, depending on the last type of record you added.

- **New Record**: By default when *Customers* opens. Click the down arrow and select the type of record you wish to create.

- **New Customer**: If the last record you created was for a customer. Click the button to create a new customer record. Click the down arrow to select another record type.

- **New Invoice**: If the last record you created was for an invoice. Click the button to create a new invoice. Click the down arrow to select another record type.

- **New Recurring Invoice**: If the last record you created was for a recurring invoice. Click the button to create a new recurring invoice. Click the down arrow to select another record type.

- **New Sales Return**: If the last record you created was for a sales return. Click the button to create a new sales return. Click the down arrow to select another record type.
The New Credit Memo button displays if the last record you created was for a credit memo. Click the button to create a new credit memo. Click the down arrow to select another record type.

The New Debit Memo button displays if the last record you created was for a debit memo. Click the button to create a new debit memo. Click the down arrow to select another record type.

The New Payment button displays if the last record you created was for a payment. Click the button to create a new payment. Click the down arrow to select another record type.

Save/New and Save/Close

While clicking the Save button saves the data in a current record, two other options are available. The Save and New and Save and Close options, available from either the File menu or the toolbar, help make data entry an easier task.

Click the down arrow on the Save button to access the drop-down menu shown below.

```
<table>
<thead>
<tr>
<th>Button</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Save and New</td>
<td>Ctrl+E</td>
</tr>
<tr>
<td>Save and Close</td>
<td>Ctrl+L</td>
</tr>
</tbody>
</table>
```

Save saves the information entered on the current record.

Save and New automatically saves and closes the current record, then opens a new, blank record. This eliminates the additional steps of saving and closing the record, and then selecting File, New to open the next blank record. This feature greatly reduces data-entry time when adding a large number of records in one sitting.

Save and Close saves, and then closes the current record, combining two steps into one and ensuring any additional information gets saved.

Standard Screen Buttons

There are many standard buttons throughout Accounts Receivable that appear on the screen, rather than the toolbar. These buttons function in the same manner regardless of where they are located. The function of each button is described below.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="Image" alt="Search" /></td>
<td>Search for or ‘look up’ data to fill in the field. (This button appears on the toolbar and screens.)</td>
</tr>
<tr>
<td><img src="Image" alt="Drop-down" /></td>
<td>Access the drop-down list associated with that field.</td>
</tr>
<tr>
<td><img src="Image" alt="Search" /></td>
<td>Search for a file.</td>
</tr>
<tr>
<td><img src="Image" alt="Search" /></td>
<td>Search the system to select the correct path and file name.</td>
</tr>
<tr>
<td><img src="Image" alt="Adjust" /></td>
<td>Adjust numbering, in numeric fields, by clicking up or down.</td>
</tr>
</tbody>
</table>
Using Shortcut Menus

Throughout *Accounts Receivable*, you can access commonly used commands by placing the cursor in a field or grid and clicking the right mouse button. A shortcut menu, similar to those shown below, appears. The available commands vary, depending on where you are in the program.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Calculator" /></td>
<td>Calculate the appropriate financial data for the field.</td>
</tr>
<tr>
<td><img src="image" alt="Calendar" /></td>
<td>Locate the correct date for the field.</td>
</tr>
<tr>
<td><img src="image" alt="Left Arrow" /></td>
<td>Move selected item to frame on the left.</td>
</tr>
<tr>
<td><img src="image" alt="Double Left Arrow" /></td>
<td>Move all items to the frame on the left.</td>
</tr>
<tr>
<td><img src="image" alt="Right Arrow" /></td>
<td>Move selected item to frame on the right.</td>
</tr>
<tr>
<td><img src="image" alt="Double Right Arrow" /></td>
<td>Move all items to the frame on the right.</td>
</tr>
<tr>
<td><img src="image" alt="Next" /></td>
<td>Move forward one screen to the next step.</td>
</tr>
<tr>
<td><img src="image" alt="Back" /></td>
<td>Move back one screen or step.</td>
</tr>
<tr>
<td><img src="image" alt="Cancel" /></td>
<td>Cancel an operation.</td>
</tr>
</tbody>
</table>

**Common Screens**

The following screen are common throughout *Accounts Receivable*. 
Print Setup Screen

You use the Print Setup screen to select a printer and set printer properties. The exact options available depend on your printer and network configuration. *Accounts Receivable* uses your default printer and properties unless you make another selection on this screen. Select File, Print Setup to open this screen.

Change Password Screen

This option is only available to users whose Security module records are marked User May Change Password. From any *Accounts Payable* module, select Edit, Change Password to open the following screen.
Select a Directory Screen

In fields requiring a path and file name click the browse icon to open a search window.

The appearance of this screen may vary depending on where you are in the program.

Search Screen

Open the record search screen. A variety of filters are available to narrow your search.
Exclusive Processes

Some processes require all users to exit, and sign out of the system (for example, Validate Database). A screen, similar to the following, appears at the beginning of all exclusive processes.

If the screen appears with user names in the left box, you must have those individuals exit and sign out of the system. All users must be out of the system before you can run an exclusive process. Once you click Proceed all users are locked out of the system until the process finishes.

Using the Calculator

In fields requiring a monetary amount, a calculator button is available. Clicking this button opens a calculator you use to determine the entry amount.

Calculate the entry amount by using your cursor to click the calculator buttons. Click Paste to enter the amount in the field and automatically close the calculator.
Using the Calendar

In fields requiring a date, a calendar button is available. Clicking this button opens a calendar from which you can search for and enter dates.

Clicking the month opens a drop-down list of the months. Select the correct month by clicking it.

Clicking the year activates a set of scroll buttons. These buttons are used to select the correct year.

Once the correct month and year are displayed, click the date to enter them in the field.
Accessing Lookup Tables

Lookup tables are used throughout *Accounts Receivable* to increase data entry speed and efficiency. There are four ways to access tables entries:

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>A</strong></td>
<td>A down arrow next to a text box indicates a table lookup is available. Click the arrow to access a drop-down list of entries for the field. A down arrow next to a button indicates that there are additional options from which to choose. Click the arrow to access the drop-down list of additional options.</td>
</tr>
<tr>
<td><strong>Arrow Keys</strong></td>
<td>Place the cursor in a text box and then press the down arrow key on your keyboard to scroll through the available entries.</td>
</tr>
<tr>
<td><strong>Typing</strong></td>
<td>Typing an entry into a text box is another way to access a lookup table. If the entry you type does not exist in the table, the program displays a dialog box asking if you want to add the new table entry. Click <strong>Yes</strong> to add the new entry to the table.</td>
</tr>
<tr>
<td><strong>F7</strong></td>
<td>Pressing F7 also accesses lookup tables. The message “Press F7 for Table Lookup” appears on the status bar when a table is available.</td>
</tr>
</tbody>
</table>

When F7 is pressed, a window similar to the one below appears.

![Lookup Table Window](image)

From this window, you can add, delete, edit, or sort table entries.
Tabs

Another integral part of Accounts Receivable is the tab. Tabs in Accounts Receivable function the same as tabs on folders in a filing cabinet; they allow you to see at a glance what information is available in each folder by the tab name. Information is accessed by clicking the tab. The following is a standard customer record illustrating the use of tabs.

Exporting to Excel

Throughout Accounts Receivable grids are used to enter and display information. Using the Export to Excel function, information from these grids can be exported for use in Microsoft Excel.
With your cursor in the grid, select File, Export to Excel.

Accounts Receivable opens Excel and begins exporting the grid information. The following screen appears.
When complete, the Excel worksheet appears containing the information from the grid.

This information can now be manipulated and used within Excel.

**Setting Preferences**

You can establish numerous user and system preferences in Accounts Receivable to define the way records appear, how your mailings will look, what parameters to include in queries and export criteria, and the appearance of your reports. Edit, Preferences is available for Customers, Mail, Query and Export, and Reports. Various other system preferences can be set in Configuration, including your choice of Internet connection and miscellaneous preferences.

**Grouping Records in Queries**

In Query and Export, you can query the database for information about records meeting specified criteria. For example, you might want to calculate late charges for all customers in a specific sales territory. Rather than searching for each record, opening it and calculating the charges, you can group the desired records and calculate the late charges with one simple operation.

Records are grouped by creating a query in Query and Export. The query process examines all records, selecting and grouping those matching the criteria you have established. For the example above, all batch records from the specified sales territory form the query group. The desired information displays on the Results tab. You can print or export the results directly from the Results tab. After you establish the criteria for a query, you can name and save the query for future use. For additional information about creating and using queries refer to the Query and Export chapter of this User’s Guide.
Sorting Grid Information

You can sort grid information by column header item (for example., Date, Description, or Status) in ascending and descending order. For example, if you click the Date header with the left mouse button, the list displays in ascending order, with the oldest date at the bottom. Click the header again and the order toggles to descending order, with the oldest date at the top.

Getting Started

You cannot access Customers or Configuration until you have set up an Accounts Receivable bank and established the account numbers in Bank Accounts.

Please refer to the Quick Startup procedure list at the end of Chapter 1 for an outline of the order in which you should proceed to get started in Accounts Receivable. Essentially, you must access and set up the following modules, in this order, before continuing with any data entry or manipulation of functions in this program:

- Bank Accounts
- Configuration
- Customers
- Security
In This Chapter

Organization Settings ............................................ 30
Preferences .......................................................... 31
Tables and Table Entries ......................................... 34
Table Entries ....................................................... 35
Attributes Tab ....................................................... 39
Products Tab ........................................................ 41
Aging Information Tab ............................................. 46
Statements Tab ...................................................... 47
Terms Tab ............................................................. 49
Sales Tax Tab ......................................................... 50
Interfund Tab ........................................................ 53
General Ledger Tab ............................................... 61
International Tab .................................................. 65
Distributions Tab ................................................... 66
Default Account Tab ............................................... 70
Configuration helps you establish system settings for *Accounts Receivable*, such as payment terms, aging information, and attributes. You can also use this module to define systemwide preferences, create tables to streamline error-free data entry, define products and services, and create your default *General Ledger* journal references.

**Organization Settings**

From the General tab, you establish address and phone information, and indicate if you want *Accounts Receivable* to automatically generate items such as recurring invoices and customer IDs.

- **Establishing organization settings**

  1. Open *Configuration*. The General tab appears.

  ![Configuration - Accounts Receivable](image)

  2. In the **Address**, **City**, **State**, **ZIP**, **Country**, and **Phone** fields, enter the information about your organization as you want it to appear on reports, statements, and other correspondence.

  3. If you want to **Allow customers to exceed credit limit**, mark the checkbox next to this option.

  4. If this option is marked, the program allows you to add documents that exceed a customer’s credit limit.

  5. If you want the program to **Automatically generate customers IDs** mark the corresponding checkbox.

  6. If you mark this option, new customer records without **Customer ID’s** are automatically assigned a sequential number. The assigned number can be overwritten or changed as long as it is not a duplicate of another customer’s ID.
7. Mark the **Automatically generate document numbers** checkbox if you want the program to automatically assign a sequential number to documents.

8. If you want the program to notify you of any recurring invoices that need to be generated, mark the **Automatically generate recurring invoices ___ days before invoice date** and enter the number of days notice you want. When you open **Customers**, the reminder appears.

9. In the **Automatically apply payments/credits to** field, you can mark **Oldest invoices and debit memos** or **Newest invoice and debit memos**. If you automatically apply a payment or credit to the oldest invoice/debit memo, the payment is applied to the first line item of that invoice first. The remaining amount of the payment is then applied to each successive line item or invoice, from oldest transaction date to newest, until the payment/credit is fully applied.

When you select the automatic application of a payment/credit to Newest invoice and debit memos, the program applies the payment directly to the first line item of the newest invoice/debit and continues toward the oldest until the payment is fully applied.

**Preferences**

The Preferences tab in **Configuration** helps you tailor **Accounts Receivable** to your organization’s needs by establishing user and system preferences, such as the Enter key function you want to use, and duplicate search settings. User and system Preferences governing other functions within this program are defined in **Customers**, **Mail**, **Query and Export**, and **Reports**. Please see the appropriate chapter for complete details on preferences governing these modules in **Accounts Receivable**.

Recurring invoices are used for customers who receive products or services on a regular basis, and are invoiced according to a schedule you define.
**Establishing general user and system preferences**

1. From *Configuration*, select the Preferences tab.

![Configuration - Accounts Receivable](image)

2. In the **Miscellaneous** frame, mark **Enter key moves to next field** if you want to change the program default that allows you to move from one field to the next by using your Tab key.

3. Direct the program to **Automatically complete table entries**, which reduces the time you need to make your data entries. As you finish typing in the first few characters of a table entry, the program automatically completes the entry for you.

4. The **Data Entry** frame allows you to customize the appearance of the transaction grid when you add new transactions to a customer record. You can select **Customer Name** or **Customer ID** to be the first field shown on a new transaction.

5. The **Account Search Mask** frame allows you to select a particular character to use as a placeholder in your account number format. You can define the way the account number field appears when you search for an account. For example, you can select the pound sign (#) as a placeholder, and when you are searching for a particular account record, this character displays in the account number entry field like this:

   ### ###### ####
6. Mark the **System Preference** option in the **Display** frame. The tab refreshes, and new frames appear.

7. The **Duplicate Customer Criteria** frame displays a grid in which you can enter up to five different fields you want the program to use when checking for duplicate customer records.

8. Mark **Automatically check for duplicates on save** if you want the program to automatically check for duplicates each time you save a new record. For example, if you mark this option and use the two default field names, **Customer Name** and **Address**, the program automatically checks for duplicate customer records using up to 20 characters of both the name and primary address on each customer record in your database. You can add or replace these filtering fields with others, such as **Class**, **Credit Rating**, and specific address and biographical fields from the Customer record.

9. If you do not mark the option to **Automatically check for duplicates on save**, the program ignores any duplication of fields in your customer records.

10. Mark the option to **Automatically check for Duplicate Invoice Numbers** if you want the program to compare invoice numbers for duplication.

11. Mark **Display a warning** if you want the program to warn you of a duplicate record.

12. Mark **Do not allow duplicate numbers** if you want the program to disallow duplicate invoice numbers.
Tables and Table Entries

Many tables you define in Configuration are shared by all Blackbaud programs present in your database. Some tables, such as Class, Credit Card Type, Credit Rating, Finance Rate, Industry, Item Category, Items, and Other Payment Type are specific to Accounts Receivable.

On the Tables tab, the Tables frame displays a list of the available tables. When you highlight a table, the options defined for that table displays in the Table Entries frame. You can view table entries using the Long description or the Short description. From the Table Entries frame, you can add, edit, insert, and delete entries. Entries can also be moved up and down within the list. You can sort and print the table entries list.

If you want to add a new table, you can do so from the Attributes tab. You can define the new table by Description, Data Type, and Table Name in either of the two record types: Customer or Document. Once you have created the new table, it appears in the list of available tables on the Tables tab.

Accessing tables

1. From Configuration, select the Tables tab.

2. In the Tables frame, highlight the table you want. The Table Entries box displays the entries for the table you highlight.

From the Tables tab, you can:

- Add a table entry
- Edit a table entry
- Insert a table entry
- Delete a table entry
- Sort the table entries
- Print the table entries
Table Entries

During data entry, table entries provide you with a set of options from which you can choose. For example, when you enter customer information, you can select the customer’s state address from the State table. Using table entries helps maintain format consistency during data entry, which is important for producing accurate reports and statements. For example, one user might enter the customer’s state address as “Fla.,” but another user could enter “FL.” Using a table, both users can select the same entry, “FL,” which is the entry from the State table.

Adding a table entry

You may need to add an entry to a particular table. For example, if your organization adds a new salesperson, you can add the name of that person to the Salesperson table.

1. From the Tables tab in Configuration, select the table to which you want to add an entry, and click Add. The Add Table Entry screen appears.

2. If you defined the table (from the Attributes tab) to include both a short description and long description, you can enter up to 3 characters in the Short Desc field.

3. Enter a unique Short Description of the entry, using up to 3 characters. You can also define the entry with a longer Description for clarification.

4. You can define an entry and then disable the entry by marking the Deactivated? checkbox. This disables the entry without deleting it from the program, and may be useful if you need to enter an option for the next year, but you do not want it available for use in the current year. You can also deactivate an entry that is no longer in use, but is needed for history and cannot be deleted.

5. Click OK to complete the entry. The new entry appears in the Table Entries frame.

Adding an entry to the phone type table

Phone Type table entries require additional information, so the steps for adding a phone type vary slightly from the above example.

1. From the Tables tab, highlight Phone Type in the Tables frame.
2. Click **Add**. The Add Phone Type screen appears.

![Add Phone Type](image)

3. Enter a **Description** of the phone type table entry you want to add.

4. Select a phone **Type** from the drop-down list. Select from **Telephone Number**, **Fax Number**, **E-mail Address**, **Web Address/URL**, and **Other**.

5. If you select **Telephone** or **Fax** number, select a **Format** from the drop-down list.

6. Click **OK** to complete the new Phone Type table entry.

#### Inserting a new table entry

Inserting a new table entry differs from adding a new table entry in that you can position the new entry in the list at precisely the point you want it to appear in the list.

1. Access the Tables tab.

2. In the **Tables** frame, highlight the table in which you want to insert a new entry. The existing entries display in the **Table Entries** frame.

3. Highlight the entry below the point where you want to insert a new entry, and click **Insert**. The Add Table Entry screen appears.

4. Follow the procedure for **Adding a Table Entry** (see previous page).

5. Click **OK**. The new entry appears above the entry you highlighted.

#### Deleting a table entry

Table entries cannot be deleted if they are currently part of an existing database record.

1. Access the Tables tab.

2. In the **Tables** frame, highlight the table from which you want to delete an entry. The existing entries are displayed in the **Table Entries** frame.

3. In the **Table Entries** frame, highlight the entry you want to delete, and click **Delete**. A warning dialog box appears.

![Delete](image)

4. Click **Yes** to delete the entry, or **No** to return to the Tables tab.
Sorting table entries

Sorting table entries does not change existing data records. Table entries maintain their short and full description you define. You can have the program sort table entries alphabetically, which makes locating entries easier, particularly in longer lists of entries. You can also choose to sort table entries by description.

1. Access the Tables tab, and highlight the table you want to sort.
2. Click Sort. The Sort Table Options screen appears.

3. Mark either the **Ascending (A-Z)** or **Descending (Z-A)** option to sort the table entries alphabetically. If you want to sort the entries by description, mark either the **Description** or **Short Description** option.
4. Click OK to start the sorting process, or click Cancel to return to the tables tab.

Printing code tables and their entries

Code tables and their respective entries can be printed, which gives you a hard copy for your records. If you change or edit your tables, this allows you to reference your original printout and reconstruct the tables if you need to.

1. Access the Tables tab, and click Print. The Print Code Tables screen appears.

2. Mark the All Code Tables option if you want to print all code tables, including all entries, in your database. You can print each table of entries on a separate page by marking the Print one table per page checkbox.
3. If you want to print only selected code tables and their entries, mark the Selected Code Tables option.

4. Highlight the table(s) you want to print, and move them to the Print these code tables frame, using the arrow buttons. You can also print each of these selections on a separate page.

5. Click OK to start the printing process, or click Cancel to return to the Tables tab.

Deleting a user-defined table

User-defined tables are those tables you add from the Attributes tab. Standard tables, which are those supplied by Blackbaud with the program, cannot be deleted.

1. In Configuration, select Edit, Delete User-defined Tables from the menu bar. The following screen appears.

2. Highlight the user-defined table you want to delete, and click Delete. A warning message appears.

3. Click Yes to delete the table. If this table exists as an attribute in any of your records, the table cannot be deleted. If this is the case, the following reminder appears.
Attributes Tab

Attributes add flexibility to Accounts Receivable by allowing you to define and store additional information about your customers and accounting documents. From the Attributes tab, you can establish attribute values and assign them to individual records. You can establish and assign attributes for all record types. Assigning attributes to a record provides you with a method of grouping customers or other record types by specific attributes. This can be helpful when you want to search for records by defining a query, or locating all records with a particular attribute.

Some examples of customer attributes are:
Years a Member
Date Placed on Credit Hold
Solicit for Donations?
Credit Rating
Occupation
Send Invitation to Special Events

For accounting documents, possible attributes are:
Reason for Credit
Reason for Return
Credit Agreement
Salesperson, Approved By
Date Invoice Printed

As you can see from the above examples, the attributes tab offers great flexibility and user-defined choices. Attributes can be specific to the customer or individual, specific to your organization, or general in nature.

Two areas attributes are especially useful are mailings and reports. For these items you can include or exclude records by filtering with one or more attributes. For example, you can print envelopes for invitations to a fund-raising event by including only records with the attribute “Send Invitation to Special Events”.

You establish attributes by entering a description and assigning a data type, such as text, number, date, currency, yes/no, or tables. If you establish an attribute as a table, you can create a new table or use an existing table for data entry.
Defining an attribute

1. From Configuration, select the Attributes tab.

All existing attributes for the selected attribute type appear in the grid.

2. Select an attribute type. Select either Customer or Document.

3. In the Attributes grid, enter a description of the new attribute in the first available blank line of the Description column.

4. Move your cursor to the adjoining field in the Data Type column. Click in the field, and select a type from the drop-down list. This defines the format for the attribute field (for example, table, date, text, yes/no, number, or currency).

5. If you select Table as your data type, click the adjoining field in the Table Name column, and select an existing table name or [Add New Table].
6. For steps on adding an attribute table, see the next procedure, **Adding an attribute table**.

![Configuration - Accounts Receivable](image)

**Adding an attribute table**

1. From the Attributes tab, follow the procedure outlined in the previous procedure to define an attribute, and select **Table** as the **Data Type**.

2. In the **Table Name** column, select [Add New Table], and then click anywhere outside the field. The Add New Table screen appears.

![Add New Table](image)

3. Enter the name of the new table. If you want to use a short description of the table name, mark the checkbox, and enter the number of characters for the abbreviation.

4. Click **OK** to save the new table. If you want to add entries to the newly created table, select the Tables tab and follow the procedure for **Adding new table entries**.

**Products Tab**

The Products tab tracks products and services your organization frequently sells. These products appear as line items on your invoices. From this tab, you can add, edit, or delete a product record.
You can define products specific to Accounts Receivable, Accounts Payable, or All programs. When you add a new product, you can assign a receivables account to which all revenues from the product are posted. If you do not associate the product with a particular account, the product revenue goes to the receivables account you define for the fund to which you post revenues from the product. In the event that neither the product nor the associated fund are associated with a receivables account, the program uses the default receivables account you define on the Default Acct tab in Configuration.

The Products tab also allows you to view products from both the Accounts Receivable and Accounts Payable programs. An Accounts Receivable product is anything your organization sells to generate income. There are three product categories: Quantity, Service, and Comment. If Blackbaud’s Accounts Payable with the optional Purchase Orders module is present, you can enter products routinely purchased from vendors. In this case, you enter products for use in both the Accounts Receivable and Accounts Payable programs.

As the number of products grows, you can simplify locating a particular product record by clicking Find. This allows you to search for a product based on all or part of the definition of the Product ID, Description, Unit of Measure, or System(s).

➤ Adding a new product (or service)

1. From Configuration, select the Products tab.
2. Click **New Product**. The Add Product screen appears.

3. In the **Type** field, select the program for the product you want to add. The screen above displays if you select **Accounts Receivable** as the type of product. If you select **Accounts Payable** or **Both** as the type of product, the Add Product screen appears.

Here you can enter an **AP Unit Cost** and **Receiving Location**.

4. If you selected **Accounts Receivable** as the type of product, enter a **Product ID** that conforms to your organization’s format. You can enter as many as 12 characters as a short description of the product. Enter a **Description** if you need to define the product further.

5. Click the down arrow in the **Unit of measure** field to make a selection from the drop-down list.

6. Mark the **Product is inactive** checkbox if you do not want it to appear as an option when you define line items for documents.
7. If you define a product you sell (an *Accounts Receivable* product) or a product for *All* types (both *Accounts Receivable* and *Accounts Payable*), select the Accounts Receivable Info tab.

8. Select one of the *Category* options, *Quantity*, *Service*, or *Comment*, from the drop-down list. *Quantity* is typically a physical product, such as play tickets, newsletters, etc., that is tracked by the quantity of the product purchased. *Service* is a category for services your organization provides, such as maintenance, life guard duty, etc. If you define a *Comment* product, this simply adds a comment as a line item on the customer’s invoice.

9. If you select *Quantity* as the product category, determine the precise decimal configuration of the quantity in the *Quantity decimals* field.

10. If you select *Quantity* as the category, you can enter price ranges in the grid that appears on the right side of the screen.

11. You can enter a receivables account number in the *AR Account* field by entering the account number in the field, or defining the account using the drop-down criteria screen. You can also click ![to locate the appropriate receivables account.

12. If you have installed Blackbaud’s *General Ledger* and *Project, Grant, and Endowment Management*, you can also enter a *Project* to which revenues from this product are assigned.

13. If the product is subject to taxes, mark the *Product is taxable* checkbox.

14. If a discount is available for prompt payment for this product, mark the *Prompt payment discount* checkbox.

*Accounts Receivable* accounts can be defined on the Default Acct tab of *Configuration*. If you define more than one account, these accounts appear as choices when you are searching for the appropriate receivables account on the Accounts Receivable Info tab of the Add Product screen. If you do not enter a receivables account, the program uses the account you define on the Default Acct tab for the product.
15. If Blackbaud’s **General Ledger** is present, you can distribute the product revenues on the Revenue Distribution tab.

![Add Products](image)

16. Click the search button in the **Account No.** field to locate and select the account number. If you are using *Project, Grant, and Endowment Management*, you can also associate the product with a **Project**.

17. You can associate revenues from the new product with more than one general ledger account by entering the percentage for distribution in the **Percent** column.

   If you want the revenues evenly distributed across the accounts, click **Distribute Evenly** instead of entering separate percentages. Click **Load Distribution** if you have defined a particular distribution table that you want to use.

18. If you want to associate the revenue or a percentage of the revenue from the product with one or more projects, enter the project ID in the **Project** column. In the event you have set up a distribution across several account numbers, and want to further divide one or more of these percentages in a project distribution, click **Projects**. This displays the Project Distribution screen, where you can select projects and set up the distribution percentages you want.

19. Click **OK** to add the product to your database.

**Editing a product**

1. From **Configuration**, select the Products tab.

2. Highlight the product you want to edit, and click **Open**. The Edit Product screen appears.

![Edit Products](image)
3. Make necessary changes on any of the tabs, and click **OK**.

 ➢ **Deleting a product**

1. From *Configuration*, select the Products tab. Highlight the product you want to delete, and click **Delete**. A confirmation message appears.

2. If the product you want to delete is not used in a line item of any record, you can delete it. If the product is currently used in a line item, a message screen appears.

---

**Aging Information Tab**

*Accounts Receivable* provides pre-defined aging periods that you can change if they are different from the aging periods your organization uses. The Aging Information tab allows you to define four default aging periods for aging-based transactions.

Aging information can be calculated based on the **Transaction date** (date the transaction was added) or the **Due date** (date payment is due on the transaction).

Aging periods must be sequential, and they cannot overlap. The start value for Period One is always zero. The program calculates the start values for periods two through four by adding one day to the end value of the previous aging period. For example, if Period One is 0 - 30 days, then Period Two automatically starts at day 31.
Defining four aging periods for aging transactions

1. From *Configuration*, select the Aging Information tab.

2. Base aging on either the **Transaction date** or the **Due date**.

3. Using the aging information setup shown in the above screen and the example of a charge with a transaction date of June 1 and a due date of July 1, aging is determined according to the following:

   **Using Transaction date**: If you viewed the activity summary on July 2, the transaction amount would appear in Period 2, the 31-60 days aging bucket, because the transaction date is more than 31 days before the viewing date.

   **Using Due date**: If you viewed the activity summary on July 2, the transaction amount would appear in Period 1, the Current aging bucket, because the due date falls within 30 days of the viewing date.

4. Enter the **End value**, **Short Description**, and a **Description** for each aging period. The program automatically calculates the next **Start** value using the previous **End** value plus one.

**Statements Tab**

The Statement tab of *Configuration* allows you to define default statement descriptions for each transaction type, including invoices, sales returns, regular credit memos, regular debit memos, payments, finance charges, and discounts taken. The default descriptions appear in the statement description field on each transaction, but you can overwrite them.
Defining statement descriptions

1. From *Configuration*, select the Statement tab.

2. In the transaction type fields provided, enter the descriptions you want to use for each of the transaction types. You can alter any of the existing defaults.
Terms Tab

Term discounts are a way to allow your customers to receive discounts based on early or prompt payment of their accounts. You can establish terms in Configuration that you can select for particular invoices. You can also establish terms for individual customers in Customers. If you define a set of terms for a customer or specific invoice, you can manually adjust these terms at any time.

The grid on the Terms tab allows you to add, edit, and delete payment terms.

- **Adding a term discount**
  1. From Configuration, select the Terms tab, and click **New Terms**. The Add Term screen appears.
  2. Enter the **Term ID**, which can be up to 12 characters.
  3. Enter a **Description** of the terms you are defining.
  4. Enter the **Due days** (number of days from the order date on which an invoice is due).
  5. Enter the **Discount %** (percentage amount of the discount if the early payment term is met)
6. Enter the **Discount days** (number of days before an invoice is due for which the customer is eligible for the discount).

7. Click **OK** to add the new set of terms.

➢ **Editing a term discount**

1. From *Configuration*, select the Terms tab, and click **Open**. The Edit Term screen appears.

2. Make any necessary changes, and click **OK**.

➢ **Deleting a set of discount terms**

1. From *Configuration*, select the Terms tab.

2. Highlight the terms you want to delete, and click **Delete**. If the term you select is not in use on any record, you can proceed with the deletion. If the term is used by one or more records, a warning message appears.

    ![Edit Term Screen](image)

    ![Delete Term Warning](image)

**Sales Tax Tab**

For each sales tax record, you must specify a tax code and description. The Sales Tax tab allows you to define multiple sales tax entities that comprise the sales tax code. For example, a tax code may be comprised of a federal tax, a state tax, and a local option sales tax. For each tax in the code, you can specify a rate and whether or not the sales tax is compounded. A maximum of five tax entities may be entered for each code you define.

The Sales Tax tab allows you to add, edit, or delete sales tax codes, as well as add, edit, and delete individual sales tax entities from any code you have defined.
Adding a sales tax code

1. From Configuration, select the Sales Tax tab.

2. Click New Sales Tax. The Add Sales Tax screen appears.

3. You must enter a Tax code of up to 12 characters and a Description of the tax code you are defining.

4. The spreadsheet grid allows you to define up to five separate tax entities that comprise the tax code. The preceding example shows two sales tax entities, each with its own Rate, which is the tax percentage added to a line item.

5. If you are using Blackbaud’s General Ledger, you can enter the GL Account number or search for the appropriate account using [A]. If General Ledger is present, the Account Description field is automatically filled in. If you are not using General Ledger, you can enter your own text for the description of the ledger account to which you post sales tax.

6. Mark the Compound? checkbox for any tax entity you want the program to calculate as compounded. You can also designate to include any applicable finance charges in the calculation of the tax entity by marking the Fin Chg? checkbox.
7. If you do not want to allow the sales tax code to be used, mark the Tax code is Inactive option. The code remains in your record of sales tax codes and can be activated again by editing the code.

8. Click OK to save the new sales tax code.

**Editing a sales tax code**

1. From Configuration, select the Sales Tax tab.

2. Highlight the sales tax code you want to edit, and click Open. The Edit Sales Tax screen appears.

3. Make any necessary changes to the code or its entities, and click OK to save the changes.

4. If you want to delete an entity entirely, select the appropriate row in the grid by clicking on the row number and pressing Delete on your keyboard. A confirmation screen appears, and if the tax entity is not in use on any record, you can delete the entity from the tax code.

**Deleting a tax code**

1. To delete a sales tax code, select the Sales Tax tab in Configuration, and highlight the tax code you want to delete.

2. Click Delete. A confirmation screen appears.

3. Click Yes to delete the sales tax code or No to return to the Sales Tax tab. If the sales tax code you want to delete is in use on one or more records, you cannot delete the code. Instead, the following message appears.
4. To delete the sales tax code, you must first remove the code from all records in your database, and then return to the Sales Tax tab and follow the deletion procedure.

**Interfund Tab**

If you have Blackbaud’s *General Ledger for Windows* installed, you can use the functions offered on the Interfund tab in *Configuration* of *Accounts Receivable*. The Interfund tab allows you to designate the appropriate accounts for the automatic creation of transactions in your general ledger system. When you post transactions, you need to create interfund entries if the income statement accounts and balance sheet accounts are in different funds. The interfund entry allows the program to balance these accounts.

On the Interfund tab, you can define default interfund entry sets that are automatically used when transactions meet the conditions you define. Interfund sets allow you to group multiple interfund entries. One set of Interfund entries is designated as the default set, but you can change this at any time. The interfund entry sets you define here, are available for all Blackbaud accounting products located in the same database. The programs in which the set can be used are defined on the Blackbaud System tab that is accessed when adding or editing interfund sets. The default set is used, unless you click the “Interfund entries” button on each account distribution tab, and select a new set from the Interfund Preview screen.

*Accounts Receivable* verifies that the interfund entries in the set you selected create a balanced batch for posting when you save. If the entry does not balance, *Accounts Receivable* does not allow you to save. If the interfund set does not contain entries to handle the interfund transfers for the transaction, the transaction can not be saved.

If you choose not to use the default interfund entry set, you can click the Interfund entries button on the Account Distribution tab to view the interfund credit and debits for the transaction, and make an alternate selection. Once you post a transaction, the interfund entry set can not be changed. Once you save a transaction, any changes to the interfund set in *Configuration* will not be reflected on the transaction, display, or at post time, unless you reopen the transaction and refresh it. There is a refresh button on each interfund preview screen.
To change the order of information in a column, click the column header. This toggles the column sort order between ascending and descending order.

Adjustments to a posted transaction also allow you to change the interfund set. There is an Interfund Entry button on the Distribution tab of the adjustment to handle this. The default set cannot be deleted from the grid.

From the Interfund tab you can:

- Add an interfund set
- Edit an interfund set
- Delete an interfund set
- Copy an interfund entry
- Create a default interfund set
- Add an interfund entry
- Edit an interfund entry
- Delete an interfund entry
- Search for an interfund entry
- Sort an interfund entry
- Create a reverse entry

**Adding an interfund set**

1. From Configuration, select the Interfund tab.

You can also establish a default by selecting an existing default set from the drop-down list on the Interfund tab.
2. Click **New Interfund Set**. The Add Interfund Set screen appears.

3. Enter an **Interfund set ID** and **Description**.

4. Select the Blackbaud Systems tab.

5. In the **System** column, choose which program(s) can use this interfund set by marking the appropriate checkbox(es).

6. Click **OK**. The Interfund tab reappears and displays the new interfund set.

➢ **Editing an interfund set**

1. From **Configuration**, select the Interfund tab.

2. Highlight the interfund set you want to edit.
3. Click **Open**. The Edit Interfund Set screen appears.

![Edit Interfund Set Screen]

If you want to add, edit, or delete individual entries within an interfund entry set, please refer to the procedures on the following pages for specific instructions.

Deleting an interfund set

1. From **Configuration**, select the Interfund tab.
2. Highlight the interfund set you want to delete.
3. Click **Delete**. A confirmation screen appears.
4. Click **Yes**.

You cannot delete an interfund set that is currently in use or defined as the default interfund set.
Copying interfund sets

1. From the Interfund tab, click **New Interfund Set**. The Add Interfund Set screen appears.

2. Click **Copy from**. The **Copy From** screen appears.

3. Highlight the Interfund set you want to copy for the new set.

4. Click **OK**.

Adding interfund entries

1. From **Configuration**, select the Interfund tab.

2. Click **New Interfund Set** (to add a new entry to a new set) or highlight and open the set to which you want to add an entry.

You can choose which interfund entries you want to view by adding criteria in the **Show interfund entries that match these criteria** frame on the General tab.
3. Click **New Interfund Entry**. The Add a New Interfund Entry screen appears.

![Add a New Interfund Entry](image)

4. Add to the sentence, **When creating a transaction that will post a DEBIT to this fund or account**, by entering a fund number or specific account number of a fund that identifies the debited fund or account.

5. Complete the sentence, **and that will post a CREDIT to this fund or account**, by entering the fund number or specific account number of the fund that identifies the credited fund or account. Notice that the debited fund number and credited fund number now appear in the fields at the bottom of this screen.

6. Fill in the **Create a CREDIT to** field with the specific account number to which the program posts the interfund credit.

7. Fill in the **and a DEBIT to** field with the specific account number to which the program posts the interfund debit.

8. To view the transactions of a reverse entry procedure, click **Show Reverse Entry**.

9. Click **Save** to save the entries for the interfund set. When you close the Add a New Interfund Entry screen, the Interfund Set screen reappears.

- **Viewing a reverse interfund entry**

1. Open the interfund entry of which you want to view a reverse entry.
CONFIGURATION

2. Click **Show Reverse Entry**. The Show Reverse Entry screen appears.

![Show Reverse Entry Screen](image)

3. Click **Close**.

- **Creating a reverse interfund entry**
  1. Highlight the interfund entry of which you want to create a reverse entry.
  2. Click **Create Reverse Entry**. The screen refreshes with your new reverse entry added to the bottom of the list.

- **Editing interfund entries**
  1. From **Configuration**, select the Interfund tab.
  2. Highlight the interfund set that contains the interfund entry you want to edit.
  3. Click **Open**. The Edit Interfund Set screen appears.

![Edit Interfund Set Screen](image)

4. Highlight the interfund entry you want to edit.
5. Click **Open**. The Edit an Interfund Entry screen appears.

   ![Edit an Interfund Entry Screen](image)

6. Make any necessary changes to account numbers or fund IDs.
7. Click **Save**.

   ➢ **Deleting interfund entries**
   1. From *Configuration*, select the Interfund tab.
   2. Highlight the interfund set that contains the interfund entry you want to delete.
   3. Click **Open**. The Edit an Interfund Entry screen appears.
   4. Highlight the interfund entry you want to delete.
   5. Click **Delete**. A confirmation screen appears.
   6. Click **Yes**. The interfund entry is deleted.

   ➢ **Searching for an interfund entry**
   1. Access the Interfund tab.
   2. Highlight the interfund set that contains the interfund entry for which you want to search.
   3. Click **Open**. The Edit Interfund Set screen appears.
   4. Click **Find**. The Find screen appears.

   ![Find Screen](image)

5. Select the **Field** for which you want to search from the drop-down list.
6. In the **Find what** field enter a search criterion.

7. Choose to **Match** any part of the **Find what** field, all of the **Find what** field or the first part of the **Find what** field.

8. Mark the **Match case** checkbox if you want the search results to match exactly what is entered in the **Find what** field.

9. Click **Find First** or **Find Next** to begin your search.

10. When you have finished searching, click **Close**.

➤ **Sorting interfund entries**

1. Open the interfund set you want to sort.

2. Click **Sort**. The program sorts the entries in hierarchical order, from most general to most specific. For example, if the set includes debit to/from credit entries that are specific accounts (or single projects) and others that are a fund and any project, the sorting order places the fund and project combinations before the more specific accounts and project combinations. You can click **Sort** again to sort the entries in reverse order if you want.

### General Ledger Tab

If you are using Blackbaud’s **General Ledger**, you can take advantage of a built-in provision of **Accounts Receivable** that allows you to keep track of your accounting transactions within your own ledger accounting system. When you periodically post batches of transactions from **Accounts Receivable**, you can reference each journal entry with a source code for identification and routing to the appropriate accounts (cash or fee accounts, accounts receivable, or accounts payable). This feature provides seamless interaction between the transactions of your **Accounts Receivable** program and the fund accounting management of **General Ledger**.
Accessing the General Ledger tab

1. From Configuration, select the General Ledger tab. The following screen appears.

From the General Ledger tab, you can perform the following procedures:

- Define the AR (Accounts Receivable) source code
- Define the Document Journal References
- Define the Cash Journal References
- Reset the Journal References to the System Defaults
- Add Journal Reference Fields

Defining the AR source code

The AR source code is used to define the origin of all transactions from Accounts Receivable. Each transaction that posts to General Ledger is marked with the source code that is defined here. The AR source field has a drop-down list of available source codes. These source codes are defined on the Tables tab of Configuration in General Ledger.

1. From Configuration, select the General Ledger tab.
2. In the **AR source** field, click the down arrow to access the drop-down list of source codes.

![Configuration - Accounts Receivable](image)

3. Select a code (choose, **Accounts Receivable**, **Cash Receipts**, or **Adjustments**).

- **Defining the document and cash journal references**

  A journal reference can be defined for **Document** transactions and for **Cash** transactions by selecting either option and entering the reference fields and lengths. Select **Document** to define a default journal reference for discounts, invoices, credit memos, and debit memos. Select **Cash** to define a default journal reference for transactions posted from **Accounts Receivable** to **General Ledger**. You may define an unlimited number of fields, totaling a maximum of 50 characters.

  1. On the General Ledger screen in **Configuration**, mark the **Document** option in the **Journal References** frame.

Since transactions are posted to your General Ledger by line item, we recommend that you include **Line Item No.** and **Line Item Description** as part of your selection of journal reference fields for both Document and Cash transactions.
2. In the **Journal References** grid, select the fields used as a default description when posting detailed transactions to **General Ledger**. In the **Reference Field Name** column, select the name of the field you want to include. In the **Length** column, specify the number of characters for the field. You can define a total of 50 characters per journal reference.

The line below the grid shows a **Sample** of how the journal reference appears, according to the criteria you establish. **Restore Defaults** returns the selected journal reference fields to the program defaults.

3. If the field you want to define for your reference is not one of the defaults, you can select an existing program field to suit your needs. Click **Fields**, and the following screen appears.

4. Enter the name of a program field you want to add to your journal reference, and click **OK** to save the field and return to the General Ledger tab.

5. When you have finished defining both Document and Cash references, you can select another tab or select **File, Exit**.
International Tab

The International tab allows you to configure address formats that are specific to countries you need for mailings, reports, and customer address references. Blackbaud’s software programs currently support default address formats for five geographic areas: The United States, The United Kingdom, Canada, Australia, and New Zealand. You can add as many countries as you like, but they must have postal address formats like one of the supported countries.

When you add a new country to your database, you can enter an abbreviation for the country, select an address format, and include the full country name or the abbreviation in addresses. This information is used when preparing reports and mailings.

On the International tab of Configuration, you can add, edit, or delete country address formats you want to use in Accounts Receivable. You can define country-specific address formats for your mailings. When you use a particular country code, the program automatically reformats the address block information as defined for the code.

Adding a country

1. From Configuration, select the International tab.

2. Click New Country. The following screen appears.

3. Enter the Name of the country you want to add, and define an Abbreviation. For example, you could enter “Scotland” and “SCT.”
4. Select the proper address format from the drop-down list. You can have the program automatically format addresses like any of the five address formats currently supported by Blackbaud: The United States, Canada, Australia, the United Kingdom, and New Zealand.

5. Click OK to save the new country format code.

Editing a country

1. From the International tab of Configuration, highlight the country you want to edit, and click Edit. The Edit screen appears.
2. Make any necessary changes to the existing country settings.
3. Click OK to save your changes.

Deleting a country

You can delete any country you have defined in Accounts Receivable, but the program does not allow you to delete the five countries that are permanently supported: The United States, Canada, Australia, the United Kingdom, and New Zealand.

1. From the International tab of Configuration, highlight the country you want to delete, and click Delete. A confirmation screen appears.
2. Click Yes. If the country code is not in use by any of your records, the country is deleted from your database.

Distributions Tab

The Distributions tab in Configuration allows you to define account distributions and project distributions (if General Ledger and Project, Grant, and Endowment Management are installed) for transactions you post to your general ledger program. Here you can establish the accounts or projects and respective percentages you want the program to use when you assign a particular distribution to a transaction you post.
Adding a new account distribution

1. From Configuration, select the Distributions tab.

2. The program defaults to displaying all defined account distributions. If you have Project, Grant, and Endowment Management as well as General Ledger installed, you can click the down arrow in the Type field to view all Project Distributions in your program.

3. Click the down arrow next to the New Distribution button, and select Account Distribution. The Add Account Distribution screen appears.

4. Enter a Distribution name that defines the distribution you want to add.

5. Click in the first blank field of the Account No. column and enter the account number, or search for an account by clicking . The Account Description automatically enters and is not editable.

6. Enter as many accounts as you want to use in the distribution, and then enter the percent of the transaction you want disbursed to each of the accounts in the Percent column. If you want to distribute the total transaction amount equally among the accounts in the distribution, click Distribute Evenly.
7. If you have *Project, Grant, and Endowment Management*, installed, you can also add a project or project distribution to any of the accounts you have defined for the account distribution. For example, using the distribution shown in the above screen, you could further distribute the State Grants account revenues to a project or project distribution.

8. Place your cursor in the **Project** field on the same line as the account to which you want to add a project, and click **Projects**. The Edit Project Distribution screen appears.

9. Enter a project or projects in the fields of the **Project** column. The project descriptions automatically enter.

10. If you are defining more than one project, you can enter specific distribution percentages for each project, or distribute the transaction amount evenly across the projects by clicking **Distribute Evenly**.

11. Click **OK** to add the project distribution to the account distribution and return to the Add Account Distribution tab.

12. Notice that the **Project** field next to the State Grants account shows the addition of a **Distributed** project. Click **OK** to save.
Adding a new project distribution

Adding a project distribution is similar to the procedure outlined for adding an account distribution. Project distributions can only be added if you have Blackbaud’s optional Project, Grant, and Endowment Management module, which functions with General Ledger.

1. Select the Distributions tab in Configuration and select Project Distribution in the Type field. The following screen appears, listing all previously defined project distributions.

2. Click the down arrow next to the New Distribution button, and select Project Distribution. The Add Project Distribution screen appears.

3. Enter a Distribution name that uniquely defines the distribution you are defining.

4. Click in the first blank field of the Project column and enter the project number, or search for a project by clicking the search button. The Project Description automatically fills and is not editable.
5. Enter as many projects as you want to use in the distribution, and then enter the percent of the transaction you want to be disbursed to each of the projects in the **Percent** column.

   If you want to distribute the total amount of the transaction equally among the projects in the distribution, click **Distribute Evenly**.

   Click **Load Distribution** if you want to use a previously defined distribution for the new project distribution. The Load Project Distribution screen appears, listing all the project distributions in your database.

   ![Load Project Distribution Screen]

6. Highlight the distribution you want to use, and click **Select**. The distribution copies into the new project distribution, and the Add Project Distribution screen returns.

7. Click **OK** to accept the distribution or make any changes you want, and then click **OK**. The new project distribution saves automatically.

---

### Default Account Tab

**Accounts Receivable** allows you to specify multiple receivables accounts on an invoice, and these accounts do not have to be in the same fund. In **Configuration**, you can define these accounts in 3 areas:

- You can define a single overall default receivables account on the Default Acct. tab. This is a minimum requirement for the program.
- You can define a single receivables account for each fund. This is also done on the Default Acct. tab.
- You can define a single receivables account for each product. This is done on the Products tab.

   The receivables account you want to use for a transaction is determined hierarchically. If you define an account on the product record, this one is used. If you do not associate the product with a receivables account, the account defined for the fund to which the transaction containing the line item is posted is used as the receivables account. If neither of these is present, then the overall default account you define on the Default Account tab in **Configuration** is used as the receivables account for the transaction line item.
Adding a default receivables account

1. From Configuration, select the Default Acct tab.

2. Enter the account number you want the program to use as the program default receivables account. Use the drop-down arrow to display the account format screen, or click the search button to locate the account you want to use. The account you enter here is used if you do not assign an account to the product used in a line item transaction and the fund to which you post the transaction does not have a receivables account assigned.

3. If you have Project, Grant, and Endowment Management, you can also enter a default project to which all transactions are posted if there is not a project defined for the product and the fund.

4. In the default accounts grid, enter accounts and projects that you want the program to use as default receivables accounts for each of your funds.

5. If you enter an account number from a fund that already has a default receivables account defined, you receive the following error message.

6. Mark the checkbox to Use these receivables accounts and projects for each fund if you want the program to use the default accounts you have defined.

   If you unmark the option, the program automatically uses the account assigned to the product, or the single Default Account you defined on this tab.
Security is where you establish access rights for all your organization’s users of Accounts Receivable. Security rights are assigned to groups of users. You can create an unlimited number of groups, with various levels of program access. An individual’s access rights depend on the rights of the groups of which the user is a member, thus enabling you to control what users are allowed to view, add, edit, or delete.

When a user logs in to Accounts Receivable, those functions the user does not have access to are automatically disabled. Changes can be made to the user’s access rights at any time, but the new rights do not take effect until the next time the user logs in.

When you receive Accounts Receivable, Security includes a user named Supervisor, whose password is admin. This user has full rights to all areas of the program and cannot be deleted. You should change the Supervisor password as soon as possible to ensure the highest level of security for your organization.

Security Access

Accessing Security

The functions relating to security groups and users begin from the main screen of Security. You can add, edit, and delete groups and users from the main screen.

1. From the Start menu, select Programs, Blackbaud Accounts Receivable. A menu appears, displaying the Accounts Receivable modules.

2. Select Security, and log in with the correct user name and password. The Blackbaud Security screen appears.

If you have already logged in to Accounts Receivable, you do not have to log in again.

You should change the Supervisor password to a password unique to your organization. Please keep the password in a secure location that is accessible by at least two users.
From the main Security screen, you can add new security groups and users, view and edit existing groups, and delete users no longer needed. You can also print a group or user profile, which includes general security information such as name, description, group-member associations, and program access.

Security for Groups

You use security groups to establish access privileges for members of the group. Each group record has tabs for group information, shared tables, and shared components, as well as a tab for each Blackbaud program present in the database.

Because Security is a module common to all Blackbaud programs, you can establish a group with access rights to one or more programs. For example, you can create the Billing group and give its members access privileges to all areas of Accounts Receivable, Accounts Payable, and Miscellaneous Cash Receipts.

Users are given access privileges based on group membership. A user must be added to the system before being added to a group. Users can be members of more than one group.

Adding a group

The following procedure takes you through the steps required to establish a new security group.


   ![Add a Group Screen](image)

   - Group Name:
   - Description:
   - Group Members:

   ![Group Members](image)

   Not Members:
   - Supervisor
   - George_Lucas
   - Grace_G
   - Justin_Marshall
   - Sandra_Lynn
   - Dona_Yee
   - John_G
   - Nichols_Indiana

   Members:

   ![Members](image)

   2. Enter the Group Name and Description.

   3. In the Group Members frame, highlight a user name and click the arrow button to move the user from the Not Members box to the Members box. Repeat this step for other users you want to add to the group.
4. Select the Shared Tables tab.

5. Mark the checkbox for each table you want the members of this group to have rights to. If the checkbox is left cleared, the user will not be able to add, edit, or delete entries from the table.

6. Select the Shared Components tab.

7. Mark the checkbox for each component you want members of the group to access. If a checkbox is cleared, users cannot access the corresponding component.
8. You can further define access privileges for shared components by highlighting the component name and clicking **Options**. The Security Options screen for the selected component appears.

![Security Options](image)

9. For each option listed in the grid, mark the checkbox to allow users to view, add, edit, and delete. If the checkbox appears in a cell with a yellow background, you cannot edit it. For some options, N/A appears instead of a checkbox to indicate the item is not available or applicable.

10. After defining privileges on the Security Options screen, click **OK** to return to the Shared Components tab.

11. Select the Accounts Receivable tab.

![Add a Group](image)

12. Mark the checkbox next to each component to which you want the users in this group to have access: **Customers**, **Configuration**, **Cash Receipts**, **Mail**, **Notes**, **Query**, **Reports**, **Utilities and Housekeeping**, **Global Change**, and **Import**.
13. You can further define access privileges for some components by highlighting the component name and clicking **Options**. The Security Options screen for the selected component appears.

![Security Options](image)

<table>
<thead>
<tr>
<th>Functions</th>
<th>View</th>
<th>Add</th>
<th>Edit</th>
<th>Delete</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customers</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Miscellaneous Info</td>
<td>✓</td>
<td>N/A</td>
<td>✓</td>
<td>N/A</td>
</tr>
<tr>
<td>Activity</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Recurring</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Notes</td>
<td>✓</td>
<td>N/A</td>
<td>✓</td>
<td>N/A</td>
</tr>
</tbody>
</table>

14. In the **Functions** box, mark the functions you want users to be able to access. When you highlight a function, the grid on the right displays items you can allow the group to view, add, edit, and/or delete. Mark the appropriate checkboxes to give users privileges. Leave the checkbox blank if you want to restrict users from those actions.

15. Repeat steps 10 and 11 to establish group access for any remaining components of **Accounts Receivable**. You can also establish group rights for any other Blackbaud programs that are present.

16. Once you define the security options for each component, click **OK** to save and return to the Accounts Receivable tab.

#### Editing a group

You can edit a group any time you need to add or delete a member, or change the group’s access privileges. If you edit a group’s privileges while one or more of its members is logged into a program, the changes you make do not take place until the user(s) exits and logs in again.

1. From **Security**, highlight the group you want to edit.
2. Select **File, Open**. The Group screen appears.

3. Make the necessary changes to the group.

4. Click **OK** to save and close the group record.

**Previewing and printing a Group Profile report**

A Group Profile includes the name and description of the group, a list of group members, and a list of access privileges assigned to that group.

1. From the Blackbaud Security screen, highlight the group for which you want to preview or print a profile.
2. Click to preview the profile, or click to print the Group Profile to your default printer.

3. If you preview the report, a processing message appears, and then the report displays.

4. Close the User/Group Profile screen to return to the Blackbaud Security screen.

Deleting a group

Use the delete function to remove security groups that are no longer used or that have been replaced.

1. From Security, highlight the group you want to delete.
2. Select File, Delete. A confirmation message appears.
3. Click Yes to delete.

Security for Users

The user record is where you establish the individual’s user name, password, and security rights. You can assign the user Supervisor rights, which extend rights of access to all areas of the program, or Selected group rights to limit access to specific areas of the program.

By choosing Selected group rights, you can limit a user’s security rights to those defined for a security group. A user can be a member of more than one group.

If General Ledger is present, you can also enable account security for the user. With account security enabled, you can restrict the user from certain accounts.
Adding a user

1. From Security, select File, New User. The Add a User screen appears with the User Information tab displayed.

   ![Add a User screen]

2. Enter the User Name and Description.

3. In the Password Options frame, enter the user’s Password. In the Confirm field, type the password again to ensure you entered the password correctly. If you want to allow the user to change this password, mark User May Change Password.

4. In the Group Assignments frame, mark Supervisor rights to give the user access to all areas of the program, or mark Selected group rights to give the user rights based on group membership. If you choose Selected group rights, use the arrow buttons to move the groups to which the user is a member from the Not a member of box to the Member of box.

5. If General Ledger is present, select the General Ledger Accounts tab.

   ![General Ledger Accounts tab]

6. Mark Account Security Enabled if you want to set security options for General Ledger accounts. If the Account Security Enabled option is cleared, you cannot edit the grid.
7. Mark Allow Access only to the Accounts selected below or Prevent Access to the Accounts selected below.

8. In the Account column, enter the accounts to which you want to allow or prevent access. Click the binocular icon to access the Search for Account screen. When you enter an account, the Description automatically displays.

9. Click OK to save and close the user record.

➤ Editing a user

Users with supervisor access rights can edit all areas of any user’s record, including group assignments.

1. From Security, highlight the user you want to edit and select File, Open. The user record screen appears.

2. Make the necessary changes to the user record.

3. Click OK to close the record. The program automatically saves the changes.
Previewsing and printing a User Profile report

A User Profile report includes the name and description of the user, a list of individual security settings, and a list of group access privileges the user can access.

1. From the Blackbaud Security screen, highlight the user for which you want to preview or print a profile.

2. Click to preview the profile, or click to print the User Profile to your default printer.

If you preview the report, a processing message appears and then the report displays.

You can print the User Profile from the preview screen.
3. Close the User/Group Profile screen to return to the Blackbaud Security screen.

- **Deleting a user**
  
  Use the delete function to remove users that no longer need access or who are no longer eligible for access to the program. You can delete former employees and current employees who have moved to other positions in the organization.
  
  1. From Security, highlight the user you want to delete.
  2. Select **File, Delete**. A confirmation message appears.
  3. Click **Yes** to delete the user record.

**Passwords**

Each user must have a password to access the *Accounts Receivable* modules. Although user names must be unique, you can use the same password for more than one user. You can define and edit passwords from each user’s record. If you mark the option **User May Change Password**, your users can change their passwords by choosing **Edit, Change Password** from the menu bar of any module.

When you receive *Accounts Receivable*, Security contains a user named *Supervisor*, whose password is *admin*. You should change the Supervisor password to a unique password as soon as possible.

- **Changing the Supervisor password**
  
  1. From the program menu, select **Blackbaud Accounts Receivable, Security**. The Login screen appears.
  2. Enter *Supervisor* in the **Name** field.
  3. Enter *admin* in the **Password** field.
4. Click **OK**. The Blackbaud Security screen appears.

5. Select **Edit**, **Change Password**. The Change Password screen appears.

6. Enter the **Old password**, **New password**, and the new password again in the **Confirm new password** field.

7. Click **OK**. A confirmation message appears.

8. Click **OK** to return to the main Security screen.
Changing a user password from Security
To change a user password, the user must have supervisor rights or have the User May Change Password option selected on the User information tab of his or her security user record.

1. From the main screen of Security, highlight the user whose password you want to change.

3. Enter the Old password, New password, and the new password again in the Confirm new password field.
4. Click OK. The following confirmation message appears.

5. Click OK to return to the Blackbaud Security screen.

Changing a user password from any module
If the User May Change Password option is marked on your user record in Security, you can change your password from the Edit menu of any Accounts Receivable module.

1. From any Accounts Receivable module, select Edit, Change Password. The Change Password screen appears.

2. Enter the Old password, New password, and the new password again in the Confirm new password field.
3. Click **OK**. The following confirmation message appears.

![Password changed successfully](image)

4. Click **OK** to return to the *Accounts Receivable* module in which you are working.
Utilities and Housekeeping

In This Chapter

System Statistics .................................................. 90
Posting Options .................................................... 91
Database Validation ............................................... 93
Utilities and Housekeeping is where you perform general database maintenance and posting tasks such as viewing system statistics, validating your database, and posting transactions to General Ledger if it is present.

Viewing system statistics gives you current totals of all customers, invoices, sales returns, debit memos, credit memos, payments, and recurring invoices in your Accounts Receivable program.

You can use the validation procedure to check your Accounts Receivable database indexes. When you select this option from the File menu of Utilities and Housekeeping, the program scans each row of your Accounts Receivable database tables and compares them to each table’s index. If one does not compare positively to the other, a corruption error message appears. Before you can run the validation process all users must log out of all Blackbaud programs.

Posting to General Ledger creates a new General Ledger batch, or export file, consisting of all Accounts Receivable transactions that have not previously been posted. During either process, the program also updates the status of each transaction included in the post or export file to Posted. Before you run the posting option, all other users must log out of the Customers module of Accounts Receivable.

System Statistics

System Statistics provides you with current counts of all transactions and customer records. The list also shows the date of the last Post to General, the user name of the person making the post, the date Finance Charges were last calculated, and the user name of the person running the calculation. The information is display only, you cannot edit or print the system statistics.

Viewing system statistics


   ![System Statistics](image)

   - Number of Customers: 19
   - Number of Invoices: 54
   - Number of Sales Returns: 3
   - Number of Debit Memos: 19
   - Number of Credit Memos: 11
   - Number of Payments: 13
   - Number of Recurring Invoices: 7
   - Post to General Ledger last run on: 12/08/1997
   - Post to General Ledger last run by: Supervisor
   - Finance Charges last run on: 02/04/2000
   - Finance Charges last run by: Kim

2. Once you have viewed the statistics, click Refresh if you want the program to update and recalculate the statistics. This is a useful procedure when other users are in the system and you want to get a current update on all statistics.

3. Click Close to exit.
Posting Options

Using the Posting procedure, you can:
• Post to an export file
• Post to General Ledger
• Print or preview a pre-posting report

You use the same procedure and set of tabs to set up each of these options. You can combine generating the report with either of the other options. On the first tab you indicate whether you want to Post directly to General Ledger or Create an export file.

Posting procedure

1. From Utilities and Housekeeping, select File, Post to General Ledger. The Post to General Ledger screen appears with the General tab displayed.

2. In the Post Accounts Receivable with source code field, select the appropriate source code from the drop-down menu. The available source codes are established on the General Ledger tab of Configuration and simply identify all transactions posted from Accounts Receivable.

3. In the posting method area, indicate if you are posting to Blackbaud’s General Ledger for Windows, or if you want to create an export file for a different application.

Mark Post directly to Blackbaud’s General Ledger or Create an export file in this format.

4. If you mark Create an export file in this format, select a format from the drop-down list. You must also enter the path and Export file name. You can click the browse icon to search for the path.

The following steps of the procedure apply regardless of the option marked.
5. Select the Posting Details tab.

6. You can change the **Post Method** for any of the five **Transaction Types**. Using the drop-down menu, select either **Detail** or **Summary**. You can also select **Summary by Deposit** for Cash transactions.

7. The Detail method prints each transaction line item, whereas the Summary method prints only the accumulated total of each transaction type by account number and **Post Date** or **Fiscal Period**. **Summary by Deposit** provides the accumulated total of each deposit by account number and **Post Date** or **Fiscal Period**.

8. You can also change the **Reference Type** from **<Default>** to **Custom**. If you choose Custom, the **Reference** field is enabled and you must enter a value.

9. In the **Summarize transactions by** field, select **Post Date** or **Fiscal Period** from the drop-down list.

10. You can mark the checkbox to **Validate deposit totals before posting**. If you mark this checkbox the program compares your running and projected totals to see if there is a discrepancy. If the deposit totals do not match you receive a warning message. You can choose to ignore the message and continue with the posting process.
11. Select the Format tab.

12. You can mark the **Preview report after posting** option to preview the report on screen. You can choose to print the report from the preview screen. You can mark **Print report after posting** to automatically send the report to the printer.

13. In the **Display report in** field, indicate if you want the pre-posting (or batch validation) report to print in **Landscape** or **Portrait** format.

14. If you marked **Print report after posting**, select a printer from the **Print report on** drop-down list.

15. In the **Sort report by** column you determine how information is displayed in the report. Three sorting levels are available.

16. Click in the **Sort report by** column to activate a down arrow. Click the down arrow and select an entry from the drop-down list.

17. For example you might select **Account number**, **Transaction number**, and **Amount**. In this case the program sorts by account numbers, then within each account number sorts by transaction number, and finally within each transaction number by amount.

18. Click in the **Order** column to activate a down arrow. Click the down arrow and select **Ascending** or **Descending**.

19. You can repeat these steps to establish the sorting order for the second and third levels.

20. Click **Pre-Posting Report**. The system will process and validate the batch before displaying the report.

21. The report opens in a preview screen. From this screen you can preview, print, or export the report.

22. Close the preview screen. To post to **General Ledger** or to an export file, click **Post Now**.

23. After processing, a message confirming completion appears. Click **OK**.

---

Before you run the posting option, all other users must log out of **Customers**.
Database Validation

Database validation checks the validity of your Accounts Receivable database indexes. Server crashes and network interference can corrupt your database; therefore, we recommend validating it weekly. Before validating the database, we recommend creating a backup of the database.

When you select this option from the File menu of Utilities and Housekeeping, the program scans each row of your Accounts Receivable database tables and compares them to each table’s index. If one does not compare positively to the other, a corruption error message appears.

There are two possible types of error messages you could receive while running the database validation procedure: errors found while running the validation and critical or assertion failed errors. The first type allows the validation procedure to continue and you can then go back through your tables to fix the error. The second type stops the validation procedure and disconnects the database. You then need to shut down your computer and restart the database. Both errors are reported on the Database Validation Control Report, which runs and appears only if you have errors. This report lists the number of errors, the table name, and the type of error found.

- Validating the database

  1. From Utilities and Housekeeping, select File, Validate Database. The Validate Database screen appears.

  ![Validate Database](image)

  2. This screen warns you that other users must be logged out of all Blackbaud programs.
3. After all other users are out of the program, you can begin the procedure by clicking **Proceed** on the Validate Database screen. The Database Validation screen appears.

4. This warning dialog screen reminds you of the conditions you must adhere to when validating your database.

5. Click **Continue**. Another confirmation screen appears.

6. Click **Yes** to continue the validation process. A status screen shows you the progress of the procedure.

7. Once the procedure is complete, the following message appears.

8. If there are errors in your database the Database Validation Control Report runs and displays. You can view the error descriptions on screen or send the report to your printer.

9. Click **OK**.
# Customers

## In This Chapter

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generating Recurring Invoices</td>
<td>98</td>
</tr>
<tr>
<td>Calculating Finance/Late Charges</td>
<td>99</td>
</tr>
<tr>
<td>Setting Defaults</td>
<td>99</td>
</tr>
<tr>
<td>Viewing Properties</td>
<td>100</td>
</tr>
<tr>
<td>Annotating records</td>
<td>100</td>
</tr>
<tr>
<td>Bookmarks</td>
<td>100</td>
</tr>
<tr>
<td>Setting Preferences</td>
<td>100</td>
</tr>
<tr>
<td>Accessing Records</td>
<td>104</td>
</tr>
<tr>
<td>Creating Defaults</td>
<td>104</td>
</tr>
<tr>
<td>Attributes and Notes</td>
<td>106</td>
</tr>
<tr>
<td>Transaction Line Items</td>
<td>107</td>
</tr>
<tr>
<td>Adding New Records</td>
<td>111</td>
</tr>
<tr>
<td>Customer Activity</td>
<td>114</td>
</tr>
<tr>
<td>Miscellaneous Customer Information</td>
<td>116</td>
</tr>
<tr>
<td>Recurring Tab</td>
<td>118</td>
</tr>
</tbody>
</table>
Using **Customers**, you can establish individual records for your customers. Each customer record maintains name, address, phone, and contact information, as well as miscellaneous items such as tax, credit, statement, and discount information. From the Activity tab, you can create invoice, credit memo, debit memo, sales return, and payment records for the customer. You can also create recurring invoice records, attributes, and notes for each of your customers.

After you complete the required system setup as outlined in the previous chapters, you can begin to use **Customers**. This chapter addresses the common options and screens, including preferences, attributes, and notes. This chapter also contains procedures for setting preferences, searching for a record, viewing properties of records, creating default files, and adding attributes, notes, and line items to records.

In addition to creating new customer records and opening existing records, other useful functions and facilities are available from the **File** or **Edit** menu of **Customers**. These include:

- Generating Recurring Invoices for customers
- Calculating Finance/Late Charges for customer records
- Establishing Defaults for individual record types
- Viewing Properties of records
- Annotating records
- Setting Bookmarks for functions within records
- Setting Preferences for records

## Generating Recurring Invoices

A recurring invoice is a template from which regular invoices are created according to a schedule. You can assign such a schedule to any customer for whom you want to generate regular invoices. From the main **Customers** screen, select **File**, Generate Recurring Invoices.

![Recurring Invoice Reminder](image)

From here you can generate recurring invoices for **All customers**, **Selected customers**, or **One customer**. You can choose the date you want the invoices to generate, post status, post date, ship date of your product or service, invoice status, and whether you want to view results and print a control report before creating the invoices.

See the **Invoices** chapter for more information about recurring invoices.
Calculating Finance/Late Charges

You have the option of assessing finance or late charges to any or all of your customers. From the Customers main screen, you select File, Calculate Finance/Late Charges, to display the screen that enables you to define all the parameters for finance charges and late charges.

See the Finance and Late Charges chapter for more information about calculating finance/late charges.
Setting Defaults

In addition to various default settings you can define from Edit, Preferences, you can also establish defaults to assist you when you add new records. By selecting File, Defaults, you can add default settings for six different types of records in your database.

From this screen, you can load defaults applicable to the type of record you are adding. The program automatically enters the default information in the respective fields in a new record.

Viewing Properties

With a customer record open, you can view the properties of that record by selecting File, Properties.
Annotating records

If you want to be reminded of an important situation or condition regarding a particular record, you can create an annotation for the record by selecting Edit, Annotate. A standard notepad screen appears.

Bookmarks

The Bookmark feature in *Accounts Receivable* is useful when you want to temporarily exit a record and be able to return to that particular record or task at a later time. With the record open, simply select Edit, Set Bookmark. After closing the record, you can return to the same record by selecting Edit, Restore Bookmark.

Setting Preferences

Setting preferences in *Customers* enables you to control the way your records appear on screen, as well as how the program presents general information.
Setting preferences

1. From Customers, select Edit, Preferences. The Preferences screen appears.

2. In the Miscellaneous frame, click the down arrow in the Toolbar new action field, and select the type of record you want to create when you click New. Select <ask> if you want the program to prompt you for the record type.

3. Mark Show save information dialog to see a confirmation message when you save a record. This is especially helpful if you are a new user.

4. Mark Recently opened records _ entries and enter the number of records (1-9) to see a list of recently opened records at the bottom of the File menu. This makes returning to a recently opened record easy.

5. Mark Display search screen automatically when using “Save and New” feature for customer records. This saves time when you need to create several transaction records for different customers.

6. In the Default Post Information frame, select a default Post Status and Post Date from the drop-down lists. You can always change these options on the transaction records.
7. Select the Defaults/Tab Settings tab.

![Preferences dialog box]

8. From this tab you can designation with tab you want to appear at front when you open the selected record. You can also set which tabs you want the program to mark with a red checkmark when the tab contains information.

9. Make your default selections for each record type.

10. In the Default tab field, select the tab you want the program to display when you create or open a record for each record type.

11. Under Tabs to check for data, mark the checkbox for those tabs you want to appear with a red checkmark when information is stored on them.

12. Click OK to save your preferences and return to the main Customers screen.

**Accessing Records**

*Accounts Receivable* includes a very efficient search feature you can use to locate any record type. You can speed your search by entering criteria on which to base the search, limiting the search to only those records that meet your definition.
Although **Accounts Receivable** enables you to have an unlimited number of customer records open, your number may be limited by your system resources.

---

### Searching for a record

When you want to open a customer record, you can perform a search based on your criteria, or you can scroll through all records in your database, filtered by record type.

1. From the **Customers** main screen, select **File, Open**. The search screen appears.

   ![Search Screen](image)

   ![Search Screen](image)

   ![Search Screen](image)

2. In the **Find** field, click the down arrow and select one the record type. To view all records of that type, click **Find Now**.

   ![Search Screen](image)

3. You can scroll through the list of records in the display window, highlight the record you want to open, and click **Open**. If your list of records is lengthy, you can narrow the list by entering criteria in the fields below the display grid.

4. Enter filter criteria such as **Customer Name**, **Customer ID**, **Phone number**, **Contact name**, **City**, **State**, **Last modified by**, and **Last modified on**.

---
5. The Contact name field changes, depending on the record type. You can select from the list of available fields.

6. Click Find Now. All records matching the criteria appear in the search results grid.

7. From the list, highlight the record you want, and click Open.

When using the search screen, you can click Query to display a list of all queries you have created. This is another way of locating a particular file, if you know it is part of a specific query record.

You can also click Open as List to view all customers in a simplified list. To add a new customer record from the search screen, click Add New.

Finally, the Options button accesses a screen where you set preferences for the Open screen, such as having the program load search results automatically.

➤ Viewing record properties

You can view the properties of any record, including the date it was added to your database or last changed, and the person who added the record or last made any changes.

1. After opening the customer record, select File, Properties. The Properties screen for that record appears.

![Properties for Advanced Optics, Inc.](image)

Creating Defaults

Defaults reduce data entry when you create new records and can be defined for all records except payments. For example, if all your local customers’ addresses have the same city, state, and country name, you can define a default for these fields and eliminate the need to enter this information each time you create a new local customer record.
Creating a defaults file

1. From Customers, select File, Defaults. The Defaults screen appears.

   ![Default Screen]

   2. Select the record type for which you want to establish defaults, and click New. The Default Information for a New Default Set screen appears.

   ![Default Information Screen]

   3. Enter the Name of the default file and the appropriate default values.

   4. Click OK to return to the Defaults screen.
Editing a defaults file

1. From Customers, select File, Defaults. The Defaults screen appears.

2. Mark the record type, highlight the defaults file, and click Edit. The defaults file appears, where you can make necessary changes.

3. Click OK to save your changes.

Deleting a defaults file

1. From Customers, select File, Defaults. The Defaults screen appears.

2. Mark the record type, highlight the defaults file you want to delete, and click Delete. A confirmation message appears.

3. Click Yes to delete the file, or No to return to the default file screen.

Attributes and Notes

You can enhance the definition of any customer record in your database by including attributes and notes. You can establish a table of attributes in Configuration to make it easy to add an attribute to a record. You can also add a new attribute to the existing table at the time you add it to a record. Attributes can add any type of information your organization finds useful, such as Number of times on credit hold or Years a member. Users with security rights can add, edit, or delete attributes associated with a record at any time.

Notes are yet another way to define individual records with useful information. You can add notes pertaining to specific conditions for discounts or a brief description of recent telephone conversations with a customer. Like attributes, users with security rights can add, edit, or delete notes to a record at any time.
Adding an attribute to a customer record

1. From Customers, locate and open the record to which you want to add an attribute.
2. Select the Attributes tab of the open record.
3. In the Category column, click the next available blank field, and select an attribute category from the drop-down list. Depending on how the attribute was defined in Configuration, a Description field, a Short Description field, or both are enabled.
4. Click the enabled Description field(s), and select from the list of descriptions in the drop-down list. If the description does not appear in the list, enter the description you want. If the attribute is a table, select from the list of short descriptions and the full description appears from the table.
5. Enter the Date and any Comments you would like associated with the attribute.
6. When you have finished entering attributes, select File, Save.

Editing a record attribute

1. Open the customer record, and select the Attributes tab.
2. Make any necessary changes in the attribute grid.
3. Select File, Save.
Adding/editing notes to a record

1. From the open customer record, select the Notes tab.

2. In the text box, enter the notes you want associated with the record. You can cut, copy, paste, delete, and insert text.

3. Select File, Save to save your notes to the record.

Transaction Line Items

You can edit and delete line items on invoices, recurring invoices, credit memos, debit memos, and sales returns. You can add line items to invoices, recurring invoices, and sales returns.

Adding a new line item

1. From the appropriate invoice record, select the Line Items tab.
2. Click **New Line Item**. The following screen appears.

3. The program automatically assigns the **Line item no.** after you save the new line item entry. If you are adding a line item to an existing invoice, you can scroll backward and forward using the arrows to view any other line items on the invoice.

4. Select the **Product type** from the drop-down list. Choose **Quantity**, **Service**, or **Comment**.

5. Enter the **Product name** by selecting from the drop-down list, which shows all products of the type you select, or use the binocular icon to search for the product you want to use. If you defined default information for the selected product, the program automatically enters this information in the appropriate fields.

6. Enter a **Description** of the product.

7. Enter the **Unit of Measure** from the drop-down list.

8. Enter the **Quantity** of the product for this line item.

9. Enter the **Unit Price** and **Discount %** (if any) for the product. The program automatically fills in the **Extended Amount** based on the quantity, price, and discount information you enter.

10. Enter a **Sales tax code** if the product is subject to tax. The drop-down list shows all sales tax codes you define in **Configuration**.

11. Enter the **Post status/date**. Choose either **Not Yet Posted** or **Do Not Post** and enter the date you want to use for the line item. This information automatically appears according to how you define the invoice post status and date in **Preferences**, but is editable on this tab.

12. You can add text about this invoice line item in the **Notes** box.

13. Check the **Invoice Totals** frame for subtotal and total calculations for the invoice.
14. Select the Revenue Account Distribution tab. The following screen appears.

15. On this tab, you can define the revenue distribution for the product you select for the line item. If you defined a revenue distribution for this product on the Products tab of Configuration, the program automatically displays the account distribution information in the appropriate fields on this tab. In this case, you can either accept the default distribution or edit the revenue account information at this time. You can also change the default distribution by clicking Load Distribution, and selecting one of the predefined distributions that you define on the Distributions tab of Configuration.

16. Enter the account(s) to which you want to post revenues from this product line item in the Account No. field. Use the binocular icon if you want to search your General Ledger database. The Account Description automatically displays.

17. If you have Project, Grant, and Endowment Management installed, you can also distribute revenues to projects. You can define a project distribution for each of the revenue accounts you enter.

18. For each account you enter, you can enter the amount you want to distribute, or click Distribute Evenly to divide the total revenue amount among all accounts in the distribution.

19. Mark Distribute by percentage if you want to distribute the revenue amount among the accounts by percentages of your choice. The Amount column changes to Percentage.

20. If you want to distribute all or part of the revenue to projects, place your cursor in the Project field next to the account from which you want to distribute, and enter the project ID. You can also click Projects to enter a separate distribution of revenue to more than one project.
If you have Blackbaud’s Project, Grant, and Endowment Management in addition to General Ledger, you can define project distributions on the Distributions tab of Configuration. You can then select a predefined project distribution to use.

21. The bottom right corner of this tab displays a running total of the distributed amount, and any remaining amount. You must distribute all or 100 percent of the revenue amount to be able to save the distribution.

22. Select the Accounts Receivable Distribution tab. The following screen appears.

23. If you define a receivables account for this product on the Products tab in Configuration, the account number appears in the grid on this tab. If you do not define a receivables account for the product, the program displays the fund(s) to which revenues from this product are posted. This information is also taken from the product definition in Configuration. If you do not assign a receivables account or a fund to which revenues from this product are posted, the program automatically posts revenue to the Default Account you must define for Accounts Receivable on the Default Account tab in Configuration.
24. Select the Payments/Credits tab. The following screen appears.

25. On this tab, the program displays all payments and credits you have applied to this invoice line item. If none are shown in the grid, this means you have not applied a payment receipt for this line item. You can mark Show all documents if you want to view all transaction documents in the grid.

➢ Editing a line item

1. From an open invoice, recurring invoice, or sales return record, select the Line Items tab.

2. Make necessary changes on the screen that appears. If you want to delete an entire line item, highlight the product and press Delete on your keyboard.

3. Select File, Save.

Adding New Records

Adding a customer record to your database is simply a matter of defining name, address, phone number, and some basic information regarding the customer’s credit, sales tax status, and invoicing terms. Much of this data is optional, and can be added at a later date. New customer records can be added by selecting File, New, using the New record icon on the toolbar, or selecting Customer from the drop-down menu next to the toolbar New record icon.

➢ Adding a customer

1. Access Customers from your Accounts Receivable package menu. The main Customers screen appears.
2. Select **File, New**.

3. You can also open the drop-down menu next to the **New Record** icon on the toolbar. This lists all types of records you can add. Select **Customer**, and the program takes you directly to the Add a Customer screen.

4. If you select **File, New**, the Create a New Record screen appears.

5. Mark the **Customer** option in the **Record Type** frame. If you want, select the appropriate record from which you would like to load defaults. These defaults are defined from **File, Defaults**, and can ease the data entry process when you create a new customer record. See **Create Defaults for New Records** earlier in this chapter for details.
6. Click **OK**. The Add a Customer screen appears.

![Customer Information Screen]

7. Enter the customer’s address information on the Customer tab. **Name** is the only required field.

8. You can enter an unlimited number of phone numbers for the customer. You can select the type of phone number from the drop-down list in the **Type** column fields.

9. Click **Bill to** if the address to which you send this customer’s invoices differs from the main address on the Customer tab. The Bill to Address screen appears, where you can add the correct address for billing purposes. You can also mark mailings to this address to the **Attention** of a specific person.

![Bill to Address Screen]

10. A similar screen appears when you click **Ship to** on the Customer tab. Here you can define a separate customer address for shipping purposes. You can edit the billing address and shipping address at any time by opening the customer record and making the necessary changes.
11. The **Class**, **Industry**, **Territory**, and **Salesperson** fields allow you to enter optional information for the customer. In each case, you can select from existing items in the drop-down list of each field or enter a new item, which adds to the table for each of these fields.

12. Select the Miscellaneous tab to add additional information. You do not need to add miscellaneous information to the new customer record immediately. This is an optional tab you can access later if you need to establish information regarding sales tax, credit, billing terms, finance charges, and discounts.

13. Select **File**, **Save** to save the new customer record.

- **Editing a customer record**
  1. From **Customers**, select **File**, **Open**. The Search screen appears.
  2. Locate and open the customer record you need to edit.
  3. Make any necessary changes.
  4. Select **File**, **Save**.

**Customer Activity**

Once you have added a customer to your database, you can begin to enter the transactions generated by the business you conduct with that customer. The customer’s record lists all relevant transactions on the Activity tab, where you can view details of the transactions, such as date, type, and description.

You can also view a summary of the customer record, which provides a history of customer transactions, including aging information, account balance, last invoice, and last payment. In the **Show** fields, you can select **All** or only **Current** transactions (sorted by transaction date or date of application) to list in the grid, and pick the type of transaction records you want to view.
Viewing the Account Summary screen

1. From a customer record, select the Activity tab.

2. Click Summary. The Account Summary screen appears.

3. You can choose to view transactions in one or two time ranges by defining date ranges in the **Range 1** and **Range 2** fields. The grid also lists a total for each type of transaction in the **Lifetime** column.

4. Enter a date in the **Age as of** field to define a date limit for the aging period you want to view.

5. In the **Aging Information** frame, mark **Transaction date** or **Due date** to designate which date you want the program to use for aging the transactions. If you want to reduce the amount(s) due in the aging calculations, mark **Use discounts for aging**.
   You can view the aging buckets and balance due for each period in the aging display grid.
6. After entering all criteria for the aging calculations, click **Recalculate** to view the revised summary of the customer transaction record. The customer’s account balance, credit limit, and available credit are shown in the display frame. Information regarding the last invoice and payment are also shown in the display frame on the right hand side of this screen.

7. Click **OK** to return to the Activity tab.

➤ **Printing the Account Summary**

You can print a copy of the customer account activity in summary for your hard copy records, or to use as a reference when communicating account information to your customer or others in your organization.

1. From the customer record, select the Activity tab.
2. Click **Summary**. The Account Summary screen appears.
3. Enter the aging information you want to use as criteria for the summary.
4. Click **Recalculate**, and then **Print**.

### Miscellaneous Customer Information

The Miscellaneous tab of a customer record is where you enter tax information, credit information, and term discount information. You can use this information as a default entry when you create documents, such as invoices, credit memos, debit memos, and sales returns. You can also define how often you want the customer to receive statements, whether to assess finance charges, and if the customer should receive a dunning letter when payment for an invoice is late.

➤ **Establishing tax information for a customer**

1. From the customer record, select the Miscellaneous tab.
2. In the Tax Information frame, mark either the Subject to sales tax or Not subject to sales tax option, depending on whether or not the customer is tax exempt. If subject to sales tax, select a Tax code from the drop-down list. If not subject to sales tax, enter the customer’s tax exempt number.

3. Select File, Save to save these defaults for this customer.

- **Establishing the customer’s credit limit**
  1. From the customer record, select the Miscellaneous tab.
  2. In the Credit Information frame, enter the maximum amount in the Limit field.
  3. You can mark the Credit hold checkbox if you ever need to suspend this customer’s credit (see next procedure for details).
  4. You can also enter an appropriate credit Rating for this customer by selecting from the drop-down list or entering a new rating, which you can then add to the Rating table.
  5. Select File, Save to save the credit information for this customer.

- **Placing a customer on credit hold**
  If a customer is placed on credit hold, you cannot add invoices or debit notes to the customer record.
  1. From the customer record, select the Miscellaneous tab.
  2. Mark the Credit hold checkbox in the Credit Information frame.
  3. Select File, Save.

- **Establishing the customer’s billing cycle**
  1. From the customer record, select the Miscellaneous tab.
  2. Mark the Send statement checkbox in the Statements frame.
  3. Select a Statement cycle from the drop-down list of table entries.
  4. Select File, Save.

- **Defining miscellaneous customer record defaults**
  1. From the customer record, select the Miscellaneous tab.
  2. In the Miscellaneous frame, you can define the Terms you want to use for all transactions with this customer by selecting from one of the payment terms you have defined in Configuration.
  3. Enter the customer freight agreement in the FOB (Freight On Board) field. Select either Destination, which means you take responsibility for the shipment until it reaches your customer, or Shipping, which means your customer takes ownership of the shipment from the time it leaves your location.
  4. In the Ship via field, you can enter the method of shipping or select one of the choices from the drop-down list.
5. If you want to allow a specific percentage discount to the customer, enter the default percent in the Discount % field.

Defining miscellaneous finance options

1. In the Finance Charges/Overdue Payments frame you can mark Apply finance charge if you want to charge the customer for allowing them to purchase goods from you on credit.

2. Mark Send dunning letter if you want the program to automatically flag the customer record for overdue payment. Then, when you run the Calculate Finance/Late Charges facility, the program flags the customer record. When you run your regular customer mailings, the program notifies you that this customer should receive a dunning letter. You then have the option of sending a dunning letter to the customer to remind them of the overdue payment.

Recurring Tab

The Recurring tab on the customer record is where you can define invoices to be automatically produced at specific intervals for customers who regularly pay the same amount for items or service you provide. Procedures for establishing this invoicing method are described in the next chapter, Invoices.
Invoices

In This Chapter

Invoices ................................................................. 120
Line Items ............................................................... 122
Payments ................................................................. 127
Reversing Invoices .................................................. 130
Recurring Invoices ................................................... 132
Recurring Invoice Frequency ................................. 138
Generating Invoices .................................................. 140
Each customer record has an Activity tab, from which you can create invoices, credit memos, debit memos, sales returns, and records of payments. Using the Recurring tab, you can also establish recurring invoices for customers who are on a regular shipping schedule for your organization’s products, or receive your services on a regular basis. A recurring invoice is a template from which invoices are generated on a regular basis, such as monthly, weekly, or quarterly. Recurring invoices help to ease your data entry time, and allow you to maintain consistency in your billing process.

The information you enter on the Customer and Miscellaneous tabs of the customer record appears as the default in the respective information fields on invoices you create for the customer. This makes creation and generation of invoices easier, and ensures consistent data entry, no matter who is creating the invoice for the customer.

Invoices

Invoices, like any of the seven different record types, can be added from a specific customer record or by selecting Invoice from the drop-down menu of the New icon on the toolbar of the Customers main screen.

Adding an invoice (from a customer record)

1. From the customer record, select the Activity tab. Click New, and then select Invoice. The following screen appears.

2. Enter an invoice number.

3. The Invoice No. field appears disabled if you mark the option to Automatically generate document numbers on the General tab of Configuration. If you do not select this option, you can enter an invoice number now. If you leave the field blank, an invoice number is automatically assigned in sequential order when you save the invoice record.

4. You can edit the Date field or accept the program default.
5. In the **Customer P.O.** field, enter the customer’s purchase order number, and enter the name of the person who placed the order in the **Ordered by** field.

6. You can edit the **Order Date** field or accept the program default.

7. Enter the **Bank Account** to which revenue from the invoice will be deposited. You can make a selection from the drop-down list.

8. Enter the **Due date**. This is a required field. You cannot save the invoice if this field is not filled in. If you forget to enter a due date, the program prompts you to enter a date before saving the invoice record.

9. Most of the remaining fields on this tab can be automatically filled with defaults you define on the Customer and Miscellaneous tabs of the customer record, or from defaults you define on the General and Statement tabs of **Configuration**.

   If any of the fields are blank, you can manually enter appropriate information at this time.

10. Enter a **Statement description**.

11. Enter a **Message** if you want one to appear on the printed invoice, such as “Thank you for your order.”

12. Enter a **Ship date**, and indicate the method of shipping in **Ship via**. You can choose from the drop-down list, or add a new method to the table by entering it manually in the field.

13. Select either **Destination** or **Shipping** for the **FOB** field.

14. If you want to extend a discount to the customer for the order, enter the percentage in **Discount %**.

15. You can enter the name of the **Salesperson** associated with the order by choosing from the drop-down list. Manually entering a new name in the field allows you to add the new name to the **Salesperson** table you created in **Configuration**.

16. Select **On Hold, Printed, Not Printed, or Reprint** for the invoice **Status**.

17. Select the **Terms** you want to use from the drop-down list. If you need to, you can create a new set of terms on the Terms tab of **Configuration**.

18. Accept the **Due date** as shown, or edit it for this invoice. The date shown is based on the **Terms** you use.

19. Enter a **Term discount** if you want to extend an additional discount for prompt payment, and indicate the **Disc. date** for the additional discount.

20. Mark **Apply finance charge** if you want the program to calculate the customer finance charges for this invoice.

21. Select **File, Save** to save the invoice.

**Editing an invoice**

1. From **Customers**, select **File, Open**.

2. Using the search screen, find and select the invoice you want to edit.

3. Make the appropriate changes to the invoice record.

---

An invoice can also be added through the **File, New** option. When adding a document using this method, you are required to locate and select the appropriate customer record from a standard Search screen.
4. Select **File, Save** to save the changes.

- **Deleting an invoice**
  1. From the Activity tab of the customer record, highlight the invoice you want to delete.
  2. Click **Delete**.
  3. Click **Yes** on the confirmation message.

**Line Items**

You can add any number of line items to an existing invoice at the time you create the invoice or at a later date. Revenue from products or services you add as line items are individually posted to receivables accounts, based upon the account(s) and distributions you assign to the product or service. If you do not associate particular accounts with the product/service, the program automatically looks to the fund with which you associate the product revenue, or the default AR account you must define in *Configuration*.

- **Adding a line item to an invoice**

  The Line Items tab is available for invoice, recurring invoice, and sales return record types. For detailed field information on the Line Items tab, please see the Customers chapter.

  1. From the invoice record, select the Line Items tab. The Line Items screen appears.
2. Click **New Line Item**. The Add Line Item screen appears.

![Add Line Item screen](image)

3. The program adds a new **Line item no.** when you save the invoice line item. You can scroll forward and back using the arrows if you want to view other line items on the invoice.

4. On the Line Item tab, enter the **Product type**. Choose **Quantity**, **Service**, or **Comment**.

5. Enter the **Product name**. You can use the drop-down list to select the product you want. If you define the product in **Configuration** by **Type**, **Description**, **Unit of Measure**, **Unit Price**, **Discount %**, and **Sales tax code**, the program automatically fills in these fields on the Line Item tab. If not, you can enter this information manually.

6. Enter the **Quantity** of the product. The program automatically calculates the **Extended Amount** when you click the **Unit Price** field. You can edit the unit price if you want.

7. Mark **Terms Discount** if you want the customer to receive the terms discount, which you define on the customer record.

8. Edit the **Post status/date** if you do not want to accept the defaults, which the program pulls from Preferences.

9. You can add **Notes** to the Line Item tab in the box at the bottom of the tab.
10. Select the Revenue Account Distribution tab. The following screen appears.

![Dashboard screen showing Revenue Account Distribution and Accounts Receivable Distribution tabs.]

11. Enter the **Account No.** to which revenue for this line item is posted. If you have Blackbaud’s **General Ledger**, you can use the the binocular icon to locate the appropriate account. The program fills in all information you define for the product in **Configuration**. You can click **Load Distribution** if you want to use a different distribution from the one you defined for this product in **Configuration**.

12. Enter all accounts to which you want to distribute revenue from this line item.

13. Enter the portion or total amount of the line item revenue in the **Amount** column. You can click **Distribute Evenly**, and the program distributes the total equally among the revenue accounts you have in the grid.

14. Mark **Distribute by percentage** if you want to distribute the revenue by selecting a percentage for each account. The **Amount** column changes to **Percent**. You can also click **Distribute Evenly** to have the program distribute equal percentages of the revenue to each of the accounts.

15. You can also enter a **Project** distribution for each of the amounts/percentages you have defined for any of the accounts.

16. Enter the project ID in the **Project** column, or you can use the the binocular icon to search for the project in your database.

17. Revenues can be distributed among any number of projects for any of the account distributions you define, and you can also use the **Distribute Evenly** function as with account distributions.
18. If you want to use a predefined project distribution or define a new one, click in the appropriate **Project** column field, and click **Projects**. The following screen appears.

19. If you have any project distributions, they appear in the grid. If not, you can define a new distribution from this screen.

20. Click the field in the **Project** column, and enter the project ID or use the binocular icon to locate the projects you want to use for the distribution.

21. When you have entered all projects you want to use for the distribution, enter the portion of the total amount of the distribution for each project in the **Amount** column. You can also click **Distribute Evenly** as with the account distributions.

22. Click **OK**, and the Revenue Account Distribution screen reappears.

23. In the above example, notice the second account in the distribution now also shows a **Distributed** project distribution. This means the 50 percent distribution of the total revenue for this line item is further distributed to a project distribution of 2 or more projects. The first account in the distribution shows a single project (0023), to which the revenue posted to that account is attributed.
24. Select the Accounts Receivable Distribution tab. The following screen appears.

25. This tab lists the receivables accounts for each line item in the invoice record. If you define accounts in *Configuration*, the program displays the receivables account you define for the product. If not, the program lists the account you define for the fund of which the account is a part. If you do not define a receivables account for either of these, the program lists the mandatory *system default receivables account* (and project) you define in *Configuration* on the Default Account tab.

26. The program default shows the *Amount* attributed to the receivables account, but you can mark *Show distribution by percentage*, which changes the *Amount* column to *Percent* and lists the percentage attributed to each account in the grid.

27. Mark *Show multiple lines for <distributed> projects* if you want to see all receivables accounts you define for any project distributions.

28. If you intend to apply an existing payment from the customer to this line item, select the Payments tab and follow the procedure for “Applying payments/credits from the invoice record” which follows.

29. Select *File, Save* or click the *Save* button on the toolbar.

**Editing a line item**

1. From the invoice record, select the Line Items tab.
2. Highlight the line item you want to edit and click *Open*.
3. The Line Item parameter screen appears. Make any necessary changes on any of the tabs.
4. Select *File, Save*. 
Payments

You can apply payments made by customers to any specific or all outstanding invoices in a customer record. You can receive payments while in Customers or through Cash Receipts. You can add a payment to a deposit directly from a customer’s activity tab. Once you have created a deposit, you can apply payments to it. You can mark a deposit as closed to prevent any future payments from being applied to it, or you can leave the deposit open for further payments.

Adding a payment from a customer record

1. Locate and highlight the open deposit to which you want to add the payment and click Select. The Add an Accounts Receivable Payment screen appears.

2. In the Customer Name field, enter the name or click the binoculars button to access the search screen.

3. Enter the Receipt date. This field defaults to the current date, but you can click the calculator button to enter another date.

4. Enter the Amount paid. You can click the calculator button to access a calculator.

5. Enter a payment receipt Description to help identify the receipt.

6. In the Payment Information frame, choose the payment method. Depending on the selected method, additional options appear:
   - Check – enter the Check number and Check date.
   - Cash – enter the amount in bills and the amount in coins.
   - COD – enter the amount in bills and the amount in coins.
   - Credit Card – enter the card number, expiration date, card type, and authorization number.
   - Other – enter a reference number, date, or other method.

7. Click File, Save.
8. Select the Applications tab. The following screen appears.

![Add an Accounts Receivable Payment](image)

9. All outstanding invoices and debit memos appear in the grid.

10. In the **Payment Amount Applied** column, enter the amount of the payment you want to apply to any of the outstanding items or click **Auto-Apply**. This automatically applies the payment amount to the items in the grid, beginning with the oldest item and continuing until all items are paid in full or the total amount of the payment has been distributed.

11. Select the Attributes/Notes tab. The following screen appears.

![Accounts Receivable Payment II 13](image)

You can assign any number of attributes to the payment by selecting the appropriate category and entering each attribute in the grid. The bottom portion of this screen allows you to enter text for pertinent notes regarding the payment you are entering.

12. Select **File, Save**.
Applying payments/credits from the invoice record
1. From the invoice record, select the Payments/Credits tab.

2. Mark Show all documents to view all payments, credits, and returns for the invoice you have open.

3. You can click Apply or Auto-Apply to apply any outstanding payments or credits to the open invoice. If you click Auto-Apply, payment is applied to all open invoice line items, beginning with the oldest, until the entire payment is applied or all amounts due are paid in full.

4. Highlight the payment you want to apply to the invoice, and click Apply. The program applies the full payment amount to the invoice. Click the save button to save the payment application.

Auto applying payments/credits from the invoice record
1. From the invoice record, select the Payments/Credits tab.

2. Click Auto Apply. The program automatically applies the existing payments/credits to the invoice in date order, beginning with the oldest balance and continuing until the invoice is paid in full, or until all existing payments/credits have been fully applied.

Unapplying an applied payment/credit
1. From the invoice record, select the Payments/Credits tab.

2. Highlight the payment application and click Unapply. The program removes the application amount.

3. Click File, Save to save your changes.

Deleting an applied payment/credit
1. From the invoice record, select the Payments/Credits tab.
2. Highlight the payment application you want to delete, and click **Delete**. The following confirmation message appears.

![Accounts Receivable](image)

3. Click **Yes** to delete.

**Reversing Invoices**

On occasion you may need to reverse an invoice or debit memo as a sales return. This may be the result of a cancelled order, for example, or as a correction for a mistaken invoicing of a customer. From **Customers**, this task is accomplished by opening the invoice you want to reverse and using the program’s automated function for this purpose.

- **Reversing an invoice as a sales return**
  1. From the invoice record, select **Invoice, Reverse as Sales Return** from the menu bar. The Add a Sales Return screen appears.

  ![Sales Return Screen](image)

  2. The original invoice information appears automatically as defaults in the Sales Return tab and Line Items tab fields.
3. Select the Line Items tab to review the information for accuracy.

4. Select the Invoices/Debits tab.

5. Enter any changes or additional information you want to the sales return record. You may, for example, want to add a reference about the reason for the return on the Notes tab.

6. Select **File, Save** to save changes. **File, Close** closes the sales return record.
Reversing an invoice as a credit memo

1. From the invoice record, select Invoice, Reverse as Credit memo. The Add a Credit Memo screen appears.

2. The original invoice information appears automatically as defaults in the fields for each tab.

3. Enter any changes you want or additional information to the credit memo.

4. Select File, Save to save changes. File, Close closes the credit memo record.

Loading invoice defaults

1. From the invoice record, select Invoice, Load defaults from. The Load Defaults from screen appears.

2. Click the down arrow to select from the list of available default files, which you defined on the Statement tab of Configuration.

3. Click Load All Defaults Now. The invoice screen returns.

Recurring Invoices

Recurring invoices maintain a consistent invoicing format for customers who receive invoices on a scheduled, regular basis. A recurring invoice is a template from which the program creates regular invoices according to a schedule you define. Recurring invoices are never posted or included in any balance calculation.
Adding a recurring invoice

1. From the customer record, select the Recurring tab.

2. Click New Recurring Invoice. The Add a Recurring Invoice for <customer> screen appears.

3. The Rec inv no. is automatically generated if you selected the option on the General tab of Configuration. If not, enter the number manually.

4. The recurring invoice number can be as many as 16 characters, with the last four characters reserved for regular invoices generated from the recurring invoice. The regular invoices are numbered -001, -002, etc. If you leave this field blank, then generated invoices also have a blank invoice number.

5. Mark On hold if you want the program to prevent users from generating additional invoices. This can be useful if, for example, the customer wants to temporarily suspend shipments.

6. Enter the Bank Account number you want to use for revenues collected from the recurring invoice.
7. Enter all information you want in the invoice information fields. Some fields are populated by default with information you provided on the General tab of the customer’s record.

8. In the Recurring Invoice Parameters frame, you can choose between a Fixed No. Invoices or an Unlimited No. Invoices. If you want the recurring invoice to generate a specific number of times, enter this number in the Fixed option field. If you mark the Unlimited option, this recurring invoice generates regularly for an indefinite period.

9. Click Change Frequency. The Recurring Invoice Frequency screen appears.

10. The Frequency field allows you to enter the periodic frequency for the recurring invoice.

11. Select Annual, Monthly, Weekly, or Irregular from the drop-down list. Depending on the frequency you select, the screen enables further definition of the frequency. For example, in the screen above, you can pick the Day <> of every <> month(s) or The <> <> of every <> month(s). You can also indicate the date you want the recurring invoices to start.

The grid on the right side of the screen shows the date and status of the invoice frequency schedule you define. If you subsequently make a change to the schedule, you can click Update to refresh the schedule grid.

12. If you enter Annually in the Frequency field, the screen changes to this view.

13. Here you can select the date you want the invoice to generate each year, and the frequency grid changes accordingly.
14. If you select **Weekly** for the **Frequency** field, the screen changes to this view.

15. Here you can select the day of the week you want the invoice to generate, and the frequency grid changes accordingly.

16. If you select **Irregular** for the **Frequency** field, the screen changes to this view.

17. With this **Frequency** selection, you must enter the exact dates in the frequency grid, as all other option fields are disabled.

18. Select the Line Items tab. The following screen appears.
19. Click **New Line Item**. The following screen appears.

![Screen Shot](image.png)

20. After you select a **Product type**, select the **Product name** from the drop-down list. Depending on how you define the product in **Configuration**, the **Description**, **Unit of Measure**, **Unit Price**, and **Sales tax code** fields fill automatically with the appropriate product information. The **Unit Price** is editable on this screen.

21. Enter the quantity of the product order in the **Quantity** field. The **Extended** column field displays the extended price, based on the quantity and **Discount %**, which are pulled from the percentage you entered in the **Discount %** option of the customer record Miscellaneous tab. If you do not want to use this percentage or do not want to extend a discount on this invoice, you can edit this field.

22. The **Invoice Totals** frame at the bottom of the screen displays calculations for the invoice. These fields are editable.
23. Select the Revenue Account Distribution tab. The following screen appears.

24. Enter the **Account No.** to which revenue for this line item is posted. If you have Blackbaud’s **General Ledger**, you can use the the binocular icon to locate the appropriate account. The program fills in all information you define for the product in **Configuration**. You can click **Load Distribution** if you want to use a different distribution from the one you defined for this product in **Configuration**.

25. Enter all accounts to which you want to distribute revenue from this line item.

26. Enter the portion or total amount of the line item revenue in the **Amount** column. You can click **Distribute Evenly**, and the program distributes the total equally among the revenue accounts you have in the grid.

27. Mark **Distribute by percentage** if you want to distribute the revenue by selecting a percentage for each account. The **Amount** column changes to **Percent**. You can also click **Distribute Evenly** to have the program distribute equal percentages of the revenue to each of the accounts.

28. You can also enter a **Project** distribution for each of the amounts/percentages you have defined for any of the accounts.

29. Enter the project ID in the **Project** column, or you can use the the binocular icon to search for the project in your database.

30. Revenues can be distributed among any number of projects for any of the account distributions you define, and you can also use the **Distribute Evenly** function as with account distributions.
31. If you want to use a predefined project distribution or define a new one, click in the appropriate **Project** column field, and click **Projects**. The following screen appears.

32. If you have any project distributions, they appear in the grid. If not, you can define a new distribution from this screen.

33. Click the field in the **Project** column, and enter the project ID or use the binocular icon to locate the projects you want to use for the distribution.

34. When you have entered all projects you want to use for the distribution, enter the portion of the total amount of the distribution for each project in the **Amount** column. You can also click Distribute Evenly as with the account distributions.

35. Click **OK**, and the Revenue Account Distribution screen reappears.

36. Select the Accounts Receivable Distribution tab.
37. This tab lists the receivables accounts for each line item in the invoice record. If you define accounts in *Configuration*, the program displays the receivables account you define for the product. If not, the program lists the account you define for the fund of which the account is a part. If you do not define a receivables account for either of these, the program lists the mandatory *system default receivables account* (and *project*) you define in *Configuration* on the Default Account tab.

38. The program default shows the *Amount* attributed to the receivables account, but you can mark *Show distribution by percentage*, which changes the *Amount* column to *Percent* and lists the percentage attributed to each account in the grid.

39. Mark *Show multiple lines for <distributed> projects* if you want to see all receivables accounts you define for any project distributions.

40. If you intend to apply an existing payment from the customer to this line item, select the Payments tab and follow the procedure for “Applying payments/credits from the invoice record” earlier in this chapter.

41. Select *File, Save* or click the *Save* button on the toolbar.

**Recurring Invoice Frequency**

If you need to, you can change the frequency schedule for a recurring invoice. For example, if your customer decides to change a monthly shipment to a weekly shipment, you can edit the customer’s recurring invoice template to accommodate this new shipping schedule.

➢ **Changing the recurring frequency**

1. From the recurring invoice record, click *Change Frequency*. The Recurring Invoice Frequency screen appears.

2. To select a new frequency, click the down arrow to display a drop-down list in the *Frequency* field. Your choices are *Annually*, *Monthly*, *Weekly*, and *Irregular*.

3. Select the day and month or, if generating monthly or weekly, the number of months and weeks.

4. Enter the *Starting on* date and the system automatically generates the *Next invoice* date. The program also tracks the number of payments and provides you with the date and status of the payments.

5. Click *Update* to refresh the status grid after making changes.
6. If you choose **Irregular** for your frequency, enter the dates and status in the grid.

7. Once you have entered the appropriate new invoice frequency information, click **OK**.

8. Select **File, Save** to save the changes.

### Generating Invoices

Generating invoices from a recurring invoice

1. Select the Invoice Schedule tab of the recurring invoice record.

2. Highlight the scheduled invoice you want to generate, and click **Generate**. The Generate Invoices screen appears.

3. Enter the **Invoices to Generate** information. You can **Generate invoices through** a specified date, **Generate <a specified number of> invoices**, or **Generate all invoices**.
4. Enter the **Post Information**. The **Post status** defaults to **Not Yet Posted** or you can choose **Do Not Post**. You can use the invoice date, due date or specify a date for the **Post date**.

5. In the **Invoice Information** frame, you can define the **Invoice status**, such as **Not Printed**, **On Hold**, **Printed**, or **Reprint**, and a specific **Ship date**. The program attaches this information to the invoices you select to generate, and eliminates having to define the status and ship date for each of the invoices separately.

6. Click **OK**. The Generate Recurring Invoices screen appears. Based upon your selected criteria, this screen displays all invoices that meet the criteria.

![Generate Recurring Invoices](image)

7. Click **Create Now**. The invoice is generated and the Invoice Schedule screen reappears, showing the results of the generation process.

![Invoice Schedule](image)

8. To create the actual recurring invoice(s) you have generated, you must prompt the program to generate the recurring invoice(s) by selecting **File**, **Generate Recurring Invoices**.

9. Save and close the Recurring Invoice.
Generating recurring invoices

If the main Customers screen is open, you can select File, Generate Recurring Invoices for this procedure. If you are entering Customers and have generated invoices from recurring invoices scheduled, a reminder screen (see below) appears, prompting you to generate the recurring invoices. This is always optional, and serves only to remind you of the existence of recurring invoices that need generating.

1. From Customers, select File, Generate Recurring Invoices. The following screen appears.

![Recurring Invoice Reminder]

2. Click Generate for to select the customers for whom you want to generate invoices. From the drop-down list, select invoices for All Customers, Selected Customers, or One Customer.

3. Enter a specific date in the Generate invoices due on or before field. You can enter the cut-off date, or click the calendar icon to select a date from the calendar.

4. Select a Post status and Post date for the invoices you want to create. For the Post date you can Use the invoice date or a Specific date.

5. Enter the Ship date and select the Invoice status.

6. Mark the checkbox if you want to View results before creating invoices and/or Print control report. The control report is a good way to maintain a hard copy record of the invoice(s) you create.
7. Click **OK**. A screen appears, listing all invoices matching the generate criteria. From this screen you can select, deselect, find, and create invoices or **Cancel** the generation.

8. By marking or unmarking the invoices in the display, you can select the invoices you want to create.

9. Once you have made your selection, click **Create Now** to initiate the invoice creation process.

   If you mark the option to **View results before creating invoices**, the following preview of the Control Report appears.

10. Click the **Print** icon to print this report.

### Loading recurring invoice defaults

To lessen the data entry time when you are generating recurring invoices, you can prompt the program to load information you have defined on the customer record Recurring tab.

1. From the recurring invoice record, select **Recurring, Load defaults from**. The Load Defaults from screen appears.
2. From the drop-down list of available default files in the Default set field, select the invoice default set you want to use.

3. Click **Load All Defaults Now**. The recurring invoice record reappears with defaults loaded.
Credit and Debit Memos

In This Chapter

Credit Memos ................................................................. 138
Applying Credit Memos ................................................. 142
Debit Memos ................................................................. 143
Applying Payments and Credits ....................................... 147
In addition to creating invoices, *Customers* allows you to create credit memo and debit memo records. When necessary, you can use credit memos to reduce the customer’s account balance. For example, credit can be issued as reimbursements, discounts taken, or a specified reduction in the price of a product or finance charge. Debit memos are used for fees and items that increase the customer’s balance, such as finance charges, membership dues, non-sufficient fund checks, etc.

## Credit Memos

A credit memo is set up similarly to an invoice, but has no line items associated with it. Credit memos are designated as one of three types: **Regular**, **Finance Charge**, and **Discount Taken**. A regular credit memo can be defined as whatever necessary to suit the situation. For example, you can define a regular credit memo to reimburse a customer for having been overcharged for a product. Finance charge and discount taken credit memos are created to reimburse finance charges previously applied to a customer or to apply a specified discount to a customer account balance.

### Adding a credit memo

1. From the customer record, select the Activity tab.
2. Click **New**, and select **Credit Memo**. The Add a Credit Memo screen appears.

   ![Credit Memo Screen](image)

3. Select the appropriate **Memo type** option. You can define **Regular** credit memos for a variety of situations, whereas **Finance Charge** and **Discount Taken** indicate specific reasons for the credit memo. These options are only for internal definition, and do not appear on documentation.
4. Depending on your preferences in **Configuration**, the program either fills the **Document no.** field automatically or you can manually enter the number at this time.
5. Enter the **Date** and the **Amount** of the credit memo. If you need, you can click the calendar and calculator icons for assistance.
6. You can edit the default **Statement description**, which prints on the credit memo statement.

7. You can enter the appropriate **Salesperson** from the drop-down list.

8. Enter the appropriate **Post status** and **Post date**.

9. Select the Revenue Account Distribution tab. The following screen appears.

10. Select the **Bank account** you want to use for the credit memo from the drop-down list. The program default for this field is the first cash or unearned revenue account in the list of accounts you define in **Bank Accounts** on the Blackbaud Systems tab.

11. In the **Account No.** column, enter the appropriate revenue account number(s), or click the search button to locate the account(s). The program automatically fills the **Account Description** field and it is not editable.

12. If you select more than one account, you can click **Distribute Evenly** if you want the program to distribute the credit amount evenly over the accounts you select.

13. Mark **Show distribution by percentage** if you want the distribution to be by percentage. This changes the **Amount** column to **Percentage**.

14. After you have entered the account number(s), either enter the amount of the credit memo you want attributed to each account, or click **Distribute Evenly**, which distributes equal portions of the total credit memo amount to the accounts you have chosen. Select **File, Save** to save the credit memo.

15. If you have Blackbaud’s **General Ledger** and **Project, Grant, and Endowment Management**, you can select a **Project** and **Project Description** to use for the credit memo.

---

**If you select more than one account for the credit memo**, you can enter the respective amounts of the credit in the **Amount** column fields. You can also click **Load Distribution** to use an existing distribution for the accounts you select.

**You can also use a project distribution if you want to distribute amounts to more than one project.** Click **Projects** to access a list of all projects, and select the projects to which you want the credit amount or portion thereof to be distributed.
16. Select the Invoices/Debits tab. The following screen appears.

17. Mark **Show all unpaid documents** to view a list of the available documents to which you can apply the credit memo.

18. Highlight the debit or invoice to which you want to apply the credit memo.

19. Click **Auto Apply** to automatically apply the credit to existing invoices/debit memos. Credit is applied in date order, beginning with the oldest invoice/debit memo, until all are paid in full or the credit balance is zero. If you want to specifically apply the credit amount, highlight the invoice or debit and click **Apply**. The total credit amount is applied to the invoice or debit you highlight.

20. If you want to add attributes to the credit memo, click the Attributes tab. The following screen appears.

21. In the **Category** field, you can select an attribute category from the drop-down list, which then fills in the grid information under **Category**, **Description**, and **Short Description** (if you defined a short description). If you do not filter the categories and accept the default <All>, you can manually enter the appropriate attribute(s) by selecting from the drop-down list in the **Category** column field.
22. You can enter the **Date** and **Comment** you want associated with the attribute(s).

23. If you want to reference the credit memo with notes, you can add this information to the Notes tab of the credit memo. Select the Notes tab, and the following screen appears.

24. Enter any reference notes you want.

25. Select **File, Save**.

**Editing a credit memo**

1. From the customer record, select the Activity tab.

2. Highlight and double click the credit memo. The Credit Memo record appears.

3. Make any necessary changes on any of the tabs.

4. Select **File, Save** to save the changes.

**Deleting a credit memo**

1. From the customer record, select the Activity tab.
2. Highlight the credit memo and click **Delete**. A confirmation message appears.

3. Click **Yes** to delete the credit memo.

### Applying Credit Memos

**Applying a credit memo**

1. After entering defining information on the Credit Memo tab of the credit memo record, select the Invoices/Debits tab.

2. You can highlight an invoice or debit and click **Apply** to apply the credit amount to any existing invoice or debit.

3. You can also click **Auto-Apply**, and the program automatically applies the credit amount to unpaid invoices and debits, beginning with the oldest, until the credit is fully applied.

4. You can also manually apply specific portions of the credit memo to select invoices and/or debits by clicking the respective **Credit Amount Applied** field, entering the amount you want to apply, and clicking **Apply**.

5. Click **File, Save** to save the application.

**Deleting an applied credit**

1. From the credit memo record, select the Invoices/Debits tab.

2. Mark **Show all unpaid documents**.

3. Highlight the invoice or debit memo from which you want to delete the credit application, and click **Unapply**. The program resets the **Credit Amount Applied** field to $0.00.
Loading defaults

To ease data entry when you create a credit memo, you can have the program load defaults you have assigned to your credit memos. These defaults are defined in Customers from File, Defaults.

1. From the credit memo record, select **Credit, Load defaults from** on the menu bar. The following screen appears.

```
Load Credit Memo Defaults from
```

2. Click the down arrow to select from the list of available default files.

3. Click **Load All Defaults Now**.

Debit Memos

Debit memos are used for fees and items that increase the customer’s balance, such as finance charges, membership dues, non-sufficient fund checks, etc.

Adding a debit memo

1. From the customer record, select the Activity tab.

2. Click **Add**, and select **Debit Memo**.

3. The Add a Debit Memo screen appears.

4. Mark the appropriate **Memo type** option. You can define **Regular** debit memos for a wide variety of situations, whereas **Finance Charge** and **Discount Taken** indicate specific reasons for the debit memo. These options are only for internal definition and do not appear on any printed documentation.
5. Depending on your preferences in Configuration, the program either automatically fills the **Document no.** field, or you can manually enter the number at this time.

6. Enter the **Date** and the **Amount** of the debit memo. If you need, you can click the calendar and calculator icons.

7. You can accept the program default in the **Statement desc.** field, or enter your own description. This prints on the debit memo statement.

8. Mark **Apply finance charge** if you want to apply finance charges to the debit memo.

9. You can enter the appropriate **Salesperson** from the drop-down list.

10. Enter the current **Print status** of the debit memo. You can choose **Printed**, **Not Printed**, **On Hold**, or **Reprint**.

11. Enter the appropriate **Post status** and **Post date**.

12. Enter the **Due date** of the debit amount. This is the date by which the customer should pay the debit amount.

13. Select the Revenue Account Distribution tab (if you have Blackbaud’s **General Ledger**). The following screen appears.

14. The program automatically enters the **Bank account** you use for the debit memo. The program default for this field is the first cash or unearned revenue account in the list of accounts you define in **Bank Accounts** on the Blackbaud Systems tab.

15. In the **Account No.** field, enter the appropriate revenue account number, or click the search button to locate the account. This is enabled if you have Blackbaud’s **General Ledger**. The program automatically fills the **Account Description** field, and this field is not editable. If you want, you can choose to have more than one account to which the program posts the debit.
16. After you have entered the account number(s), either enter the **Amount** of the debit you want charged to each account, or click **Distribute Evenly**, which distributes equal portions of the total debit amount to the accounts you select.

17. If you have also Blackbaud’s *Project, Grant, and Endowment Management*, you can select the **Project** and **Project Description** to use for the debit memo.

18. Select the Accounts Receivable Distribution tab.

19. On this screen, the program displays the receivable account you defined in *Configuration* for this fund. All revenues from the debit are distributed to this account. Project identification(s) and distribution(s) are also shown if you have defined a project distribution and have *Project, Grant, and Endowment Management* in addition to **General Ledger**.

20. If you want to add attributes to the debit memo, click the Attributes tab. The following screen appears.
21. In the **Category** field, you can enter the attribute categories you defined in *Configuration*, which then fills in the grid information under **Category**, **Description**, and **Short Description** (if you defined a short description). If you do not filter the categories and accept the default <**All**>, you can manually enter the appropriate attribute(s) by selecting from the drop-down list in the **Category** column.

22. You can enter the appropriate **Date** and **Comment** you want.

23. If you want to reference the debit memo with notes, you can add this information to the Notes tab of the debit memo. Select the Notes tab, and the following screen appears.

![](debitememo.png)

24. Enter any reference text you want.

25. Select **File, Save**.

#### Editing a debit memo

1. From the customer record, select the Activity tab.
2. Highlight the debit memo you want to edit and click **Open**.
3. The Debit Memo record appears. You can make necessary edits and change editable information on any tab.
4. Select **File, Save** to save the changes.

#### Deleting a debit memo

1. From the customer record, select the Activity tab.
2. Highlight the debit memo and click **Delete**.
3. A confirmation message appears.

![Confirmation Message](confirmation.png)
4. Click Yes.

Applying Payments and Credits

- Applying payments, credits, from the debit memo record
  1. From the debit memo record, select the Payments/Credits tab. The following screen appears.

2. Mark Show all documents to display existing credits and payments for the customer.

3. Click Auto-Apply to automatically apply all unapplied payments and credits to the debit memo. The program applies payment in date order, beginning with the oldest payment or credit, until the full amount of the payment is distributed.
   You can also highlight a specific payment or credit and click Apply, which allows you to apply the full amount of that payment to the debit memo.

4. You can manually enter the full or portion of a payment/credit amount in the Amount Applied field.

5. If you want, you can edit the payment amount, or delete the payment to the debit memo from this screen by clicking Unapply or Unapply All.

- Deleting an applied payment/credit
  1. From the debit memo record, select the Payments/Credits tab.
  2. Highlight the payment application and click Delete.
3. A confirmation message appears.

4. Click Yes to delete.

Loading defaults

To ease data entry when you create a debit memo, you can have the program load defaults you have assigned to your debit memos. These defaults are defined in Customers from File, Defaults.

1. From the debit memo record, select Debit, Load defaults from. The following screen appears.

2. Click the down arrow to select from the list of available default files.

3. Click Load All Defaults Now. The debit memo record reappears.
Sales Returns

In This Chapter

Sales Returns ............................................................. 150
Applying Sales Returns ............................................. 153
For those occasions when a customer returns a product or you need to correct an invoice or debit, you can add a sales return to that customer’s activity record through *Customers*. Sales returns place a credit on the customer record that can be applied to any existing invoice or debit memo. As a timesaving measure, you can also reverse an invoice as a sales return. When you use the reverse option, the sales return record is created using the invoice record information, such as line items, original invoice number, etc., as defaults. This also saves you data entry time. Please refer to the Invoices chapter for complete details on **Reversing** (an Invoice) as **Sales Return**.

Sales Returns

- **Adding a sales return**

  1. From the customer record, select the Activity tab.
  2. Click **Add**, and select **Sales Return**. The Add a Sales Return screen appears.
  3. Enter a **Return no.** for the sales return record. The **Return no.** field displays the next sales return number if you configure the program to automatically generate document numbers.
  4. Enter the **Date** of the return.
  5. Enter the **Original invoice no.** If you do not recall the number of the original invoice for the order, you can open the invoice record, check the number, and minimize the record screen while you fill in the appropriate information on the return record. This allows you to refer to the original invoice for other information you need on the return.
  6. Enter all other information into the fields on the Add a Sales Return screen.
  7. If you have defaults defined for Sales Return documents, you can select **Return, Load Defaults From** from the Sales Return main screen menu bar. This saves data entry time.
8. Select the Line Items tab. The following screen appears.

![Add a Sales Return for Advanced Optics, Inc.](image)

**New Line Item**

- **Product Name**: NoteCards
- **Description**: Holiday In The Lowes... Box
- **Qty**: 25
- **Unit Price**: $0.227
- **Discount %**: 0.00
- **Extended**: $7.00

**Subtotal**: $75.08
**Sales Tax**: $4.58
**Total**: $79.58
**Terms Discount**: 0.00

9. If you are creating the sales return from an invoice, the line items of the invoice appear in the grid (as shown above). You can choose to create the return for all line items, or delete those you do not want to use for the return by highlighting them and clicking **Delete**.

10. If you are creating the sales return from the customer record Activity tab, proceed with defining the line item(s) you want to appear on the sales return.

11. Click **New Line Item** to access the parameter tabs for the line item you want to use for the return. You can define as many line items as you want, repeating the procedure for adding a new line item each time. Please refer to the Invoices chapter for complete details on entering appropriate information on the line item tabs.

12. Select the Invoices/Debits tab. The following screen appears.

![Add a Sales Return for Advanced Optics, Inc.](image)

**Auto Apply**

- **Sales Return applied to these invoices/debits**:
  - Invoice 54: 12/14/97: Invoice for Holiday Cards $79.58 ($79.58) ($0.00)
  - Debit Memo 03/31/98: Returned Check Fee: Oct. 4, 1998 $25.00 ($25.00) ($0.00)

**Sales Return**: $79.58
**Total Applied**: $0.00
**Balance**: $79.58

13. Click **Auto Apply** if you want the sales return to be applied to all outstanding debits and invoices for this customer. The program automatically applies the return amount to the oldest outstanding invoice/debit first, and continues until the return amount is zero, or all outstanding invoices/debits have a zero balance.
14. Highlight the invoice or debit to which you want to apply the return, and click **Apply** if you want to be selective with the application of the return amount.

15. On this screen, you can portion the return amount as you like to the existing invoice/debit records by entering the appropriate amount(s) in the **Apply Amount** column.

16. Select the Attributes tab if you want to associate attributes to the sales return. The following screen appears.

17. When you click in the **Category** field, a drop-down list appears, from which you can select the appropriate category for the return. The various category selections are contained in a table you define in **Configuration**.

18. After selecting a category, click the first field in the **Category** column and select an appropriate value for the type of return, such as “Reason for Return”.

19. Select the Notes tab if you want to add reference notes to the sales return. The following screen appears.

20. Select **File, Save**.

➤ **Editing a sales return**

1. From the customer record, select the Activity tab.
2. Highlight the sales return and click **Open**. The Sales Return record appears.
3. Make the necessary changes, and select **File, Save** to save the changes.

➢ **Deleting a sales return**
   1. From the customer record, select the Activity tab.
   2. Highlight the sales return and click **Delete**.
   3. A confirmation message appears.
   4. Click **Yes**.

### Applying Sales Returns

➢ **Applying the sales return**
   1. From the sales return record, select the Invoices/Debits tab.
   2. Mark **Show all documents**.
   3. Highlight the invoice or debit to which you want to apply the sales return. The return amount automatically appears in the **Sales Return Amount Applied** column.
   4. If you want to apply the sales return amount to all existing invoices and debits, click **Auto-Apply** (see next procedure). You can also manually enter the amount you want to apply to any selected invoice or debit memo in the **Apply Amount** column, and click **OK**.

➢ **Auto applying the sales return**
   1. From the sales return record, select the Invoices/Debits tab.
   2. Click **Auto Apply**. The program automatically applies the sales return to the existing invoices and debit memos in date order, beginning with the oldest balance and continuing until the sales return is fully applied or all invoices/debit memos are fully paid. If there is a surplus after full application, the program automatically displays the amount of the surplus on the customer’s activity tab.

➢ **Editing an applied sales return**
   1. From the sales return record, select the Invoices/Debits tab.
2. Highlight the invoice or debit memo. You can now edit the amount of the applied return or click Unapply, which removes the applied amount from the highlighted record. If you click Unapply All, all applications of the sales return are removed from all invoices/debits to which it was applied.

➤ Deleting an applied sales return

1. From the customer record, select the Activity tab.
2. Highlight the applied sales return record, and click Delete.
3. A confirmation message appears.

   ![Confirmation Message]

4. Click Yes to delete the sales return.

➤ Loading defaults for a sales return record

To ease data entry when you create a sales return, you can load defaults that you define for all sales returns under File, Defaults.

1. From the sales return record, select Return, Load defaults from.
2. The Load Sales Return Defaults screen appears.

   ![Load Defaults Screen]

3. Click the down arrow to select from the list of available default files.
4. Click Load All Defaults Now.
In This Chapter

- Deposits .................................................. 166
- Receipts .................................................. 170
- Print Deposit Tickets ............................... 177
- Cash Receipts Preferences ...................... 184
The previous chapters have shown how you can create invoices, credit and debit memos, and sales returns from Customers. Cash Receipts enables you to add all deposits and receipts. You can create new deposits and payments, as well as edit previous deposits and payments. Cash Receipts also facilitates printing deposit tickets.

Accessing Cash Receipts

1. From the Start menu, select Programs, Blackbaud Accounts Receivable, Cash Receipts. The main screen of Cash Receipts appears.

From the main screen of Cash Receipts, you can:

- Add, edit, and delete deposits
- Add, edit, and delete payment receipts
- Generate Automatic Payments
- Create Prenote Authorization File
- Create an EFT File
- Print a deposit ticket
- Define Cash Receipts preferences

Deposits

Even though they are reflected on the customer record, payments are stored within a deposit. You can add, edit, apply, and delete payments from a deposit. Deposit numbers are automatically generated by the program in sequential order. They are strictly numeric and are not preceded by any special characters.
Adding a deposit

1. Open Cash Receipts and select File, New. The Create a New Record screen appears.

2. Mark the Deposit for option.

3. Select Accounts Receivable by clicking the down arrow. Although the default program may be one other than Accounts Receivable, the drop-down list reveals all applicable programs you have available.

4. Click OK. The Add an Accounts Receivable Deposit screen appears.

5. On the Deposit tab, enter the Deposit date. This is the date the deposit will be made.

6. Type the Entry date. This is the date the deposit is entered in Accounts Receivable.

7. Select the Deposit status. Choose from Open or Closed. Typically, a closed deposit indicates no additional receipts will be added and no changes will be made to the deposit.

8. Enter a Description of the deposit. This field is used to identify the deposit.

9. If you are entering a deposit for which a deposit ticket has been printed, mark Deposit ticket printed on, and enter the appropriate date. If you create deposit tickets from the program, this is entered automatically.
10. The **Bank account** and **GL cash account** fields display automatically, using the information defined in *Bank Accounts*.

11. If the deposit has cleared, mark **Deposit cleared on** and enter the appropriate date.

12. In the **Post status/date** fields, enter the post status of the deposit and the date when this status is effective.

13. You can enter the **Projected** number of receipts and the total amount of the deposit in the **Deposit Totals** frame. These fields can be used to ensure all receipts are correctly entered. When you finish entering receipts into the deposit, you can compare the **Actual totals** to the **Projected totals** for any discrepancies.

14. Select the Receipt Defaults tab. The following screen appears.

15. In the **Allow these Payment Methods** frame, mark the payment methods you want to allow in this deposit. These fields help designate the purpose of a deposit. For example, you may want to create a deposit for cash and check receipts and another deposit for credit card receipts.

16. In the **Receipt Settings** frame, you can establish default values for the fields that appear on the receipt record.

17. For each item in the **Field** column, enter the appropriate **Default Value**. The checkboxes in the **Show?** column determine whether or not the field appears when entering receipts from the grid view.

18. Click **Reset to System Defaults** to return the grid to the default values shipped with the program.

19. Click the **Load from** button to display the search screen, which allows you to locate an existing deposit and copy the default values to the new deposit.

20. Use the **Up** and **Down** buttons to move a row up or down within the grid. When you enter receipts using the grid view, the fields appear in the same order you specify in the **Receipt Settings** grid.
21. Select the Receipts tab. The following screen appears.

22. From this tab, you can add, edit, delete, and find receipts in the deposit. For more information, please see the Receipts section in this chapter.

23. Once you finish entering the appropriate information for the deposit, select File, Save.

➢ Editing a deposit

1. From Cash Receipts, select File, Open. The Cash Receipts – Open screen appears. Make sure Deposit appears in the Find field.

2. Using the search criteria fields or the list of deposits, locate and highlight the deposit you want to edit, and click Open.

3. Make any necessary changes to the deposit.

4. Select File, Save.
Deleting a deposit

1. From Cash Receipts, select File, Open.
2. Using the search criteria fields, locate and highlight the deposit record you want to delete.
3. Open the deposit.
4. Select File, Delete. A confirmation screen appears, asking if you are sure you want to delete the deposit.
5. Click Yes to delete the deposit.

Receipts

Once you have created a deposit, you can apply payments to it. You can mark a deposit as closed to prevent any future payments from being applied to it, or you can leave the deposit open for further payments.

You can add payments to deposits from the Activity tab of any customer record in Customers, and apply the payment to an existing invoice or debit memo. You can also accomplish this task by adding a payment to an existing deposit.

The deposit post date defaults to the receipt post date; however, the payment application date defaults to the system date. If you want to edit the payment application date, select the Applications tab of the receipt and click the Application History button. You can change the date in the Application Date column for each unposted application.

Adding a payment receipt

1. From the Cash Receipts main screen select File, New. The Create a New Record screen appears.
2. If you have not created a deposit for new receipts, mark the Deposit for option and proceed with creating a Deposit as described in the preceding procedure. After you create a deposit, you can continue adding receipts as described below.
3. Mark Receipt and then select Accounts Receivable Payment from the drop-down list. Click OK. The Select a Deposit screen appears.

![Select a Deposit](image1)

4. Locate and highlight the open deposit to which you want to add the payment and click Select. The Add an Accounts Receivable Payment screen appears.

![Add an Accounts Receivable Payment](image2)

5. In the Customer Name field, enter the name or click the binoculars button to access the search screen.

6. Enter the Receipt date. This field defaults to the current date, but you can click the calendar button to enter another date.

7. Enter the Amount paid. You can click the calculator button for this purpose if necessary.

8. Enter a payment receipt Description to help identify the receipt.

9. In the Payment Information frame, choose the payment method. Depending on the selected method, additional options appear:
   - Check – enter the Check number and Check date.
• **Cash** – enter the amount in bills and the amount in coins.
• **COD** – enter the amount in bills and the amount in coins.
• **Credit Card** – enter the card number, expiration date, card type, and authorization number.
• **Other** – enter a reference number, date, or other method.

10. Select the Applications tab. The following screen appears.

![Add an Accounts Receivable Payment](https://example.com/payment-screen.png)

11. All outstanding invoices and debit memos for the selected customer appear in the grid.

12. In the **Payment Amount Applied** column, enter the amount of the payment you want to apply to any of the outstanding items or click **Auto-Apply**. This automatically applies the payment amount to the items in the grid, beginning with the oldest item and continuing until all items are paid in full or the total amount of the payment has been distributed.

   The payment **Application Date** automatically defaults to the system date. If you want to change this date, click the **Application History** button at the top of the Applications tab.

   The payment **Application Date** automatically defaults to the system date. If you want to change this date, click the **Application History** button at the top of the Applications tab and edit the date in the **Application Date** column.
13. Select the Attributes/Notes tab. The following screen appears.

You can assign any number of attributes to the payment by selecting the appropriate category and entering each attribute in the grid. The bottom portion of this screen allows you to enter text for pertinent notes regarding the payment you are entering.

14. Select File, Save.

➢ Editing a payment receipt

1. From Cash Receipts, select File, Open. The Search screen appears.

2. In the Find field, select Accounts Receivable Payment.

3. Either scroll or use the search criteria fields to locate and highlight the receipt you want to edit.
4. Click **Open**. The payment record appears.

![Accounts Receivable Payment III](image)

5. Make any necessary changes to the payment record by reviewing each tab.

6. Select **File, Save**.

➢ **Deleting a payment receipt**

1. Open the payment receipt record as in the preceding procedure.

2. Select **File, Delete**. A dialog box appears, asking if you are sure you want to delete the receipt.

![Cash Receipts](image)

3. Click **Yes**. The receipt is deleted.
Applying a payment receipt

1. From the payment receipt record, select the Applications tab.

2. In the Payment Amount Applied column, enter the appropriate amount for each charge or click Auto-Apply to automatically apply the payment beginning with the first charge in the grid. To clear all applied amounts, click Unapply All.

   The payment Application Date automatically defaults to the system date. If you want to change this date, click the Application History button at the top of the Applications tab and edit the date in the Application Date column.

3. Select File, Save.

Editing the payment receipt applications

1. From the payment receipt record, select the Applications tab.
The payment Application Date automatically defaults to the system date. If you want to change this date, click the Application History button at the top of the Applications tab.

2. In the Payment Amount Applied column, make the necessary changes to the applied amount for each charge by highlighting the existing amount, and then entering the correct amount. To clear all applied amounts, click Unapply All. Applications can be changed at any time, provided you have not purged the charges and the payment has not been voided.

3. Select File, Save.

➢ Auto-applying a payment receipt

1. From the payment receipt record, select the Applications tab.

2. Click the Auto-Apply button. The program applies the payment to the unpaid charges, beginning at the top of the grid, until all charges are paid or the payment is fully applied.

3. Select File, Save.

➢ Unapplying all applications of a payment

1. From the payment receipt record, select the Applications tab. The following screen appears.
2. Click **Unapply All** to remove application of all payments that you previously applied. The program clears the **Applied** column for all applied payments in the grid.

3. Click **File, Save**.

### Print Deposit Tickets

The Print Deposit Tickets facility allows you to print a deposit ticket you can use to make deposits to your bank.

This feature is very flexible. You can print deposit tickets for all, selected, or just one deposit record. You can also filter the deposits that are to be included in the print run by their status, choosing either open, closed, or both. You can also filter by a deposit date range.

You can limit the deposits to be printed by origin, choosing from programs such as *Student Billing*, *Accounts Receivable*, *Payroll*, and *Miscellaneous Cash Receipts*, depending on which programs you have in your database.

As part of the printing process, the program marks the **Deposit ticket printed** checkbox and enters the print date on all deposit records for which tickets are printed.

For any future printing, the program automatically filters out all deposit tickets with the **Deposit ticket printed** checkbox marked.

Before printing deposit tickets, you can preview the tickets to your monitor screen. This option allows you to review the tickets for accuracy before printing.

#### Printing deposit tickets

1. From *Cash Receipts*, select **File, Print Deposit Tickets**. The Print Deposit Tickets screen appears with the General tab selected.
2. On the General tab, you determine for which records a deposit ticket is printed. You can print a ticket for all deposits or use the fields on this tab to limit the process to one or a number of specific deposits.

3. Click the Include button and indicate whether you want to print a deposit ticket for all records, selected records (using a query), or one record. If you choose Selected records, the query search screen appears. Locate and open the appropriate query. If you choose One record, the deposit search screen appears. Locate and open the appropriate deposit.

4. In the Include these Deposits frame, mark the appropriate option to include deposits with a status of Open, Closed, or Both.

5. For the Deposit dates field, click the down-arrow to select from the following options: <Specific range>, Include All dates, Last month, This month, Next month, Last week, This week, Next week, Last period, This period, Next period, This billing period, Yesterday, Today, Tomorrow.

6. If you choose <Specific range>, the Start and End options appear. Enter the beginning date, and the ending date, for the date range. All deposits with a date on or after the Start date and on or before the End date are included.

7. If you are using Blackbaud’s Student Billing, or Payroll, Miscellaneous Cash Receipts, the Include deposits with these origins option is available. Mark the checkbox for those programs with deposits for which you want deposit tickets printed. Choose from Student Billing and Miscellaneous Cash Receipts. The program name appears only for those programs present in your system.

8. If you want the program to automatically change the deposit status to closed during the print process, mark Change deposit status to “closed” after ticket has been printed.
9. Click **Next**. The Bank Accounts tab appears.

10. Choose to print deposit tickets for all or selected bank accounts by marking the appropriate option. If you choose selected bank accounts, highlight the bank account or accounts you want to use.

11. Using the arrow buttons, move the account or group of accounts to the **Bank accounts to include** box.

12. Click **Next**. The Deposits tab appears.
13. All deposits that meet the criteria you specify on tabs 1 and 2 appear in the deposits grid.

14. In the **Print?** column, mark checkboxes to include the deposits for which you want to print a deposit ticket. You can click **Select All** to mark all the deposits in the grid, or click **Deselect All** to clear the checkboxes for all deposits.

15. Click **Next**. The Format tab appears.

16. On this tab, you can define the format of the report heading, detail, footers, and amount display.

17. In the **Format Options** frame, mark **Headings**. The heading options appear to the right.

18. In the **Heading Format** frame, enter the **Title** and **Subtitle** of the report.

19. For the **Align** option, click the down-arrow to choose from **Left**, **Center**, or **Right**.

20. If you want the organization name to print in the header, mark the option checkbox.

21. If you want the page number to print in the header, mark **Print Page # in Heading**. The frame options become available. Select the appropriate **Format**. Choose from **Page 1**, **p1**, or **1**. Select **Left**, **Center**, or **Right** for the page number alignment.

22. If you want the report date to print, mark **Print Report Date in Heading**. The frame options become available. Select the appropriate **Format**. Choose **Short date** (01/01/00) or **Long date** (January 1, 0000).

23. If you want the heading to print on each page, mark the option checkbox.
24. Mark **Detail** in the **Format Options** frame. The **Show Detail for Each of these Payment Types** frame appears.

25. Choose the payment types for which you want to see detailed deposit information by marking the checkbox(es).

26. If you want the detail for each payment type to print on a separate page, mark **Page break on payment type**.

27. Mark **Page footer** in the **Format Options** frame. The footer options for the pages appear.
28. Enter the text you want to print in the footer of each page of the printed deposit tickets and define the alignment.

29. If you want to print page number and report date in the footer of each page, mark these options and define the format and alignment of each item.


31. Enter the text you want to print in a separate report footer on the last page of the deposit tickets report. This appears just under the report details on the last page. Define the alignment of the report footer.

33. Here you can choose the way you want monetary amounts to display on the deposit ticket(s). Choose from Show currency character, Show 1000’s separator, Show decimals, Show percent sign, and Show blank space instead of zero amounts. Applicable options you choose are reflected in the Sample Display frame. You can choose to show negative amounts as (1234567.89) or -1234567.89.

34. If you want to check the deposit tickets for accuracy and layout, click Preview. The report appears on your monitor screen for your review.
35. If you are satisfied with the content and appearance of the report, click Print to start the printing process.

Cash Receipts Preferences

You can establish preferences for various functions within Cash Receipts, including how many recently opened receipts are listed, whether to show deleted receipts, and formats to use when displaying receipts from any of the programs you are running.

Establishing preferences

1. From the Cash Receipts main screen, select Edit, Preferences. The following screen appears.

2. In the Miscellaneous frame, you can mark Show save information dialog to indicate you want to be prompted to save the information you have added or edited on a receipt record. This prevents closing a receipt without saving it and losing the information you have entered.

3. Mark Show deleted receipts if you want to show those receipts you have deleted in the receipts grid for any of the programs in which you are operating.

4. You can have the program keep a list of a specified number of receipts you have recently opened, by marking this option and entering the number of entries you want the program to list.

5. You can have the program automatically display the search screen whenever you save and close a new payment record. If you do not mark this option, you can select File, Save and New, which takes you directly to a new receipt record.
6. In the **Receipt Formats** frame, click **Accounts Receivable** to define or select the format you want to use for the receipts you print from **Accounts Receivable**. The following screen appears.

![Select a Parameter File](image)

7. Highlight the set of receipt parameters you want to use for this run of receipts, and click **Select**. All parameter files you have defined for **Accounts Receivable** receipts are listed in the grid.

8. Select the Defaults/Tab Settings tab. The following screen appears.

![Preferences](image)

9. Depending on the Blackbaud programs you have, you can establish preferences for as many as five different types of receipt/deposit records. In each case, you can then have the program mark the various tabs of the receipt or deposit record with a red check mark to indicate the tab contains data. You can also choose which of the tabs in a given record appear on top by default.
10. Mark **General Receipt**. The screen displays new options.

![Preferences](image)

11. In the **Default Receipt View** frame, mark the option to view receipt records in **Form view** or **Grid view**.

12. In the **Grid Default Behavior** frame, choose whether the program populates cells or fields of a receipt automatically, or when you press **F3**.

13. Mark **Accounts Receivable** in the **Preferences** frame.

![Preferences](image)

14. Choose the record tab(s) you want to mark with a red checkmark to indicate the tab contains data. In **Default tab**, you can also choose which tab appears on top by default.

15. Select the **Default bank account** for your receipts.

16. Click **OK** to save and close your preferences.
Finance and Late Charges

In This Chapter

Calculating Charges .................................................. 178
Setting Debit Memo Defaults ...................................... 179
The **Calculate Finance Charges** process calculates balances and creates debit memos for those customers who have overdue charges that are subject to finance charges. There are two types of charges that you can create in this process: finance charges and late charges. Finance charges are based on a percentage of the customer’s account balance. Late charges are a flat fee added when a customer has an outstanding account balance as of a date you specify.

When creating finance and late charges, you must enter parameters for both the calculation of the charge and for posting and billing the charge. The first section of this chapter addresses setting the parameters for calculating the charge. Debit memo defaults are covered in the second section.

### Calculating Charges

In this section we describe the entries required to calculate the charge. In the following section we describe the entries for posting and billing the charge. Completion of both procedures is required to create finance and late charges.

#### Calculating finance/late charges

This procedure is used to create both finance and late charges. Not all fields apply to both types of charges. Fields that apply to only one of the charge types are identified as they are mentioned.

1. From *Customers*, select *File, Calculate Finance/Late Charges*. The Calculate Finance Charges screen appears.

2. Select the **Calculate** option you want. Choose either **Finance Charges** or **Late Charges**, depending on the charges you want the program to create.

3. Click **Calculate for** and select **All Customers**, **One Customer**, or **Selected Customers**.

---

**Note:**

- For detailed instructions on how to use the Calculate Finance Charges process, refer to the manual that comes with QuickBooks. The screenshots and steps provided here are meant to give you an overview of the process. For specific instructions, consult the QuickBooks documentation.
4. If you select **One Customer**, a record search screen appears. If you select **Selected Customers**, a query search screen appears.

5. In the **Calculate charges as of** field, enter the date you want to use as the inclusion point of your calculation. The program uses this date to establish which customers are to be assessed late/finance charges.

6. In the **Base calculation on** field, select either Due date or Invoice date. The program uses either one of these dates as the beginning of the aging period for calculating charges.

7. In the **Finance charge method** field, click the down arrow to select which past due balance criteria to use. This field is not present when calculating late charges.

8. Select either **Transaction past due balance**, which calculates the charge based upon the individual transaction, not the customer’s total account balance, or **Overall past due balance**, which calculates the charge based on the customer’s overall account past due amount.

9. Enter the desired **Annual finance charge %**. You can use the calculator button if you need assistance. This field is not present when calculating late charges.

10. In the **Days past due for charge** field, enter the number of days after which you want the program to assess finance or late charges.

11. The program compares this number to the number of days from the Invoice or Due date, and calculates charges for those customers whose balance is within this range.

12. Enter a **Minimum charge** amount. This field is not present when calculating late charges.

13. If, after calculating finance charges, the charge is less than this minimum amount, finance charges are not assessed.

14. Enter a **Minimum balance** to filter out all accounts with balances not equal to or greater than the minimum amount necessary to assess either finance/late charges.

15. With this section complete, proceed to the **Setting Debit Memo Defaults** procedure.

### Setting Debit Memo Defaults

The second half of creating finance and late charges is setting the debit memo defaults. Debit memo defaults establish basic information about the charges and statements you create as a result of your **Calculate** settings. Debit memo defaults are required to complete the finance/late charge process.

> **Setting Debit Memo Defaults**

All fields in the Debit Memo Defaults frame apply to both finance and late charges.

1. In the **Debit Memo Defaults** frame, enter the **Document Date**.

2. Enter the desired **Due Date**.
3. Select a **Post status**. Choose either Not Yet Posted or Do Not Post.

4. Enter a **Post date**.

5. If desired, mark **Use customer salesperson** if you want the name of the salesperson assigned to the customer to appear on the debit memo.

6. If the customer has special finance terms, you can mark the option to **Use customer terms if they exist** instead of entering terms on this screen.

7. Mark **Compound finance/late charge** if you want the program to calculate finance/late charges based on the customer’s balance due amount, including existing finance/late charge debits.

8. If you want, mark the checkbox to **View results before creating charges**.

9. You can also check the option to **Print control report** if you want to keep a hard copy of the finance/late charges you create.

10. Click **OK** to begin processing. A verification screen appears if you marked **View results before creating charges**.

This provides an opportunity to remove charges before you create the finance charges as debit memos to the customer account(s). Clear the box(es) under the **Generate?** column to eliminate the charge for that customer.

11. Click **Deselect All** if you do not want to generate charges for any of the customers listed.

12. If the list of charges is lengthy, you can quickly locate a charge by clicking **Find**. A standard search criteria screen appears.

13. Click **Create Now** when you are ready to create the selected charges you have defined. All finance and late charges appear on customer records as debit memos. If you marked **View results before creating charges**, the report appears on screen for you to confirm the accuracy of all charges. If you marked **Print control report**, the report prints when you close this screen.
Bank Accounts

In This Chapter

Bank Account Access ......................................................... 185
Bank Account Records ...................................................... 186
Account Management ....................................................... 191
Account Preferences ......................................................... 191
Account Adjustments ....................................................... 193
Account Display ............................................................. 195
Bank Account Utilities ....................................................... 200
This chapter focuses on procedures you can initiate from the main Bank Accounts screen. From here you can add, edit, delete, and make adjustments to your bank accounts. If you have installed Bank Account Reconciliation, you can also reconcile bank accounts. You can also filter for account searches and view bank account transactions in detail or summary format.

Bank Accounts stores bank account information for your Accounts Receivable bank accounts, and the Cash account, Suspense account, and Discount taken accounts.

Using Bank Accounts, you can add, edit, delete, and reconcile bank account information (if Bank Reconciliation is present), and establish references between bank accounts. Because Bank Accounts is a shared Blackbaud component, this module stores bank account information for all your integrated Blackbaud applications.

You cannot access Customers or Configuration until you have set up an Accounts Receivable bank and established the applicable ledger account numbers. Once sales tax codes, products, or transactions are entered in the program, you cannot change the fund with which they are associated. You can, however, edit the account numbers for the bank, but they must remain in the same fund.

The main screen of Bank Accounts opens with a grid view of a bank account in your system, based on the last account you were working in. For example, if you were last entering transactions in a bank account named “AP and SB”, this account appears. Of course, before you establish your bank accounts, the main screen appears without any transactions displayed in the grid, and no bank name entered in the Bank Account field. If you are using Blackbaud’s General Ledger, you must define account number segments in General Ledger before you can establish your Accounts Receivable bank account.

Bank Account Reconciliation is a very useful addition to the functions of Bank Accounts. If you have this optional feature, you can find full details about its use in the Bank Accounts Reconciliation User’s Guide.
Bank Account Access

Accessing Bank Accounts

Open Bank Accounts from the Accounts Receivable program group. The main screen opens, from which you can perform all available functions related to your bank accounts.

From the main screen of Bank Accounts, you can:

- Add a bank account.
- Open another bank account register.
- Apply filters to view specific checks, deposits, and adjustments from the selected bank account register.
- View summaries of the selected bank account register.
- Print graph summaries.
- Edit bank information.
- Add a note.
- Reconcile your account (if you have installed Bank Account Reconciliation).
Bank Account Records

Adding a bank account

If you are using the optional Bank Account Reconciliation module with Bank Accounts, there is an additional tab available for defining a list of adjustment types you can use when you want to reconcile an account. You must have Bank Account Reconciliation to perform a reconciliation of any of your Blackbaud system accounts.


2. On the Bank Account tab, enter the Account ID. This should be a short (20 characters maximum), unique identifier of the account, and can be alphanumeric. The Description you enter can be a more definitive identifier of the account (30 characters maximum).

3. Click the down arrow in the Account type field, and choose Checking, Savings, or Other.

4. The Account no. and Routing no. fields should contain the respective numbers assigned to this account by the bank. In the Routing no. field, you need to enter only the first eight digits provided by your bank. The program creates the ninth digit.

5. There may be occasions when you want to suspend or terminate activity to this account, in which case you can mark the Account is inactive option. This prevents any user from entering transactions affecting this account. You can reactivate the account by clearing the option checkbox.

6. In the bank information frame, enter the name, address, and phone number(s) of the bank. You can also add information concerning your contact person at the bank, and mark the Print option if you want this information to print on account activity reports.
7. Select the Blackbaud Systems tab, and mark the checkbox next to **Accounts Receivable** in the program window. The following screen appears.

8. All Blackbaud programs in your system that use *Bank Accounts* are listed in the program window under **Use this account with these Blackbaud systems**.

9. Mark the **Accounts Receivable** program checkbox and enter the **Cash**, **Suspense**, and **Discounts taken** account numbers in the **General Ledger Accounts** frame. If you have Blackbaud’s **General Ledger** installed, you can click the binocular icon to locate and select the appropriate account number, or you can type it in the account number field.

**Cash Account**

1. The cash account you define here is the collection account for invoices and debit memos entered into your **Accounts Receivable** system. Payments applied to the cash account increase the cash account balance while reducing either the Accounts Receivable account or Suspense Account.

**Suspense Account**

1. This account allows you to apply transactions to source documents (i.e. invoices and credit memos) at your discretion as opposed to immediately. For some, this account could be viewed as an unearned revenue account. However, in **Accounts Receivable**, credit memos as well can pass through the Suspense Account. Credit memos do not meet the requirements for unearned revenue, which implies payment for services rendered has been received in advance. As such, the Suspense Account should be considered a contra-asset account valuing the Accounts Receivable control account,
and offsetting the balance of the Accounts Receivable account. Your end-of-year processing should include an adjustment to the Suspense Account and Unearned Revenue account to properly allocate revenue collected in advance of services to the appropriate liability account in the balance sheet.

**Discounts Taken Account**

1. The Discounts Taken account is debited when the program automatically generates Prompt Payment Discount credit memos for paid invoice line items that qualify for this discount. The Discounts taken account can take the form of a contra-revenue account valuing the gross sales account or as an expense in operations. In either case, the Accounts Receivables account uses the Discounts Taken account when revenue is collected within the specified discount period on a line item-by-line item basis.

2. If you are using Blackbaud’s *Bank Account Reconciliation*, you can select the Adjustment Types tab. The following screen appears.

![Add a Bank Account](image)

3. On this tab, you can enter as many applicable types of adjustments you need. This creates a useful table of adjustment types for you to choose from whenever an adjustment is necessary. For example, if you anticipate making frequent adjustments to this account because of a regular service charge, you can set up an adjustment type for this charge.

4. Enter an applicable definition of the adjustment in the Adjustment Type column.

5. In the Default Debit Acct column, either manually enter the debit account number with which this adjustment is to be associated, or, if you have *General Ledger* installed, search your database for an appropriate debit account to use by clicking the binoculars button. If you enter an account from *General Ledger*, the description of the account is automatically entered in the Description column.
6. Select a credit account to use with the adjustment you are defining, and enter this account number in the **Default Credit Acct** column. Again, if you have **General Ledger**, you can locate and select this entry by clicking the binoculars button. The **Description** column automatically fills with the account description.

7. If you have **Accounts Payable**, **Student Billing**, and/or **Miscellaneous Cash Receipts**, you can select the Interfund Entries tab. The following screen appears.

![Interfund Entries Tab](image)

8. You can use the Interfund Entries tab to distribute expense accounts across funds without having to make manual entries to your general ledger. If you are entering an invoice that needs to be expensed to an account in a fund other than the cash account fund, offsetting entries must be created to ensure your funds stay in balance.

You define interfund transfers to allow expensing invoices from one fund while paying the invoice from a different fund. The source account is located in the same fund as your cash account, while the destination account is in the receiving fund of the expense account. For example, you can define a “transfer out” account in fund 01 and a corresponding “transfer in” account in fund 02.

9. For further information regarding the establishment of interfund entries, please see the User’s Guide for **Accounts Payable**, **Student Billing**, and/or **Miscellaneous Cash Receipts**.
10. Select the Notes tab. The following screen appears.

If you want to add, edit, or delete a note about the bank account, you can do so from this screen. You can identify the type of note you want to add by selecting from the available types on the drop-down list, or compose a new note by clicking the **New Note** icon on the task bar.

11. Click **OK** to save the bank record you have defined.

### Making a bank account inactive

Use this option when you want to suspend or terminate activity to a bank account. This prevents any user from entering transactions affecting this bank account. You can reactivate the account by clearing the option checkbox.

1. Open **Bank Accounts** from the **Accounts Receivable** program group.
2. From the main screen, select **File, Bank Information**.
3. On the Bank Account tab, mark the **Account is inactive** checkbox.
4. Click **OK**.

### Opening another bank account register

1. From the **Bank Accounts** main screen, click the down arrow in the **Bank Account** field, or select **File, Bank Account List**.
2. Highlight the bank account you want to view, and click **Open Register**. The register for the bank account you have chosen opens.

### Editing a bank account

1. From the **Bank Accounts** main screen, display the account you want to edit.
2. Select **File, Bank Information**.
3. Select the tabs you want to edit, and make changes. You can also display this bank information screen by selecting File, Bank Account List. Then highlight the bank account you need to edit, and click Edit Bank Info. You can select the tabs you want to review or edit, and make necessary changes.

4. Click OK to save your changes.

- Deleting a bank account

1. From the Bank Accounts main screen, display the account you want to delete.

2. Select Bank Account List from the File menu.

3. Highlight the bank account you want to delete, and click Delete Bank Acct.

4. A confirmation message appears, asking if you are sure you want to delete the record.

5. Click Yes to delete the bank account.

Account Management

Once you have entered deposit and payment transactions in your Accounts Receivable bank account, you can make use of the many other features of Bank Accounts. You can create adjustments to your account balance, reconcile the account (if you are using Bank Account Reconciliation), sort the account register to suit your needs, customize the appearance of the account register with colors and sorting options, and print or view bank account transaction details and summaries.

Account Preferences

One of the first things you can do to customize Bank Accounts is to set the preferences that suit you and your organization. Since Bank Accounts is a Blackbaud shared module, there are preference options that apply to other programs visible when you open Bank Accounts Preferences from Accounts Receivable. For example, if you have Accounts Payable or Student Billing, you can set check writing preferences while you are in Accounts Receivable, even though this program does not include a check writing function. If you are using Blackbaud’s General Ledger, you can define a source reference for posting, and a Journal/Adjustment reference on the General Ledger tab.
Setting Bank Account preferences

1. From the main screen of *Bank Accounts*, select **Edit, Preferences**. The following screen appears.

![Preferences](image.png)

2. Define the background color of lines in your bank register by clicking the box for **Even lines** or **Odd lines**, which displays a screen from which you can select a background color.

3. Mark the option to choose a color for the checks you print from Blackbaud’s *Accounts Payable, Student Billing*, or *Payroll*, if any of these programs are installed.

4. In the **Bank Register Print Options** frame, select either **Portrait** or **Landscape** to define the report format.

5. You can mark **Show General Ledger distributions** if you want all associated *General Ledger* account distributions to print on the bank register report.

6. In the **Miscellaneous** frame, you can choose to show horizontal and vertical lines in the bank register, and also to show a date when each transaction clears your bank.

7. In the **Default Check Format** frame, you can indicate whether you prefer to see the check form as it will print or just the data information form, which displays the information you want to include on the check.
8. Select the Check Position tab if you want to define more preferences for the checks you can generate through Blackbaud's *Accounts Payable*, *Student Billing*, or *Payroll*. Follow the instructions on the screen that appears.

![Preferences dialog box](image)

9. At any time, you can click **Restore Defaults** if you want to use predefined program preferences.

10. Select the General Ledger tab (if *General Ledger* is present). The following screen appears.

![Preferences dialog box](image)

11. Enter a source code you want the program to use when you post an adjustment from *Bank Accounts* to *General Ledger*. The drop-down list displays all codes in your system.

12. Using the **Reference Field Name** grid, define the fields you want to print on the Adjustments Journal. You can define multiple fields, up to a total of 50 characters in length. You can add additional fields to the reference by clicking **Fields**, and defining the field you want.
13. Click OK to save your preferences for Bank Accounts.

**Account Adjustments**

Adjustments can be made to any of your bank accounts if you have the optional Bank Account Reconciliation module for Bank Accounts. There is a separate User’s Guide for this module, which you can use for detailed information on functions and procedures.

When you establish your bank accounts, you have the option to define any number of appropriate adjustment types on the Adjustment Types tab of the Add a Bank Account screen. This creates a useful table of adjustment types for you to choose from whenever an adjustment is necessary. For example, if you anticipate making frequent adjustments to this account because of a regular service charge, you can set up an adjustment type for this charge.

➢ **Creating a new adjustment to your bank account**

When you want to create an adjustment to an account, locate and display the account on the main Bank Accounts screen.

2. Select New Adjustment. The following screen appears.

![New Adjustment Screen](image)

3. In the Type field, enter the type of adjustment you are using. The drop-down arrow reveals a list of all types of adjustments you have defined. If you enter a new type in the field, the program displays a message, asking if you want to add the new type to the adjustment types table.
4. Enter the Date, Amount, and a Reference for the adjustment you want to create.
5. Enter the Post status for the adjustment and an appropriate Post date.
6. Indicate the appropriate general ledger **Debit account** for the adjustment required to debit your account. Also enter the applicable **Credit account** for credit due as a result of the adjustment. In each case, you can search your database for the ledger account by clicking the search button in these fields. If you are associating the adjustment with an interfund transaction, provide the interfund account in the **Interfund** field.

7. Mark the appropriate choice for the **Enter by** option, which defines the adjustment as a percentage or a specific amount.

8. If your **General Ledger** closing methods require you to use one or more projects, then you must enter the appropriate **Project ID, Project Description, Amount**, and **Percent** if applicable. The **Total, Used, and Remaining** amount of the adjustment are shown in the display to the right of the **Projects** grid.

9. As an alternative to assigning projects and project distributions to the adjustment, you can use a predefined project or group of projects for the adjustment by clicking **Copy Projects**. This displays a list of all projects from which you can choose.

10. Click **Save, Save and Close, or Save and New** to save your adjustment.

**Account Display**

There are features in *Bank Accounts* that allow you to view summaries and details of transactions in any of bank account in your system. You can also customize the appearance of the displayed information.

> Viewing the list of bank accounts

1. Select **File, Bank Account List**. The following screen appears.

![Bank Account List](image)

2. The grid displays all bank accounts in your system, including the **Accounts Receivable** account. You can filter the accounts you want to view by choosing the **System from which** you want to see accounts. The drop-down list in this field shows all programs in your system that use the **Bank Accounts** module. You can also filter the display by **Account type**, for example **Checking, Savings, or Other**.
3. Open an account from here by highlighting it and clicking **Open Register**. You can also click **Edit Bank Info** if you want to make changes to general information about any of the displayed accounts. If you want to add a new bank account, click **Add Bank Acct**. If you click **Delete Bank Acct**., the following confirmation screen appears.

4. If you want to limit the account display to only those in a particular program, click the down arrow in **System** and choose from **Accounts Payable**, **Accounts Receivable**, **Miscellaneous Cash Receipts**, or **Student Billing**, depending on which of these Blackbaud programs you have in your system. You can further limit the display by selecting the **Account type**. Enter **Checking**, **Savings**, or **Other** in the field. If either or both of these fields are left blank, all available system account types are displayed.

**Viewing a bank account transaction summary**

You can view activity for the bank account you have selected from the main screen of **Bank Accounts**.

1. Select **File, Bank Summary** or click the Bank Summary icon on the toolbar. The following screen appears.

2. The grid displays all available Blackbaud systems and applicable transactions for the bank you have chosen. For example, in the above screen, the AR 101 bank is chosen for summary view. The grid shows all Blackbaud systems, but only the activity related to the AR 101 account.

3. Limit the summary by defining a date range in the **Summary for** field and then clicking **Recalculate**. Only the transactions for the dates you have set are then displayed in the grid.
4. You can export this information to Excel by clicking **Export to Excel**. The screen also displays the current account balance, the name of the person who performed the last reconciliation, and the last reconciliation date (available with Blackbaud’s **Bank Account Reconciliation** module).

➢ **Viewing bank account transaction detail**

While viewing a bank account register, you can highlight a line item and view the details of that transaction. Since all receipts are contained in deposits, the transaction record is a deposit record.

1. Highlight the transaction (deposit record) you want to view. Select **View**, Transaction Details.

   ![Deposit Details Screen](image)

   2. Information displays about the transaction, including the date, status, and account number.
3. Select the Receipts tab to view a list of all receipts in the deposit. The following screen appears.

- Viewing bank account information

1. Display the bank account you want to view and select **File, Bank Information** or click the Bank Information icon on the toolbar. The following screen appears.

2. You can edit any information on any of the tabs for this bank account. Please see the procedure for adding a new bank or the reference section of this chapter for complete details regarding each tab.
Viewing the bank register legend

Adding specific line item colors to your bank register allows you to quickly identify transaction types. The Register Legend allows you to select colors you want to use for any of the transaction types in any of the banks in your system.

1. From the main screen of Bank Accounts, select View, Legend. The following screen appears.

2. Depending on the type of account you want to customize, apply color to any of the transaction types displayed in the right hand frame by clicking the box next to the type. This displays a color palette screen, from which you can choose an appropriate color.

3. Specify a particular color to highlight voided transactions, posted transactions, cleared transactions, and reconciled transactions by marking the checkbox next to the item, and then clicking the color box.

Finding a transaction in a bank record

When you want to quickly locate a particular transaction in a bank account register, you can use the Find feature from the main screen.

1. With the main screen of Bank Accounts open to your bank account register, select Edit, Find. The following screen appears.
2. Using the down arrow in **Field**, highlight the item with which you want to identify the transaction you are looking for.

3. In the **Find what** field, enter the corresponding information for locating the transaction. You can also enter all or part of the identification of the transaction in the **Match** field, as well as the option to **Match Case**. This filters the search to the exact transaction you want to find in the register.

### Sorting bank account transactions

If you want to sort the list of transactions in a bank account register differently from the system default method, you can either click the grid column heading to switch between ascending and descending, or you can sort using an editing feature.

1. With the bank account register open on the main screen of *Bank Accounts*, select **Edit, Sort**. The following screen appears.

2. Here you can select the register grid column you want to sort and choose either ascending or descending for the sort order.

3. If you want to save your sort settings and use them as the default, mark the **Save settings as default** option checkbox. You can return to the system default sort settings by clicking **Reset to System Defaults**.

### Bank Account Utilities

The **Utilities** menu of the main screen in *Bank Accounts* offers a up to four possible facilities for managing your bank account data:

**Post to General Ledger** is available if you have Blackbaud’s *General Ledger* program, and allows you to post adjustment transactions to your ledger file. Since this is only used for adjustments, you must also have Blackbaud’s *Bank Reconciliation* for this facility to be enabled.

**Purge Voided Checks** is enabled if you have voided checks in any of your bank account registers. This feature is only available for programs from which you can write checks.

**Raiser’s Edge Import** is enabled if you have Blackbaud’s *Raiser’s Edge for Windows*. This facility allows you to import posted batch and transaction information directly from your *Raiser’s Edge* database. You must also define a bank account for use with all *Raiser’s Edge* transactions before this is available.
General Ledger Import is enabled if you have Bank Reconciliation and General Ledger. Using this feature, you can import posted General Ledger batches from Journal Entry into your Bank Register.
Query and Export

In This Chapter

Query Types .......................................................... 203
Query Format ......................................................... 203
Query Criteria Operators ......................................... 203
Criteria Operators .................................................. 204
Query Merge Operators ............................................ 205
Accessing Query and Export ...................................... 206
Creating Queries ..................................................... 207
Using and Editing Queries ......................................... 210
Merging Queries ...................................................... 215
Exporting Queries .................................................. 216
Printing Queries ...................................................... 217
Properties ............................................................. 218
Favorites .............................................................. 219
Preferences ........................................................... 219
Creating queries is an efficient way of sorting and selecting specific records. For example, you can create a query to select only those customer records with accounts that are past due by 31 to 60 days. You can then create and send the second in a series of three account overdue (dunning) letters.

Exporting is the process by which you prepare information from your database to use with other modules and products.

*Query and Export* can be used to select and export records that meet a set of defined criteria. When you create a query, you are creating a definition for the records you want to include. Then, when you run a procedure using the query, *Accounts Receivable* processes only those records matching the query definition.

A query group is simply a list of those records meeting the criteria you select. You can use queries throughout *Accounts Receivable* for procedures such as printing statements and processing reports.

By using a query, you can perform a function for a specific group of records. For example, you can produce a report for all customers who use a specific payment plan, or you can create mailing labels for all customers with past due balance as of a certain date.

The main function of *Query and Export* is to identify and generate a list of records based on defined criteria, which can then be used by the *Accounts Receivable* program to perform other functions. You can define a query to select and sort records by any field in the database and by numerous summary fields.

You can also extract information from the records in the query by defining the output fields of the query. For example, if you create a query of customers in a specific geographical area, the query contains a list of record IDs for those customers who are in that area. However, to determine if you have defined the query correctly, you want additional information to be shown on the Results tab. By defining output fields, your query not only offers a list of the records included in the query, but also shows the information from selected fields of each customer’s record on the query Results tab.

You can also export the information on the Results tab to a word processing program, a spreadsheet program, or another type of program.

The process of creating a query is best illustrated by an example:

Suppose you need to review all sales returns for Aerie Enterprises, and you want to know dates of returns and the salesperson connected to the customer account. To do this, you need to create a query to define the group of records from which the sales return information should be pulled.

In *Query and Export*, you can create a *Sales Return* query, filtering on *Customer*. The Customer criterion equals Aerie Enterprises. To make the query complete, you need to include sales return dates and the salesperson’s name on the list. To do this, you select the *Sales Return* output field and the *Date* output field. By selecting these output fields, you can view the list of records you have selected from the Results tab to ensure you have selected the appropriate records. Finally, you can sort the query to produce the list of sales returns in order by date or number.

The selections in the Output frame determine what appears in the query results or in the export.

In *Query and Export* you can create, save, open, run, print, and delete a query. You can also refresh a query, merge two queries, and export the results of a query.
Query Types

To use queries correctly, you need a basic understanding of the different query types the program can produce. Seven query types exist: Credit Memo, Customers, Debit Memo, Invoice, Recurring Invoice, Payment, and Sales Return.

Selecting a specific type instructs the program to look only at the IDs of the record type you want to include in the query. For example, only customer records display in a Customer Records query.

Selecting the query type is the first step in narrowing the list of records you want the program to access or process.

Query Format

Query format enables you to define whether the query is dynamic or static.

The Static query provides a “snapshot” of the data at the time you establish the query. When you create the query, it searches the database and generates a list of all records that match the specified criteria. The program stores this list with the static query.

If you run a report two months later using the same query, the program uses the list of records stored in the original query to produce the report. Any records added to your database after you created the static query are not included in the query list; they do not appear on any report generated by that query.

For example, if you want to compare a list of invoices as of March 30, with a list of invoices as of May 30, you can create two static queries. The first static query gives you a list of all invoices as of March 30. The second static query gives you a list of all invoices as of May 30. You can then print a report listing the invoices from each query, and compare the two lists to determine which invoices were added between March 30 and May 30.

A Dynamic query automatically refreshes each time you run the query. It searches the database, gathering the records that match the query criteria and providing the most current results.

For example, you can determine how many sales returns you issued at the end of each month by creating a dynamic query. When you use this query to print a report at the end of March, the query searches the database and compiles a list of all sales returns. Then, when you use the same query to print the report at the end of May, the query again searches the database and updates the list of all sales returns. If new sales returns were issued in April or May, they appear on the May report because you used a dynamic query.

Query Criteria Operators

When you define a query, you establish a set of values, or requirements, that a record must meet to be included. You establish each value by selecting a data field and then defining a criterion the field must meet. Accounts Receivable uses criteria operators to more precisely define criteria, allowing you to narrow a search to include only records of interest. In other words, criteria operators act as additional filters, focusing the search and reducing the number of records included. Several criteria operators appear in the program, but not all criteria operators work with every field.
Criteria Operators

**Equals:** When you choose Equals as your operator, records selected for the query must have the exact entry you define. For example, if you choose City Equals Charleston, the program selects only records with the exact entry “Charleston.”.

**Does Not Equal:** When you choose Does Not Equal as your operator, you select only the records with entries that do not match the defined criterion. For example, if you choose City Does Not Equal Charleston, the program selects every record without “Charleston” entered as the city.

**Greater Than:** The Greater Than operator indicates that records selected must have a value greater than the one you define. For example, if you select Invoice Amount Greater Than $50, only invoice records with a total amount of $50.01 and higher are selected. An amount of $50 is not included.

**Greater Than or Equal To:** The Greater Than or Equal To operator limits the records selected to those that have a value greater than or equal to the one you define. For example, if you select Invoice Amount Greater Than or Equal To $50, only invoice records with a total amount of $50 and higher are selected. This operator includes the value you select when extracting records.

**Less Than:** The Less Than operator limits records selected to ones that have an entry less than the value you define. For example, if you select Invoice Amount Less Than $50, only invoice records with a total amount of $49.99 and lower are selected. An amount of $50 is not included.

**Less Than or Equal To:** The Less Than or Equal To operator selects records which have an entry either equal to or less than the value you define. For example, if you select Invoice Amount Less Than or Equal to $50, only invoice records with a total amount of $50 and lower are selected.

**One Of:** The One Of operator selects records which have one of the entries you define. The One Of operator acts as an Or between the entries you select. For example, if you select City is One Of Charleston, Summerville, or Goose Creek, records selected must have one of the three cities to be chosen.

**Not One Of:** The Not One Of operator selects records which do not have one of the entries you define. For example, if you select City is Not One Of Charleston, Summerville, or Goose Creek, records selected can not have one of the entries you define.

**Between:** The Between operator allows you to select a range of entries that records could have in order to be selected. For example, if you select Amount is Between $50 and $100, records of invoices that fall within this amount range are selected.

**Not Between:** The Not Between operator allows you to select a range of entries that records must not have in order to be included in the query. For example, if you select Amount is Not Between $50 and $100, records of invoices who fall within this amount range are not selected.

**Begins With:** The Begins With operator selects records which have an entry that begins with the value you define. For example, if you choose Vendor Name Begins With Bel, vendors whose Vendor Name has “Bel” at the beginning (Bell, Bellingham, Bellmont, etc.) are selected. You can use wildcard characters with this operator.

**Does Not Begin With:** The Does Not Begin With operator selects records which do not begin with the entry you define. For example, if you choose Vendor Name Does Not Begin With Bel, vendors whose Vendor Name does not have “Bel” at the beginning are selected. You can use wildcard characters with this operator.
Contains: The Contains operator selects records that have the entry you define anywhere in the field. For example, if you define criteria for Vendor Name Contains Z, records with the letter “Z” anywhere in the vendor name field are selected. You can use wildcard characters with this operator.

Does Not Contain: The Does Not Contain operator selects records that do not have the entry you define anywhere in the field. For example, if you define criteria for Vendor Name Does Not Contain Z, only records without a “Z” anywhere in the vendor name field are selected. You can use wildcard characters with this operator.

Like: The Like operator allows you to use wildcards (special characters) to replace a character or set of characters in a field. These wildcards are particularly useful when you are not sure of the spelling of a name or you suspect something might be spelled incorrectly on a record.

Not Like: The Not Like operator selects records that do not have the entry you define. You can use wildcard characters with this operator.

Blank: The Blank operator selects any record with a blank field you define. For example, if you choose the criteria “ID is Blank,” the system selects all records with an empty ID field.

Not Blank: The Not Blank operator selects any record with anything in the entry you define. For example, if you select the criteria “ID Is Not Blank,” the system selects records that have an entry in the ID field.

<Ask>: The <Ask> operator allows you to defer the criteria selection for a field value until you actually run the query. For example, you may have a report you run on different dates that otherwise has identical criteria and output. As you create the query for the report, you can select the appropriate date fields and select <Ask> as the criteria operator. When you run the query, an “Ask at Runtime” wizard appears, prompting you to select criteria for any fields defined by the <Ask> criteria operator.

You can then select any of the standard criteria operators or select <use any value>, a new option that includes all records for which the filter field has any value. You can click the Review Criteria button to review other criteria set for this query.

Click Next to continue through the wizard for any other “Ask at Runtime” fields, and click Finish to complete the wizard and run the query.

Query Merge Operators

You can merge two queries to make a third query. The new query is always a static query. The combination of data included in the final query is determined by the merge operator you use to create the third query. The following merge operators are available:

AND: When you use AND as the merge operator, only data common to both queries appears in the final query.
**OR:** When you use **OR** as the merge operator, the two queries add together to make one query, but data that appears in both queries will appear only once in the final query.

**XOR:** When you use **XOR** as the merge operator, the final query contains only the data unique to either query, but not in both. If a record exists in both, it is not included.

**SUB:** When you use **SUB** as the merge operator, the order of the queries is important because the output query contains data unique to the first (primary) query. All data in the second (secondary) query and data in contained in both queries is not included in the final query.

## Accessing Query and Export

To begin creating queries, you must first open *Query and Export*.

1. From the Start menu, select **Programs, Blackbaud Accounts Receivable**. The *Accounts Receivable* menu appears.
2. Select **Query and Export**. The main screen appears.

---

From *Query and Export* you can:

- Add a query
- Print query results
- Edit a query
- Preview a query list
Creating Queries

The creating a new query process starts by you selecting a query type and format on the New Query screen. With this accomplished, you are taken to the New Query record. The New Query record consists of four tabs. The Criteria tab is where you identify the records to be included in the query. You then select the record fields you want to appear in the query on the Output tab. The order in which the selected fields are presented is established on the Sort tab. Examine the query on the Results tab. You can return to any tab and make changes as desired.

This section contains the procedure for adding queries. Following sections describe procedures for using, merging, exporting, and printing queries.

1. From Query and Export, click the New Query icon, or select File, New. The New Query screen appears.

2. Select the type of query you want to create from the drop-down list in the Query type field. You can select from Credit Memo, Customer, Debit Memo, Invoice, Recurring Invoice, Payment, or Sales Return.

3. In the Query format field, select either Dynamic or Static for the query format. A dynamic query updates each time you access it, whereas a static query contains only those records included in the query at the time you created it.

4. In the Include in field, you can designate to show the new query in the Export List, Query List, or Both.
5. Click **OK** when you have defined the type of query you want to create. The New <type> Query record screen appears.

6. From the Criteria tab, select the criteria you want to use for selecting records from your database. For example, you can select all records with the Credit Memo Amount field greater than or equal to $5.00, which includes the records of all credit memos in the amount of $5.00 or more.

7. To select a field, click the **Show** drop-down list to select a specific group of fields, or select <All> to see a complete list of **Available Fields** categories. You can expand the category to reveal all the available criteria fields.

8. Highlight the field you want to use as a criterion for record selection, and click **Select**. The Edit Field Criteria screen appears.

9. Select the operator you want from the drop-down list. Please refer to the description of operators in the **Criteria Operators** section of this chapter.
10. Click **OK**. The criterion appears in the **Filters** frame.

11. Select the **Output** tab.

12. Select the fields you want to appear as part of the final result. These are the fields from each of the selected records that you want to view on the results tab to ensure the appropriate records have been selected. The output fields can also be exported and used on a custom report.

13. To select an output field, expand the categories and highlight the output field you want in the **Available Fields** frame and click **Select**. The field now appears in the **Output** frame.
14. Select the Sort tab.

15. Indicate how you want the output fields to sort, and click the Results tab to view the results of the query you just created. Depending on the size of your database and the number and complexity of the criteria you chose, this may take some time.

16. The Results tab displays the results of the query you created.
17. If you find the query is not as you want, you can edit the query by returning to any of the tabs to make corrections. When you are satisfied with the results, proceed to saving the query.

18. Select File, Save to save the query. The Save Query As screen appears.

19. Enter the Query name and Description. Select the appropriate Query format and Include in list options.

20. Click OK to save the query.

Using and Editing Queries

This section includes procedures for finding, editing, running, deleting, and refreshing queries.

Finding a query

The Find Query feature is helpful for locating queries created by other users or in other Blackbaud programs. With multiple users, when you include <All> queries in the database, the list could get very long. You can also use the three filter fields at the top of the main Query & Export screen to find a query. Use these fields to narrow the list of queries displayed on the main screen and select from that list.

1. From Query and Export, click Edit, Find. The Find Query screen appears.

2. For Field, select the query field on which you want to search from the drop-down list. For example, if you want to search for a particular query by name, select Query Name.
3. In the **Find what** field, enter the value of the field for which you are searching, for example, Credit Memos.

4. Indicate if the query you are looking for should match **Any part of field**, **Whole field**, or **Start of field**. If you want to specify that the field for **Find what** should be case sensitive, mark **Match Case**.

5. Click **Find First** to begin the search at the top of the list of your existing queries, or click **Find Next** to search for the next query matching your search criteria.

6. Click **Close** to return to the main query screen.

---

### Editing a query

You can change the properties of an existing query at any time. This may be necessary if, for example, you need to add an output field to a query, or change the query’s filter criteria to include a particular attribute.

1. From the main **Query and Export** screen, open the query you want to edit by highlighting the query from the list and clicking **File, Open**.

2. The query opens with the **Criteria** tab showing. Make any necessary changes to the criteria. To change a field, highlight the field in the **Filters** list, and click **Change**. The **Edit Criteria** screen appears.

![Edit Field Criteria](image)

3. Make any necessary changes to the **Operator** and **Value** fields. Click **OK** to save your changes and return to the query’s Criteria tab.

4. Select the **Output** tab. Make the necessary changes to the output fields. You can add additional fields, move the fields up or down in the list, remove a field, or click **Change** to access and change the preferences for a field.

5. Select the **Sort** tab. You can add and remove sort fields, change preferences for a sort field, move a field up or down in the sort order, or change a field from ascending to descending.

6. After making your changes, select the **Results** tab. Review the results to ensure that you have updated your query correctly.
7. If you want to replace the original query with the one you just edited, click **File, Save**. If you wish to keep the original query and also create a new query based on the edits you just made, click **File, Save As**. The Save Query As screen appears. Enter the **Query name** and **Description**. Select the appropriate **Query format** and **Include in** list. If appropriate, mark **Other users may execute this query** and **Other users may modify this query**.

8. Click **OK** to save the new query.

### Editing query options

You can edit the description of a query, allow access/edit rights to other users, pull selected records from other queries, and limit the output of a query for special purposes. This can often save time when you want to use an existing query, but need some of its features to be modified.

1. From **Query and Export**, open the query for which you wish to set options.

2. Select **File, Options**. The Options screen appears.

3. If necessary, edit the **Description** of the query.

4. If appropriate, mark **Other users may execute this query** and **Other users may modify this query**.

5. If you want rows containing duplicate information to appear only once, mark **Suppress duplicate rows**. For example, if Aerie Enterprises appears in two rows, you can eliminate the duplicate row.

6. If you want the query to select from records in another query but not from the entire database, mark **Select from query** and enter the desired query or click the binocular icon to select a query. This is a convenient way to create a new query by editing the existing query. You can, for example, edit a query containing both credit memo and sales return records because you need to create a report showing a combination of these transactions. You can select records from a query containing only sales return records for the query you are editing.
7. If you want, you can change the **Query format**, and the **Include in** selection. You can also limit the output results to a random sampling or top number of rows in the query. This is useful if you need to perform a lottery choosing, for example. This creates an unbiased selection process.

8. Click **OK** to save the options you selected for the query.

### Running a query

1. From the main screen of **Query and Export**, highlight the query you want to run.

2. Select **File, Run Query** or click the exclamation point button on the toolbar. The query processes and opens with the Results tab on top.

3. From the Results tab, you can **Print, Export**, view **Properties**, or **Find** field values using buttons on the toolbar. You can also edit the visual **Format** of the display grid, and **Refresh** the records in the query. Select Records, **Refresh** to refresh the query data. You can use the **Refresh** option to update or “refresh” a static query. Refreshing updates the static query with new record information and data entered after the creation of the query.

### Deleting a query

1. From the main screen of **Query and Export**, highlight the query you want to delete.

2. Select **File, Delete**. The Delete Queries screen appears.

3. The highlighted query appears in the **Queries to Delete** box.

4. Click **OK**. A confirmation screen appears.

5. Click **Yes**.
Refreshing a query

You can use the Refresh option to update or “refresh” a static query. Refreshing updates the static query with new record information and data entered after the creation of the query.

1. From the main screen of Query and Export, highlight the static query you want to refresh.
2. Select File, Refresh. Select Current Query from the submenu. The program refreshes the query, then displays a confirmation message.
3. Click OK.

Refreshing more than one query

1. From the main screen of Query and Export, highlight one of the static queries you want to refresh.
2. Select File, Refresh. Choose Selected Queries from the submenu.
3. The Refresh Queries screen appears.
4. You can highlight a query and click the single arrow buttons to move it to either the Queries box or the Queries to Refresh box. Clicking the double arrow buttons moves all the queries from one box to the other box.
5. Click Properties to view the properties of a highlighted query. From the Properties screen, you can click Print to print the query.
6. Click Find to search for a particular query you want to refresh.
7. Click OK. The program refreshes the selected queries and returns you to the main screen.

Merging Queries

You can merge two queries to make a third query. The combination of records included in the final query is determined by the merge operator you use to create the third query.

The Refresh option is disabled if the program is not able to refresh the query you highlight on the main screen. For example, the program cannot refresh a dynamic query or a static query merged with a dynamic query.


Merging two queries

1. From the main screen of *Query and Export*, click **File**, **Merge**. The Merge Queries screen appears.

2. Select the primary and secondary queries you wish to merge, using the find button if necessary. Also select the merge operator to determine which records from each query should be included in the merged query. Select from:

   - **AND**: All records in both queries appear in the merged query.
   - **OR**: The two queries join to make one query. All records in both queries appear, but not in duplicate.
   - **XOR**: Determines the final query, containing all records that appear in either query, but excludes any records that appear in both queries.
   - **SUB**: The order of the queries is important when using SUB to merge queries, because the merged query contains only those records that are exclusively in the first (primary) query. All records that appear in the second (secondary) query and records that appear in both queries are eliminated.

7. Click **OK**. The Save Static Query screen appears.

8. Enter the **Query name** and **Description**.

9. Select the list in which you want to include the query. Choose from **Query lists**, **Export lists**, or **Both**.

10. If appropriate, mark **Other users may execute this query** and **Other users may modify this query**.

11. Click **OK** to save the new query.
Exporting Queries

You can export information from the Results tab of any query to a word processor, spreadsheet, or reports program. Accounts Receivable includes a large selection of export formats.

➢ Exporting a query

1. In Query and Export, highlight the query you want to export.

2. Click File, Export. The Export Parameters screen appears.

3. Select the Data format you want to use from the drop-down list of available formats. These include Comma Separated Values, Crystal Reports Database (MDB), etc.

4. Enter the Export file name and path or click the browse icon to search for the file name and path. For example, if you want to save the file to a Files directory on the C: drive, you can enter C:\Files\Customers.mdb.

5. If you choose a field with more than one value, you can create a separate record for each value or create a single record for each category. If you create a single record, enter the appropriate information in the grid.

6. Click OK to export the query. When the query finishes exporting, a message appears informing you that your export file has been created.

7. Click OK.

Printing Queries

You can print a list of queries as well as the results of any query. Procedures for these two functions are provided in this section.
Printing a list of queries

1. From *Query and Export*, click **File, Print, Query List**. The Print Query List screen appears.

2. Mark **Summary List** or **Detail List**, depending on how much detail you want to see on the list. If you mark **Detail List**, you can mark the options to **Include field detail** and **Print one query per page**.

3. Using the arrow buttons, move the queries you want to print from the list to the **Queries to Print** box.

4. If you want only queries you have created to appear in the **Queries** box, mark **Only show my queries**.

5. When you have finished selecting the queries you want to print, click **OK** to send your selections to the printer.

Printing query results

You can print the results of any single query.

1. From *Query and Export*, highlight the query you want to print.

2. Select **File, Print, Results**. The query opens briefly, the results are sent to the printer, and the query closes.

Properties

You can review the properties of any existing query. This is useful when you want to determine whether the query can be used for a particular application.

Viewing query properties

1. From *Query and Export*, highlight the query whose properties you want to view.
2. Click File, Properties. The Properties screen appears.

   ![Properties screen]

3. The General tab provides general information, including the query type, description, format, the date it was last run, the time it took to run the query, the date and by whom it was created, the date and by whom it was last modified, and access/editing rights information.

4. Select the Selected Fields tab to view the criteria, output, and sort fields used in the query.

   ![Selected Fields screen]

5. View the results, and click OK to close; or click Print to preview the properties on screen. From the Preview screen, you can print or e-mail the properties of the query.
Favorites

If you need to access a query often, you can add this query to a list of queries under Favorites on the Query and Export main screen toolbar. Favorite queries can also be organized or removed.

- Adding a query to the list of favorites
  1. From Query and Export, highlight the query you want to add to the list of favorites.
  2. Click Favorites, Add to Favorites. The query is added to the list of favorites.

- Organizing the list of favorites
  1. From Query and Export, select Favorites, Organize Favorites. The Organize Favorites screen appears.
  2. Organize the list of favorites. To remove unwanted queries from this list, highlight the query and click Remove. You can also change the order of the queries in the list by using the up and down arrow keys.
  3. Click OK to save the changes.

Preferences

Query preferences determine the presentation defaults for query related screens and field values. You can select default formats for currency, dates, numbers, tables, and yes/no values.

Preferences are set from the main query screen, and they can also be set from specific queries. Preferences set from a specific query affect that query only, while preferences set from the main query screen affect any new queries.

- Setting general query preferences
  General query preferences affect all new queries.
  1. From Query and Export, select Edit, Preferences.
2. The general Preferences screen appears with the General tab selected.

<table>
<thead>
<tr>
<th>Preferences</th>
<th>General</th>
<th>Advanced</th>
<th>Currency</th>
<th>Number</th>
<th>Date</th>
<th>Tables</th>
<th>Yes/No</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Display selection fields alphabetically</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Display number of records found</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sort table entry order</td>
<td>Alphabetically</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show this tab first</td>
<td>Criteria</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>New Queries</td>
<td>Default type: Ask</td>
<td>Query format: Dynamic</td>
<td>Include in: Query Lists</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Round balanced amounts to: 2 decimal places</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Recently opened query list</td>
<td>Number of records to list: 5</td>
<td>Include records for which the following actions have been taken:</td>
<td>New</td>
<td>Run</td>
<td>Open</td>
<td>Export</td>
</tr>
<tr>
<td></td>
<td>Double click preference: Open</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

3. Mark the checkbox if you want to **Display selection fields alphabetically**.

4. Mark the checkbox if you want to **Display number of records found**.

5. You can sort the table entries alphabetically or by table order, or have the program prompt you for the order when you create a query.

6. In the **Show this tab first** field, choose which tab is selected when you open or add a query.

7. In the **New Queries** frame, select the **Default type**, **Query format**, and **Include in** defaults. These fields determine how the New Query toolbar button functions. If you select **Ask** as the **Default type**, the program prompts you to choose the query type before opening a new query. If you select a specific query type, a query using the specified type, format, and **Include in** information opens when you click the New toolbar button.

8. If you want to maintain a list of recently opened queries, mark **Recently opened query list**. Now you can specify the **Number of records to list**. You can include queries in this list that have a history of actions performed by marking the specific action.

9. The **Double click preference** determines the action performed when you double click a query. Select from **Open**, **Run**, **Export**, and **Print**.
10. Select the Advanced tab.

11. In the **Automatic Output** frame, mark the checkbox if you want the selected criteria fields and the selected sort fields to be automatically entered as output fields. These options eliminate having to choose from the list of criteria and sort fields again when you need to select your output fields.

12. In the **Summary Fields** frame, indicate if you want the program to automatically **Apply criteria**, **Do not apply criteria**, or **Prompt** you to choose how you want criteria applied.

13. Select the Currency tab.
14. Mark the checkbox if you want *Accounts Receivable* to use the Windows default format. If you do not want to use the default, mark the format options you want to appear. You can choose to show the currency character, 1000’s separator, and decimals.

15. Select the **Negative amount format**. Choose from a minus sign or parentheses.

16. Select the Number tab.

17. Mark the checkbox if you want *Accounts Receivable* to use the Windows default format. If you do not want to use the default, mark the format options you want to appear. You can choose to show the 1000’s separator, decimals, and the percent sign.

18. Select the **Negative amount format**. Choose from a minus sign or parentheses.
19. Select the Date tab.

![Preferences dialog window with Date options]

20. If you want to use the Windows default format, mark the checkbox. If you do not want to use the default, choose the order in which you want the day, month, and year to appear. Choose from month, day, year (MDY); day, month, year (DMY); and year, day, month (YDM). Select the appropriate format for the **Month**, **Day**, and **Year** fields from the drop-down menu. For the dividing fields, type in either a dash or a slash.

21. Select the Tables tab, and indicate if you want tables to appear using the **Short description** or **Long description**.

![Preferences dialog window with Tables options]
22. Select the Yes/No tab.

23. Select the Yes/No field format you want from the drop-down list. This determines how a yes/no field appears throughout Query and Export. Click OK to save your preferences.

Setting specific query preferences

In addition to general preferences for all queries, you can define and edit preferences for each query you have created. Specific query preferences include Currency, Number, Date, Tables, and Yes/No tabs identical to those included in the general preferences. Specific preferences also include an Optimizations tab.

1. From Query and Export, open the query for which you want to set specific preferences.

2. Select Edit, Preferences. The Preferences screen appears.
3. From this screen you can set preference information that is specific to the open query.

4. On the Currency tab, mark the checkbox if you want *Accounts Receivable* to use the Windows default format. If not, mark the format options you want to appear. You can choose to show the currency character, 1000’s separator, and decimals.

5. Select the **Negative amount format**. Choose from a minus sign or parentheses.

6. Select the Number tab.

7. Mark the checkbox if you want *Accounts Receivable* to use the Windows default format. If not, mark the format options you want to appear. You can choose to show the 1000’s separator, decimals, and the percent sign.

8. Select the **Negative amount format**, either a minus sign or parentheses.

9. Select the Date tab.
10. If you want to use the Windows default format, mark the checkbox. If you do not want to use the default, choose the order in which you want the day, month, and year to appear. Choose from month, day, year (MDY); day, month, year (DMY); and year, day, month (YDM). Select the appropriate format for the **Month**, **Day**, and **Year** fields from the drop-down menu. For the dividing fields, type either a dash or a slash.

11. Select the Tables tab, and indicate if you want tables to appear using the **Short description** or **Long description**.

12. Select the Yes/No tab.

13. Select the appropriate **Yes/No field** format. This determines how a yes/no field is appear for the query.
14. Select the Optimizations tab.

15. When generating the list of records matching your query criteria, *Accounts Receivable* follows a specific process. For a small percentage of queries, this process is not always the most efficient. If you have a large database and typically run complex queries, these options (when marked) prompt the program to **always** use the most efficient method to generate the list of records.

16. If desired, select **Use attribute functions in select clause** and/or **Use code table functions instead of joins**.

17. Click **OK**.
Mail

In This Chapter

Calculating Balances .................................................. 230
Processing Attributes .................................................. 231
Mail Basics ............................................................... 231
Accessing Mail ........................................................... 233
Labels ........................................................................... 234
  The General Tab ......................................................... 234
  The Attributes Tab ...................................................... 234
  The Fields to Include Tab .......................................... 234
  The Format Tab ........................................................ 234
Envelopes ....................................................................... 240
Cards .............................................................................. 244
  Card Label Types ....................................................... 244
Letters ............................................................................. 248
Invoices .......................................................................... 254
Statements ..................................................................... 258
Receipts .......................................................................... 264
Credit Memos ............................................................... 268
Debit Memos ............................................................... 272
Mail is where you use the information stored in your Accounts Receivable database to design and print items such as labels, envelopes, Rolodex cards, index cards, regular statements, and Statements of Annual Charges. You can also create and export information to merge with your word processing program to create dunning letters.

For each function in Mail, you can design and save multiple parameter forms. This means you can design a parameter form, and then save it with a specific name that describes its purpose. When you run the process again, you need only review the saved parameter and make any necessary changes to the fields you entered previously. For example, you can create a parameter form to run statements for customers who receive monthly statements and a separate parameter form to run statements for customers who receive biannual statements. Then, you simply use the appropriate parameter form each time you print statements. Saving individual parameter forms eliminates having to reenter the criteria each time you run statements or another mail function.

You can also run a mail function at any time using the New parameter form. This is a clean parameter form with only the defaults as shipped by Blackbaud.

The Accounting Queue module, a relatively new addition to Blackbaud’s accounting programs, allows you to schedule a sequence of tasks that can be executed, one after the other, automatically and unattended. Using this optional program module can save time with many of the tasks you regularly perform in Accounting for Nonprofits programs.

Because you can set up a queue to run overnight or while you are at lunch, using queues can save you time on almost all of the tasks the Accounting for Nonprofits software performs. For example, you can schedule a queue of financial reports, a queue of mailings, and a queue of statistical reports to run overnight. This allows you to use your workstation and printer for other tasks during normal working hours.

For detailed information about this module, please refer to the Accounting Queue User’s Guide.

Calculating Balances

For printing statements and dunning letters, Accounts Receivable must run through the process of calculating balances.

When calculating the balance, the program looks at the transaction date to determine if the date falls after the transaction cutoff date. If so, the transaction is not included in the balance calculation.

The aging date is used to determine in which aging period the transaction falls. If a transaction/due date falls after the aging date, the transaction is considered current.

Accounts Receivable follows the steps below to determine the balance in accounting systems configured as Open Item.

Sum up charge balances for each period.

Sum up unapplied payments and credits. The unapplied total is equal to the total of all unapplied payments/credits plus the total of all applied payments/credits where the paid charges fall after the transaction cutoff/due as of dates.

For example, if you apply a $200 credit dated 3/31 to a $500 charge dated 5/31, the $200 remains unapplied when you run dunning letters as of 3/31. This $200 may be used to reduce the aging balances if you use the Reduce balance by unapplied payments/credits option.
Processing Attributes

If you mark the **Include or Exclude Records with these Attributes** checkbox, then the grid in the frame is enabled. When the checkbox is marked, at least one attribute needs to be defined.

The **Filter** column drop-down list contains **Include** and **Exclude**. **Include** tells the program to include only those records with the attribute. **Exclude** tells the program to exclude all records with the attribute. **Exclude** takes precedence over **Include**. If you set up an include rule and an exclude rule that affect the same record, then the record is excluded.

You can specify an unlimited number of attributes and attribute values to use as filters.

If you mark the **Add, Update or Delete these Attributes for each Record** checkbox, the grid is enabled. You can specify an unlimited number of add, update, or delete rules.

If you want to add an attribute, you must specify both a category and description.

If you establish an update rule, the program can only update the attribute if the update category exists on the record before the mail run. Records not having the category are not updated.

If you establish a delete attribute rule, then ‘delete category and defined description’ must exist on the record before the mail run. The program does not delete attributes from records without the category and description.

Attributes are not added, updated, and/or deleted if you **Preview**. You need to select **Print** or **Export** to add, update, and/or delete.

Attributes are added/updated/deleted in the final part of the mail run. If the mail run does not complete successfully, no attributes are updated. If you answer **No** at the prompt asking if the mail run was successful, then you are prompted to restart. Once the run is successfully completed, the attributes are updated.

Mail Basics

- **Viewing/editing preferences**
  1. From **Mail**, click **Edit, Preferences**. The Preferences screen appears.
2. Mark the checkbox if you want the program to automatically save mailing parameters. If you leave this checkbox blank, a prompt appears, asking if you want to save the parameters when you click Print or Preview. If marked, the Save Mailing As screen appears automatically.

3. Mark **Show only my mailings** if you want only those parameter files that you have created to show.

4. From the **Double click preference** drop-down list, select which action you want the program to take when you double-click on a saved mailing. Choose from Export, Mail, Open, Preview, and Print.

5. In the **Font Options** frame, select the **Name** of the font you want to use from the drop-down list and select the point **Size**.

6. Click **OK** to save your preferences.

**Including select customers for mailing functions**

1. From Mail, open the mailing function you want to perform. For example, highlight the envelope set you want to create/run, and select **File, New** to view the envelope parameters.

2. On the General tab, click **Include, Selected customers**. The standard query Open screen appears.

3. Highlight the appropriate query to include the select customers you want to include. Click **Open**.

4. Now the General tab displays **Selected customers from <query name>** next to the **Include** button, designating your specific selection of customers.

**Including one customer for mailing functions**

1. From Mail, open the mailing function you want to perform. For example, highlight the envelope set you want to create/run, and select **File, New** to view the envelope parameters.

2. On the General tab, click **Include, One customer**.

3. The standard Open screen appears. Search for and highlight the one customer you want to include. Click **Select**.

4. You are now back to the General tab. Notice the name of the customer you selected to include appears beside the **Include** button.

**Including all customers for mailing functions**

1. From Mail, open the mailing function you want to perform. For example, highlight the envelope set you want to create/run, and select **File, New** to view the envelope parameters.

2. On the General tab, click **Include, All customers**.

3. The General tab now displays **All customers** next to the **Include** button, designating that all customers in the system are included in this mailing function.
Include customers based on attributes for mailing functions

1. From Mail, open the mailing function you want to perform. For example, highlight the envelope set you want to create/run, and select File, New to view the envelope parameters.

2. On the Attributes tab, mark the checkbox for the top grid. This activates the grid and allows you to select attributes that determine which records are included or excluded from this mailing function.

3. In the Filter column, select from the drop-down list either Include or Exclude.

4. In the Category column, select from the drop-down list the attribute category. Only valid attribute categories in your database are available.

Creating an output query from a mailing function

1. From Mail, open the mailing function you want to perform. For example, highlight the envelope set you want to create/run and select File, New to view the envelope parameters.

2. On the General tab, mark the Create Output Query checkbox.

3. Set all appropriate parameters and complete your mail function (for example, print the envelopes).

4. While it prepares to print, you are prompted to name your new output query. Enter a name and description for the new query and mark additional options you want. Click OK.

Accessing Mail

Accessing Mail

1. From the Start menu, select Programs, Accounts Receivable. The Accounts Receivable program group opens.
2. Select Mail. The main screen of Mail appears.

![Mail Screen]

**Labels**

The Labels facility is available under the Labels, Envelopes, and Cards folder. Once you open the New Labels screen, a series of tabs appear, with the General tab on top.

**The General Tab**

The Include button allows you to choose whether you want to include All customers, Selected customers, or One customer. If you choose Selected, you need to locate and open an existing query. If you choose One, you need to locate and open a specific customer record.

The Label Type grid contains all of the supported label types for which Accounts Receivable can print labels. To select the label type you want, simply highlight the label. Once you select a label type, you need to choose the font and font size, and the starting print row and column.

You can choose to Create labels for the Preferred address, ‘Bill to’ address, or the ‘Ship to’ address of the customer record.

**The Attributes Tab**

From the Attributes tab, you prompt the program to include or exclude records based on an attribute. You can also have the program add, update, or delete attributes for each record during the label processing.

**The Fields to Include Tab**

From this tab, you choose which fields you want to print on the label and the order in which you want them to print.
The Format Tab

On the Format tab, you establish the label sort order and other output options such as print in all caps or omit punctuation.

Finally, you can choose to print the truncation reports before the label run to see if the labels are being cut off vertically or horizontally. You can also indicate if you want the program to either create an exception query and/or exclude records from the label run for any records that the system finds being truncated.

By clicking the corresponding button you can view the Layout, Preview the label run, or Print the labels.

Printing labels

1. From Mail, open the Labels, Envelopes, and Cards folder on the left side of the screen, and highlight Labels.

2. Double click the New icon on the right side of the screen. The New Labels screen appears with the General tab on top.

3. Click Include and choose from All customers, Selected customers, and One customer. If you choose Selected customers, locate and open the appropriate query from the search screen. If you choose One customer, locate and open the individual or organization from the search screen.

4. Choose the customer address format you want to use on the labels by marking either the Preferred address, ‘Bill to’ address, or ‘Ship to’ address option checkbox.

5. In the Label type grid, highlight the type of label to which you are printing.

6. Select the Label font, and select the Font size from the respective drop-down lists.
7. Select the **Start printing in Row** number and **Column** number using the arrow buttons to scroll up or down the number line.

8. If you want, mark **Create output query**. When marked, the program creates a query of those records for which a label is printed.

9. Click **Next**. The Attributes tab appears.

10. From this tab, you can choose to include or exclude records based on an attribute. Also, you can add, update, or delete attributes for each individual or organization included in the label run.

11. If you want, mark **Include or Exclude Customers with these attributes**.

12. In the **Filter** column, choose **Include** or **Exclude** from the drop-down list.

13. In **Category** column, click the field to select from the drop-down list of available categories.

14. In the **Description** column, select the appropriate description from the drop-down list. The **Short Description** displays, if available.

15. Mark **Add, Update or Delete these Attributes for each Customer**. For each attribute, select the **Action** you want. Select the **Category** and **Description**. Enter any date and/or comment you want associated with the attribute.
16. Click Next. The Fields to Include tab appears.

![Image of the Fields to Include tab]

17. The fields selected in the grid print on the label in the order in which they appear except for the postal bar code, which always prints at the top of the label.

18. In the Field Name column, select the field from the drop-down list of available fields. In the Options column, either <No options available> displays or you can select any of the options associated with the selected field from the drop-down list.

19. You can move the fields Up or Down, Insert a field, or Delete a field using the buttons on the right side of the screen.
20. Click Next. The Format tab appears.

21. You can choose to Print Truncation Reports before Label Run to see if the labels are being cut off vertically or horizontally. You can also indicate if you want the program to either Create exception query and/or Exclude customer from this label run for any records that the system finds being truncated.

22. In the Label Sort Order frame, choose from Alphabetical, ZIP Code, and Query (available if you are including Selected records).

23. Mark the checkbox(es) if you want to:
   - Print in ALL CAPS
   - Omit punctuation
   - Include total number of labels
   - Skip this many lines before printing the first line (When marked, enter the number of lines to skip.)
   - Include this many spaces before each line (When marked, enter the number of spaces to include before each line.)

24. Click Layout to view on screen a sample of how the labels will print. Click the X icon to close the Layout screen and return to the parameter form.

25. Click Print.

26. Or, click Preview to view the label print run on screen. You are prompted to save the parameters for the label run.

27. Enter the Mailing name and Description. If true, mark Others can execute this mailing and/or Others can modify this mailing. Then, click Save and Preview.

28. From the Preview screen you can print or e-mail the labels.
29. You are prompted to save the label parameter form. Enter the **Mailing name** and **Description**. If true, mark **Others can execute this mailing** and/or **Others can modify this mailing**. Then, click **Save and Print**.

30. Several screens can appear briefly, such as a status bar, when the labels print. When the labels have printed, a screen appears to verify that the labels printed correctly. You should check the labels and answer accordingly. If they did not print correctly, you are prompted to have the labels print again.

➢ **Editing fields to include on labels**

When printing labels, you need to select the fields you want to print. Selecting or editing these fields is just one of the steps in defining the criteria for printing labels.

1. Open an existing label parameter or create a new label parameter.
2. Select the Fields to Include tab.
3. In the grid, select the fields you want to print from a drop-down list in the **Field Name** column.
4. In the **Options** column, some fields have options you can select from a drop-down list. For those fields without options, `<No options available>` displays.
5. Once you select fields, you can edit or adjust their position using the **Up** or **Down** buttons. **Delete** removes a field from the grid. **Insert** adds a row to the grid in the line above the selected row.

➢ **Changing the label format**

1. Open an existing label parameter or create a new label format parameter.
2. Select the Format tab.
3. If you want, mark **Print Truncation Reports before Label Run**. When marked, the options in the frame become available. Mark the checkbox if you want to **Check for horizontal truncations** and/or **Check for vertical truncations**. If truncations are found, mark the option to indicate if you want to the program create an exception query and/or exclude the record from the label run.
4. In the **Label Sort Order** frame, choose from **Alphabetical** and **ZIP Code. Query** is only available if you are printing for selected records.
5. Mark the checkbox(es) if you want to:
   • **Print in ALL CAPS**
   • **Omit punctuation**
   • **Include total number of labels**
   • **Skip this many lines before printing the first line** (When checked, enter the number of lines to skip.)
   • **Include this many spaces before each line** (When checked, enter the number of spaces to include before each line.)
Printing label truncation report while printing labels

1. Open an existing label parameter file, or create a new parameter file.
2. Select the Format tab.
3. Mark Print Truncation Reports before Label Run. When marked, the options in the frame become available.
4. Mark the checkbox if you want to Check for horizontal truncations and/or Check for vertical truncations.
5. Indicate which action the program should take if truncations are found, by marking Create exception query and/or Exclude record from this label run.
6. The truncation reports print before the labels print. Depending on the action you select, the program excludes the customer from the label run and, if selected, includes the name of the customer in the exception query.

Running a label truncation report without printing labels

1. From Mail, open the Labels, Envelopes, and Cards folder on the left side of the screen.
2. Highlight Label Truncation Reports.
4. Click Print.

Mark the appropriate parameters on the series of tabs, as you would if you were actually preparing to print the labels (see the procedure for Printing labels).
5. Click Print.


Envelopes

- **Printing envelopes**

1. From *Mail*, open the **Labels, Envelopes, and Cards** folder on the left side of the screen.
2. Highlight **Envelopes**.
3. Double click the **New** icon at right.
4. The New Envelopes screen appears with the General tab on top.

5. Click **Include** and choose from **All customers**, **Selected customers**, and **One customer**. If you choose **Selected customers**, locate and open the appropriate query from the search screen. If you choose **One customer**, locate and open the appropriate customer record from the search screen.

6. Mark your choice of checkbox to indicate the address format to use for the envelopes: **Preferred address**, ‘Bill to’ address, or ‘Ship to’ address.

7. In the **Envelope Type** grid, highlight the type of envelope on which you are printing.

8. Select the **Envelope font** and the **Font size** from the respective drop-down lists.

9. If you want, mark **Create output query**. When marked, the program creates a query of those records for which an envelope is printed.
10. Click **Next**. The Attributes tab appears.

11. From this tab, you can include or exclude records based on an attribute. Also, you can add, update, or delete attributes for each individual or organization included in the envelope run.

12. If you want, mark **Include or Exclude Customers with these attributes**. In the **Filter** column, choose **Include** or **Exclude** from the drop-down list. In the **Category** column, click on the field to select from the drop-down list of available categories.

13. In the **Description** column, select the appropriate description from the drop-down list. The **Short Description** displays, if available.

14. If you want, mark **Add, Update or Delete these Attributes for each Customer**. For each attribute, select the **Action** you want. Select the **Category** and **Description**. Enter any date and/or comment you want associated with the attribute.
15. Click **Next**. The Fields to Include screen appears.

![Field Selection Screen](image)

16. The fields selected in the grid will print on the envelope in the order in which they appear.

17. In the **Field Name** column, select the field from the drop-down list of available fields. In the **Options** column either **<No options available>** displays, or you can select from the drop-down list of any options associated with the selected field.

18. You can move the fields **Up** or **Down**, **Insert** a field, or **Delete** a field using the corresponding buttons.
19. Click Next. The Format tab appears.

20. Mark Print Return Address on Envelope if you want your organization’s address to print on the envelopes.

21. Make selections for Font and Font size from the respective drop-down lists.

22. In the Envelope Sort Order frame, you can choose to sort the envelope run alphabetically, by ZIP code, or by query (if you are creating envelopes for Selected customers). You can also mark the checkboxes to have the addresses Print in ALL CAPS and/or Omit punctuation from the addresses.

23. You can Preview the envelopes you have created, view the Layout of the envelopes, and Print the envelopes when you are ready.

24. You are prompted to save the envelope parameter form. Enter the Mailing name and Description. If you want, mark Others can execute this mailing and/or Others can modify this mailing. Then click Save and Print. If you want, you can also Print without Saving.

- Selecting fields to include on envelopes

1. Open an existing envelope or create a new envelope.

2. Select the Fields to Include tab.

3. Select the fields you want from the drop-down list of available fields in the Field Name column of the grid. Certain fields have options you can select from the corresponding Options column. Once you select fields, you can edit or adjust their position using the buttons to the right of the grid.
Cards

Accounts Receivable Mail includes an option that allows you to print index cards with pertinent information about your customers. The Rolodex and Index Cards option appears in Mail under Accounts Receivable, Labels, Envelopes, and Cards. You can print to any of the supported label types. The program prints information on the cards according to fields that you specify. You can modify what you want to print on the card by selecting/deselecting any of the available information fields. You can print cards for only one record type at a time.

Card Label Types

<table>
<thead>
<tr>
<th>Types</th>
<th>Height</th>
<th>Width</th>
<th># Across</th>
<th># Down</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avery 5385</td>
<td>2 1/6</td>
<td>4</td>
<td>2</td>
<td>4</td>
<td>Rotary Card</td>
</tr>
<tr>
<td>Avery 5386</td>
<td>3</td>
<td>5</td>
<td>1</td>
<td>3</td>
<td>Rotary Card</td>
</tr>
<tr>
<td>Avery 5388</td>
<td>3</td>
<td>5</td>
<td>1</td>
<td>3</td>
<td>Index Card</td>
</tr>
<tr>
<td>Avery 5389</td>
<td>4</td>
<td>6</td>
<td>1</td>
<td>2</td>
<td>Post Card</td>
</tr>
</tbody>
</table>

Printing cards

1. From Mail, open the Labels, Envelopes, and Cards folder on the left side of the screen.
2. Highlight Rolodex and Index Cards.
3. Double click the New icon on the right side of the screen. The New Rolodex and Index Cards screen appears.
4. On the General tab, click Include and choose from All customers, Selected customers, and One customer. If you choose Selected, locate and open the appropriate query from the search screen. If you choose One customer, locate and open the appropriate customer record from the search screen.

5. Mark one of the address options next to Create cards for to indicate the customer address you want to print on the card.

6. In the Card type display grid, highlight the type of card on which you are printing.

7. Select the Card font, and select the Font size from the associated drop-down list.

8. Select the Start printing in Row number and Column number using the arrow buttons to scroll up or down the number line.

9. If you want to create a query of those records for which a card is printed, mark Create output query.

10. Click Next. The Attributes tab appears.

11. From this tab, you can choose to include or exclude records based on an attribute. Also, you can add, update, or delete attributes for each individual or organization included in the envelope run.

12. If you want, mark Include or Exclude Customers With these attributes. In the Filter column, choose Include or Exclude from the drop-down list. In the Category column, click on the field to select from the drop-down list of available categories.

13. In the Description column, select the appropriate description from the drop-down list. The Short Description displays, if available.
14. Mark **Add, Update or Delete these Attributes for each Customer**. For each attribute, select the **Action** you want. Select the **Category** and **Description**. Enter any **Date** and/or **Comment** you want associated with the attribute.

15. Click **Next**. The **Fields to Include** tab appears.

16. The fields you mark in the **Include** column print on the card in the order in which they appear in the grid.

17. In the **Include?** column, mark the checkbox if you want the field to print. In the **Options** column either **<No options available>** displays, or you can select one of the options associated with the selected field from the drop-down list.
18. Click Next. The Format tab appears.

19. In the **Format Options** frame, mark **Output options**. This enables you to make selections for **Card Sort Order** and whether you want to **Print in ALL CAPS**, **Omit punctuation**, and/or **Include total number of cards**, which gives you a total count of the number of cards you print.

20. Click **Layout** to see how the cards will print. If you see a margin or alignment problem, you can resolve this by marking the **Form adjustment** option in the **Format Options** frame. New options appear.
21. Adjust the margins if needed. The directions on this screen serve to eliminate minor problems with text positioning on the cards you print.

22. Click Print, and continue to step 21.

23. Or, click Preview to view the cards on screen before printing. You are prompted to save the parameters for the card run.

24. Enter the Mailing name and Description. If true, mark Others can execute this mailing and/or Others can modify this mailing. Then, click Save and Preview.

25. From the Preview screen you can print or e-mail the cards. (Skip Step 21.)

26. The program prompts you to save the card parameter form. Enter the Mailing name and Description. If true, mark Others can execute this mailing and/or Others can modify this mailing. Then, click Save and Print. Or, you can Print without Saving.

Letters

The Dunning Letters option under the Letters category of Mail helps you produce letters for customers with past due account balances. The program creates an export file that is used with your word processor to perform a mail merge. Dunning letters for all aging periods may be produced in the same export, or you can create separate export files. You determine if a dunning letter should be produced by establishing the minimum balance in each aging period that a payer must reach before a dunning letter is created.

From the General tab of Dunning Letters, you can determine if you want to include all, selected (using a query), or one record in the export file. The Age As Of date determines which transactions are included in the balance calculation. Activity with a transaction date after the cutoff date is not included in the balance calculation. For more information on the how the Age as of date affects aging, see Due Date vs. Transaction Date in the Configuration chapter.

The Aging tab is where you establish aging period definitions. In the Aging Period grid, marking the Check for Balance? checkbox instructs the program to compare the balances for the aging period. When left blank, the Aging Period Definition, Include All Balances Over, and Aging Code to Send to Interface File cells are disabled. The Aging Period Definition column information defaults from the Aging Periods tab in Configuration. You can edit these periods by returning to Configuration and making changes to the period definitions.

In the Include All Balances Over column, you establish the minimum balance amount. The program compares this amount to each customer’s balance to determine if the information should be included in the dunning letter export. If the customer’s balance for this aging period is higher than the amount entered in this column, the customer receives a dunning letter. The program compares balances, beginning with the oldest aging period and working forward. For more information on how the program determines a customer’s balance, see Calculating Balances.

On the Attributes tab, you can include or exclude records based on an attribute. For example, you can exclude all customers who are staff members from the dunning letter process. To do this, you would have an attribute that indicates the customer is a staff member. Then, on the Attributes tab, you can select Exclude as the filter and choose the attribute Staff Member with the description Yes.

On the Fields tab, you select which fields to export.
You can also add, update, or delete an attribute for each record. For example, you can add the attribute **Dunning Letter Received** with the description of **Yes**.

The Format tab is where you determine how the export file is set up. With **Output options** marked in the **Format Options** frame, you choose to sort the file by **Customer** or **Query** (if creating dunning letters for selected records). Under **Amount display**, you determine how amounts appear.

### Creating an export file for dunning letters

1. From Mail, open the Letters folder on the left side of the screen, and highlight **Dunning Letters**.

2. Double click the **New** icon on the right side of the screen. The New Dunning Letters screen appears.

3. On the General tab, click **Include** and choose from **All customers**, **Selected customers**, and **One customer**.

4. If you choose **Selected**, locate and open the appropriate query from the search screen.

5. If you choose **One customer**, locate and open the appropriate individual or organization from the search screen.

6. In the **Age As Of** frame, enter the **Date** you want to use for the starting point of aging period calculation. Select either **Today** or **<Specific Date>**, which requires you to enter the specific date you want to use. Mark either **Transaction date** or **Due date** to indicate what the program should **Base aging on**.

7. The **Include Transactions with these Transaction Dates** and **Include Transactions with these Due Dates** frames require you to designate which customer transactions you want the program to include in the selection process for dunning letters.
8. You can specify a particular range of transaction dates or due dates for inclusion in the selection, or select one of the options above in each of the Date fields.

9. If you want, mark the checkbox to **Reduce balance by unapplied credits**. When marked, the program calculates any credits and payments that have not been credited to the customer, and then subtracts that amount from the balance before comparing the balance to the aging period’s minimum balance. If the customer’s balance is greater than the minimum, the program creates a dunning letter.

10. For example, if a customer has a past due balance of $150 and an unapplied credit memo of $50, the past due balance is calculated to be $100. The program then compares the $100 balance to the **Include All Balances Over** amount entered on the Aging tab to determine if a dunning letter is created. If the minimum amount was $50, in the example above, the payer information would be included in the dunning letter export.

11. Mark **Create output query** if you want the program to save the selected records used in this dunning letter run as a query for future use.

12. Click **Next**. The Aging tab appears.

13. The Aging tab is where you establish aging period definitions.

14. In the **Aging Period** grid, mark the **Check for Balance?** checkbox(es) to instruct the program to compare the balances for the aging period. When left blank, the **Aging Period Definition**, **Include All Balances Over**, and **Aging Code to Send to Interface File** cells are disabled. The **Aging Period Definition** column information defaults from the Aging Periods tab in Configuration. You can edit these periods by returning to Configuration and making changes to the period definitions.
15. In the **Include All Balances Over** column, you can establish the minimum balance amount. The program compares this amount to each customer’s balance to determine if the information should be included in the dunning letter export. If the customer’s balance for this aging period is higher than the amount entered in this column, the customer receives a dunning letter. The program compares balances, beginning with the oldest aging period and working forward.

16. The **Aging Code to Send to Interface File** column is where you enter the code for defining the aging period for an interface file. This is the minimum number in the aging period followed by a plus (+) sign.

17. Click **Next**. The Attributes tab appears.

18. With this tab, you can determine which records you want to include or exclude from the dunning letter process based on an attribute. You can also add, update, or delete an attribute for each record in the dunning letter process.

19. If you want, mark **Include or Exclude Customers with these attributes**. In the **Filter** column, choose **Include** or **Exclude** from the drop-down list. In the **Category** column, click the field to select from the drop-down list of available categories.

20. In the **Description** column, select the appropriate description from the drop-down menu. The **Short Description** displays, if available.

21. You can mark **Add, Update or Delete these Attributes for each Customer**. For each attribute, select the **Action** you want. Select the **Category** and **Description**. Enter any date and/or comment you want associated with the attribute.
22. Click Next. The Fields tab appears.

23. Select the fields you want included in the dunning letter export file. The fields available for export are listed in the **Available Fields** box.

24. To select a field, click the + to open the category folder and highlight the field. Then, click the right arrow button to send the field to the **Include these fields** box. You can select items from the **Available Fields** box multiple times.

25. Click Next. The Format tab appears.
26. Mark **Output options**. In the Sort Order frame, choose from **Customer** or **Query**. **Query** is only available when creating dunning letters for **Selected** records.

27. Mark **Amount display**.

28. Mark checkboxes for those items you want to show in the amounts. You can include the currency character, 1000’s separator, decimals, and percent sign.

29. Select the **Negative amount format**. Choose from parentheses or a minus sign.

30. Click **Export**. The Save Mailing As screen appears. Enter the **Mailing name**. This is the name of the parameter file.

31. Enter a **Description** of the parameter file.

32. If true, mark **Others can execute this mailing** and/or **Others can modify this mailing**. These options give other users access to open and create dunning letters using the parameter file and to modify the parameter file.

33. Click **Save and Export**. The Export Format screen appears.

34. Select the **Data format** from the list of available formats.

35. Enter the directory where you want the file saved and the name of the export file in the **Export file name** field.

36. Click **OK** to process the mailing.

### Invoices

Invoices can be generated for customers by accessing the Invoices subfolder in the **Forms** folder of **Mail**. You can generate all, selected, or a range of open invoices for your customers.
Generating a new invoice

1. Open the *Accounts Receivable* file in *Mail*, and expand the *Forms* folder. Click **Invoices**, and then double-click the **New** icon in the right-hand display box. The New Invoices screen appears with the General tab on top.

2. Click **Include**, and select **All records**, **Selected records**, which allows you to use a query, or **One record**, which displays a standard search screen to locate the customer record you need.

3. In the **Include Invoices with these Dates** frame, you can select the date(s) to use for filtering the invoices you want to generate. Available date options include a **Specific range**, **Include all dates**, **Today**, **Yesterday**, **This week**, **Last month**, **This quarter**, etc. Keep in mind that "year" refers to either the fiscal year from *General Ledger* or the calendar year as defined in Preferences of *Configuration*.

4. If you choose **Specific range**, the associated date text boxes and labels appear, which allow you to enter a **Start** and **End** date to define the range you want to use. If you do not enter a start date, the range encompasses invoices with all dates up to the end date you enter. If you do not enter an end date, the program generates invoices with dates from the start date through all dates in your database. Finally, if you leave both **Start** and **End** date fields blank, all invoices, regardless of date, are generated.

5. In the **Include Invoices with these Numbers** frame, you can select a range of invoices to generate by defining either a starting invoice number, an ending invoice number, or both. If you do not enter a **Start** or **End** invoice number, all invoices, regardless of number, are generated.

6. In the **Include Invoices with these Statuses** frame, the default includes all status types. You can limit the invoices you want to generate by deselecting any of the statuses you do not want in the run. You must, however, mark at least one of the invoice status options.
7. Mark the Create output query checkbox if you want to create an output query of the invoices that are printed during the run.

8. Click Next. The Attributes tab appears.

9. With this tab you can determine which records you want to include or exclude from the invoice generating process based on an attribute. You can also add, update, or delete an attribute for each record in the invoice run.

10. If you want, mark Include or Exclude Invoices with these attributes. In the Filter column, choose Include or Exclude from the drop-down list. In the Category column, click on the field to select from the drop-down list of available categories.
    In the Description column, select the appropriate description from the drop-down list. The Short Description displays, if available.

11. You can mark Add, Update or Delete these Attributes for each Invoice. For each attribute, select the Action you want. Select the Category and Description. Enter any date and/or comment you want associated with the attribute.
12. Click Next. The Format tab appears.

13. Mark Output options in the Format Options frame. Now you can make selections in the Include on Invoice, Sort Order, and Line Item Spacing frames that are applicable to your invoicing needs.

14. You can choose between Pre-printed Laser Format (available if you are using Forms) and Laser-Printed Format in the Invoice format field.

16. Mark the appropriate Amount Display Options to indicate the format the program uses when displaying amounts in the invoices.

17. Click **Layout** to view the way your invoices appear before printing. If you want to review your option selections for the invoices you are generating, click **Preview**.

18. If the layout and formatting are acceptable, proceed to the next step. If you find that the layout needs adjusting so that the information prints in the proper location on the invoice form, click **Form adjustment**. New options appear.

19. Follow the instructions on the screen to make minor adjustments to the layout of your invoices. Click **Layout** to check the adjustments.

20. Click **Print** to generate and send the invoices to your printer.

**Statements**

Generating statements for your customers is similar to the function and process of generating invoices. You can generate statements for all, selected, or just one customer, as well as limit the statements to those customers who are set up for weekly, quarterly, or monthly statement cycles.
Generating a new customer statement

1. Open the *Accounts Receivable* file in *Mail*, and expand the *Forms* folder. Click *Statements*, and then double click the *New* icon in the right hand display box. The New Statements screen appears with the General tab on top.

2. Click *Include*, and select from *All customers*, *Selected customers*, or *One customer* to indicate for which customers you want to generate statements.

3. In the *Activity Cut Off Date*, *Statement Date*, and *Age As Of* frames, choose the dates you want to use to limit and define the statement run. You can use *Today* or a *<Specific date>* for each of these fields.

4. In the *Include Customers With* frame, mark the appropriate checkboxes to limit the statement run to those customers with *No activity*, *A credit balance*, and/or *A zero balance*. You can mark any or all of these options to specify that the statement run includes customer records containing these statuses.

   If you do not mark any of these options, the remaining two options, *A balance over* *<amount>* and *A balance past due* *<number of> days*, are enabled. This allows you to filter the statement run by choosing only those customers whose accounts have a specific balance, or more, or those customers with past due balances of a specified number of days.

5. You can also mark *Summarize transactions before* *<a specified date>* if you want to have the program summarize activity of customers with transactions before a certain date. This is particularly useful for statements that are lengthy, and provides a transaction history up to the date you specify. This allows for transactions after the date you specify to be shown in detail on the statement.

6. Mark *Create output query* if you want the program to create an output query of the customers for whom you run statements.
7. Click **Next**. The Statement Cycle tab appears.

![Statement Cycle Tab](image)

8. This tab allows you to include statements that are scheduled to be generated automatically by the program. In *Customers*, you can mark the option to **Send statement** on the Miscellaneous tab of the customer record. This enables the option to select whether a weekly, monthly, or quarterly statement is automatically generated for that customer. Choose from the **Available statement cycles** listed in the left box, and move your choice(s) to the **Selected statement cycles** box using the arrow buttons. The program includes these selections in the statement run you are creating.
9. Click Next. The Attributes tab appears.

![Attributes Tab]

10. With this tab you can determine which records you want to include or exclude based on an attribute. You can also add, update, or delete an attribute for each record in the invoice run.

11. Mark Include or Exclude Customers with these attributes. In the Filter column, choose Include or Exclude from the drop-down list. In the Category column, click on the field to select from the drop-down menu of available categories. In the Description column, select the appropriate description from the drop-down list. The Short Description will display, if available.

12. You can mark Add, Update or Delete these Attributes for each Customer. For each attribute, select the Action you want. Select the Category and Description. Enter any date and/or comment you want associated with the attribute.
13. Click **Next**. The Format tab appears.

14. Mark **Output options** in the **Format Options** frame. Now you can make selections in the **Include on Statements**, **Sort Order**, and **Line Item Spacing** frames that are applicable to your statement needs.

15. Mark **Finance Charge** in the **Format Options** frame. This screen allows you to include additional information on your statements, including a billing cycle closing date, finance charge disclosure statement, year-to-date finance charges, and finance charge calculation information.
16. Mark the **Message** option in the **Format Options** frame. The following screen appears.

17. This screen allows you to include a specific message on each statement. In the text box, type the message as you want it to appear on the statements. The screen also displays a sample of the layout of your statements.

18. Mark the **Amount display** option in the **Format Options** frame. The following screen appears.
19. Mark the appropriate **Amount Display Options** to indicate the format the program uses when displaying amounts in the statements. The **Sample Display** frame shows how the amount displays.

20. Click **Layout** to view the way your statements appear before printing. If you want to review your option selections for the statements you are generating, click **Preview**.

21. If the layout and formatting are acceptable, proceed to the next step. If you find that the layout needs adjusting so that the information prints in the proper location on the statements form, click **Form adjustment**. The following screen appears.

22. Follow the instructions on the screen to make minor adjustments to the layout of your statements. Click **Layout** to check the adjustments.

23. Click **Print** to generate and send the statements to your printer.

**Receipts**

Receipts can be generated for your **Accounts Receivable** customers by accessing the Receipts subfolder in the Forms folder of **Mail**. You can generate receipts with all, selected, or a range of transaction dates.

Generating receipts for your customers is similar to the function and process of generating invoices and statements. You can generate receipts for **All**, **Selected**, or just **One** customer, as well as limit the mailing by transaction number and deposit number.

The standard Attributes and Format tabs are available to allow you to filter the information to be included and excluded from the receipts, and also define the sort order, address parameters, and general appearance of the receipts.
Generating a new receipt

1. Open the Accounts Receivable file in Mail, and expand the Forms folder.

2. Click Receipts, and then double click the New icon in the right display box. The New Receipts screen appears, with the General tab on top.

3. Click Include and select All records, Selected records, which allows you to use a query, or One record, which brings up a standard search screen to locate the receipt record you need.

4. In the Include Receipts with these Transaction Dates frame, you can select the date(s) to use for filtering the receipts you want to generate. Available date options include a Specific range, Include all dates, Today, Yesterday, This week, Last month, This quarter, etc. Keep in mind that “year” refers to either the fiscal year from General Ledger or the calendar year as defined in Preferences of Configuration.

5. If you choose Specific range, the associated date text boxes and labels appear, which allows you to enter a Start and End date to define the range you want to use. If you do not enter a start date, the range encompasses receipts with all dates up to the end date you enter. If you do not enter an end date, the program generates receipts with dates from the start date through all dates in your database. Finally, if you leave both Start and End date fields blank, all receipts, regardless of date, are generated.

6. In the Include Receipts with these Transaction Numbers frame, you can select a range of receipts to generate by defining either a starting receipt number, an ending receipt number, or both. If you do not enter a Start or End receipt number, all receipts, regardless of number, are generated.
7. In the **Include these Deposit Numbers** frame, the default is to include all deposits, but you can limit the deposits you want to include by defining a range of deposit numbers you want in the run.

8. Mark the **Create output query** checkbox if you want to create an output query of the receipts that are printed during the run.

9. Click **Next**. The Address tab appears.

![](image)

10. This screen allows you to define the address you want to print on the receipt. You can choose from any of the addresses you have defined on the customer record by clicking the down arrow in the first **Customer’s** field of the **Include on Receipt** frame. The program defaults to using the regular address, but you can use the billing address or shipping address if these have been defined on the customer record.

11. If you mark the second **Customer’s** option, you can enter the customer phone number you want to include on the receipt. Choose from any of the phone numbers defined on the customer record by clicking the down arrow in the field next to this option.

12. Mark the **USPS bar code** option if you want the postal service computer bar code to print on the receipt with the customer address you choose. This may be helpful if you use envelopes that have an address window, allowing the post office to scan the bar code for sorting and routing your mail electronically.
13. Click Next. The Attributes tab appears.

14. With this tab you can determine which records you want to include or exclude from the receipt generation process based on an attribute. You can also add, update, or delete an attribute for each record in the receipt run.

15. If you want, mark Include or Exclude Receipts with these Attributes. In the Filter column, choose Include or Exclude from the drop-down list. In the Category column, click the field to select from the drop-down menu of available categories.
   In the Description column, select the appropriate description from the drop-down list. The Short Description displays, if available.

16. You can mark Add, Update or Delete these Attributes for each Receipt. For each attribute, select the Action you want. Select the Category and Description. Enter any date and/or comment you want associated with the attribute.
17. Click **Next**. The Format screen appears.

18. Mark **Output options** in the **Format Options** frame. This option allows you to establish the order in which you want the receipts to be sorted.

19. In the **Sort Order** frame, choose the primary sorting criteria you want the program to use by selecting the field to sort on from the drop-down list in the **Sort by** field. You can sort by **Name**, **Receipt Number**, or **Receipt Date**. Next, you can define the secondary sorting criteria by entering a different sort criteria in the **then by** field. Using the example as shown in the above screen, the program first sorts all receipts by customer name and then by receipt number. In addition to the sort order criteria, you can choose to sort receipts in **Ascending** or **Descending** order for both the primary and secondary sorting.
20. Mark **Amount Display** in the **Format Options** frame. The following screen appears.

21. Mark the appropriate **Amount Display Options** to indicate the format the program uses when displaying amounts on the receipts.

22. Click **Layout** to view the way your receipts appear before printing. If you want to review your option selections for the receipts you are generating, click **Preview**.

23. If you are satisfied with all your selections and are ready to print the receipts, click **Print**.

**Credit Memos**

Credit Memos can be generated for customers by accessing the Credit Memos sub-folder in the Forms folder of **Mail**. You can generate all, selected, or a range of credit memos for your customers.

Generating credit memos for your customers is similar to the function and process of generating invoices. You can generate credit memos for all, selected, or just one customer, as well as limit the mailing by memo date and memo number.

The standard Attributes and Format tabs are available to allow you to filter the information to be included and excluded from the credit memos, and also define the sort order, address parameters, and general appearance of the memos.
Generating a new credit memo

1. Open the Accounts Receivable file in Mail, and expand the Forms folder. Click Credit Memos, and then double click the New icon in the right display box. The New Credit Memos screen appears, with the General tab on top.

2. Click Include and select All customers, Selected customers, which allows you to use a query, or One customer, which brings up a standard search screen to locate the customer record you need.

3. In the Include Credit Memos with these Dates frame, you can select the date(s) to use for filtering the credit memos you want to generate. Available date options include a Specific range, Include all dates, Today, Yesterday, This week, Last month, This quarter, etc. Keep in mind that “year” refers to either the fiscal year from General Ledger or the calendar year as defined in Preferences of Configuration.

4. If you choose Specific range, the associated date text boxes and labels appear, which allows you to enter a Start and End date to define the range you want to use. If you do not enter a start date, the range encompasses credit memos with all dates up to the end date you enter. If you do not enter an end date, the program generates credit memos with dates from the start date through all dates in your database. Finally, if you leave both Start and End date fields blank, all credit memos, regardless of date, are generated.

5. In the Include Credit Memos with these Numbers frame, you can select a range of credit memos to generate by defining either a starting credit memo number, an ending credit memo number, or both. If you do not enter a Start or End invoice number, all credit memos, regardless of number, are generated.
6. In the **Include Credit Memos with these Statuses** frame, the default includes all status types, but you can limit the credit memos you want to generate by deselecting any of the statuses you do not want in the run. You must, however, mark at least one of the credit memo status options.

7. Mark the **Create output query** checkbox if you want to create an output query of the credit memos printed during the run.

8. Click **Next**. The Attributes tab appears.

9. With this tab you can determine which records you want to include or exclude based on an attribute. You can also add, update, or delete an attribute for each record in the credit memo run.

10. Mark **Include or Exclude Credit Memos with these Attributes**. In the **Filter** column, choose **Include** or **Exclude** from the drop-down list. In the **Category** column, click the field to select from the drop-down list of available categories.

11. In the **Description** column, select the appropriate description from the drop-down list. The **Short Description** displays if available.

12. You can mark **Add, Update or Delete these Attributes for each Credit Memo**. For each attribute, select the **Action** you want. Select the **Category** and **Description**. Enter any date and/or comment you want associated with the attribute.
13. Click Next. The Format tab appears.

14. Mark Output options in the Format Options frame. Now you can make selections in the Include on Memo, Sort Order, and Line Item Spacing frames that are applicable to your mailing needs.

15. You can choose the Memo format (available if you are using Forms) you want to use for the credit memo run.

16. Select Amount display in the Format Options frame. The following screen appears.
17. Mark the appropriate Amount Display Options to indicate the format the program uses when displaying amounts in the credit memos.

18. Click **Layout** to view the way your credit memos appear before printing. If you want to review your option selections for the credit memos you are generating, click **Preview**.

19. If the layout and formatting are acceptable, proceed to the next step. If you find that the layout needs adjusting so that the information prints in the proper location on the credit memo form, click **Form adjustment**. The following screen appears.

20. Follow the instructions on the screen to make minor adjustments to the layout of your credit memos. Click **Layout** to check the adjustments.

21. Click **Print** to generate and send the credit memos to your printer.

### Debit Memos

Debit Memos can be generated for customers by accessing the Debit Memos subfolder in the **Forms** folder of Mail. You can generate all, selected, or a range of debit memos for your customers.

Generating debit memos for your customers is similar to the function and process of generating invoices. You can generate debit memos for all, selected, or just one customer, as well as limit the mailing by memo date and memo number.

The standard Attributes and Format tabs are available to allow you to filter the information to be included and excluded from the debit memos. They also define the sort order, address parameters, and general appearance of the memos.
Generating a new debit memo

1. Open the *Accounts Receivable* file in *Mail*, and expand the *Forms* folder. Click *Debit Memos*, and then double click the *New* icon in the right display box. The New Debit Memos screen appears with the General tab on top.

2. Click *Include* and select *All customers*, *Selected customers*, which allows you to use a query, or *One customer*, which brings up a standard search screen to locate the customer record you need.

3. In the *Include Debit Memos with these Dates* frame, you can select the date(s) to use for filtering the debit memos you want to generate. Available date options include a *Specific range*, *Include all dates*, *Today*, *Yesterday*, *This week*, *Last month*, *This quarter*, etc. Keep in mind that “year” refers to either the fiscal year from *General Ledger* or the calendar year as defined in Preferences of *Configuration*.

4. If you choose *Specific range*, the associated date text boxes and labels appear, which allows you to enter a *Start* and *End* date to define the range you want to use. If you do not enter a start date, the range encompasses debit memos with all dates up to the end date you enter. If you do not enter an end date, the program generates debit memos with dates from the start date through all dates in your database. Finally, if you leave both *Start* and *End* date fields blank, all debit memos, regardless of date, are generated.

5. In the *Include Debit Memos with these Numbers* frame, you can select a range of debit memos to generate by defining either a starting debit memo number, an ending debit memo number, or both. If you do not enter a *Start* or *End* debit memo number, all debit memos, regardless of number, are generated.
6. In the **Include Debit Memos with these Statuses** frame, the default is to include all status types, but you can limit the debit memos you want to generate by deselecting any of the statuses you do not want in the run. You must, however, mark at least one of the debit memo status options.

7. Mark the **Create output query** checkbox if you want to create an output query of the debit memos that are printed during the run.

8. Click **Next**. The Attributes tab appears.

9. With this tab you can determine which records you want to include or exclude from the debit memo generation process based on an attribute. You can also add, update, or delete an attribute for each record in the debit memo run.

10. If you want, mark **Include or Exclude Debit Memos with these Attributes**. In the **Filter** column, choose **Include** or **Exclude** from the drop-down list. In the **Category** column, click on the field to select from the drop-down list of available categories.

11. In the **Description** column, select the appropriate description from the drop-down list. The **Short Description** displays if available.

12. You can mark **Add, Update or Delete these Attributes for each Debit Memo**. For each attribute, select the **Action** you want. Select the **Category** and **Description**. Enter any date and/or comment you want associated with the attribute.
13. Click Next. The Format tab appears.

14. Mark Output options in the Format Options frame and make the appropriate selections in the Include on Memo, Sort Order, and Line Item Spacing frames.

15. You can choose the Memo format (available if you are using Forms) you want to use for the debit memo run.

16. Select Amount display in the Format Options frame. The following screen appears.
17. Mark the appropriate **Amount Display Options** to indicate the format the program uses when displaying amounts in the debit memos.

18. Click **Layout** to view the way your debit memos appear before printing. If you want to review your option selections for the debit memos you are generating, click **Preview**.

19. If the layout and formatting are acceptable, proceed to the next step. If you find that the layout needs adjusting so that the information prints in the proper location on the debit memo form, click **Form adjustment**. The following screen appears.

20. Follow the instructions on the screen to make minor adjustments to the layout of your debit memos. Click **Layout** to check the adjustments.

21. Click **Print** to generate and send the debit memos to your printer.
Reports

In This Chapter

- **Main Report Screen** ................................................................. 291
- **Accounts Receivable Reports** ............................................. 292
  - Customer Reports .......................................................... 292
  - Deposit and Payment Reports ........................................ 292
  - Document Reports ......................................................... 292
  - Product Reports ........................................................... 292
  - Reconciliation Reports .................................................. 292
- **Reports Procedures** ............................................................ 293
- **Getting Started** ................................................................. 293
- **Creating Reports** ................................................................. 296
  - Customer Sales Analysis ................................................ 296
  - Customer Account Activity ........................................... 303
  - Deposit Tickets ............................................................. 310
  - Cash Receipts Journal .................................................... 316
  - Aged Accounts Receivable ............................................. 323
  - Open Item ........................................................................ 329
  - Invoice Edit List ............................................................ 335
  - Account Distribution Report ......................................... 341
  - Product Item List .......................................................... 350
- **Creating an Output Query** ................................................ 362
- **Reference** ........................................................................ 364
  - General Tab ...................................................................... 364
  - Format Tab ...................................................................... 365
    - Headings ...................................................................... 365
    - Criteria ......................................................................... 366
    - Detail ............................................................................ 367
    - Page Footer ................................................................... 367
    - Report Footer ............................................................. 368
    - Miscellaneous ............................................................ 368
  - Accounts Tab ................................................................. 369
  - Attributes Tab ................................................................. 370
  - Banks Tab ...................................................................... 370
  - Funds Tab ...................................................................... 371
  - Payment Methods Tab .................................................. 371
  - Products Tab .................................................................. 372
  - Projects Tab ................................................................... 372
  - Salespersons Tab .......................................................... 373
  - Sales Tax Entities Tab .................................................... 373
  - Statement Cycles Tab ..................................................... 374
  - Transaction Criteria Tab ............................................... 375
Transaction Types Tab .................................................. 376
Sample Reports .......................................................... 376
Reports for Accounts Receivable is a shared module that you can access from any Blackbaud program. The available standard reports in Accounts Receivable are organized by category and by type. Each type of report has a set of parameter tabs that you can format to produce reports based on different criteria. You can name and save each set of report criteria as a report parameter record. You can then use the report parameter record to produce a specific report. You can preview, print, export, or send as e-mail the reports.

You can use the optional Accounting Queue module to automatically generate your reports. For example, you can schedule a queue of financial report printing, a queue of report mailings, and a queue of statistical report printing to run overnight.

For detailed information about this module, please refer to the Accounting Queue User’s Guide.

Main Report Screen

The main screen of Reports displays a list of all reports available for various Blackbaud programs, including Accounts Receivable. There are five major categories of reports in Accounts Receivable. The reports are grouped into five major categories: Customer Reports, Deposit and Payment Reports, Document Reports, Product Reports, and Reconciliation Reports. Under each category, you find a list of all available report types.

The main screen allows you to perform a variety of functions common to all reports, as well as define certain features for the reports you create.

The left pane of the main Reports screen shows all reports available in each program and category. When you expand each category, you can highlight the type of report you want to create, edit, view, or print. The right pane of the screen displays saved report parameter files for each report type. At the bottom of the screen, you can display a description of each report, an option found on the View menu.
Accounts Receivable Reports

The following list displays the report categories and report types available in Accounts Receivable. Project reports appear only if the optional module Project, Grant, and Endowment Management is installed.

Customer Reports

- Customer Account Activity
- Customer Sales Analysis
- Customer Credit Report
- Customer Statistics

Deposit and Payment Reports

- Cash Receipts Journal
- Deposit Tickets
- Deposit Summary

Document Reports

- Account Distribution Report
- Document Edit List
- Invoice Edit List
- Project Distribution Report
- Sales Tax Report
- Aged Accounts Receivable
- Document Journal
- Open Item Report
- Recurring Invoice Report

Product Reports

- Product Item List
- Product Sales Report
- Product Sales Summary

Reconciliation Reports

- Batch Reconciliation Report
Reports Procedures

The procedures section of this chapter provides step-by-step guidelines for creating reports in *Accounts Receivable*. Each procedure relates to a particular tab, common Reports function, or screen. The procedures cover the steps you need to follow when the report you want to create presents a particular tab or screen. The procedures also explain how to define your reports for printing.

The procedures that follow cover the various functions and procedures you find on the main Reports screen and explain how to create a report using criteria found on the most commonly used parameter tabs of *Accounts Receivable* reports.

*Accounts Receivable* reports has five categories of reports: Customer Reports, Deposit and Payment Reports, Document Reports, Product Reports, and Reconciliation Reports.

Getting Started

- **Opening the Reports main screen**

  The main screen lets you perform a variety of functions common to all reports, as well as define certain automatic features for all reports you create.

  1. From the Start menu, select Programs and your main Blackbaud accounting program. A submenu of the program’s modules appears.

  2. Select Reports. The Reports module opens, displaying the main screen.

  ![Blackbaud - Reports](image)

  3. Here you see a list of Blackbaud program folders, which contain lists of all available reports.

  4. Double click the Accounts Receivable folder to view its five report categories: Customer Reports, Deposit and Payment Reports, Document Reports, Product Reports, and Reconciliation Reports.

  5. Click the plus sign beside each category to view a list of all available report types.
Viewing/editing report preferences

Before you begin to create reports, you can establish some overall preferences for use in all reports you define.

1. From the Reports main screen, select Edit, Preferences. The Preferences screen appears.

2. Mark Automatically save report parameters if you want to eliminate the need to select File, Save after creating a report.

3. Mark Show only my reports if you do not want to see any of the reports other users create.

4. Define Double click preference by selecting Open, Export, Mail, Preview, or Print. This determines what happens when you double click a saved report listed on the main screen.

5. In the Font Options frame, select the font type and size you want to use in your reports. You can choose from the drop-down lists of styles and font sizes, and then choose to apply your choices to either the Entire Report or just the Detail Section of your reports.

6. Select Paper Orientation. You can choose to have the orientation determined by the report type or individually select an orientation from the Print Setup screen each time you print.

7. Click OK to save preferences and return to the main screen.
Setting preferences

1. From the main screen of Reports, select Edit, Preferences. The Preferences screen appears.

2. Mark Automatically save report parameters if you want the program to save automatically when you exit a parameter record. Marking this checkbox causes the program to automatically save the parameter record criteria, without displaying a prompt or confirmation message.

3. You can mark the Show only my reports checkbox to reduce the number of parameter records displayed.

4. You can define what happens when you double click a report listed on the main screen. You can have the program Open, Export, Mail, Preview, or Print the report you double click.

5. In the Font Options frame, you can select a font Name from the drop-down list.

6. In the Font Options frame, you can select a font Size from the drop-down list.

7. In the Apply to field, you can select whether you want these options to apply to the Entire Report or only to the Detail Section of a report.

8. In the Paper Orientation frame, you can determine how the orientation is selected. As defined for Report orients the paper according to the report’s design.

9. As defined in Print Setup orients the paper according to the print setup setting, overriding the report design orientation.

10. Click OK to save all preferences.
Creating Reports

This section contains examples of some of the reports you use frequently. First is a procedure on how to create the report and then a sample report of how the report appears using the standard program defaults. Included are the Customer Sales Analysis, Customer Account Activity, Deposit Tickets, Cash Receipts Journal, Aged Accounts Receivable, Open Item, Invoice Edit List, Account Distribution, and the Product Item List.

Customer Sales Analysis

Creating the Customer Sales Analysis Report

1. From Reports, select Customer Reports.
2. Select Customer Sales Analysis. The following screen appears.

Completing the General tab

1. Click the include button and select from All Records, Selected Records, or One Record to include in the report.
2. In the Transaction date field select the dates for the transactions you want the report to include.
3. In the Perform Analysis by frame, select to create a list of customers based on Salesperson, Territory, Industry, State, or Class. This feature allows you to create your report by organizing the information according to the option you select.
4. Mark the Create output query option if you want to create an output query.
5. Click **Next**, or select the Statement Cycles tab.

**Completing the Statement Cycles tab**
1. On this tab select to include **all statement cycles** or **Include only selected statement cycles**. If you choose to **Include only selected statement cycles** use the arrows in the center column to designate the specific statement cycles to include.
2. Mark the corresponding checkbox if you want to **Include inactive statement cycles**. This option is available if you mark to **Include selected statements**.
3. Click **Next**, or select the Transaction Types tab.

**Completing the Transaction Types tab**
1. On this tab select to **Include all transaction types** or **Include only selected transaction types**. If you choose **Include only selected transaction types** use the arrows in the center column to designate the transaction types to include.
2. Mark the corresponding checkbox if you want to **Include inactive transaction types**. This option is available if you mark to **Include only selected transaction types**.
3. Click **Next**, or select the Salespersons tab.

**Completing the Salespersons tab**
1. On this tab select to **Include all salespersons** or **Include only selected salespersons**. If you choose **Include only selected salespersons** use the arrows in the center column to designate the specific salespersons to include.
2. Mark the corresponding checkbox if you want to **Include inactive salesperson**. This option is available if you mark to **Include only selected salespersons**.
3. Click **Next**, or select the Format tab.

**Completing the Territory tab**
1. On this tab select to **Include all territories** or **Include only selected territories**.
2. Mark the corresponding checkbox if you want to **Include inactive territories**. This option is available if you mark to **Include only selected territories**.
3. Click **Next**, or select the Format tab.

**Completing the Industry tab**
1. On this tab select to **Include all industries** or **Include only selected industries**.
2. Mark the corresponding checkbox if you want to **Include inactive industries**. This option is available if you mark to **Include only selected industries**.

3. Click **Next**, or select the Format tab.

**Completing the State**

1. On this tab select to **Include all states** or **Include only selected states**.
2. Mark the corresponding checkbox if you want to **Include inactive states**. This option is available if you mark to **Include only selected states**.
3. Click **Next**, or select the Format tab.

**Completing the Class tab**

1. On this tab select to **Include all classes** or **Include only selected classes**.
2. Mark the corresponding checkbox if you want to **Include inactive classes**. This option is available if you mark to **Include only selected classes**.
3. Click **Next**, or select the Format tab.

**Completing the Headings options on the Format tab**

1. Click the Format tab, or click the **Back** and **Next** buttons to display this tab. The tab displays with the **Headings** option marked.

2. From the **Heading Format frame**, you can enter a **Title** and **Subtitle** for your report. The program default uses the report type as the **Title**, but you can change this.

3. Click the down arrow in the **Align** field, and select **Left**, **Center**, or **Right**.
4. Mark **Print organization name in header** if you want the program to include this name on the report automatically.

5. Mark the **Print Page No. in Heading** frame if you want this included on your report.

6. Click the **Format** down arrow, and choose from **Page 1**, **p1**, or **1**, depending on how you want your report to appear.

7. Click the **Align** down arrow, and choose from **Left**, **Center**, or **Right**, depending on how you want your report to appear.

8. Mark the **Print Report Date in Heading** frame if you want this included on your report.

9. Click the **Format** down arrow, and select from **Short Date**, **Long Date**, **Short Date and Time**, or **Long Date and Time**.

10. Click the **Align** down arrow, and choose from **Left**, **Center**, or **Right**.

11. Mark **Print report heading on each page** if you want the program to do this automatically.

---

**Completing the Criteria options on the Format tab**

1. From the Format tab, mark **Criteria**. The tab refreshes and displays a new frame.

   ![Image](image_url)

2. Mark **Print Report Criteria** if you want the program to print this information automatically when it prints a report.

3. Select the criteria you want to see printed at the end of the report.

4. Choose from: Saved report name, Customers to include, Transaction date range, Statement cycles to include, Transaction types to include, Salespersons to include, and Perform Analysis by.
5. Mark the option to see this criteria printed **On a separate page** or **On the first page**.

- **Completing the Detail option on the Format tab**

  1. From the Format tab, mark **Criteria**. The tab refreshes and displays a new frame.

  ![Image of the Format tab with options](image)

  2. Select a Report Format to be **Detail** or **Summary**.

  3. In the **Break Options** frame select to have the page break at the header or the footer of the page.

  4. If you select break header you can enter a **Text before value** and **Text after value** in the corresponding fields. This information prints on the report at the break header.

  5. If you select break footer, a list of features pertaining to salespeople appears. Here you can select to print a count of transactions per salesperson, print count as a % of total, or page break with each new salesperson. Mark the checkbox to enable the corresponding action.
Completing the Page footer options on the Format tab

1. From the Format tab, mark **Page footer**. The tab refreshes and displays new frames.

2. In the **Text** box, you can type a reference note to appear as a page footer on your report.

3. Use the down arrow in the **Align** field to determine whether this footer appears **Left**, **Center**, or **Right** justified at the bottom of the report.

4. Mark **Print Page No. in Footer** if you want this included on your report.

5. Click the **Format** down arrow, and choose from **Page 1**, **p1**, or **1**, depending on how you want your report to appear.

6. Click the **Align** down arrow, and choose from **Left**, **Center**, or **Right**, depending on how you want your report to appear.

7. Mark **Print Report Date in Footer** if you want this included on your report.

8. Click the **Format** down arrow, and select from **Short Date**, **Long Date**, **Short Date and Time**, or **Long Date and Time**.

9. Click the **Align** down arrow, and choose from **Left**, **Center**, or **Right**.
Completing the Report footer options on the Format tab

1. From the Format tab, mark **Report footer**. The tab refreshes and displays a new frame.

2. In the **Text** box, you can type a reference note to appear as a report footer on your report.

3. Use the down arrow in the **Align** field to determine whether this footer appears **Left**, **Center**, or **Right** justified at the end of the report.
Completing the Miscellaneous options on the Format tab

1. From the Format tab, mark **Miscellaneous**. The tab refreshes and displays new frames.

![New Customer Sales Analysis](image)

2. From the **Amount Display Options** frame, select how you want monetary figures to display on your report.

3. You can choose to Show currency character, Show 1000’s separator, Show decimals, Show percent sign, or Show blanks instead of zero amounts.

4. Click the down arrow in the **Negative amount format** field, and decide whether you want negative numbers to display with the negative sign or in parenthesis. Now you can export, save, or print your report.

Customer Account Activity

Creating the Customer Account Activity Report

1. From **Reports**, select **Customer Reports**.
2. Select **Customer Account Activity**. The following screen appears.

![Customer Account Activity Screen](image)

- **Completing the General tab**
  1. Click the include button and select from **All Records**, **Selected Records**, or **One Record** to include in the report.
  2. In the **Include Transactions with these Transactions Dates** frame, select the dates for the transactions you want the report to include.
  3. Mark **Display a summary balance for transactions before** _, if you want to display a summary balance for transactions before a specific date.
  4. Mark **Include only those customers with a balance over** _, if you want to include customers with a balance over the amount you designate.
  5. Mark **Exclude customers with a credit balance** if you do not want customers with a credit balance to print on the report.
  6. Mark **Exclude customers with a zero balance** if you do not want customers with a zero balance to print on the report.
  7. Mark **Create output query** to create an output query for the report. Now, you can print, preview, export, or save the report.

- **Completing the statement cycles tab**
  1. On this tab select to include **All Statement cycles** or **Selected statement cycles**. If you choose selected statement cycles use the arrows in the center column to designate the specific statements to include.
  2. Mark the corresponding checkbox if you want to Include inactive statement cycles. This option is available if you mark to include selected statements.
Completing the Headings options on the Format tab

1. Click the Format tab, or click the Back and Next buttons to display this tab. The tab displays with the Headings option marked.

2. From the Heading Format frame, you can enter a Title and Subtitle for your report. The program default uses the report type as the Title, but you can change this.

3. Click the down arrow in the Align field, and select Left, Center, or Right.

4. Mark Print organization name in header if you want the program to include this name on the report automatically.

5. Mark the Print Page No. in Heading frame if you want this included on your report.

6. Click the Format down arrow, and choose from Page 1, p1, or 1, depending on how you want your report to appear.

7. Click the Align down arrow, and choose from Left, Center, or Right, depending on how you want your report to appear.

8. Mark the Print Report Date in Heading frame if you want this included on your report.

9. Click the Format down arrow, and select from Short Date, Long Date, Short Date and Time, or Long Date and Time.

10. Click the Align down arrow, and choose from Left, Center, or Right.

11. Mark Print report heading on each page if you want the program to do this automatically.
Completing the Criteria options on the Format tab

1. From the Format tab, mark Criteria. The tab refreshes and displays a new frame.

2. Mark Print Report Criteria if you want the program to print this information automatically when it prints a report.

3. Select the criteria you want to see printed at the end of the report.

4. Choose from: Saved report name, Customer to include, Transaction Date Range, Output query name, and Statement cycles to include.

5. Mark the option to see this criteria printed On a separate page or On the first page.
Completing the Details option on the Format tab

1. From the Format tab, mark Details. The tab refreshes and displays a new frame.

![New Customer Account Activity](image.png)

2. In the Report Order frame, you can select to order the customers on your report Alphabetically or from a previously created Query.

3. In the transactions order field, select to order the report by Date or by Apply-to.

4. Mark Print One Customer per page to print one customer on each page of the report.
Completing the Page footer options on the Format tab

1. From the Format tab, mark Page footer. The tab refreshes and displays new frames.

2. In the Text box, you can type a reference note to appear as a page footer on your report. This footer prints on every page of the report.

3. Use the down arrow in the Align field to determine whether this footer appears Left, Center, or Right justified at the bottom of the report.

4. Mark Print Page No. in Footer if you want this included on your report.

5. Click the Format down arrow, and choose from Page 1, p1, or 1, depending on how you want your report to appear.

6. Click the Align down arrow, and choose from Left, Center, or Right, depending on how you want your report to appear.

7. Mark Print Report Date in Footer if you want this included on your report.

8. Click the Format down arrow, and select from Short Date, Long Date, Short Date and Time, or Long Date and Time.

9. Click the Align down arrow, and choose from Left, Center, or Right.
Completing the Report footer options on the Format tab

1. From the Format tab, mark Report footer. The tab refreshes and displays a new frame.

2. In the Text box, you can type a reference note to appear as a report footer on your report. This footer appears at the end of the report.

3. Use the down arrow in the Align field to determine whether this footer appears Left, Center, or Right justified at the end of the report.
Completing the Miscellaneous options on the Format tab

1. From the Format tab, mark **Miscellaneous**. The tab refreshes and displays new frames.

![New Customer Account Activity window](image)

2. From the **Amount Display Options** frame, select how you want monetary figures to display on your report.

3. You can choose to Show currency character, Show 1000’s separator, Show decimals, Show percent sign, or Show blanks instead of zero amounts.

4. Click the down arrow in the **Negative amount format** field, and decide whether you want negative numbers to display with the negative sign or in parenthesis.

5. Select a **Report Orientation**. Choose from **Portrait** or **Landscape**.

Deposit Tickets

Creating Deposit Tickets Report

1. From **Reports**, select **Customer Reports**.
2. Select **Deposit Tickets**. The following screen appears.

![Deposit Tickets Screen]

- **Completing the General tab**
  1. Click the include button and select from **All Records**, **Selected Records**, or **One Record** to include in the report.
  2. In the **Include Transactions with These Dates** frame, enter the date in the **Deposit date** field.
  3. Select to **Include Deposits with these Numbers** and enter the specific Deposit numbers in the field.
  4. In the **Include Deposits with these Statuses**, select the deposit tickets you want to include with the **Open**, **Closed**, and **Both** status.
  5. Mark **create output query** if you want to create an output query.
Completing the Headings options on the Format tab

1. Click the Format tab, or click the Back and Next buttons to display this tab. The tab displays with the Headings option marked.

2. From the Heading Format frame, you can enter a Title and Subtitle for your report. The program default uses the report type as the Title, but you can change this.

3. Click the down arrow in the Align field, and select Left, Center, or Right.

4. Mark Print organization name in header if you want the program to include this name on the report automatically.

5. Mark the Print Page No. in Heading frame if you want this included on your report.

6. Click the Format down arrow, and choose from Page 1, p1, or 1, depending on how you want your report to appear.

7. Click the Align down arrow, and choose from Left, Center, or Right, depending on how you want your report to appear.

8. Mark the Print Report Date in Heading frame if you want to include this on your report.

9. Click the Format down arrow, and select from Short Date, Long Date, Short Date and Time, or Long Date and Time.

10. Click the Align down arrow, and choose from Left, Center, or Right.

11. Mark Print report heading on each page if you want the program to do this automatically.
Completing the Criteria options on the Format tab

1. From the Format tab, mark **Criteria**. The tab refreshes and displays a new frame.

2. Mark **Print Report Criteria** if you want the program to print this information automatically when it prints a report.

3. Select the criteria you want to see printed at the end of the report. Choose from: Saved report name, Output query name, Deposit dates to include, Deposit numbers to include, Deposit statuses to include.

4. Mark the option to see this criteria printed **On a separate page** or **On the first page**.
Completing the Page footer options on the Format tab

1. From the Format tab, mark **Page footer**. The tab refreshes and displays new frames.

2. In the **Text** box, you can type a reference note to appear as a page footer on your report.

3. Use the down arrow in the **Align** field to determine whether this footer appears **Left**, **Center**, or **Right** justified at the bottom of the report.

4. Mark **Print Page No. in Footer** if you want this included on your report.

5. Click the **Format** down arrow, and choose from **Page 1**, **p1**, or **1**, depending on how you want your report to appear.

6. Click the **Align** down arrow, and choose from **Left**, **Center**, or **Right**, depending on how you want your report to appear.

7. Mark **Print Report Date in Footer** if you want this included on your report.

8. Click the **Format** down arrow, and select from **Short Date**, **Long Date**, **Short Date and Time**, or **Long Date and Time**.

9. Click the **Align** down arrow, and choose from **Left**, **Center**, or **Right**.
Completing the Report footer options on the Format tab

1. From the Format tab, mark **Report footer**. The tab refreshes and displays a new frame.

2. In the **Text** box, you can type a reference note to appear as a report footer on your report.

3. Use the down arrow in the **Align** field to determine whether this footer appears **Left**, **Center**, or **Right** justified at the end of the report.
Completing the Miscellaneous options on the Format tab

1. From the Format tab, mark Miscellaneous. The tab refreshes and displays new frames.

2. From the Amount Display Options frame, select how you want monetary figures to display on your report.

3. You can choose to Show currency character, Show 1000’s separator, Show decimals, Show percent sign, or Show blanks instead of zero amounts.

4. Click the down arrow in the Negative amount format field, and decide whether you want negative numbers to display with the negative sign or in parenthesis. Now you can save, export, preview or print the report.

Cash Receipts Journal

Creating the Cash Receipts Journal

1. From Reports, select Customer Reports.
2. Select **Cash Receipts Journal**. The following screen appears.

![New Cash Receipts Journal](image)

- **Completing the General tab**
  1. Click the include button and select from **All Records**, **Selected Records**, or **One Record** to include in the report.
  2. In the **Include Deposits with these Dates** frame, select the dates for the deposits you want the report to include.
  3. In the **Include Deposits with these Numbers** frame, select deposits, and in the **Receipt Numbers** field, enter receipts with the specific dates you want to include.
  4. In the **Include Receipts with these Post Statuses** frame, select from **Posted**, **Not Yet Posted**, and **Do Not Post** receipts.
  5. Mark **Include applied and unapplied amounts** on the report if you want to include this information.
  6. Mark the **create output query** option if you want to create an output query.
Completing the Payment Method tab

1. Click the Payment Method tab. The tab refreshes and displays a new screen.

2. Mark *Include all payment methods* or *Include only selected payment methods*. By marking *Include only selected payment methods*, you can select to *Include inactive payment methods*.
Completing the Headings options on the Format tab

1. Click the Format tab, or click the Back and Next buttons to display this tab. The tab displays with the Headings option marked.

2. From the Heading Format frame, you can enter a Title and Subtitle for your report. The program default uses the report type as the Title, but you can change this.

3. Click the down arrow in the Align field, and select Left, Center, or Right.

4. Mark Print organization name in header if you want the program to include this name on the report automatically.

5. Mark the Print Page No. in Heading frame if you want this included on your report.

6. Click the Format down arrow, and choose from Page 1, p1, or 1, depending on how you want your report to appear.

7. Click the Align down arrow, and choose from Left, Center, or Right, depending on how you want your report to appear.

8. Mark the Print Report Date in Heading frame if you want this included on your report.

9. Click the Format down arrow, and select from Short Date, Long Date, Short Date and Time, or Long Date and Time.

10. Click the Align down arrow, and choose from Left, Center, or Right.

11. Mark Print report heading on each page if you want the program to do this automatically.
Completing the Criteria options on the Format tab

1. From the Format tab, mark **Criteria**. The tab refreshes and displays a new frame.

2. Mark **Print Report Criteria** if you want the program to print this information automatically when it prints a report.

3. Select the criteria you want to see printed at the end of the report.

4. Choose from: Saved report name, Customers to include, Output query name, Deposit date range, Deposits to include, Payments to include, Receipts to include, and Post status to include.

5. Mark the option to see this criteria printed **On a separate page** or **On the first page**.
Completing the Page footer options on the Format tab

1. From the Format tab, mark **Page footer**. The tab refreshes and displays new frames.

2. In the **Text** box, you can type a reference note to appear as a page footer on your report.

3. Use the down arrow in the **Align** field to determine whether this footer appears **Left**, **Center**, or **Right** justified at the bottom of the report.

4. Mark **Print Page No. in Footer** if you want this included on your report.

5. Click the **Format** down arrow, and choose from **Page 1**, **p1**, or **1**, depending on how you want your report to appear.

6. Click the **Align** down arrow, and choose from **Left**, **Center**, or **Right**, depending on how you want your report to appear.

7. Mark **Print Report Date in Footer** if you want this included on your report.

8. Click the **Format** down arrow, and select from **Short Date**, **Long Date**, **Short Date and Time**, or **Long Date and Time**.

9. Click the **Align** down arrow, and choose from **Left**, **Center**, or **Right**.
Completing the Report footer options on the Format tab

1. From the Format tab, mark Report footer. The tab refreshes and displays a new frame.

2. In the Text box, you can type a reference note to appear as a report footer on your report.

3. Use the down arrow in the Align field to determine whether this footer appears Left, Center, or Right justified at the end of the report.
Completing the Miscellaneous options on the Format tab

1. From the Format tab, mark Miscellaneous. The tab refreshes and displays new frames.

2. From the Amount Display Options frame, select how you want monetary figures to display on your report.

3. You can choose to Show currency character, Show 1000’s separator, Show decimals, Show percent sign, or Show blanks instead of zero amounts.

4. Click the down arrow in the Negative amount format field, and decide whether you want negative numbers to display with the negative sign or in parenthesis. Now you can save, preview, print, or export your report.

5. Select a Report Orientation. Choose from Portrait or Landscape.

Aged Accounts Receivable

Creating the Aged Accounts Receivable Report

1. From Reports, select Document Reports.
2. Select Aged Accounts Receivable. The following screen appears.

![New Aged Accounts Receivable window]

- **Completing the General tab**
  1. Click the include button and select from All Records, Selected Records, or One Record to include in the report.
  2. In the Calculate Aging As Of frame, Select the dates for the transactions you want the report to include. In the Base aging on field select a Due date or Document date. From the Aging date field, select the day you want to include.
  3. In the Include Documents with these dates frame, in the Document Date field enter the dates of the documents you want to include. In the Due date field select a date for documents that are due on a specific date.
  4. Mark include those customers with a balance over _ in period_, you can enter a certain balance from within a designated period to include customers with a certain balance in your accounting period.
  5. Mark the create output query option if you want to create an output query.
  6. Click Next to proceed to the next tab.

- **Completing the Statement Cycles tab**
  1. On this tab select to Include all statement cycles or Include only selected statement cycles. If you choose Include only selected statement cycles use the arrows in the center column to designate the specific statement cycles to include.
  2. Mark the corresponding checkbox if you want to Include inactive statement cycles. This option is available if you mark to Include only selected statement cycles.
Completing the Headings options on the Format tab

1. Click the Format tab, or click the Back and Next buttons to display this tab. The tab displays with the Headings option marked.

2. From the Heading Format frame, you can enter a Title and Subtitle for your report. The program default uses the report type as the Title, but you can change this.

3. Click the down arrow in the Align field, and select Left, Center, or Right.

4. Mark Print organization name in header if you want the program to include this name on the report automatically.

5. Mark the Print Page No. in Heading frame if you want this included on your report.

6. Click the Format down arrow, and choose from Page 1, p1, or 1, depending on how you want your report to appear.

7. Click the Align down arrow, and choose from Left, Center, or Right, depending on how you want your report to appear.

8. Mark the Print Report Date in Heading frame if you want this included on your report.

9. Click the Format down arrow, and select from Short Date, Long Date, Short Date and Time, or Long Date and Time.

10. Click the Align down arrow, and choose from Left, Center, or Right.

11. Mark Print report heading on each page if you want the program to do this automatically.
Completing the Criteria options on the Format tab

1. From the Format tab, mark **Criteria**. The tab refreshes and displays a new frame.

2. Mark **Print Report Criteria** if you want the program to print this information automatically when it prints a report.

3. Select the criteria you want to see printed at the end of the report.

4. Choose from: Saved report name, Customers to include, Base aging on, Document dates to include, Due dates to include, Output query name, and Statement cycles to include.

5. Mark the option to see this criteria printed **On a separate page** or **On the first page**.

Completing the Detail option on the Format tab

1. From the Format tab, mark **Detail**. The tab refreshes and displays a new frame.
2. Mark **Include Contact name** or **Include phone number**. When you mark **Include phone number** decide if you want to use the phone number in the customer record and which phone number to use.

![New Aged Accounts Receivable](image)

➢ **Completing the Page footer options on the Format tab**

1. From the Format tab, mark **Page footer**. The tab refreshes and displays new frames.

![New Aged Accounts Receivable](image)

2. In the Text box, you can type a reference note to appear as a page footer on your report.
3. Use the down arrow in the **Align** field to determine whether this footer appears **Left**, **Center**, or **Right** justified at the bottom of the report.

4. Mark **Print Page No. in Footer** if you want this included on your report.

5. Click the **Format** down arrow, and choose from **Page 1**, **p1**, or **1**, depending on how you want your report to appear.

6. Click the **Align** down arrow, and choose from **Left**, **Center**, or **Right**, depending on how you want your report to appear.

7. Mark **Print Report Date in Footer** if you want this included on your report.

8. Click the **Format** down arrow, and select from **Short Date**, **Long Date**, **Short Date and Time**, or **Long Date and Time**.

9. Click the **Align** down arrow, and choose from **Left**, **Center**, or **Right**.

➤ **Completing the Report footer options on the Format tab**

1. From the Format tab, mark **Report footer**. The tab refreshes and displays a new frame.

2. In the **Text** box, you can type a reference note to appear as a report footer on your report.

3. Use the down arrow in the **Align** field to determine whether this footer appears **Left**, **Center**, or **Right** justified at the end of the report.
Completing the Miscellaneous options on the Format tab

1. From the Format tab, mark **Miscellaneous**. The tab refreshes and displays new frames.

![Screenshot of the Format tab](image.png)

2. From the **Amount Display Options** frame, select how you want monetary figures to display on your report.

3. You can choose to Show currency character, Show 1000’s separator, Show decimals, Show percent sign, or Show blanks instead of zero amounts.

4. Click the down arrow in the Negative amount format field, and decide whether you want negative numbers to display with the negative sign or in parenthesis.

5. Select a **Report Orientation**. Choose from Portrait or Landscape.

Open Item

Creating the Open Item Report

1. From **Reports**, select **Document Reports**.
2. Select **Open Item Report**. The following screen appears.

![New Open Item Report](image)

**Completing the General tab**

1. Click the include button and select from **All Records**, **Selected Records**, or **One Record** to include in the report.

2. In the **Include Transactions with these Dates** frame, use the drop down arrow to create a transaction and a post date. Select the dates for the transactions you want the report to include.

3. In the **Include Transactions with these Post Statuses** frame, select to create a list of customers based on a post status. Your choices are **Posted**, **Not Yet Posted** and **Do Not Post**. This feature allows you to create your report organizing the information according to the option you select.

4. Enter a date in the **Show transactions open as of** field if you want to include transactions for a specific date.

5. Mark the **create output query** option if you want to create an output query.

**Completing the Transactions Type tab**

1. On this tab select to **include all transaction types** or **include only selected transaction types**. If you choose **include only selected transaction types**, use the arrows in the center column to select the transactions you want to include.

2. Mark the corresponding checkbox if you want to **include inactive transaction types**, this option is available if you mark to **include only selected transaction types**.
Completing the Statement Cycles tab

1. On this tab select to include All statement cycles or to Include selected statement cycles. If you choose selected statement cycles use the arrows in the center column to designate the specific statement cycles to include.

2. Mark the corresponding checkbox if you want to Include inactive statement cycles. This option is available if you mark to Include only selected statements.

Completing the Headings options on the Format tab

1. Click the Format tab, or click the Back and Next buttons to display this tab. The tab displays with the Headings option marked.

2. From the Heading Format frame, you can enter a Title and Subtitle for your report. The program default uses the report type as the Title, but you can change this.

3. Click the down arrow in the Align field, and select Left, Center, or Right.

4. Mark Print organization name in header if you want the program to include this name on the report automatically.

5. Mark the Print Page No. in Heading frame if you want this included on your report.

6. Click the Format down arrow, and choose from Page 1, p1, or 1, depending on how you want your report to appear.

7. Click the Align down arrow, and choose from Left, Center, or Right, depending on how you want your report to appear.

8. Mark the Print Report Date in Heading frame if you want this included on your report.
9. Click the **Format** down arrow, and select from **Short Date**, **Long Date**, **Short Date and Time**, or **Long Date and Time**.

10. Click the **Align** down arrow, and choose from **Left**, **Center**, or **Right**.

11. Mark **Print report heading on each page** if you want the program to do this automatically.

➤ **Completing the Criteria options on the Format tab**

1. From the Format tab, mark **Criteria**. The tab refreshes and displays a new frame.

2. Mark **Print Report Criteria** if you want the program to print this information automatically when it prints a report.

3. Select the criteria you want to see printed at the end of the report.

4. Choose from: Saved report name, Customers to include, Transaction date range, Post date range, Post status to include, Transaction types to include, Statement Cycles to include, and Output query name.

5. Mark the option to see this criteria printed **On a separate page** or **On the first page**.
Completing the Page footer options on the Format tab

1. From the Format tab, mark **Page footer**. The tab refreshes and displays new frames.

2. In the **Text** box, you can type a reference note to appear as a page footer on your report.

3. Use the down arrow in the **Align** field to determine whether this footer appears **Left**, **Center**, or **Right** justified at the bottom of the report.

4. Mark **Print Page No. in Footer** if you want this included on your report.

5. Click the **Format** down arrow, and choose from **Page 1**, **p1**, or **1**, depending on how you want your report to appear.

6. Click the **Align** down arrow, and choose from **Left**, **Center**, or **Right**, depending on how you want your report to appear.

7. Mark **Print Report Date in Footer** if you want this included on your report.

8. Click the **Format** down arrow, and select from **Short Date**, **Long Date**, **Short Date and Time**, or **Long Date and Time**.

9. Click the **Align** down arrow, and choose from **Left**, **Center**, or **Right**.
Completing the Report footer options on the Format tab

1. From the Format tab, mark Report footer. The tab refreshes and displays a new frame.

2. In the Text box, you can type a reference note to appear as a report footer on your report.

3. Use the down arrow in the Align field to determine whether this footer appears Left, Center, or Right justified at the end of the report.
Completing the Miscellaneous options on the Format tab

1. From the Format tab, mark **Miscellaneous**. The tab refreshes and displays new frames.

2. Select a **Report Orientation**. Choose from **Portrait** or **Landscape**.

3. From the **Amount Display Options** frame, select how you want monetary figures to display on your report.

4. You can choose to Show currency character, Show 1000’s separator, Show decimals, Show percent sign, or Show blanks instead of zero amounts.

5. Click the down arrow in the Negative amount format field, and decide whether you want negative numbers to display with the negative sign or in parenthesis.

**Invoice Edit List**

- **Creating the Customer Sales Analysis Report**
  1. From **Reports**, select **Document Reports**.
2. Select **Invoice Edit List**. The following screen appears.

![Invoice Edit List Screen](image)

**Completing the General tab**

1. Click the include button and select from **All Records**, **Selected Records**, or **One Record** to include in the report.

2. In the **Include Transactions with these dates** frame select the dates for the transactions you want the report to include.

3. In the **Include Transactions with these numbers** frame enter the numbers from a set of transactions to include on the report.

4. In the **Include Transactions with these Transaction Types** frame, mark the **Invoice and sales return**, **Invoice only**, or **Sales returns only** if you want to include any of these transaction types on your report.

5. In the **Include Transactions with these Print Statuses** frame, mark the **Printed**, **On hold**, **Not printed**, and **Reprint** checkboxes to print the corresponding types of transactions.

6. Mark the **create output query** option if you want to create an output query.

**Completing the statement cycles tab**

1. On this tab select to include **all statement cycles** or **selected statement cycles**. If you choose selected statement cycles use the arrows in the center column to designate the specific statements to include.

2. Mark the corresponding checkbox if you want to **Include inactive statement cycles**. This option is available if you mark to **include only selected statement cycles**.
Completing the Headings options on the Format tab

1. Click the Format tab, or click the Back and Next buttons to display this tab. The tab displays with the Headings option marked.

2. From the Heading Format frame, you can enter a Title and Subtitle for your report. The program default uses the report type as the Title, but you can change this.

3. Click the down arrow in the Align field, and select Left, Center, or Right.

4. Mark Print organization name in header if you want the program to include this name on the report automatically.

5. Mark the Print Page No. in Heading frame if you want this included on your report.

6. Click the Format down arrow, and choose from Page 1, p1, or 1, depending on how you want your report to appear.

7. Click the Align down arrow, and choose from Left, Center, or Right, depending on how you want your report to appear.

8. Mark the Print Report Date in Heading frame if you want this included on your report.

9. Click the Format down arrow, and select from Short Date, Long Date, Short Date and Time, or Long Date and Time.

10. Click the Align down arrow, and choose from Left, Center, or Right.

11. Mark Print report heading on each page if you want the program to do this automatically.
Completing the Criteria options on the Format tab

1. From the Format tab, mark **Criteria**. The tab refreshes and displays a new frame.

2. Mark **Print Report Criteria** if you want the program to print this information automatically when it prints a report.

3. Select the criteria you want to see printed at the end of the report.

4. Choose from: Saved report name, Customers to include, Transaction date range, Transaction numbers to include, Transaction types to include, Print Status to include, Output query, Statement cycles to include.

5. Mark the option to see this criteria printed **On a separate page** or **On the first page**.
Completing the Page footer options on the Format tab

1. From the Format tab, mark **Page footer**. The tab refreshes and displays new frames.

2. In the **Text** box, you can type a reference note to appear as a page footer on your report.

3. Use the down arrow in the **Align** field to determine whether this footer appears **Left**, **Center**, or **Right** justified at the bottom of the report.

4. Mark **Print Page No. in Footer** if you want this included on your report.

5. Click the **Format** down arrow, and choose from **Page 1**, **p1**, or **1**, depending on how you want your report to appear.

6. Click the **Align** down arrow, and choose from **Left**, **Center**, or **Right**, depending on how you want your report to appear.

7. Mark **Print Report Date in Footer** if you want this included on your report.

8. Click the **Format** down arrow, and select from **Short Date**, **Long Date**, **Short Date and Time**, or **Long Date and Time**.

9. Click the **Align** down arrow, and choose from **Left**, **Center**, or **Right**.
Completing the Report footer options on the Format tab

1. From the Format tab, mark **Report footer**. The tab refreshes and displays a new frame.

2. In the **Text** box, you can type a reference note to appear as a report footer on your report.

3. Use the down arrow in the **Align** field to determine whether this footer appears **Left**, **Center**, or **Right** justified at the end of the report.
Completing the Miscellaneous options on the Format tab

1. From the Format tab, mark **Miscellaneous**. The tab refreshes and displays new frames.

![Invoice Edit List](image)

2. From the **Amount Display Options** frame, select how you want monetary figures to display on your report.

3. You can choose to Show currency character, Show 1000’s separator, Show decimals, Show percent sign, or Show blanks instead of zero amounts.

4. Click the down arrow in the Negative amount format field, and decide whether you want negative numbers to display with the negative sign or in parenthesis.

5. Select a **Report Orientation**. Choose from **Portrait** or **Landscape**.

### Account Distribution Report

Creating the Customer Sales Analysis Report

1. From **Reports**, select **Document Reports**.
2. Select **Account Distribution Report**. The following screen appears.

![New Account Distribution Report](image)

- **Completing the General tab**
  1. Click the include button and select from **All Records**, **Selected Records**, or **One Record** to include in the report.
  2. In the **Include transactions with these Dates** frame, use the drop down arrow to select a date in the **Transaction Date** and **Post Date** fields.
  3. Select to include transactions with specific post statuses. To include **Posted**, **Not Yet Posted**, or **Do Not Post**, mark the corresponding checkbox.

- **Completing the statement cycles tab**
  1. On this tab select to include **all statement cycles** or **selected statement cycles**. If you choose selected statement cycles use the arrows in the center column to designate the specific statements to include.
  2. Mark the corresponding checkbox if you want to Include inactive statement cycles. This option is available if you mark to include selected statements cycles.

- **Completing the Funds tab**
  1. From the report mark the Funds tab and the screen refreshes.
  2. Select to include **all funds** or **include only selected funds**. If you mark **include only selected funds** use the arrows in the center column to designate the funds you want to include.
  3. Click **Next** to proceed to the next tab.
Completing the Accounts tab

1. Select the Accounts tab, the following screen appears.

2. Here you can select which accounts if any that you want to include on the report. You can select All accounts, selected accounts, or Range of accounts. If you mark Selected accounts or Range of Accounts, the grid changes accordingly to meet your needs.

Completing the projects tab

1. Select the Projects tab, the screen refreshes.

2. From the projects tab mark to Include all projects or to Include only selected projects. If you mark Include only selected projects, use the arrows in the center column to designate the projects to include.

Completing the banks tab

1. Select the banks tab, the screen refreshes.

2. Mark to include all banks (accounts) or to include only selected banks (accounts). If you mark to Include only selected bank accounts, use the arrows in the center to designate which bank accounts you want to include on the report.
Completing the Attributes tab

1. Select the Attributes tab, the following screen appears.

2. Here you can mark **Include Customers with these Attributes**, and enter the customers in the grid that you want to include in the report.

3. You can mark **Exclude Customers with these Attributes**, and enter those customers you want to exclude from the report in the grid.
Completing the Headings options on the Format tab

1. Click the Format tab, or click the Back and Next buttons to display this tab. The tab displays with the Headings option marked.

2. From the Heading Format frame, you can enter a Title and Subtitle for your report. The program default uses the report type as the Title, but you can change this.

3. Click the down arrow in the Align field, and select Left, Center, or Right.

4. Mark Print organization name in header if you want the program to include this name on the report automatically.

5. Mark the Print Page No. in Heading frame if you want this included on your report.

6. Click the Format down arrow, and choose from Page 1, p1, or 1, depending on how you want your report to appear.

7. Click the Align down arrow, and choose from Left, Center, or Right, depending on how you want your report to appear.

8. Mark the Print Report Date in Heading frame if you want this included on your report.

9. Click the Format down arrow, and select from Short Date, Long Date, Short Date and Time, or Long Date and Time.

10. Click the Align down arrow, and choose from Left, Center, or Right.

11. Mark Print report heading on each page if you want the program to do this automatically.
Completing the Criteria options on the Format tab

1. From the Format tab, mark **Criteria**. The tab refreshes and displays a new frame.

2. Mark **Print Report Criteria** if you want the program to print this information automatically when it prints a report.

3. Select the criteria you want to see printed at the end of the report.

4. Choose from: Saved report name, Customers to include, Transaction date range, Post date range, Post statuses to include, Funds to include, Accounts to include, Projects to include, Banks to include, Attributes to include, Attributes to exclude, Report format.

5. Mark the option to see this criteria printed **On a separate page** or **On the first page**.
Completing the Detail option of the Format tab

1. Select Detail on the Format tab. The screen refreshes.

2. In the Report Format field mark to print the report in Detail or Summary.

3. In the Break down report by Bank Account frame select to have the page break at the header or the footer of the page.

4. If you select Define break header you can enter a Text before value and Text after value in the corresponding fields. This information prints on the report at the break header.

5. If you select break footer, a list of features pertaining to the bank appears. Here you can select to print a count of invoices per transaction, print count as a % of total, or a page break with each new bank account. Mark the checkbox to enable the corresponding action.

6. Select to print the Bank Account ID, Description, or ID and Description.
Completing the Page footer options on the Format tab

1. From the Format tab, mark Page footer. The tab refreshes and displays new frames.

2. In the Text box, you can type a reference note to appear as a page footer on your report.

3. Use the down arrow in the Align field to determine whether this footer appears Left, Center, or Right justified at the bottom of the report.

4. Mark Print Page No. in Footer if you want this included on your report.

5. Click the Format down arrow, and choose from Page 1, p1, or 1, depending on how you want your report to appear.

6. Click the Align down arrow, and choose from Left, Center, or Right, depending on how you want your report to appear.

7. Mark Print Report Date in Footer if you want this included on your report.

8. Click the Format down arrow, and select from Short Date, Long Date, Short Date and Time, or Long Date and Time.

9. Click the Align down arrow, and choose from Left, Center, or Right.
Completing the Report footer options on the Format tab

1. From the Format tab, mark **Report footer**. The tab refreshes and displays a new frame.

2. In the **Text** box, you can type a reference note to appear as a report footer on your report.

3. Use the down arrow in the **Align** field to determine whether this footer appears **Left**, **Center**, or **Right** justified at the end of the report.
Completing the Miscellaneous options on the Format tab

1. From the Format tab, mark **Miscellaneous**. The tab refreshes and displays new frames.

2. From the **Amount Display Options** frame, select how you want monetary figures to display on your report.

3. You can choose to Show currency character, Show 1000’s separator, Show decimals, Show percent sign, or Show blanks instead of zero amounts.

4. Click the down arrow in the Negative amount format field, and decide whether you want negative numbers to display with the negative sign or in parenthesis. From here you can preview, print, save or export your report.

Product Item List

Creating the Product Item List

1. From **Reports**, select **Product Reports**.
2. Select **Product Item List**. The following screen appears.

![New Product Item List](image)

- **Completing the General tab**
  1. In the **Include Products with these Categories** frame, mark the checkbox next to the product categories you want to include on the report.

- **Completing products tab**
  1. Mark to **Include all products** or to **Include only selected products**. If you mark **Include only selected products** you can select to **Include inactive products**.
  2. If you mark to **Include only selected products** use the arrows in the center to select the products you want to include.
Completing the Headings options on the Format tab

1. Click the Format tab, or click the Back and Next buttons to display this tab. The tab displays with the Headings option marked.

2. From the Heading Format frame, you can enter a Title and Subtitle for your report. The program default uses the report type as the Title, but you can change this.

3. Click the down arrow in the Align field, and select Left, Center, or Right.

4. Mark Print organization name in header if you want the program to include this name on the report automatically.

5. Mark the Print Page No. in Heading frame if you want this included on your report.

6. Click the Format down arrow, and choose from Page 1, p1, or 1, depending on how you want your report to appear.

7. Click the Align down arrow, and choose from Left, Center, or Right, depending on how you want your report to appear.

8. Mark the Print Report Date in Heading frame if you want this included on your report.

9. Click the Format down arrow, and select from Short Date, Long Date, Short Date and Time, or Long Date and Time.

10. Click the Align down arrow, and choose from Left, Center, or Right.

11. Mark Print report heading on each page if you want the program to do this automatically.
Completing the Criteria options on the Format tab

1. From the Format tab, mark **Criteria**. The tab refreshes and displays a new frame.

2. Mark **Print Report Criteria** if you want the program to print this information automatically when it prints a report.

3. Select the criteria you want to see printed at the end of the report.

4. Choose from: Saved report name, Categories to include, and Products to include.

5. Mark the option to see this criteria printed **On a separate page** or **On the first page**.
Completing the Detail option on the Format tab

1. Select the **Detail** option on the Format tab. The screen refreshes.

2. If you want to **Show the account distribution detail**, mark the corresponding checkbox.

Completing the Page footer options on the Format tab

1. From the Format tab, mark **Page footer**. The tab refreshes and displays new frames.
2. In the **Text** box, you can type a reference note to appear as a report footer on your report.

3. Use the down arrow in the **Align** field to determine whether this footer appears **Left**, **Center**, or **Right** justified at the end of the report.

4. Mark **Print Page No. in Footer** if you want this included on your report.

5. Click the **Format** down arrow, and choose from **Page 1**, **p1**, or **1**, depending on how you want your report to appear.

6. Click the **Align** down arrow, and choose from **Left**, **Center**, or **Right**, depending on how you want your report to appear.

7. Mark **Print Report Date in Footer** if you want this included on your report.

8. Click the **Format** down arrow, and select from **Short Date**, **Long Date**, **Short Date and Time**, or **Long Date and Time**.

9. Click the **Align** down arrow, and choose from **Left**, **Center**, or **Right**.

**Completing the Report footer options on the Format tab**

1. From the Format tab, mark **Report footer**. The tab refreshes and displays a new frame.

2. In the **Text** box, you can type a reference note to appear as a report footer on your report.

3. Use the down arrow in the **Align** field to determine whether this footer appears **Left**, **Center**, or **Right** justified at the end of the report.
Completing the Miscellaneous options on the Format tab

1. From the Format tab, mark **Miscellaneous**. The tab refreshes and displays new frames.

   ![Image of the Format tab with miscellaneous options highlighted]

2. From the **Amount Display Options** frame, select how you want monetary figures to display on your report.

3. You can choose to Show currency character, Show 1000’s separator, Show decimals, Show percent sign, or Show blanks instead of zero amounts.

4. Click the down arrow in the Negative amount format field, and decide whether you want negative numbers to display with the negative sign or in parenthesis.

5. Select a **Report Orientation**. Choose from **Portrait** or **Landscape**.

Saving a report record

1. If you want to save the report parameter record you have create, select **File, Save**. The Save Report As screen appears.

   ![Image of the Save Report As screen]

   - **Report name**: Customer Account Activity
   - **Description**: [Enter description]
   - **Option to allow other users**: [Select options]

   Click **OK** to save the report record.
2. Enter a **Report name**. This name displays on the main *Reports* screen and the title bar of the report.

3. Enter a **Description**. This description displays on the status bar of the main *Reports* screen.

4. You can mark **Other users can execute this report**.

5. If you mark the previous checkbox, you can mark **Other users can modify this report**.

6. Click **OK** to save the report parameter record. You can now **Preview** or **Print** the report.

## Previewing a report

1. From *Reports*, expand the **Accounts Receivable** folder on the left side of the screen to display the available report categories.

2. Expand the category folder you want to display the specific report types.

3. Highlight the report type you want to display the saved report parameter records on the right side of the screen.

4. Open the report you want to preview. The report parameter record appears. You can review the parameters on each tab before you preview the report.

5. Click **Preview** on the lower right corner of any tab. The report processes and the report preview screen appears.

6. You can click the size field ▼ and select a different setting.

7. You can use the directional arrows to view additional pages.
8. Click 📨 to print the report.

9. Click 🔄 to refresh the report data. This runs the report to update the information displayed.

10. Click 📚 to export the report.

11. Close the preview screen and return to Reports.

Printing a report

1. From Reports, expand the Accounts Receivable folder on the left side of the screen to display the available report categories.

2. Expand the appropriate category folder to display the specific report types.

3. Highlight the appropriate report type to display saved report parameter records on the right side of the screen.

4. Open the report you want to print. The report parameter record appears. You can review the parameters on each tab before you print the report.

5. Click the Print button on the lower right corner of any tab. The program processes and prints the report. A status screen displays. You can cancel the report from this screen if necessary.

Exporting a report

1. From the main screen of Reports, locate the saved report you want to export by highlighting the type of report from the list.

2. From the display on the right side of the screen, highlight the saved report you want to export and select File, Export.


4. In the Format field, select the format of the information being exported. Click 📈 for a list of options.

5. In the Destination field, select the export destination. Click the down arrow for a list of options.
6. Click **OK**. The Character-Separated Values screen appears.

   ![Character-Separated Values](image)

7. Enter a **Separator**.
8. Enter a **Delimiter**.
9. Click **OK**. The Number and Date Format Dialog screen appears.

   ![Number and Date Format Dialog](image)

10. Mark the checkbox to use the **Same number formats as in report**.
11. Mark the checkbox to use the **Same date formats as in report**.
12. Click **OK**. The Choose Export File screen appears.

   ![Choose Export File](image)

13. Select a folder to **Save in**. You can click the drop down arrow to search for the correct folder.
14. Enter the **File name**. The **Save as type** displays automatically and cannot be changed.
15. Click **Save**. An Exporting Records message appears.

![Exporting Records Screen]

16. Once the export process is complete, the file appears in the folder you select. You can now open the file using another program or transfer it.

* Sending a report as e-mail

If your organization utilizes a MAPI (Messaging Application Programming Interface) compliant online messaging system, such as Microsoft Mail, you can send information gathered in *General Ledger* to other users as e-mail. MAPI is a standard set by Microsoft Corporation for Windows-compatible online messaging systems and applications such as e-mail and scheduling systems.

1. From the main screen of *Reports*, locate the saved report you want to e-mail by highlighting the type of report from the list.

2. Select **File**, **Send as Mail**. The Export screen appears.

![Export Screen]

3. In the **Format** field, select the format of the information you want to send. Click the drop down arrow for a list of options.

4. In the **Destination** field, select **Microsoft Mail (MAPI)** from the drop-down list of options.

5. Click **OK**. The Character-Separated Values screen appears.

![Character-Separated Values Screen]

6. Enter a **Separator**.
7. Enter a **Delimiter**.

8. Click **OK**. The Number and Date Format Dialog screen appears.

![Number and Date Format Dialog]

9. Mark the checkbox to use the **Same number formats as in report**.

10. Mark the check box to use the **Same date formats as in report**.

11. Click **OK**. The Send Mail screen appears.

![Send Mail]

12. Enter an e-mail address in the **To** field. If you have an address book set up, you can click **Address** to search for an address.

13. You can enter an e-mail address in the **Cc** field. If you have an address book set up, you can click **Address** to search for an address.

14. You can type an entry in the **Subject** field.

15. You can enter a **Message** to send with the report. For example, you can identify the report and its format.

16. Click **Send**. The Exporting Records message appears.

![Exporting Records]

*If you have an address book set up, you can type part of a name in the **To** field and click **Check Names** to open a search screen showing all names similar to the typed entry.*
17. When the processing is complete, the report is automatically attached to the e-mail form and sent.

Creating an Output Query

You can create an output query from some Accounts Receivable reports by selecting the Create output query option on the General tab. This option creates a static query containing all the records included in the report you are generating. This query is useful when you want to create a new report in the future using the same records, or to generate labels or envelopes in Mail.

The static query is a “snapshot” of the data at the time the query is created. When you create a query, it searches through the database and generates a list of customers, projects, or transactions that match the criteria you specify. This list is then stored with the static query. If you run a report two months later using the same query, the system uses the list of records stored in the original query to produce the report. Any records you add to your database after you create the static query are not included in the query list and do not appear on any report generated with that query.

You cannot refresh static queries created in Reports.

> Creating an output query from a report

1. From Reports, open the report parameter record you want to use. For example, highlight the report type you want to create/run and select File, Open to view the report parameters.
2. On the General tab, mark the Create output query checkbox.
3. Enter the appropriate parameters for the report and select an output option (for example, Preview or Print). The Save Static Query screen appears.

4. Enter the Query name. This name displays on the main Query screen.
5. Enter a Description of the query. This description displays on the main Query screen.
6. Query format defaults to Static and cannot be changed.
7. Static queries act as a snapshot in time. You cannot refresh static queries created in Reports.
8. In the **Include in** field, you must select **Query Lists**, **Export Lists**, or **Both**.

9. You can mark **Other users may execute this query**

10. You can mark **Other users may modify this query**.

11. Click **OK** to save your new static query.
Reference

This section of the chapter provides field-by-field descriptions of the tabs used in creating *Accounts Receivable* reports. We show and explain all of the tabs used to create these reports. Each field is assigned a type: R for required, O for optional, D for display only, and B for button.

*Accounts Receivable* Reports consists of a series of tabs and screens, where you can define the parameters for the report you want to create. Most of the report parameter records have several tabs in common. For example, the Format tab is almost the same for all report parameter records. There are also tabs and screens that relate specifically to the report you create. To become familiar with the various common and report-specific parameter tabs, you can review the following descriptions.

General Tab

This tab appears on all *Accounts Receivable* report parameter records. The General tab is where you can specify the records to include (for example, All, Selected, or One record). This tab usually has a checkbox to designate whether an output query is created from the records selected for the report. If appropriate, the General tab also allows you to enter specific date ranges or additional report options.
Format Tab

This tab appears on all Accounts Receivable report parameter records. The Format tab allows you to designate output formatting for the report—specifically formatting for Headings, Criteria, Detail, Page footer, Report footer, and Miscellaneous options.

Headings

The Headings option offers you choices as to what you want to include in the heading of the report as well as each page of the report.

In the Heading Format frame, you can enter a Title for your report. This field can have a maximum of 50 characters. If you leave this field blank, your report does not print with a title. You can also enter a Subtitle if you want and define the location of the title in the header (left, center, or right). If you want to have the name of your organization printed in the report header, you can mark the option to indicate this choice.

In the Print Page # and Print Report Date frames, you can choose the way these items appear on your report. These items are optional and only available if you mark the appropriate checkboxes.

If you want all heading information you have defined to appear at the top of each page, you can choose this option by marking the checkbox. If you leave this option unmarked, the report heading prints at the top of the first page only.

You can view a sample of the heading format you have defined by clicking Layout, or preview the entire report by clicking Preview.
Criteria

If you want the criteria you select to print on your report, you can mark this option and mark the criteria information you want to print on the first page of the report or on a separate page.

When you mark the option to Print Report Criteria, the program shows a list of all appropriate criteria related to the report in the display window. Simply mark those criteria you want to print on your report.
**Detail**

This Format Option category allows you to choose the details you want to appear on your report. The choices may differ, depending on the type of report for which you are defining parameters. You may have the option to choose the order in which the output of the report appears, as in the screen shown here. You can have the option to select summarized or detailed information or to limit the information to specific types of transactions.

**Page Footer**

The **Page footer** format option allows you to define the text you want to appear in the footer of each page of your report. You can select to have a page number and/or date printed in the footer of each page.
Report Footer

If you want to define text to be entered at the end of the report (not necessarily at the bottom of the last page), you can enter the text in the Report footer text frame text box.

You can also choose to align this text to the left, right, or center.

Miscellaneous

The Miscellaneous format options allow you to designate how you want amounts to display in your report. This tab option is identical across most of the Accounts Receivable reports.

All options listed in the Amount Display Options frame are optional. You can choose whether you want a currency character, 1000’s separator, decimals, and/or percent signs to show in your report. As you mark any of the checkboxes, the results are shown in the Sample Display frame.

You can show all negative amounts with a minus sign or the default parenthesis.
The choice of paper orientation, **Portrait** or **Landscape**, is available for some reports. You can set your *Reports* preferences to allow you to choose the paper orientation at the time of printing or allow the system to use the orientation defined for the report. Normally, this option is only used with wide-carriage, dot-matrix printers. We recommend you use the standard program defaults to ensure accuracy in the appearance of your report.

## Accounts Tab

The Accounts tab provides you with a feature for including records based on their account number. You can filter by specific account numbers or a range of account numbers.

This tab is found on the **Account Distribution Report**.

![New Account Distribution Report](image)
Attributes Tab

This tab appears on the following reports:

The Project Distribution Report is only available with the optional Project, Grant, and Endowment Management module installed.

The Attributes tab allows you to include and exclude records based on the attributes assigned to the records. For example, you can designate that a record must have Reason for Credit, and Group Discount as attributes to include in the report.

This tab is found on the Accounts Receivable Account Distribution Report.

Banks Tab

The Banks tab allows you to include records based on the assigned bank. For example, you can designate that only records assigned to the Accounts Receivable bank are included in the report.

This tab is found on the Account Distribution Report.
Funds Tab

The Funds tab allows you to include records based on the assigned fund. For example, you can include records assigned to the Unrestricted Operating Fund or the Plant Fund. This tab is found on the Account Distribution Report.

Payment Methods Tab

The Payment Methods tab allows you to include records based on the method of payment (for example, check, cash, or credit card). You can designate that an invoice must have a payment method of Credit Card – American Express in order to be included in the report. This tab is found on the Cash Receipts Journal.
Products Tab

The Products tab allows you to include records based on products specific to your organization. For example, you can designate that an invoice must have a certain product as a line item to include it in this report.

This tab is found on the Product Item List, Product Sales Report, and the Product Sales Summary.

Projects Tab

The Project Distribution Report and the Projects tab are available if the optional Project, Grant, and Endowment Management module is installed.

The Project tab allows you to include records based on the assigned project. For example, you can designate that a record be assigned to one of a specific group of projects to be included in the report.

This tab is found on the Account Distribution Report, and the Project Distribution Report.
Salespersons Tab

The Salespersons tab allows you to include records based on which salesperson is assigned to the record. For example, you can designate that a customer must have a certain salesperson designated in order to be included in the report.

This tab is found on the Customer Sales Analysis, Product Sales Report, and Product Sales Summary.

Sales Tax Entities Tab

The Sales Tax Entities tab allows you to include records based on which sales tax entities are included. For example, you can designate that an invoice must have South Carolina State as a sales tax entity in order to be included in this report.

This tab is found on the Sales Tax Report.
Statement Cycles Tab

The Statement Cycles tab allows you to include records based on which statement cycles are included. For example, you can designate that a customer must have a Quarterly statement cycle to be included in this report.

This tab appears on the following reports:
- Customer Account Activity
- Customer Credit Report
- Customer Sales Analysis Report
- Aged Accounts Receivable Account Distribution Report
- Document Edit List
- Document Journal
- Invoice Edit List
- Open Item Report
- Project Distribution Report
- Recurring Invoice Report
The Transaction Criteria tab allows you to include batches based on which types of transactions are included. For example, you can designate that only batches including Sales return and Reversing Entries are included in the report.

This tab appears on the Batch Reconciliation Report.
Transaction Types Tab

The Transaction Types tab allows you to include records based on which types of transactions are included. For example, you can designate that only Invoice, Sales return, and Regular debit memo transactions are included in the report.

This tab appears on the Customer Sales Analysis Document Edit List, Document Journal, and Open Item Report.

Sample Reports

This section contains an example of the frequently used reports you find in *Accounts Receivable*. These sample reports correspond with the procedures located at the beginning of this chapter. Following is a list of the reports:

- Customer Sales Analysis
- Customer Account Activity Report
- Cash Receipts Journal
- Aged Accounts Receivable
- Open Item Report
- Account Distribution Report
- Product Item List
## Lowcountry Preservation Society
### Customer Sales Analysis

<table>
<thead>
<tr>
<th>Date</th>
<th>Document Number</th>
<th>Customer</th>
<th>Type</th>
<th>Subtotal</th>
<th>Sales Tax</th>
<th>Discount</th>
<th>Extended Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>11/17/1997</td>
<td>42</td>
<td>Happy Days String Band</td>
<td>Invoice</td>
<td>$125.00</td>
<td>$7.50</td>
<td>$0.00</td>
<td>$132.50</td>
</tr>
<tr>
<td>12/14/1997</td>
<td>56</td>
<td>Folly Realtors</td>
<td>Invoice</td>
<td>$295.00</td>
<td>$15.00</td>
<td>$0.00</td>
<td>$310.00</td>
</tr>
<tr>
<td>12/16/1997</td>
<td>54</td>
<td>Advanced Optics, Inc.</td>
<td>Invoice</td>
<td>$83.43</td>
<td>$4.50</td>
<td>$(8.35)</td>
<td>$79.58</td>
</tr>
<tr>
<td>12/22/1997</td>
<td>38</td>
<td>Brookside Veterinary Clinic</td>
<td>Invoice</td>
<td>$4.00</td>
<td>$0.24</td>
<td>$(0.10)</td>
<td>$4.14</td>
</tr>
<tr>
<td>01/08/1998</td>
<td>3</td>
<td>Folly Realtors</td>
<td>Sale Return</td>
<td>$(7.00)</td>
<td>$(7.50)</td>
<td>$(77.50)</td>
<td></td>
</tr>
<tr>
<td>01/26/1998</td>
<td>36</td>
<td>Brookside Veterinary Clinic</td>
<td>Invoice</td>
<td>$290.00</td>
<td>$15.00</td>
<td>$0.00</td>
<td>$305.00</td>
</tr>
<tr>
<td>01/29/1998</td>
<td>39</td>
<td>Brookside Veterinary Clinic</td>
<td>Invoice</td>
<td>$4.00</td>
<td>$0.24</td>
<td>$(0.10)</td>
<td>$4.14</td>
</tr>
<tr>
<td>01/29/1998</td>
<td>2</td>
<td>Brookside Veterinary Clinic</td>
<td>Sales Return</td>
<td>$(4.00)</td>
<td>$(0.24)</td>
<td>$(0.10)</td>
<td>$(4.14)</td>
</tr>
<tr>
<td>01/29/1998</td>
<td>3</td>
<td>Troop 16</td>
<td>Credit Memo</td>
<td>$(60.00)</td>
<td>$0.00</td>
<td>$(60.00)</td>
<td></td>
</tr>
</tbody>
</table>

**Totals for Fredrick Washington:**

- Subtotal: $1,171.43
- Sales Tax: $41.74
- Discount: $(34.17)
- Extended Price: $1,179.00

<table>
<thead>
<tr>
<th>Date</th>
<th>Document Number</th>
<th>Customer</th>
<th>Type</th>
<th>Subtotal</th>
<th>Sales Tax</th>
<th>Discount</th>
<th>Extended Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>08/16/1997</td>
<td>11</td>
<td>Mall Walker's Club of Great</td>
<td>Invoice</td>
<td>$553.43</td>
<td>$0.00</td>
<td>$(27.68)</td>
<td>$525.75</td>
</tr>
<tr>
<td>10/28/1997</td>
<td>41</td>
<td>Charleston Rotary</td>
<td>Invoice</td>
<td>$227.57</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$227.57</td>
</tr>
<tr>
<td>11/25/1997</td>
<td>31</td>
<td>Mall Walker's Club of Great</td>
<td>Invoice</td>
<td>$51.25</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$51.25</td>
</tr>
<tr>
<td>01/05/1998</td>
<td>48</td>
<td>The Downtown Retail Assoc</td>
<td>Invoice</td>
<td>$262.50</td>
<td>$0.00</td>
<td>$(13.12)</td>
<td>$249.38</td>
</tr>
</tbody>
</table>

**Totals for Kim:**

- Subtotal: $1,598.50
- Sales Tax: $0.00
- Discount: $(65.99)
- Extended Price: $1,532.51

<table>
<thead>
<tr>
<th>Date</th>
<th>Document Number</th>
<th>Customer</th>
<th>Type</th>
<th>Subtotal</th>
<th>Sales Tax</th>
<th>Discount</th>
<th>Extended Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>06/07/1997</td>
<td>2</td>
<td>Plumb Thumb Contracting</td>
<td>Invoice</td>
<td>$328.50</td>
<td>$0.00</td>
<td>$(32.85)</td>
<td>$295.65</td>
</tr>
<tr>
<td>06/14/1997</td>
<td>3</td>
<td>Plumb Thumb Contracting</td>
<td>Invoice</td>
<td>$328.50</td>
<td>$0.00</td>
<td>$(32.85)</td>
<td>$295.65</td>
</tr>
<tr>
<td>06/21/1997</td>
<td>4</td>
<td>Plumb Thumb Contracting</td>
<td>Invoice</td>
<td>$328.50</td>
<td>$0.00</td>
<td>$(32.85)</td>
<td>$295.65</td>
</tr>
<tr>
<td>06/28/1997</td>
<td>5</td>
<td>Plumb Thumb Contracting</td>
<td>Invoice</td>
<td>$328.50</td>
<td>$0.00</td>
<td>$(32.85)</td>
<td>$295.65</td>
</tr>
<tr>
<td>07/05/1997</td>
<td>6</td>
<td>Plumb Thumb Contracting</td>
<td>Invoice</td>
<td>$328.50</td>
<td>$0.00</td>
<td>$(32.85)</td>
<td>$295.65</td>
</tr>
<tr>
<td>07/12/1997</td>
<td>7</td>
<td>Plumb Thumb Contracting</td>
<td>Invoice</td>
<td>$328.50</td>
<td>$0.00</td>
<td>$(32.85)</td>
<td>$295.65</td>
</tr>
<tr>
<td>07/19/1997</td>
<td>8</td>
<td>Plumb Thumb Contracting</td>
<td>Invoice</td>
<td>$328.50</td>
<td>$0.00</td>
<td>$(32.85)</td>
<td>$295.65</td>
</tr>
<tr>
<td>07/26/1997</td>
<td>9</td>
<td>Plumb Thumb Contracting</td>
<td>Invoice</td>
<td>$328.50</td>
<td>$0.00</td>
<td>$(32.85)</td>
<td>$295.65</td>
</tr>
<tr>
<td>08/02/1997</td>
<td>12</td>
<td>Plumb Thumb Contracting</td>
<td>Invoice</td>
<td>$328.50</td>
<td>$0.00</td>
<td>$(32.85)</td>
<td>$295.65</td>
</tr>
<tr>
<td>08/09/1997</td>
<td>13</td>
<td>Plumb Thumb Contracting</td>
<td>Invoice</td>
<td>$328.50</td>
<td>$0.00</td>
<td>$(32.85)</td>
<td>$295.65</td>
</tr>
<tr>
<td>08/16/1997</td>
<td>14</td>
<td>Plumb Thumb Contracting</td>
<td>Invoice</td>
<td>$328.50</td>
<td>$0.00</td>
<td>$(32.85)</td>
<td>$295.65</td>
</tr>
<tr>
<td>08/23/1997</td>
<td>15</td>
<td>Plumb Thumb Contracting</td>
<td>Invoice</td>
<td>$328.50</td>
<td>$0.00</td>
<td>$(32.85)</td>
<td>$295.65</td>
</tr>
<tr>
<td>08/30/1997</td>
<td>16</td>
<td>Plumb Thumb Contracting</td>
<td>Invoice</td>
<td>$328.50</td>
<td>$0.00</td>
<td>$(32.85)</td>
<td>$295.65</td>
</tr>
<tr>
<td>09/06/1997</td>
<td>17</td>
<td>Plumb Thumb Contracting</td>
<td>Invoice</td>
<td>$328.50</td>
<td>$0.00</td>
<td>$(32.85)</td>
<td>$295.65</td>
</tr>
<tr>
<td>09/13/1997</td>
<td>18</td>
<td>Plumb Thumb Contracting</td>
<td>Invoice</td>
<td>$328.50</td>
<td>$0.00</td>
<td>$(32.85)</td>
<td>$295.65</td>
</tr>
<tr>
<td>09/20/1997</td>
<td>19</td>
<td>Plumb Thumb Contracting</td>
<td>Invoice</td>
<td>$328.50</td>
<td>$0.00</td>
<td>$(32.85)</td>
<td>$295.65</td>
</tr>
<tr>
<td>09/27/1997</td>
<td>20</td>
<td>Plumb Thumb Contracting</td>
<td>Invoice</td>
<td>$328.50</td>
<td>$0.00</td>
<td>$(32.85)</td>
<td>$295.65</td>
</tr>
<tr>
<td>10/04/1997</td>
<td>21</td>
<td>Plumb Thumb Contracting</td>
<td>Invoice</td>
<td>$328.50</td>
<td>$0.00</td>
<td>$(32.85)</td>
<td>$295.65</td>
</tr>
<tr>
<td>10/11/1997</td>
<td>22</td>
<td>Plumb Thumb Contracting</td>
<td>Invoice</td>
<td>$328.50</td>
<td>$0.00</td>
<td>$(32.85)</td>
<td>$295.65</td>
</tr>
<tr>
<td>10/18/1997</td>
<td>23</td>
<td>Plumb Thumb Contracting</td>
<td>Invoice</td>
<td>$328.50</td>
<td>$0.00</td>
<td>$(32.85)</td>
<td>$295.65</td>
</tr>
<tr>
<td>10/25/1997</td>
<td>24</td>
<td>Plumb Thumb Contracting</td>
<td>Invoice</td>
<td>$328.50</td>
<td>$0.00</td>
<td>$(32.85)</td>
<td>$295.65</td>
</tr>
<tr>
<td>11/01/1997</td>
<td>25</td>
<td>Plumb Thumb Contracting</td>
<td>Invoice</td>
<td>$328.50</td>
<td>$0.00</td>
<td>$(32.85)</td>
<td>$295.65</td>
</tr>
<tr>
<td>11/08/1997</td>
<td>26</td>
<td>Plumb Thumb Contracting</td>
<td>Invoice</td>
<td>$328.50</td>
<td>$0.00</td>
<td>$(32.85)</td>
<td>$295.65</td>
</tr>
<tr>
<td>11/15/1997</td>
<td>27</td>
<td>Plumb Thumb Contracting</td>
<td>Invoice</td>
<td>$328.50</td>
<td>$0.00</td>
<td>$(32.85)</td>
<td>$295.65</td>
</tr>
<tr>
<td>11/22/1997</td>
<td>28</td>
<td>Plumb Thumb Contracting</td>
<td>Invoice</td>
<td>$328.50</td>
<td>$0.00</td>
<td>$(32.85)</td>
<td>$295.65</td>
</tr>
<tr>
<td>11/29/1997</td>
<td>29</td>
<td>Plumb Thumb Contracting</td>
<td>Invoice</td>
<td>$328.50</td>
<td>$0.00</td>
<td>$(32.85)</td>
<td>$295.65</td>
</tr>
<tr>
<td>12/06/1997</td>
<td>30</td>
<td>Plumb Thumb Contracting</td>
<td>Invoice</td>
<td>$328.50</td>
<td>$0.00</td>
<td>$(32.85)</td>
<td>$295.65</td>
</tr>
</tbody>
</table>

**Totals for Lois:**

- Subtotal: $8,869.50
- Sales Tax: $0.00
- Discount: $(886.95)
- Extended Price: $7,982.55

**GRAND TOTALS:**

- $11,639.43
- $41.74
- $(987.11)
- $10,694.06

45 transaction(s) listed.
## Lowcountry Preservation Society

### Customer Account Activity

<table>
<thead>
<tr>
<th>Customer ID</th>
<th>Customer ID</th>
<th>Reference Number</th>
<th>Transaction Date</th>
<th>Type</th>
<th>Description</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>BROOK</td>
<td>Brookside Veterinary Clinic</td>
<td>11/24/1997</td>
<td>Invoice</td>
<td>Generated from: 3</td>
<td>$4.14</td>
<td></td>
</tr>
<tr>
<td>38</td>
<td></td>
<td>12/22/1997</td>
<td>Invoice</td>
<td>Generated from: 3</td>
<td>$4.14</td>
<td></td>
</tr>
<tr>
<td>36</td>
<td></td>
<td>01/26/1998</td>
<td>Invoice</td>
<td>Invoice- AD</td>
<td>$305.00</td>
<td></td>
</tr>
<tr>
<td>39</td>
<td></td>
<td>01/26/1998</td>
<td>Invoice</td>
<td>Generated from: 3</td>
<td>$4.14</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>01/29/1998</td>
<td>Sales Return</td>
<td>Sales Return</td>
<td>$(4.14)</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
<td>01/29/1998</td>
<td>Payment</td>
<td>Payment Received - Thank You.</td>
<td>$(350.00)</td>
<td></td>
</tr>
</tbody>
</table>

6 transaction(s) listed for Brookside Veterinary Clinic: $(536.72)

<table>
<thead>
<tr>
<th>ID</th>
<th>Customer ID</th>
<th>Reference Number</th>
<th>Transaction Date</th>
<th>Type</th>
<th>Description</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>HAPPY</td>
<td>Happy Days String Band</td>
<td>11/17/1997</td>
<td>Invoice</td>
<td>Invoice for Playbill AD</td>
<td>$132.50</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td>01/27/1998</td>
<td>Credit Memo</td>
<td>Credit on Holiday AD in Playbill</td>
<td>$(12.50)</td>
<td></td>
</tr>
<tr>
<td>45</td>
<td></td>
<td>01/27/1998</td>
<td>Invoice</td>
<td>Generated from: 4</td>
<td>$119.26</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td>01/27/1998</td>
<td>Payment</td>
<td>Payment Received - Thank You.</td>
<td>$(120.00)</td>
<td></td>
</tr>
</tbody>
</table>

6 transaction(s) listed for Happy Days String Band: $(115.26)

| CHS-140 | Plumb Thumb Contracting | 06/07/1997 | Invoice          | Generated from: 1     | $295.65                                   |            |
|         |                         | 06/14/1997 | Invoice          | Generated from: 1     | $295.65                                   |            |
|         |                         | 06/21/1997 | Invoice          | Generated from: 1     | $295.65                                   |            |
|         |                         | 06/28/1997 | Invoice          | Generated from: 1     | $295.65                                   |            |
|         |                         | 06/30/1997 | Payment          | Payment - Thank You.  | $(1,182.60)                               |            |
|         |                         | 06/30/1997 | Credit Memo - DT | Prompt Payment credit | $(6.08)                                   |            |
|         |                         | 07/05/1997 | Invoice          | Generated from: 1     | $295.65                                   |            |
|         |                         | 07/12/1997 | Invoice          | Generated from: 1     | $295.65                                   |            |
|         |                         | 07/19/1997 | Invoice          | Generated from: 1     | $295.65                                   |            |
|         |                         | 07/26/1997 | Invoice          | Generated from: 1     | $295.65                                   |            |
|         |                         | 07/31/1997 | Payment          | Payment - Thank You.  | $(1,176.52)                               |            |
|         |                         | 07/31/1997 | Credit Memo - DT | Prompt Pay Credit     | $(6.08)                                   |            |
|         |                         | 08/02/1997 | Invoice          | Generated from: 1     | $295.65                                   |            |
|         |                         | 08/09/1997 | Invoice          | Generated from: 1     | $295.65                                   |            |
|         |                         | 08/16/1997 | Invoice          | Generated from: 1     | $295.65                                   |            |
|         |                         | 08/23/1997 | Invoice          | Generated from: 1     | $295.65                                   |            |
|         |                         | 08/30/1997 | Invoice          | Generated from: 1     | $295.65                                   |            |
|         |                         | 08/31/1997 | Credit Memo - DT | Prompt Pay Credit     | $(6.08)                                   |            |
|         |                         | 09/06/1997 | Invoice          | Generated from: 1     | $295.65                                   |            |
|         |                         | 09/13/1997 | Invoice          | Generated from: 1     | $295.65                                   |            |
|         |                         | 09/20/1997 | Invoice          | Generated from: 1     | $295.65                                   |            |
|         |                         | 09/27/1997 | Invoice          | Generated from: 1     | $295.65                                   |            |
|         |                         | 09/30/1997 | Payment          | Payment - Thank You.  | $(1,176.52)                               |            |
|         |                         | 09/30/1997 | Credit Memo - DT | Prompt Pay Credit     | $(6.08)                                   |            |
|         |                         | 10/04/1997 | Invoice          | Generated from: 1     | $295.65                                   |            |
|         |                         | 10/11/1997 | Invoice          | Generated from: 1     | $295.65                                   |            |
|         |                         | 10/18/1997 | Invoice          | Generated from: 1     | $295.65                                   |            |
|         |                         | 10/25/1997 | Invoice          | Generated from: 1     | $295.65                                   |            |
|         |                         | 11/01/1997 | Invoice          | Generated from: 1     | $295.65                                   |            |
|         |                         | 11/01/1997 | Debit Memo - FC | Finance Charge       | $1.00                                     |            |
|         |                         | 11/01/1997 | Payment          | Payment - Thank You.  | $(1,478.25)                               |            |
|         |                         | 11/01/1997 | Credit Memo - DT | Prompt Pay Credit     | $(6.08)                                   |            |
|         |                         | 11/08/1997 | Invoice          | Generated from: 1     | $295.65                                   |            |
|         |                         | 11/15/1997 | Invoice          | Generated from: 1     | $295.65                                   |            |
|         |                         | 11/22/1997 | Invoice          | Generated from: 1     | $295.65                                   |            |
|         |                         | 11/29/1997 | Invoice          | Generated from: 1     | $295.65                                   |            |
|         |                         | 12/06/1997 | Invoice          | Generated from: 1     | $295.65                                   |            |

36 transaction(s) listed for Plumb Thumb Contracting: $3,467.09

| PREST | Prestige Plumbing | 12/15/1997 | Invoice          | Invoice for Playbill AD- Spring play | $172.50 |            |

1 transaction(s) listed for Prestige Plumbing: $172.50

GRAND TOTAL $1,723.13

A total of 49 transaction(s) listed
## Lowcountry Preservation Society
### Cash Receipts Journal

<table>
<thead>
<tr>
<th>Customer Name</th>
<th>Deposit No.</th>
<th>Deposit Date</th>
<th>Receipt Number</th>
<th>Pay Method</th>
<th>Post Status</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced Optics. Inc.</td>
<td>11</td>
<td>12/05/1997</td>
<td>17</td>
<td>Cash</td>
<td>Posted</td>
<td>$79.58</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>01/26/1999</td>
<td></td>
</tr>
<tr>
<td>Brookside Veterinary Clinic</td>
<td>12</td>
<td>01/30/1998</td>
<td>13</td>
<td>Cash</td>
<td>Posted</td>
<td>$350.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>01/26/1999</td>
<td></td>
</tr>
<tr>
<td>Charleston Rotary</td>
<td>10</td>
<td>01/05/1998</td>
<td>9</td>
<td>Check: 12548, 01/15/1998</td>
<td>Posted</td>
<td>$227.57</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>01/26/1999</td>
<td></td>
</tr>
<tr>
<td>The Downtown Retail Associates</td>
<td>10</td>
<td>01/05/1998</td>
<td>12</td>
<td>Check: 32587, 01/21/1997</td>
<td>Posted</td>
<td>$1,200.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>01/26/1999</td>
<td></td>
</tr>
<tr>
<td>Happy Days String Band</td>
<td>10</td>
<td>01/05/1998</td>
<td>10</td>
<td>Discover</td>
<td>Posted</td>
<td>$120.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>01/26/1999</td>
<td></td>
</tr>
<tr>
<td>Mary Kitchen</td>
<td>11</td>
<td>12/05/1997</td>
<td>11</td>
<td>Check: 5874, 12/04/1997</td>
<td>Posted</td>
<td>$85.40</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>01/26/1999</td>
<td></td>
</tr>
</tbody>
</table>

1 receipt(s) listed for Advanced Optics. Inc.: $79.58

1 receipt(s) listed for Brookside Veterinary Clinic: $350.00

1 receipt(s) listed for Charleston Rotary: $227.57

1 receipt(s) listed for The Downtown Retail Associates: $1,200.00

1 receipt(s) listed for Happy Days String Band: $120.00

1 receipt(s) listed for Mary Kitchen: $85.40

**GRAND TOTALS:** $2,062.55

6 receipt(s) listed
### Aged Accounts Receivable

<table>
<thead>
<tr>
<th>Customer</th>
<th>Current</th>
<th>31-60 days</th>
<th>61-90 days</th>
<th>over 90 days</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced Optics, Inc.</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$25.00</td>
<td>$25.00</td>
</tr>
<tr>
<td>Blackbaud Employee's Social Club</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$240.00</td>
<td>$240.00</td>
</tr>
<tr>
<td>Brookside Veterinary Clinic</td>
<td>($36.72)</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>($36.72)</td>
</tr>
<tr>
<td>Cately and Associates, Inc.</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$10.60</td>
<td>$10.60</td>
</tr>
<tr>
<td>Charleston Acoustics</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$263.00</td>
<td>$263.00</td>
</tr>
<tr>
<td>Charleston Rotary</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$58.28</td>
<td>$58.28</td>
</tr>
<tr>
<td>The Downtown Retail Associates</td>
<td>($235.50)</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>($235.50)</td>
</tr>
<tr>
<td>Folly Realtors</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$357.50</td>
<td>$357.50</td>
</tr>
<tr>
<td>Happy Days String Band</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$119.26</td>
<td>$119.26</td>
</tr>
<tr>
<td>Dr. Janis Knoll</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$213.75</td>
<td>$213.75</td>
</tr>
<tr>
<td>Lowcountry Dental Associates</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$291.87</td>
<td>$291.87</td>
</tr>
<tr>
<td>Mall Walker's Club of Greater Charleston</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$51.25</td>
<td>$51.25</td>
</tr>
<tr>
<td>Charleston Metro Crisis Center</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$207.50</td>
<td>$207.50</td>
</tr>
<tr>
<td>Mr. Walter O'Neil</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$10.07</td>
<td>$10.07</td>
</tr>
<tr>
<td>Plumb Thumb Contracting</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$1,467.09</td>
<td>$1,467.09</td>
</tr>
<tr>
<td>Prestige Plumbing</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$172.50</td>
<td>$172.50</td>
</tr>
<tr>
<td>Troop 16</td>
<td>($15.00)</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>($15.00)</td>
</tr>
<tr>
<td>UAW- Local 7585</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$78.38</td>
<td>$78.38</td>
</tr>
</tbody>
</table>

**GRAND TOTALS:**

- 18 customer(s) listed
- ($287.22) $0.00 $0.00 $3,566.05 $3,278.83

### Open Item Report

<table>
<thead>
<tr>
<th>Customer</th>
<th>Transaction Date</th>
<th>Transaction Number</th>
<th>Type</th>
<th>Original Amount</th>
<th>Paid/Applied</th>
<th>Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prestige Plumbing</td>
<td>12/15/1997</td>
<td>53</td>
<td>Invoice - Line 1</td>
<td>$132.50</td>
<td>$0.00</td>
<td>$132.50</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Invoice - Line 2</td>
<td>$40.00</td>
<td>$0.00</td>
<td>$40.00</td>
</tr>
</tbody>
</table>

**Total for transaction 53:**

- $172.50 $0.00 $172.50

**1 transaction(s) listed for Prestige Plumbing:**

- $172.50 $0.00 $172.50

**GRAND TOTALS:**

- $172.50 $0.00 $172.50

A total of 1 transaction(s) listed
### Account Distribution Report

#### Lowcountry Preservation Society

<table>
<thead>
<tr>
<th>Transaction Date</th>
<th>Transaction Number</th>
<th>Transaction Type</th>
<th>Customer</th>
<th>Project ID</th>
<th>Journal Reference</th>
<th>Posted?</th>
<th>Debit Amount</th>
<th>Credit Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>12/15/1997</td>
<td>53</td>
<td>Invoice - Line 1</td>
<td>Prestige Plumbing</td>
<td>Accounts Receivable</td>
<td>Yes, 12/15/1997</td>
<td>$132.50</td>
<td>$0.00</td>
<td></td>
</tr>
<tr>
<td>12/15/1997</td>
<td>53</td>
<td>Invoice - Line 2</td>
<td>Prestige Plumbing</td>
<td>Accounts Receivable</td>
<td>Yes, 12/15/1997</td>
<td>$40.00</td>
<td>$0.00</td>
<td></td>
</tr>
</tbody>
</table>

1 transaction(s) listed for 01-212100-00-00: $172.50 $0.00

#### 01-213500-00-00 - Southeast Mortgage

<table>
<thead>
<tr>
<th>Transaction Date</th>
<th>Transaction Number</th>
<th>Transaction Type</th>
<th>Customer</th>
<th>Project ID</th>
<th>Journal Reference</th>
<th>Posted?</th>
<th>Debit Amount</th>
<th>Credit Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>12/15/1997</td>
<td>53</td>
<td>Invoice - Line 1</td>
<td>Prestige Plumbing</td>
<td>Accounts Receivable</td>
<td>Yes, 12/15/1997</td>
<td>$0.00</td>
<td>$7.50</td>
<td></td>
</tr>
</tbody>
</table>

1 transaction(s) listed for 01-213500-00-00: $0.00 $7.50

#### 01-453000-00-00 - Advertisement Sales

<table>
<thead>
<tr>
<th>Transaction Date</th>
<th>Transaction Number</th>
<th>Transaction Type</th>
<th>Customer</th>
<th>Project ID</th>
<th>Journal Reference</th>
<th>Posted?</th>
<th>Debit Amount</th>
<th>Credit Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>12/15/1997</td>
<td>53</td>
<td>Invoice - Line 1</td>
<td>Prestige Plumbing</td>
<td>Prestige Plumbing -53</td>
<td>Yes, 12/15/1997</td>
<td>$0.00</td>
<td>$125.00</td>
<td></td>
</tr>
<tr>
<td>12/15/1997</td>
<td>53</td>
<td>Invoice - Line 2</td>
<td>Prestige Plumbing</td>
<td>Prestige Plumbing</td>
<td>Yes, 12/15/1997</td>
<td>$0.00</td>
<td>$40.00</td>
<td></td>
</tr>
</tbody>
</table>

1 transaction(s) listed for 01-453000-00-00: $0.00 $165.00

Totals for AR-101: $172.50 $172.50

#### Grand Totals:

1 transaction(s) listed. $172.50 $172.50
Import

In This Chapter

Import Main Screen ............................................. 385
Import Parameter Files ........................................... 386
Import File Without Field Names - Separated .................. 387
Import File Without Field Names - Fixed Width .................. 393
Import File Containing a Header Record ......................... 400
Import File With a Separate Header Record ..................... 406
Viewing an Import Data File ...................................... 413
Line Item Information ............................................. 414
Revenue Account Distribution Information ....................... 415
Required Import Fields ............................................ 415
Customers ......................................................... 416
Invoices .............................................................. 416
Recurring Invoices ................................................ 416
Credit Memos ....................................................... 417
Debit Memos ....................................................... 417
Payments ............................................................ 418
Sales Returns ....................................................... 418
Import Field Code Names ......................................... 419
The Import module provides you with a single, concise facility to import data into Accounts Receivable and other Blackbaud Windows based programs.

In Import, you set up and save import parameter files that can be used repeatedly. The program supports four different import file formats:

- Import file without field names — Separated
- Import file without field names — Fixed Width
- Import file contains header record
- Import file with separate header record

You have the flexibility, with all four file formats, to define import parameter files that include the fields you need. You can use imported information to create new records and/or update existing records. Both of these functions can be accomplished in one import; however, we do not recommend this since each function imposes different required field limitations.

The four import file formats vary in how the included fields are defined or identified. The simplest and easiest to use format, Import file without field names — Separated, differentiates fields by the order they are arranged. You select and order the fields in the parameter file and use text qualifiers and field separators in the import document to identify field boundaries.

The Import file without field names — Fixed Width format identifies each field by where the value is placed in a numbered stream of characters. Two other file formats, Import file contains header record and Import file has a separate header record, use a header record to identify the imported fields. The only difference between these last two is that one places the header record at the top of the import document and the other has the header record in a separate file.

As you proceed through the import process, you can examine the raw import data before running the actual import. The program also provides an option that allows you to validate record data without actually performing an import.

If you are new to importing, we recommend that you review this entire chapter to gain an understanding of the different import formats. Each format presents different process requirements and limitations that make them more or less suitable to a given situation. Select the format that best suits your needs and establish a set of standard import files for use by your reporting entities. You may also find the import process a quick and efficient means of entering information into your database.

We begin this chapter with a section that describes the Import main screen. Following that, the Import Parameter Files section describes the procedures and requirements for creating each of the four different imports.

Imports that use a header record require that header record to be defined using field codes. Field codes are established for, and correspond to, the fields in each type of Account Receivable record. A complete listing of Required Import Fields and Field Code Names is found at the end of this chapter just before the Reference section.
The steps of creating an import vary depending on the record type. The following diagram identifies the steps involved in the creation of an import file. An “X” in the column below an import format signifies a required action.

<table>
<thead>
<tr>
<th>Action</th>
<th>Separated (Import file does not contain field names)</th>
<th>Fixed Width (Import file does not contain field names)</th>
<th>Import file contains a header record</th>
<th>Import file with separate header file</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select/Order desired import fields including record identifier</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Select text qualifier and separator</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create header record</td>
<td></td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Define field lengths and overall record length</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>

**Import Main Screen**

The main screen of Import is a list view screen with folders for program names and record types listed in the left box and parameter files listed in the right box. The screen also provides a description of the highlighted item which is displayed across the bottom.
**Import** is a shared Blackbaud module. This means that you can use it with more than one Blackbaud program. On the main screen, a folder appears on the left for each Blackbaud program present in the database with **Import** capabilities. When you open a program folder, additional folders appear for each record type associated with that program.

**Accounts Receivable** has 8 record types: **Customers**, **Invoices**, **Recurring Invoices**, **Credit Memos**, **Debit Memos**, **Sales Returns**, and **Payments**, and **Attributes**. For each record type you can create and save for reuse multiple parameter files. The parameter file determines what information is included in the import and how the import file is structured.

You can include Line Item information when importing Invoices, Recurring Invoices, and Sales Returns. For information specific to Line Items see page 414.

You can include Revenue Account Distribution information when importing Credit Memos and Debit Memos. For information specific to Revenue Account Distributions see page 415.

## Import Parameter Files

Each parameter file includes a series of tabs. Whenever a record type folder is highlighted, both the **Add a new** and saved import parameter files appear in the right box. You can create a new parameter file by highlighting the record type and selecting **File, New** or double clicking the **Add a new** icon.

There are three ways to open an existing parameter file:

- Double click the parameter file icon,
- Highlight the parameter file icon and select **File, Open**, or
- Right click the parameter file icon to access the shortcut menu and select **Open**.
From the parameter file, the View Data button accesses the browse screen so you can review the contents of the import file. This button is enabled when a file name has been selected.

The Import Now button begins the import process. For new parameter files, this button is only available on the Summary screen.

Since the Import wizard needs to be completed sequentially when you are defining new parameters, the tabs appear as you step through the screens. When you open a new parameter file only the Options tab is available. Additional tabs display as you complete a tab and click Next.

A saved parameter file has all available tabs displayed, based on the type of import.

You can create four different import types:
- Import file without field names – Separated
- Import file without field names – Fixed Width
- Import file containing a header record
- Import file with separate header record

**Import File Without Field Names - Separated**

Creating an import file without field names is probably the easiest of the four types to accomplish. Even though you are not required to create a header or define field or record lengths, the procedure still requires the import document and parameter file formats match. The import parameter file is established to reflect the format of the import document. This procedure guides you through establishing import parameters.

The fields to be imported are selected and ordered on the Fields tab. The order of the import fields on the Fields tab must match the arrangement of field values in the import file. On the File Format tab, you select a separator and text qualifier. The separator is used in the import file as a break between import fields. The text qualifier identifies the actual field value to be imported.

The fields you select to import, in the order they are listed on the Fields tab, with the separators and text qualifiers you choose on the File Format tab, determine the required format of record information in the import document.

- **Creating an import file without field names - Separated**
  1. From Import, open the Accounts Receivable folder on the left side of the screen. Highlight the record type for which you are importing information. The parameter files appear to the right.
2. On the left, highlight the desired record type and select File, New or double click the Add a new <record type> Import icon on the right. For the purpose of explaining the procedure, we use the record type Customers. However, the procedure is the same for each record type. The Options tab appears.

3. Mark the checkboxes if you want to Create new Customer records (import information) and/or Overwrite existing Customer records (update information). If you mark Create new Customer records (import information), the import must include the required fields for that record type. If you are updating existing records, a record identifier must be included in each import record. See the Required Import Fields section on page 415.

4. Mark the option to indicate you want the program to Automatically create a new table entry or Do not create a new table entry and process the record as an exception in the case where a table entry does not exist.

5. Mark the Validate Customer data without performing an import checkbox if you want the program to validate customer data without performing an import to examine the data in the import file and ensure its compatibility with the import process.

6. Mark the Create an output query of Customers that are imported checkbox if you want to create a query of records that are imported.

7. Mark the Create an output query of Customers that are updated checkbox if you want to create a query of records that are updated.
8. Mark the Create a control report checkbox if you want to create a control report of the import process, once it takes place. When marked, you have the option to Include exception detail. Mark this option to have detail information about any import exceptions that appear on the control report.


10. Enter the file path and name or click the browse icon to locate and select the file to import. You must format import files must as *.txt, *.csv, or *.prn files.

11. In the Import File Format frame, select Import file does not contain field names. Select field names in Step 3.

12. Mark Fields are Separated by Characters. Mark the checkbox for those characters you want to use as field separators in the import document. If you select Other, enter the character.

13. In the Text qualifier field, choose from Quotation, Apostrophe, {custom}, or {none}. If you choose {custom}, enter the qualifier of your choice. The Text qualifier is used in the import document to identify the field text to be imported.

Example: Select Semicolon as a separator and Quotation as a Text qualifier on the File Format tab. On the Fields tab, move Customer Name, Address, City, State, and ZIP to the Import these customer fields box. With these selections the import document has to be formatted as follows to complete a successful import:

“Colin Byrd”;“555 St. Andrews Blvd.”;
“Charleston”;“SC”;“29418-7160”

The other two options in the Import File Format frame are used in other procedures described later in this chapter.

The import document must be formatted using the separator and text qualifier you select here. In addition, the import values must be arranged in the order you set the field names on the Fields tab.

The identifier you select to match records must be one of the fields contained in the import document.

15. Select Customer ID or Customer Import ID to match records. Available options only include those fields that you identify as included in the import. If your import only includes Customer ID, then that will be the only option available in this field.

16. Select the fields you want to import in the order in which they appear in the import file. To select a field, highlight the field in the Customer fields box and use the arrow button to move the field to the Import these customer fields box. You can click Browse to view a complete list of field values currently in the database.
17. Click Next. The Summary screen appears.

18. Click View Data to examine the import information in the specified import file.

19. Verify the information is correct and click Close to return to the Summary tab. You can click View Data from any tab after an import file has been selected.
20. You can also click **Find** on the View Import Data screen to locate a specific field value in the data display. The Find screen appears.

![Find Screen Example](image)

21. Select the **Field** for which you want to locate a value.

22. In the **Find what** field, enter the value you want to locate and click **Find First**. If this value is in multiple fields, click **Find Next** until the desired record is located.

23. Click **Close** to return to the View Import Data screen.

24. At this point you can click either **Save** or **Import Now**.

25. Click **Save** to save the import parameter file. The Save Import As screen appears. Enter a **Name** and **Description** for the parameter file. Use this option to save your parameter file for later use.

![Save Import As Screen Example](image)

26. Mark the checkboxes if you want to allow others to run and/or modify this import.

27. Click **Save**, and the Summary screen returns.

28. Click **Import Now** to begin processing.

29. If you have not saved the import parameter file a Save Import As screen appears.

![Save Import As Screen Example](image)
30. Enter a **Name** and **Description** for the parameter file.

31. Mark the checkboxes if you want to allow others to run and/or modify this import.

32. Click **Save and Import** or **Import without Saving**.

33. When the import finishes the Import Complete screen appears.

![Import Complete Screen]

The screen displays the number of records processed, added, and updated along with the number of exceptions. Exceptions indicate records that could not be processed.

34. Click **Close**. If you marked **Create a control report** on the Options tab the report automatically displays. You can view and/or print the report.

35. Close the report and return to the main **Import** screen.

### Import File Without Field Names - Fixed Width

You must already have an import document formatted and ready to import to complete this procedure. Review the information in this section and create a sample import document to test your import file content requirements. Start with a simple record and expand until you have a usable parameter file established. Remember to allow a sufficient number of characters for fields with variable size values such as a name or address field. Fill unused characters with spaces.

When you import information with the fixed width format, you must select and order the desired import fields. You also must assign each record a set number of characters. This type of import does not use separators or text qualifiers. It differentiates the fields of a record by location in a character stream of established proportions. An import record is made up of the individual fields pertaining to each individual or organization. You decide how many characters are in a record. An import document can contain one or many records.

Field names are selected and ordered on the Fields tab. The order of the import fields on the Fields tab must match the arrangement of field values in the import file. The size (number of characters) of individual fields within a record is established on the File Layout tab.
Creating an import file without field names - Fixed Width

1. From Import, open the Accounts Receivable folder on the left. Highlight the record type for which you are importing. The parameter files appear at right.

2. Double click Add a new <record type> Import.

3. For the purpose of explaining the procedure, we use the record type Customers. However, the procedure is the same for each record type. The Options tab appears.

4. Mark the checkboxes if you want to Create new Customer records (import information) and/or Overwrite existing Customer records (update information). If you mark Create new Customer records (import information) checkbox, the import must include the required fields for the selected record type. If you are updating existing records, a record identifier must be included in each import record. See the Required Import Fields section later in this chapter.

5. Mark the option to indicate you want the program to Automatically create a new table entry or Do not create a new table entry and process the record as an exception in the case where a table entry does not exist.

6. Mark the Validate Customer data without performing an import checkbox to validate customer data without performing an import to examine the data in the import file and ensure its compatibility with the import process.

7. Mark the Create a control report checkbox if you want to create a control report of the import process, once it takes place. When marked, you have the option to Include exception detail. Mark this option to have detail information about any import exceptions that appear on the control report.
8. Click Next. The File Format tab appears.

9. Enter the file path and name or click the browse icon to find the import file. Import files must be formatted as *.txt, *.csv, or *.prn files.

10. Mark **Import file does not contain field names. Select field names in Step 3.**

11. Mark **Fields have fixed widths and the Record is ___ characters wide** and enter the total number of characters in the import record(s).

   **Example:** On the File Format tab, select the **Fields have fixed widths and the Record is ___ characters wide** option. Enter 34 in the number field to import new customer records with 13 characters in the **Customer Name** field, 16 in **Address**, and 5 in **ZIP**. On the Fields tab, move **Customer Name, Address, and ZIP** to the **Import these customer fields** box. With these selections the import document has to be formatted as follows to complete a successful import:

   Colin Byrd 555 St. Andrews Blvd. 29407 
   Katya Gubenko 264 South River Dr. 31045

12. Notice that there are no spaces between the end of one record and the beginning of the next.

---

When the **Fields have fixed widths and the record is ___ characters wide** option is selected, enter the total number of characters contained in each record, including spaces and punctuation.
13. Click Next. The Fields tab appears.

The identifier you select to match records must be one of the fields contained in the import document.

14. Select the fields to import and the order in which they appear in the import file. Select **Import ID** or **User Defined ID** as an identifier to match records in the import with records in **Accounts Receivable**.

15. Click Next. The File Layout tab appears.
16. The Field Distribution grid lists the fields you have selected to import. The first records in the import document is displayed in the **Import Record Display** with each character numbered. The number you entered as the total number of characters in each record is shown in parenthesis above the display.

17. For each **Field**, enter the field **Width** as displayed in the **Import Record Display**. If you discover that you need to increase the total number of characters defined for the overall width, you can return to the File Format tab and increase the number you entered.

18. Click **Next**. The Summary tab appears.

19. Check the summary information to ensure import parameters and information is set up properly.
20. Click View Data to view the import data from the specified import file.

21. Verify the information is correct and click Close to return to the Summary tab. You can click View Data from any tab after an import file has been selected.

22. You can also click Find on the View Import Data screen to locate a specific field value in the data display. The Find screen appears.

23. Select the Field for which you want to locate a value. In the Find what field, enter the value you want to locate and click Find First. If this value is in multiple fields, click Find Next until the desired record is located. Click Close to return to the View Import Data screen.

24. At this point you can click either Save or Import Now.

25. Click Save to save the import parameter file. The Save Import As screen appears.
26. Enter an appropriate **Name** for the import file and a **Description**.

![Save Import As](image)

27. Mark the checkboxes if you want to allow others to run and/or modify this import.
28. Click **Save**, and the Summary screen returns.
29. Click **Import Now** to begin processing.
30. If you have not saved the import parameter file a Save Import As screen appears.

![Save Import As](image)

31. Enter a **Name** and **Description** for the parameter file.
32. Mark the checkboxes if you want to allow others to run and/or modify this import.
33. Click **Save and Import** or **Import without Saving**.

When these checkboxes are marked, all users with security rights to **Import** can run and/or modify the import.
34. Click **Import Now** to begin processing. When the import finishes the Import Complete screen appears.

![Import Complete Screen](image)

The screen displays the number of records processed, added, and updated along with the number of exceptions. Exceptions indicate records that could not be processed.

35. Click **Close**. If you marked **Create a control report** on the Options tab the report automatically displays. You can view and/or print the report.

36. Close the report and return to the main *Import* screen.

---

### Import File Containing a Header Record

You must already have an import document formatted and ready to import to complete this procedure. Review the information in this section and create a sample import document to test your import file content requirements. Start with a simple record and expand until you have a usable parameter file established.

Use this procedure to import record information where the record fields are defined in the first line of the import document. The header record identifies the fields to which you are importing information. The header record is located on the first line of the import document. Following that, you create import records using the same format and sequence as the header record. Each import record contains field values for one individual or organization and must contain at least one of the three record identifiers - `<record type> ID`, SSN, or import ID. Use the field code names listed at the end of this chapter, with the separators and text qualifiers you define on the File Format tab, to create the header record in the import document.

#### Creating an import file containing a header record

1. From *Import*, open the **Accounts Receivable** folder on the left. Highlight the record type for which you are importing information. The parameter files appear at right.
2. Double click Add a new <record type> Import. For the purpose of explaining the procedure, we use the record type Customers. However, the procedure is the same for each record type. The Options tab appears.

3. Mark the checkboxes if you want to Create new Customer records (import information) and/or Overwrite existing Customer records (update information). If you mark Create new Customer records (import information) checkbox, the import must include the required fields for the selected record type. If you are updating existing records, a record identifier must be included in each import record. See the Required Import Fields section on page 415.

4. Mark the option to indicate you want the program to Automatically create a new table entry or Do not create a new table entry and process the record as an exception in the case where a table entry does not exist.

5. Mark the Validate Customer data without performing an import checkbox if you want the program to validate customer data without performing an import to examine the data in the import file and ensure its compatibility with the import process.

6. Mark the Create an output query of Customers that are imported checkbox if you want to create a query of records that are imported.

7. Mark the Create an output query of Customers that are updated checkbox if you want to create a query of records that are updated.

8. Mark the Create a control report checkbox if you want to create a control report of all the import process, once it takes place. When marked, you have the option to Include exception detail. Mark this option to have detail information about any import exceptions that appear on the control report.

10. Enter the file path and name or click the browse icon to locate and select the file.

11. In the Import File Format frame, select **Field names are on the first line of the import file**.

12. The **Fields have Fixed Widths and the Record is ___ characters wide** option becomes disabled.

13. In the **Text qualifier** field, select from **Quotation**, **Apostrophe**, **{Custom}**, or **{None}**. If you choose **{Custom}**, enter the qualifier of your choice.

   **EXAMPLE**: Select **Semicolon** as a separator and **Quotation** as a **Text Qualifier** on the File Format tab. To import a customer’s name, address, and ZIP enter the following header on the first line of the import document:

   “CUSTOMER NAME”; “ADDRESS”; “ZIP”

14. Below that, enter the customer’s information using the same separator and qualifier as follows:

   “Kim Jones”; “462 East Shore Lane”; “31079”

15. Notice that each separator is followed by a space, both in the header and in the import record. This is required for the import to function properly.

16. If you select to include a Revenue Account Distribution in the import, add the selected fields to the end of the header and each record. To distribute an amount to two different accounts, add the following to the end of the header record:

   “ACCT_ACCOUNT_NO._1”; “ACCT_AMOUNT_1”; “ACCT_ACCOUNT_NO._2”; “ACCT_AMOUNT_2”
17. Notice that the import field names are duplicated once for each distribution. The number at the end of the field name groups the fields into specific distributions. To further distribute the import, repeat the field names and change the last number.

18. In each import record, add the distribution information in the same order. The following sample of the Revenue Account Distribution portion of an import record shows $1000 distributed evenly between two GL accounts. “01-54010-10”; “500”; “01-54030-15”; “500”

19. Click Next. The Fields tab appears.

![Import Customers dialog box](image)

Step 3

Review the field names present in the import file:

Use [ ] to match records in the import file with records in Accounts Receivable

<table>
<thead>
<tr>
<th>Import Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CUSTOMER_NAME</td>
<td>Customer Name</td>
</tr>
<tr>
<td>ADDRESS</td>
<td>Address</td>
</tr>
<tr>
<td>ZIP</td>
<td>ZIP</td>
</tr>
</tbody>
</table>

20. Review the import file field names and descriptions as they are listed in the grid.

21. If you need to make corrections to the import file, you can do so before importing into *Accounts Receivable*. The identifier you select to match records must be one of the fields contained in the import document.
22. Click **Next**. The Summary screen appears.

![Import Customers](image)

**Step 4**
Review this summary to verify that your import parameters are set up properly.

- **Accounts Receivable for Windows - Import Customers**
- **Import File Name:** D:\Transfer\Customer_Import3.txt
- **Create new Customer records**
- **Do not overwrite existing Customer records**
- **Field names are on the first line of the import file**
- **Fields are separated by <Separator>**
- **The text qualifier is a <Quotation>**
- **These fields will be imported:**
  - **Customer Name**
  - **Address**
  - **ZIP**

![View Data](image)

**View Import Data**
This is the Customer information in D:\Transfer\Customer_Import3.txt:

<table>
<thead>
<tr>
<th>#</th>
<th>Customer Name</th>
<th>Address</th>
<th>ZIP</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Jones</td>
<td>1622 East Shore Ln</td>
<td>31079</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

23. Review the import parameters to determine if the import is set up correctly.

24. Click **View Data** to view the import data from the specified import file.

25. Verify the information is correct and click **Close** to return to the Summary tab. You can click **View Data** from any tab after an import file has been selected.
26. You can also click **Find** on the View Import Data screen to locate a specific field value in the data display. The following screen appears.

![Find Screen](image)

27. Select the **Field** for which you want to locate a value.

28. In the **Find what** field, enter the value you want to locate and click **Find First**. If this value is in multiple fields, click **Find Next** until the desired record is located.

29. Click **Close** to return to the View Import Data screen.

30. At this point you can click either **Save** or **Import Now**.

31. Click **Save** to save the import parameter file. The Save Import As screen appears.

32. Enter an appropriate **Name** for the import file and a **Description**.

![Save Import As](image)

33. Mark the checkboxes if you want to allow others to run and/or modify this import.

34. Click **Save**, and the Summary screen returns.

35. Click **Import Now** to begin processing.
36. If you have not saved the import parameter file a Save Import As screen appears.

37. Enter a **Name** and **Description** for the parameter file.

38. Mark the checkboxes if you want to allow others to run and/or modify this import.

39. Click **Save and Import** or **Import without Saving**.

40. When the import finishes the Import Complete screen appears.

41. Click **Close**. If you marked **Create a control report** on the Options tab the report automatically displays. You can view and/or print the report.

42. Close the report and return to the main Import screen.

**Import File With a Separate Header Record**

You must already have an import document formatted and ready to import to complete this procedure. Review the information in this section and create a sample import document to test your import file content requirements. Start with a simple record and expand until you have a usable parameter file established.
Use this procedure to import record information where the record fields are defined in a file other than the import document. The header and import records are formatted just as in the previous procedure except the header record is located in a separate file. Use the field code names listed at the end of this chapter with the separators you define on the File Format tab to format the header record and import document.

Creating an import file with a separate header record

1. From Import, open the Accounts Receivable folder on the left. Highlight the record type for which you are importing information. The parameter files appear at right.

2. Double click Add a new <record type> Import. For the purpose of explaining the procedure we use the record type Customers. However, the procedure is the same for each record type.

3. The Options tab appears

4. Mark the checkboxes if you want to Create new Customer records (import information) and/or Overwrite existing Customer records (update information). If you mark Create new Customer records (import information) checkbox, the import must include the required fields for the selected record type. If you are updating existing records, a record identifier must be included in each import record. See the Required Import Fields section on page 415.

5. Mark the option to indicate you want the program to Automatically create a new table entry or Do not create a new table entry and process the record as an exception in the case where a table entry does not exist.

If Overwrite existing <type> records is marked, all records in the import must contain a record identifier. Clear this checkbox when only creating new records. Both options can be selected at the same time; however we recommend that you perform only one of these operations in each import.
6. Mark the **Validate Customer data without performing an import** checkbox if you want the program to validate customer data without performing an import to examine the data in the import file and ensure its compatibility with the import process.

7. Mark the **Create an output query of Customers that are imported** checkbox if you want to create a query of records that are imported.

8. Mark the **Create an output query of Customers that are updated** checkbox if you want to create a query of records that are updated.

9. Mark the **Create a control report** checkbox if you want to create a control report of all the import process, once it takes place. When marked, you have the option to **Include exception detail**. Mark this option to have detail information about any import exceptions that appear on the control report.

10. Click **Next**. The File Format tab appears.

11. Enter the file path and name or click the browse icon to locate and select the file.

12. Import files must be formatted as *.txt, *.csv, or *.prn files.

13. In the **Import File Format** frame, select **Field names are in a separate file**, and enter the file path and name. You can use the browse button to locate the appropriate file. When this option is marked, the **Fields have Fixed Widths and the Record is __ characters wide** option is disabled.

14. In the **Fields are Separated by Characters** frame, mark the checkbox for those characters you want to use as a separator. If you select **Other**, enter the character.

15. In the **Text qualifier** field, select from **Quotation**, **Apostrophe**, {**Custom**}, or {**None**}. If you choose {**Custom**}, enter the qualifier of your choice.
Example: Select **Semicolon** as a separator and **Quotation** as a **Text Qualifier** on the File Format tab. To import a customer name, address, and ZIP, enter the following header on the first line of the header document:

“CUSTOMER_NAME”; “ADDRESS”; “ZIP”

16. On the import document, enter the customer’s information using the same separator and qualifier as follows:

“Kim Jones”; “462 East Shore Lane”; “31079”

17. Notice that each separator is followed by a space, both in the header and in the import record. This is required for the import to function properly.

18. If you select to include a Revenue Account Distribution in the import, add the selected fields to the end of the header and each import record. To distribute an amount to two different accounts, add the following to the end of the header record:

“ACC_ACCOUNT_NO._1”; “ACC_AMOUNT_1”;
“ACC_ACCOUNT_NO._2”; “ACC_AMOUNT_2”

19. Notice that the import field names are duplicated once for each distribution. The number at the end of the field name groups the fields into specific distributions. To further distribute the import, repeat the field names and change the last number.

20. In each import record, add the distribution information in the same order. The following sample of the Revenue Account Distribution portion of an import record shows $1000 distributed evenly between two GL accounts.

“01-54010-10”; “500”; “01-54030-15”; “500”

21. Click **Next**. The Fields tab appears. There are two versions of this screen depending on the import file format information you designated on the File Format tab.
22. The following screen appears if the field names are in a separate file.

23. Review the import file field names and descriptions as they are listed in the grid. If you need to make corrections to the import file, you can do so before importing into Accounts Receivable.

24. Click Next. The Summary screen appears.

25. Review the import parameters to determine if the import is set up correctly.
26. You can also click **View Data** to view the import information from the specified import file.

![View Import Data](image)

27. Verify the information is correct and click **Close** to return to the Summary tab. You can click **View Data** from any tab after an import file has been selected.

28. You can also click **Find** on the View Import Data screen to locate a specific field value in the data display.

   The following screen appears.

![Find](image)

29. Select the **Field** for which you want to locate a value.

30. In the **Find what** field, enter the value you want to locate and click **Find First**. If this value is in multiple fields, click **Find Next** until the desired record is located. Click **Close** to return to the View Import Data screen.

31. At this point you can click either **Save** or **Import Now**.

32. Click **Save** to save the import parameter file. The Save Import As screen appears.
33. Enter an appropriate **Name** for the import file and a **Description**.

34. Mark the checkboxes if you want to allow others to run and/or modify this import.

35. Click **Save**, and the Summary screen returns.

36. Click **Import Now** to begin processing.

37. If you have not saved the import parameter file a Save Import As screen appears.

38. Enter a **Name** and **Description** for the parameter file.

39. Mark the checkboxes if you want to allow others to run and/or modify this import.

40. Click **Save and Import** or **Import without Saving**.
41. When the import finishes the Import Complete screen appears.

The screen displays the number of records processed, added, and updated along with the number of exceptions. Exceptions indicate records that could not be processed.

42. Click Close. If you marked Create a control report on the Options tab the report automatically displays. You can view and/or print the report.

43. Close the report and return to the main Import screen.

**Viewing an Import Data File**

Using View Data, you can verify the contents of an import data file after importing it to Accounts Receivable. This is an efficient way to ensure your import was successful and the correct information was imported.

- **Viewing an import data file**

  1. From Import, open the Accounts Receivable folder on the left side of the screen. Highlight the import type and select File, New from the menu. The Import <record type> screen appears.

  2. Click Next to view the File Format tab. Enter the File name or click the browse icon to find the import file.

  3. Click View Data to view the import information from the specified import file.
You must arrange the selected import fields in the same order as the information in the import file. Use the up and down arrows to move each field into the proper position.

Line Item Information

You can include Line Item information when importing Invoices, Recurring Invoices, and Sales Returns using import files without field names - separated. When you select Line Item on the Fields tab the Account Distribution Import Parameters screen appears.

On this screen you establish how many times fields repeat in the import. You repeat the distribution fields for each account to which you distribute a line item. You also select the account distribution fields included in the import.
Revenue Account Distribution Information

You can include Revenue Account Distribution information when importing Credit Memos and Debit Memos using import files without field names separated. When you select Revenue Account Distribution on the Fields tab the Account Distribution Import Parameters screen appears.

![Account Distribution Import Parameters](image)

On this screen you establish how many times fields repeat in the import. You repeat the distribution fields for each account to which you distribute an imported amount. You also select the account distribution fields included in the import.

**Required Import Fields**

This section provides a listing of the import fields required for each type of import. The required fields for each record type are listed separately for easy reference. Import requirements are determined by the type of record for which you are importing data. The import process works with most any combination of import fields that you select; however, unless the required fields are imported, the program will not create or update your records.

You can use imported information to create new records or update existing records. The required fields for these two functions are normally very different. Because of these differences we recommend that you perform these two functions in separate imports. When you are creating a new record, you must import the fields required to create and save a record as if you are doing so from your own computer terminal. To update an existing record, all that is normally required is the record Import ID or record number and the fields you desire to update.

The `<Record Type>Import ID` for a particular record can be identified by opening the record and selecting File, Properties. The User-defined ID is the `<Record Type> ID`, such as a Customer ID, found in the each record.
The following are minimum requirements for importing information into Accounts Receivable.

**Customers**

The following field is required to create a new customer record:

Customer Name

If you are overwriting or updating existing records, one of the following fields must be included in the import record:

Customer Import ID

Customer ID

With Phone # as a selected field, Phone Type is required.

With any attribute fields selected, then both Attribute Category and Attribute Description are required.

**Invoices**

The following fields are required to create a new invoice record:

Customer ID

Post Status

Date

Date Due

Bank ID

Revenue Account #

Product ID

Quantity

Unit of Measure

Unit Price

Product Type

Post Date

If you are overwriting or updating existing records, one of the following fields must be included in the import record:

Customer Import ID

Customer ID

Invoice Import ID or Invoice ID is required.

**Recurring Invoices**

The following fields are required to create a new recurring invoice record:

Customer ID

Revenue Account #
Product ID
Quantity
Unit of Measure
Unit Price
Product Type
Post date
Post status
Bank ID

If you are overwriting or updating existing records, one of the following fields must be included in the import record:
Customer Import ID
Customer ID
Recurring Invoice Import ID or Recurring Invoice ID is required.

Bank ID is required.

Credit Memos

The following field is required to create a new credit memo record:
Customer ID
Post date
Date
Post status
Bank ID

If you are overwriting or updating existing records, one of the following fields must be included in the import record:
Customer Import ID
Customer ID
Credit Memo Import ID or Credit Memo ID is required.

Date, Post Status, and Bank ID are required.

Debit Memos

The following field is required to create a new debit memo record:
Customer ID

If you are overwriting or updating existing records, one of the following fields must be included in the import record:
Customer Import ID
Customer ID
Debit Memo Import ID or Debit Memo ID is required.

Date, Post Status, Due Date, and Bank ID are required.
Payments

The following field is required to create a new payment record:
Customer ID

If you are overwriting or updating existing records, one of the following fields must be included in the import record:
Customer Import ID
Customer ID

Payment Import ID or Payment ID is required.

Date, Amount Paid, and Deposit No. are required.

Sales Returns

The following field is required to create a new sales return record:
Customer ID
Date
Bank ID

If you are overwriting or updating existing records, one of the following fields must be included in the import record:
Customer Import ID
Customer ID

Sales Return Import ID or Sales Return ID is required.

Date and Bank ID are required.
# Import Field Code Names

Use the field code names listed below with the separators you define on the File Format tab to format the header and import records. These field code name are only used when creating imports that use a header record.

<table>
<thead>
<tr>
<th>Code Description</th>
<th>Field Code</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Importing Customers</strong></td>
<td></td>
</tr>
<tr>
<td>Biographical Fields</td>
<td></td>
</tr>
<tr>
<td>Apply finance charge?</td>
<td>APPLY FINANCE_CHARGE?</td>
</tr>
<tr>
<td>Class</td>
<td>CLASS</td>
</tr>
<tr>
<td>Contact First Name</td>
<td>CONTACT_FIRST_NAME</td>
</tr>
<tr>
<td>Contact Last Name</td>
<td>CONTACT_LAST_NAME</td>
</tr>
<tr>
<td>Contact Position</td>
<td>CONTACT_POSITION</td>
</tr>
<tr>
<td>Contact Suffix</td>
<td>CONTACT_SUFFIX</td>
</tr>
<tr>
<td>Contact Title</td>
<td>CONTACT_TITLE</td>
</tr>
<tr>
<td>Credit hold</td>
<td>CREDIT_HOLD</td>
</tr>
<tr>
<td>Credit Limit</td>
<td>CREDIT_LIMIT</td>
</tr>
<tr>
<td>Credit Rating</td>
<td>CREDIT_RATING</td>
</tr>
<tr>
<td>Customer ID</td>
<td>CUSTOMER_ID</td>
</tr>
<tr>
<td>Customer Import ID</td>
<td>CUSTOMER_IMPORT_ID</td>
</tr>
<tr>
<td>Customer Name</td>
<td>CUSTOMER_NAME</td>
</tr>
<tr>
<td>Discount %</td>
<td>DISCOUNT_%</td>
</tr>
<tr>
<td>FOB</td>
<td>FOB</td>
</tr>
<tr>
<td>Industry</td>
<td>INDUSTRY</td>
</tr>
<tr>
<td>Notes</td>
<td>NOTES</td>
</tr>
<tr>
<td>Salesperson</td>
<td>SALESPERSON</td>
</tr>
<tr>
<td>Send dunning letter</td>
<td>SEND_DUNNING_LETTER</td>
</tr>
<tr>
<td>Send statement</td>
<td>SEND_STATEMENT</td>
</tr>
<tr>
<td>Ship via</td>
<td>SHIP_VIA</td>
</tr>
<tr>
<td>Statement cycle</td>
<td>STATEMENT_CYCLE</td>
</tr>
<tr>
<td>Subject to sales tax</td>
<td>SUBJECT_TO_SALES_TAX</td>
</tr>
<tr>
<td>Tax code</td>
<td>TAX_CODE</td>
</tr>
<tr>
<td>Tax exempt #</td>
<td>TAX_EXEMPT_#</td>
</tr>
<tr>
<td>Terms</td>
<td>TERMS</td>
</tr>
<tr>
<td>Territory</td>
<td>TERRITORY</td>
</tr>
<tr>
<td><strong>Bill to Address Fields</strong></td>
<td></td>
</tr>
<tr>
<td>Code Description</td>
<td>Field Code</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td>Bill to address</td>
<td>BILL_TO_ADDRESS</td>
</tr>
<tr>
<td>Bill to address different from Main address</td>
<td>BILL_TO_ADDRESS_DIFFERENT_FROM_ MAIN_ADDRESS</td>
</tr>
<tr>
<td>Bill to Address Name</td>
<td>BILL_TO_ADDRESS_NAME</td>
</tr>
<tr>
<td>Bill to attention</td>
<td>BILL_TO_ATTENTION</td>
</tr>
<tr>
<td>Bill to city</td>
<td>BILL_TO_CITY</td>
</tr>
<tr>
<td>Bill to Country</td>
<td>BILL_TO_COUNTRY</td>
</tr>
<tr>
<td>Bill to state</td>
<td>BILL_TO_STATE</td>
</tr>
<tr>
<td>Bill to ZIP</td>
<td>BILL_TO_ZIP</td>
</tr>
<tr>
<td>Ship to Address Fields</td>
<td></td>
</tr>
<tr>
<td>Ship To address</td>
<td>SHIP_TO_ADDRESS</td>
</tr>
<tr>
<td>Ship to address different from Main address</td>
<td>SHIP_TO_ADDRESS_DIFFERENT_FROM_ MAIN_ADDRESS</td>
</tr>
<tr>
<td>Ship To Address Name</td>
<td>SHIP_TO_ADDRESS_NAME</td>
</tr>
<tr>
<td>Ship to attention</td>
<td>SHIP_TO_ATTENTION</td>
</tr>
<tr>
<td>Ship to city</td>
<td>SHIP_TO_CITY</td>
</tr>
<tr>
<td>Ship to Country</td>
<td>SHIP_TO_COUNTRY</td>
</tr>
<tr>
<td>Ship to state</td>
<td>SHIP_TO_STATE</td>
</tr>
<tr>
<td>Ship to ZIP</td>
<td>SHIP_TO_ZIP</td>
</tr>
<tr>
<td>Address Fields</td>
<td></td>
</tr>
<tr>
<td>Address</td>
<td>ADDRESS</td>
</tr>
<tr>
<td>City</td>
<td>CITY</td>
</tr>
<tr>
<td>Country</td>
<td>COUNTRY</td>
</tr>
<tr>
<td>State</td>
<td>STATE</td>
</tr>
<tr>
<td>ZIP</td>
<td>ZIP</td>
</tr>
<tr>
<td>Phone Fields</td>
<td></td>
</tr>
<tr>
<td>Phone No.</td>
<td>PHONE_NO.</td>
</tr>
<tr>
<td>Phone Type</td>
<td>PHONE_TYPE</td>
</tr>
<tr>
<td>Attribute Fields</td>
<td></td>
</tr>
<tr>
<td>Attribute Category</td>
<td>ATTRIBUTE_CATEGORY</td>
</tr>
<tr>
<td>Attribute Comment</td>
<td>ATTRIBUTECOMMENT</td>
</tr>
<tr>
<td>Attribute Date</td>
<td>ATTRIBUTE_DATE</td>
</tr>
<tr>
<td>Attribute Description</td>
<td>ATTRIBUTE_DESCRIPTION</td>
</tr>
</tbody>
</table>
## Code Description

<table>
<thead>
<tr>
<th>Importing Invoices</th>
<th>Field Code</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Invoice Fields</strong></td>
<td></td>
</tr>
<tr>
<td>Apply Finance Charge?</td>
<td>APPLY_FINANCE_CHARGE?</td>
</tr>
<tr>
<td>Bank ID</td>
<td>BANK_ID</td>
</tr>
<tr>
<td>Customer ID</td>
<td>CUSTOMER_ID</td>
</tr>
<tr>
<td>Customer Import ID</td>
<td>CUSTOMER_IMPORT_ID</td>
</tr>
<tr>
<td>Customer PO</td>
<td>CUSTOMER_PO</td>
</tr>
<tr>
<td>Date</td>
<td>DATE</td>
</tr>
<tr>
<td>Discount %</td>
<td>DISCOUNT_%</td>
</tr>
<tr>
<td>Discount Date</td>
<td>DISCOUNT_DATE</td>
</tr>
<tr>
<td>Due Date</td>
<td>DUE_DATE</td>
</tr>
<tr>
<td>FOB</td>
<td>FOB</td>
</tr>
<tr>
<td>Invoice Import ID</td>
<td>INVOICE_IMPORT_ID</td>
</tr>
<tr>
<td>Invoice no.</td>
<td>INVOICE_NO.</td>
</tr>
<tr>
<td>Message</td>
<td>MESSAGE</td>
</tr>
<tr>
<td>Notes</td>
<td>NOTES</td>
</tr>
<tr>
<td>Order date</td>
<td>ORDER_DATE</td>
</tr>
<tr>
<td>Ordered by</td>
<td>ORDERED_BY</td>
</tr>
<tr>
<td>Salesperson</td>
<td>SALESPERSON</td>
</tr>
<tr>
<td>Ship Date</td>
<td>SHIP_DATE</td>
</tr>
<tr>
<td>Ship Via</td>
<td>SHIP_VIA</td>
</tr>
<tr>
<td>Statement desc.</td>
<td>STATEMENT_DESC.</td>
</tr>
<tr>
<td>Status</td>
<td>STATUS</td>
</tr>
<tr>
<td>Tax code</td>
<td>TAX_CODE</td>
</tr>
<tr>
<td>Terms</td>
<td>TERMS</td>
</tr>
<tr>
<td>Terms Discount Percent</td>
<td>TERMS_DISCOUNT_PERCENT</td>
</tr>
<tr>
<td><strong>Attribute Fields</strong></td>
<td></td>
</tr>
<tr>
<td>Attribute Category</td>
<td>ATTRIBUTE_CATEGORY</td>
</tr>
<tr>
<td>Attribute Comment</td>
<td>ATTRIBUTE_COMMENT</td>
</tr>
<tr>
<td>Attribute Date</td>
<td>ATTRIBUTE_DATE</td>
</tr>
<tr>
<td>Attribute Description</td>
<td>ATTRIBUTE_DESCRIPTION</td>
</tr>
<tr>
<td><strong>Line Items Fields</strong></td>
<td></td>
</tr>
<tr>
<td>Discount %</td>
<td>LINE_DISCOUNT_%</td>
</tr>
<tr>
<td>Revenue Account Number</td>
<td>LINE_REVENUE_ACCOUNT_NUMBER</td>
</tr>
</tbody>
</table>
## Code Description | Field Code
---|---
Product ID | LINE_PRODUCT_ID
Quantity | LINE_QUANTITY
Sales Tax Code | LINE_SALES_TAX_CODE
Unit of Measure | LINE_UNIT_OF_MEASURE
Unit Price | LINE_UNIT_PRICE
Terms Discount | LINE_TERMS_DISCOUNT
Comment | LINE_COMMENT
Description | LINE_DESCRIPTION
Line Item Number | LINE_LINE_ITEM_NUMBER
Notes | LINE_NOTES
Post Date | LINE_POST_DATE
Post Status | LINE_POST_STATUS
Product Type | LINE_PRODUCT_TYPE
Project ID | LINE_PROJECT_ID

## Importing Recurring Invoices

### Recurring Invoice Fields

- **Apply Finance Charge?** APPLY_FINANCE_CHARGE?
- **Bank ID** BANK_ID
- **Customer ID** CUSTOMER_ID
- **Customer Import ID** CUSTOMER_IMPORT_ID
- **Customer PO No.** CUSTOMER_PO_NO.
- **Disc Days** DISC_DAYS
- **Discount Percent** DISCOUNT_PERCENT
- **Due Days** DUE_DAYS
- **Fixed # Invoices** FIXED_#_OF_INVOICES
- **FOB** FOB
- **Message** MESSAGE
- **Notes** NOTES
- **Number of Invoices** NUMBER_OF_INVOICES
- **On hold** ON_HOLD
- **Order Date** ORDER_DATE
- **Ordered By** ORDERED_BY
- **Recurring Invoice Import ID** RECURRING_INVOICE_IMPORT_ID
<table>
<thead>
<tr>
<th>Code Description</th>
<th>Field Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recurring Invoice No.</td>
<td>RECURRING_INVOICE_NO.</td>
</tr>
<tr>
<td>Sales Tax Code</td>
<td>SALES_TAX_CODE</td>
</tr>
<tr>
<td>Salesperson</td>
<td>SALESPERSON</td>
</tr>
<tr>
<td>Ship Via</td>
<td>SHIP_VIA</td>
</tr>
<tr>
<td>Statement Description</td>
<td>STATEMENT_DESCRIPTION</td>
</tr>
<tr>
<td>Terms</td>
<td>TERMS</td>
</tr>
<tr>
<td>Terms Discount Percent</td>
<td>TERMS_DISCOUNT_PERCENT</td>
</tr>
<tr>
<td>Attributes Fields</td>
<td></td>
</tr>
<tr>
<td>Attribute Category</td>
<td>ATTRIBUTE_CATEGORY</td>
</tr>
<tr>
<td>Attribute Comment</td>
<td>ATTRIBUTE_COMMENT</td>
</tr>
<tr>
<td>Attribute Date</td>
<td>ATTRIBUTE_DATE</td>
</tr>
<tr>
<td>Attribute Description</td>
<td>ATTRIBUTE_DESCRIPTION</td>
</tr>
<tr>
<td>Line Items Fields</td>
<td></td>
</tr>
<tr>
<td>Discount %</td>
<td>LINE_DISCOUNT_%</td>
</tr>
<tr>
<td>Revenue Account Number</td>
<td>LINE_REVENUE_ACCOUNT_NUMBER</td>
</tr>
<tr>
<td>Product ID</td>
<td>LINE_PRODUCT_ID</td>
</tr>
<tr>
<td>Quantity</td>
<td>LINE_QUANTITY</td>
</tr>
<tr>
<td>Sales Tax Code</td>
<td>LINE_SALES_TAX_CODE</td>
</tr>
<tr>
<td>Unit of Measure</td>
<td>LINE_UNIT_OF_MEASURE</td>
</tr>
<tr>
<td>Unit Price</td>
<td>LINE_UNIT_PRICE</td>
</tr>
<tr>
<td>Terms Discount</td>
<td>LINE_TERMS_DISCOUNT</td>
</tr>
<tr>
<td>Comment</td>
<td>LINE_COMMENT</td>
</tr>
<tr>
<td>Description</td>
<td>LINE_DESCRIPTION</td>
</tr>
<tr>
<td>Line Item Number</td>
<td>LINE_LINE_ITEM_NUMBER</td>
</tr>
<tr>
<td>Notes</td>
<td>LINE_NOTES</td>
</tr>
<tr>
<td>Post Date</td>
<td>LINE_POST_DATE</td>
</tr>
<tr>
<td>Post Status</td>
<td>LINE_POST_STATUS</td>
</tr>
<tr>
<td>Product Type</td>
<td>LINE_PRODUCT_TYPE</td>
</tr>
<tr>
<td>Project ID</td>
<td>LINE_PROJECT_ID</td>
</tr>
</tbody>
</table>

**Importing Credit Memos**

Credit Memo Fields

<table>
<thead>
<tr>
<th>Code Description</th>
<th>Field Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amount</td>
<td>AMOUNT</td>
</tr>
<tr>
<td>Bank ID</td>
<td>BANK_ID</td>
</tr>
</tbody>
</table>
### Code Description | Field Code
---|---
Credit Memo Import ID | CREDIT_MEMO_IMPORT_ID
Credit Memo No. | CREDIT_MEMO_NO.
Credit Memo Type | CREDIT_MEMO_TYPE
Customer ID | CUSTOMER_ID
Customer Import ID | CUSTOMER_IMPORT_ID
Date | DATE
Notes | NOTES
Post Date | POST_DATE
Post Status | POST_STATUS
Salesperson | SALESPERSON
Statement Description | STATEMENT_DESCRIPTION

#### Attribute Fields
- Attribute Category | ATTRIBUTE_CATEGORY
- Attribute Comment | ATTRIBUTE_COMMENT
- Attribute Date | ATTRIBUTE_DATE
- Attribute Description | ATTRIBUTE_DESCRIPTION

#### Revenue Account Distribution Fields
- Account No. | ACCT_ACCOUNT_NO.
- Percent | ACCT_PERCENT
- Amount | ACCT_AMOUNT
- Project ID | ACCT_PROJECT_ID
- Comment | ACCT_COMMENT

#### Importing Debit Memos

#### Debit Memo Fields
- Amount | AMOUNT
- Apply finance charge? | APPLY_FINANCE_CHARGE?
- Bank ID | BANK_ID
- Customer ID | CUSTOMER_ID
- Customer Import ID | CUSTOMER_IMPORT_ID
- Date | DATE
- Debit Memo Import ID | DEBIT_MEMO_IMPORT_ID
- Debit Memo No. | DEBIT_MEMO_NO.
- Debit Memo Type | DEBIT_MEMO_TYPE
<table>
<thead>
<tr>
<th>Code Description</th>
<th>Field Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Due Date</td>
<td>DUE_DATE</td>
</tr>
<tr>
<td>Notes</td>
<td>NOTES</td>
</tr>
<tr>
<td>Post Date</td>
<td>POST_DATE</td>
</tr>
<tr>
<td>Post Status</td>
<td>POST_STATUS</td>
</tr>
<tr>
<td>Salesperson</td>
<td>SALESPERSON</td>
</tr>
<tr>
<td>Statement Description</td>
<td>STATEMENT_DESCRIPTION</td>
</tr>
<tr>
<td><strong>Attribute Fields</strong></td>
<td></td>
</tr>
<tr>
<td>Attribute Category</td>
<td>ATTRIBUTE_CATEGORY</td>
</tr>
<tr>
<td>Attribute Comment</td>
<td>ATTRIBUTE_COMMENT</td>
</tr>
<tr>
<td>Attribute Date</td>
<td>ATTRIBUTE_DATE</td>
</tr>
<tr>
<td>Attribute Description</td>
<td>ATTRIBUTE_DESCRIPTION</td>
</tr>
<tr>
<td><strong>Revenue Account Distribution Fields</strong></td>
<td></td>
</tr>
<tr>
<td>Account No.</td>
<td>ACCT_ACCOUNT_NO.</td>
</tr>
<tr>
<td>Percent</td>
<td>ACCT_PERCENT</td>
</tr>
<tr>
<td>Amount</td>
<td>ACCT_AMOUNT</td>
</tr>
<tr>
<td>Project ID</td>
<td>ACCT_PROJECT_ID</td>
</tr>
<tr>
<td>Comment</td>
<td>ACCT_COMMENT</td>
</tr>
</tbody>
</table>

**Importing Sales Returns**

<table>
<thead>
<tr>
<th>Sales Return Fields</th>
<th>Field Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bank ID</td>
<td>BANK_ID</td>
</tr>
<tr>
<td>Customer ID</td>
<td>CUSTOMER_ID</td>
</tr>
<tr>
<td>Customer Import ID</td>
<td>CUSTOMER_IMPORT_ID</td>
</tr>
<tr>
<td>Customer PO</td>
<td>CUSTOMER_PO</td>
</tr>
<tr>
<td>Date</td>
<td>DATE</td>
</tr>
<tr>
<td>Discount %</td>
<td>DISCOUNT_%</td>
</tr>
<tr>
<td>Message</td>
<td>MESSAGE</td>
</tr>
<tr>
<td>Notes</td>
<td>NOTES</td>
</tr>
<tr>
<td>Order Date</td>
<td>ORDER_DATE</td>
</tr>
<tr>
<td>Ordered By</td>
<td>ORDERED_BY</td>
</tr>
<tr>
<td>Original Invoice Number</td>
<td>ORIGINAL_INVOICE_NUMBER</td>
</tr>
<tr>
<td>Sales Return Import ID</td>
<td>SALES_RETURN_IMPORT_ID</td>
</tr>
<tr>
<td>Sales Return No.</td>
<td>SALES_RETURN_NO.</td>
</tr>
<tr>
<td>Salesperson</td>
<td>SALESPERSON</td>
</tr>
<tr>
<td><strong>Code Description</strong></td>
<td><strong>Field Code</strong></td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>Statement Desc.</td>
<td>STATEMENT_DESC.</td>
</tr>
<tr>
<td>Status</td>
<td>STATUS</td>
</tr>
<tr>
<td>Tax Code</td>
<td>TAX_CODE</td>
</tr>
<tr>
<td><strong>Attributes Fields</strong></td>
<td></td>
</tr>
<tr>
<td>Attribute Category</td>
<td>ATTRIBUTE_CATEGORY</td>
</tr>
<tr>
<td>Attribute Comment</td>
<td>ATTRIBUTE_COMMENT</td>
</tr>
<tr>
<td>Attribute Date</td>
<td>ATTRIBUTE_DATE</td>
</tr>
<tr>
<td>Attribute Description</td>
<td>ATTRIBUTE_DESCRIPTION</td>
</tr>
<tr>
<td><strong>Line Item Fields</strong></td>
<td></td>
</tr>
<tr>
<td>Discount %</td>
<td>LINE_DISCOUNT_%</td>
</tr>
<tr>
<td>Revenue Account Number</td>
<td>LINE_REVENUE_ACCOUNT_NUMBER</td>
</tr>
<tr>
<td>Product ID</td>
<td>LINE_PRODUCT_ID</td>
</tr>
<tr>
<td>Quantity</td>
<td>LINE_QUANTITY</td>
</tr>
<tr>
<td>Sales Tax Code</td>
<td>LINE_SALES_TAX_CODE</td>
</tr>
<tr>
<td>Unit of Measure</td>
<td>LINE_UNIT_OF_MESUR</td>
</tr>
<tr>
<td>Unit Price</td>
<td>LINE_UNIT_PRICE</td>
</tr>
<tr>
<td>Terms Discount</td>
<td>LINE_TERMS_DISCOUNT</td>
</tr>
<tr>
<td>Comment</td>
<td>LINE_COMMENT</td>
</tr>
<tr>
<td>Description</td>
<td>LINE_DESCRIPTION</td>
</tr>
<tr>
<td>Line Item Number</td>
<td>LINE_LINE_ITEM_NUMBER</td>
</tr>
<tr>
<td>Notes</td>
<td>LINE_NOTES</td>
</tr>
<tr>
<td>Post Date</td>
<td>LINE_POST_DATE</td>
</tr>
<tr>
<td>Post Status</td>
<td>LINE_POST_STATUS</td>
</tr>
<tr>
<td>Product Type</td>
<td>LINE_PRODUCT_TYPE</td>
</tr>
<tr>
<td>Project ID</td>
<td>LINE_PROJECT_ID</td>
</tr>
</tbody>
</table>

**Importing Payments**

<table>
<thead>
<tr>
<th><strong>Payment Fields</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Amount Bills</td>
<td>AMOUNT_BILLS</td>
</tr>
<tr>
<td>Amount Coins</td>
<td>AMOUNT_COINS</td>
</tr>
<tr>
<td>Amount Paid</td>
<td>AMOUNT_PAID</td>
</tr>
<tr>
<td>Authorization No.</td>
<td>AUTHORIZATION_NO.</td>
</tr>
<tr>
<td>Check Date</td>
<td>CHECK_DATE</td>
</tr>
<tr>
<td>Check No.</td>
<td>CHECK_NO.</td>
</tr>
<tr>
<td>Code Description</td>
<td>Field Code</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td>Credit Card Expires On</td>
<td>CREDIT_CARD_EXPIRES_ON</td>
</tr>
<tr>
<td>Credit Card No.</td>
<td>CREDIT_CARD_NO.</td>
</tr>
<tr>
<td>Credit Card Type</td>
<td>CREDIT_CARD_TYPE</td>
</tr>
<tr>
<td>Customer ID</td>
<td>CUSTOMER_ID</td>
</tr>
<tr>
<td>Customer Import ID</td>
<td>CUSTOMER_IMPORT_ID</td>
</tr>
<tr>
<td>Date</td>
<td>DATE</td>
</tr>
<tr>
<td>Deposit No.</td>
<td>DEPOSIT_NO.</td>
</tr>
<tr>
<td>Description</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>Notes</td>
<td>NOTES</td>
</tr>
<tr>
<td>Other Payment Type</td>
<td>OTHER_PAYMENT_TYPE</td>
</tr>
<tr>
<td>Payment Method</td>
<td>PAYMENT_METHOD</td>
</tr>
<tr>
<td>Payment No.</td>
<td>PAYMENT_NO.</td>
</tr>
<tr>
<td>Post Date</td>
<td>POST_DATE</td>
</tr>
<tr>
<td>Post Status</td>
<td>POST_STATUS</td>
</tr>
<tr>
<td>Reference Date</td>
<td>REFERENCE_DATE</td>
</tr>
<tr>
<td>Reference No.</td>
<td>REFERENCE_NO.</td>
</tr>
<tr>
<td>Attribute Fields</td>
<td></td>
</tr>
<tr>
<td>Attribute Category</td>
<td>ATTRIBUTE_CATEGORY</td>
</tr>
<tr>
<td>Attribute Comment</td>
<td>ATTRIBUTE_COMMENT</td>
</tr>
<tr>
<td>Attribute Date</td>
<td>ATTRIBUTE_DATE</td>
</tr>
<tr>
<td>Attribute Description</td>
<td>ATTRIBUTE_DESCRIPTION</td>
</tr>
</tbody>
</table>

**Importing Attributes**

Attribute Fields

<table>
<thead>
<tr>
<th>Attribute Category</th>
<th>ATTRIBUTE_CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attribute Comment</td>
<td>ATTRIBUTE_COMMENT</td>
</tr>
<tr>
<td>Attribute Date</td>
<td>ATTRIBUTE_DATE</td>
</tr>
<tr>
<td>Attribute Description</td>
<td>ATTRIBUTE_DESCRIPTION</td>
</tr>
<tr>
<td>Attribute Import ID</td>
<td>ATTRIBUTE_IMPORT_ID</td>
</tr>
<tr>
<td>Customer ID</td>
<td>CUSTOMER_ID</td>
</tr>
<tr>
<td>Customer Import ID</td>
<td>CUSTOMER_IMPORT_ID</td>
</tr>
</tbody>
</table>
Global Change

In This Chapter

Global Change Functions ........................................... 366
Change Parameters .................................................... 366
Add ................................................................. 366
Replace .............................................................. 367
Partial replace ......................................................... 367
Delete ................................................................. 367
Increase/Decrease ...................................................... 367
Copy ................................................................. 368
Swap ................................................................. 368
Move ............................................................... 368
Performing a Global Change ...................................... 368
Preferences .......................................................... 373
The **Global Change** module allows you to add, change, and delete information in a field based on a query of records in your database. For example, if the salesperson assigned to an area changes, you can perform a global change to replace the name of the previous salesperson with the name of the new salesperson.

**Global Change** operates hierarchically. First you select the program in which you want to work. Next, you select a category or record type in the program. Then, you choose a subcategory and the name of the field on that tab. Changes are made at the field level. Because global changes are based on records in a query, changes must be made by record type.

**Global Change** is a shared module, which means it works with other Blackbaud programs in your database. In **Accounts Receivable**, you can globally change fields on Customer, Invoice, Recurring Invoice, Payment, Sales Return, Credit Memo, Debit Memo, Accounts Receivable Deposit, and Accounts Receivable Payment records.

From the main screen, you can create, open, edit, and save global change parameter records. The main screen has two panes: programs and record types are listed in the left pane, and saved parameter records appear in the right pane. Double clicking a record type opens a new parameter file. Double clicking a saved parameter record, in the right pane, opens the selected parameter record. Double clicking the **Add a New** icon opens a new parameter record.

As part of the global change process, you can preview your intended global changes before they are actually made. You can also create a query of the records affected by the global change, which you can use in other modules. Finally, you can create an exception query of the records that, for one reason or another, could not be changed by the global change process.

The global change process includes several global change functions. You can add, replace, partially replace, delete, increase/decrease, copy, swap, and move information in selected fields in your database. The next section of the chapter explains these functions.

### Global Change Functions

Each global change function (add, replace, partially replace, delete, increase/decrease, copy, swap, and move) has its own parameters. Function availability depends on the field type; not all global change functions listed are available for all fields.

### Change Parameters

Change parameters are criteria you establish enabling you to change your database globally. Change parameters include the global change function and the values associated with that function.

#### Add

The Add function places a value in a field. This value can either replace the current value or make no changes to the current data, depending on whether you mark the Overwrite existing value checkbox.

If you do not mark the **Overwrite existing value** checkbox, only empty fields receive the new value. Fields containing data are not modified.
If you mark the **Overwrite existing value** checkbox, the new value is added to empty fields and replaces values in fields with existing values. Any existing values are overwritten.

For example, for a global change of **Add** Salesperson with the **Overwrite existing value** checkbox marked, the Salesperson field entry for all records in the query changes to the new name. With the checkbox unmarked, only records in the query with an empty salesperson field reflect the new value.

You can add a new value to some tables during the global change **Add** process if you mark the **Automatically add table entries** checkbox.

**Replace**

The **Replace** function searches for records that exactly match the value. Checkbox fields can be replaced with **Unchecked/Checked** values. You can leave the **With** field blank to clear existing data from the field.

When available, you can mark **Match case** to make the search case sensitive.

You can add a new value to some tables during the global change **Replace** process, if you mark the **Automatically add table entries** checkbox.

**Partial replace**

**Partial replace** searches for records that contain the value. When available, mark **Match case** to make the search case-sensitive. The **Partial replace** function is not available for table fields.

For example, you can use the **Partial Replace** global change function to change the area codes for records within a query. Since the entire phone number, including area code, is part of one long field, **Partial Replace** allows you to replace part of the phone number (the area code or first three digits) with a new value. If you partially replace 803 with 843, any records in the query with a phone number that includes 803 will have those numbers replaced with 843.

**Delete**

The **Delete** function allows you to delete all of the values in the specified field. You cannot use blanks (non-values) for the **Delete** global change function.

**Increase/Decrease**

For fields that contain a numeric value, you can use **Increase** or **Decrease** as the global change function. You can increase/decrease values by an exact amount or by a percentage.

For fields that contain a date value, you can use **Increase** or **Decrease** to change the date by a specified number of days, weeks, months, or years. **Increase** and **Decrease** take into account different length months and leap years.

For example:

Increasing by 1 day replaces 07/06/1999 with 07/07/1999, or 07/31/1999 with 08/01/1999.

Decreasing by 1 week replaces 07/08/1999 with 07/01/1999, or 06/02/1999 with 05/26/1999.
Increasing by 1 month replaces 07/13/1999 with 08/13/1999, or replaces 01/30/199 with 02/28/1999 (the last day of the following month).

**Copy**

The **Copy** global change function places the entire value from the source field to a compatible target field. In the **Copy to** field, click the binocular icon to search for and select the target field. If you mark **Overwrite existing value**, all target fields receive the value copied from the source field. If you do not mark this checkbox, only blank target fields receive the copied value. You can add a new value to some tables during the global change **Copy** process.

**Swap**

The **Swap** global change function places the entire value from the source field to the target field and the original value of the target field in the source field. In the **Swap with** field, click the binocular icon to search for and select the target field. You can add a new value to some tables during the global change **Swap** process if you mark the **Automatically add table entries** checkbox.

**Move**

The **Move** global change function places the entire value from the source field to the target field and deletes the value from the source field. In the **Move to** field, click the binocular icon to search for and select the target field. Mark **Overwrite existing value** to move the value from the source to all target fields; otherwise, only blank target fields get the value.

You can add a new value to some tables during the global change **Move** process if you mark the **Automatically add table entries** checkbox.

**Performing a Global Change**

When you perform a global change, you make a change at the field level for the program, record type, and subcategory you select. Also, because you perform a change for selected records based on a query definition, the change is limited to those records in the query. Because **Global Change** is a shared module, available Blackbaud programs appear in the left pane.
Before performing a global change, you should always make sure you have a tested backup copy of your database.

Performing a global change

This procedure uses the steps required to **Add** a Salesperson’s name to customer records as an example.

1. From *Global Change*, double click the **Accounts Receivable** folder on the left side of the screen to view the global change record types.


---

**Global Change - Blackbaud**

**Accounts Payable**

**Accounts Receivable**

- **Customer**
- **Invoicing**
- **Receivables**
- **Payment**
- **Sales Return**
- **Credit Memo**
- **Refund Memo**
- **Accounts Receivable Deposit**
- **Accounts Receivable Payment**
- **Cash Receipts**
- **Fixed Assets**
- **Payroll**
- **Student Billing**

**Global Change Customers**

**Global Change Customers - Blackbaud**

**Fields to Change**

- **Customer**
- **Miscellaneous**
- **Attributes**
- **Notes**

**Options**

- **Create a query of customers that are changed**
- **Preview changes**
- **Display selected query**
- **Automatically add table entries**
If a query does not exist that meets your criteria, you can click Add New to create a new query.

3. Click Include to select the query of records you want to globally change. The Open search screen appears.

4. If a large number of queries display, you can use the filters to locate the query you want to include.

5. When you have highlighted the query, click Open. The Global Change Customers screen reappears.

6. In the Available Fields frame, you can filter the fields you view in the pane by selecting a category from the Show drop-down list, or you can show All fields.

7. If you select All fields for the Show field, double click a folder to view the individual fields.
8. Highlight the field you want to globally change and click Select. The Edit Change Parameters screen appears for the selected field.

9. Select the global Operation to perform.

10. Depending on the field type and the global Operation, enter the appropriate information in the additional fields.
   - For Add, enter information in the Add field.
   - For Replace, enter information in the Replace and With fields.
   - For Partial replace, enter information in the Partially replace and With fields.
   - For Delete, enter information in the Delete field.
   - For Increase or Decrease the operation requires you to select whether to Modify by Amount or Percentage, or whether to Modify by Day(s), Week(s), Month(s), or Years. Then enter the amount, the percent, or the number of days, weeks, months, or years in the corresponding field.
   - For Copy, enter information in the Copy to field.
   - For Swap, enter information in the Swap with field.
   - For Move, enter information in the Move to field.

11. If you want all records in the query changed, including those with existing information in the selected field, mark Overwrite existing value.

12. Once all information is entered, click OK.

13. You can click Browse Changes to view the modifications that will take place when you run the global change later. This allows you to edit change parameters prior to previewing or performing the global change.

14. You can mark Create a query of customers that are changed to have a query of all of the records affected by this global change.

15. Mark Create exception query to have a query of the records that should have been but were not changed in this process.

16. You can mark Preview changes to view a list of records that will be affected by this global change before the changes take place.
17. This gives you the opportunity to preview the results before global changes are made. If the results are incorrect, you can cancel the global change process and correct the global change parameters without any changes being made.

18. Mark **Automatically add table entries** if you want to add or replace existing table entries with table entries that are not currently in the database. This adds new table entries to the selected fields as well as the appropriate table in *Configuration*.

19. If you entered new table entries in a change parameter field and you do not mark this box, the fields are unchanged and the reason given for the exception is that you can only use existing table values unless you mark **Automatically add table entries**.

20. Click **Change Now** to run the global change process. The Save Global Change As screen appears.

21. Enter a **Name** for the Global Change parameter record.

22. Enter a **Description** of the Global Change.

23. You can mark **Others can run this global change**.

24. You can mark **Others can modify this global change**.

25. Click **Save and Change**.

26. If you click **Change without Saving** or **Preview without Saving**, the program makes the global change and returns to the Global Change main screen without saving a file of the changes made.

27. If you marked **Create a query of customers that are changed**, **Create exception query**, or both, screens appear for you to name and save the queries.
28. Finally, a Global Change screen appears showing you how many records processed successfully and how many records were completely changed, partially changed, and unchanged.

29. Click Print Control Report to generate a detailed report of the global change processing.

30. A preview screen opens, allowing you to review the report on screen or print copies for your files.

31. Click OK to return to Global Change.

Editing change parameters

1. In the Fields to Change frame on the Global Change <record type> screen, highlight the change parameter you want to edit.

2. Click Criteria. The Edit Change Parameters screen appears.

3. Make the necessary changes.

4. When you are finished, click OK.

Preferences

Selecting Edit, Preferences from the Global Change main screen menu accesses preferences. You can select a display preference: Group fields by tab within each category or Display fields alphabetically within each category.

For example, with the Group fields by tab within each category option marked, the Customers folder opens with this display:

Customer Name
Customer ID
Address
City
State
Country

The list continues, displayed in the order the fields appear in the Customer record.
With the **Display fields alphabetically within each category** option marked, the Customers folder opens with this display:

Address
Bill to Address
Bill to Address Different from Main Address
Bill to Attention
Bill to City
Bill to Name

The list continues, displayed in alphabetical order of the Customer record fields.

➤ **Setting preferences**

*Global Change* preferences determine how options display. These preferences are not applied systemwide but are specific to the workstation where they are set.

1. From *Global Change*, select **Edit, Preferences** from the menu. The Preferences screen appears.

2. Mark either **Group fields by tab within each category** (which displays fields in the tab order in which they appear in a category) or **Display fields alphabetically within each category** (which displays fields from each tab in alphabetical order).

3. Click **OK**.
Glossary

Symbols

* (asterisk) – a wildcard operator used in Global Change. Using * as a wildcard tells the program that * can stand for any string of characters. For example, when searching for someone whose last name is Johnson, but you are not sure how to spell it, you want to search for Jo*son or Jo*s?n (if you are not sure of the ending). This would return results like Jonson, Jonsen, Johnson, Johnsen, etc.

< > – information contained between the greater than and less than sign is used as an example. The exception occurs when you define criteria as punctuation written out between the signs, then the greater than/less than signs represent the punctuation mark. For example, <hyphen> means the hyphen symbol is included.

% (percent) – found in Query and Export, the percent sign can replace a series of characters. For example, if you query to find a note written by someone with a last name beginning with “John,” you can use the criteria “Author Like John%.” The program selects notes with Author beginning with “John” (e.g., Johnson, Johnston, Johns, and Johnathan-Willis).

? (question mark) – a wildcard operator used in Global Change. Using ? as a wildcard tells the program that ? can stand for one character. For example, if you are searching for someone whose last name is Johnson, but you are not sure if it is spelled with an o or an e at the end, you want to search for John?n. This would return results like Johnson, Johnsen, Johnsan, etc.

Accounts – a Blackbaud module found in General Ledger where you add, edit, and delete account records as well as enter budget information, organize and maintain your Chart of Accounts, and copy a range of accounts from one fund to another.

Accounts Payable – Blackbaud’s comprehensive check writing and payment information program. It helps you manage your expenses and plan your payment schedule.

Accounts Receivable – Blackbaud’s comprehensive billing and customer information program. It helps you manage your receivables and plan your cash flow. Along with customer account management, you can use this program for billing and payment applications, creating invoices, statements, and correspondence, as well as producing reports.

accrual – the accumulation of assets, expenses, liabilities, or revenue items whose value has been determined but for which no cash has yet been transferred.

accumulated depreciation – the cumulative amount of all depreciation (includes prior years and year-to-date depreciation).

accumulated depreciation account – the account to which accumulated depreciation is expensed. It is a contra asset account.

accumulated depreciation journal reference – the transaction identification numbers defined on the General Ledger tab in Configuration. These transaction numbers serve as an identifier for all accumulated depreciation when posting to a general ledger.

ACH – Automated Clearing House. A regional entity that electronically processes fund transfers between banks.

ACH Credit – an electronic funds transfer (EFT) initiated by an employer to a designated financial institution for the amount of a tax payment.

ACH Debit – an electronic funds transfer (EFT) in which a designated bank, with employer authorization, notifies the employer’s bank to transfer funds.

ACRS (Accelerate Cost Recovery System) – a method of depreciation used for assets that were placed in service after 1980, but before 1987.

Add – a Global Change function that adds a value to a field. This value can either replace the current value or make no changes to the current data, depending on whether you mark Overwrite existing value.

adjustment – a debit or credit added to your bank account to bring the account in balance.
adjustment type – a category of adjustments, such as ATM fees, minimum balance fees, or monthly service charges, associated with general ledger debit and credit accounts. When you create an adjustment, you first select an adjustment type, enter an amount, and then the program automatically fills in the corresponding general ledger information to create your adjustment.

Adobe Acrobat Reader – a free download from Adobe that allows electronic distribution of formatted documents.

AFN – Accounting for Nonprofits.

Alternate ACRS – method of depreciation that uses a modified Straight Line depreciation calculation. This method should only be used for assets that were placed in service after 1980, but before 1987.

Alternate Depreciation System (ADS) – ADS uses a Straight Line depreciation method. The ADS must be used for the following: tangible property used outside the United States, tax-exempt property, tax-exempt bond-financed property, imported property covered by executive order, or farming property under some circumstances.

annotate – notes you type to add detail about a specific account. This feature is found on the Edit menu in Bank Accounts.

annual wage – the fixed salary paid to an employee over the course of a calendar year.

appendix – supplemental information found after the last chapter in a Blackbaud user’s guide that provides detail about optional features.

<B><Ask> – a criteria operator that allows you to choose the field value query criteria at the time you run the query. When you run the query, an “Ask at Runtime” wizard appears, prompting you to select criteria for any fields defined by the <Ask> criteria operator.

asset – property (tangible or intangible) that has value.

Assets – a Blackbaud module in Fixed Assets where you to create an asset using the Asset Wizard, depreciate assets using a variety of schedules, track and calculate depreciation, and post and adjust transactions.

Asset Wizard – a utility in Fixed Assets that collects specific information from the user and creates an asset record.

attributes – a reporting tool that lets you group information based on a common theme. With attributes defined, you can filter information to your specification.

backup withholding – taxes withheld from an individual’s income when the proper Taxpayer Identification Number (TIN) can not be identified or when required by the Internal Revenue Service. The rate is typically 31 percent.

balance forward – a system configuration that automatically applies payments and credits to the total balance with the oldest charges paid first.

Bank Account Reconciliation – a Blackbaud optional module designed to provide in-depth details about bank activity while balancing bank accounts. Bank Account Reconciliation can be added to these Windows programs: Accounts Payable, Accounts Receivable, Miscellaneous Cash Receipts, Payroll and Student Billing; and it works with General Ledger for Windows and The Raiser’s Edge for Windows.

Bank Accounts – a shared module contained within Blackbaud accounting programs. From the Bank Accounts main screen, you initiate procedures for Bank Account Reconciliation (if installed) and Check Writer. Bank Accounts now contains the functionality for both.

bank list – a list of all bank accounts added in your Blackbaud software. From this list, you can filter the account information you want to display, open the bank account register, edit the bank account information, add a new bank account, or delete a bank account.

bank summary report – an overview statement of your account based on filters you select in the Reports module of your main Blackbaud accounting program. This report is useful when providing bank information to auditors or board members.

begins with – a Query and Export criteria operator, which selects records with an entry that begins with the value you define. For example, if you choose Vendor Name Begins With Bel, vendors whose Vendor Name has “Bel” at the beginning (Bell, Bellingham, Bellmont, etc.) are selected. You can use wildcard characters with this operator.

between – a Query and Export criteria operator, which lets you select a range of entries that records could have in order to be selected. For example, if you select Amount is Between $50 and $100, the program selects records of invoices that fall within this amount range.

bitmap – a file format for online art.

biweekly payroll – paid 26 times a year.
Blackbaud Systems – a catch-all phrase for main Blackbaud programs such as General Ledger, Student Billing, Payroll, etc.

Blank – a Query and Export criteria operator, which selects any record with a blank field you define. For example, if you choose the criteria Alias is Blank, the program selects all records with an empty Alias field.

Budget Management – a Blackbaud optional module used to enhance and expand your budget development capabilities within General Ledger.

button – a picture or word icon appearing on screens and toolbars. When clicked, buttons let you perform functions, such as saving, without using the menu bar.

C

Cash Receipts – a Blackbaud module in which you create deposits and add payment and deposit receipts. You can also print deposit tickets and receipts.

cash receipts journal – a set of parameters you define in Accounts Receivables to standardize receipt appearance.

change parameters – criteria you establish to change your database globally.

chart of accounts – a list of revenue and expense sources appearing in ascending account number order by category. This chart is maintained in General Ledger, Accounts module.

Check Writer – formerly a Blackbaud shared module. Its functionality now resides within the Bank Accounts module of Accounts Payable and Payroll.


CODA – Cash or Deferred Arrangement. This is a type of employee benefit plan, also know as 401K.

computer-based training – a self-paced, interactive form of multimedia training completed on a computer. Also known as CBTs, they can be delivered on a CD-ROM or over a network to a student workstation anywhere and at any time. Blackbaud CBTs are called Interactive Workshops.

Configuration – a shared module within Blackbaud accounting programs. This is where you define program settings and create tables that increase efficiency, accuracy, and speed data entry.

consolidation code – a General Ledger code comprised of letters or numbers that can be program-generated or user-generated. Consolidation codes filter accounts and create combinations of multiple regular accounts within multiple funds as defined in the Chart of Accounts. They are established in Configuration on the Consolidations tab.

Consumer Credit Protection Act – a federal law that limits the amount of an employee’s wages that may be subject to garnishment.

Contains – a Query and Export operator, which selects records that have your defined entry anywhere in the field. For example, if you define criteria for Vendor Name Contains Z, records with the letter “Z” anywhere in the vendor name field are selected. You can use wildcard characters with this operator.

Copy – a Global Change function that places the entire value from the source field into a compatible target field.

credit – an increase in a revenue, net worth, or liability account.

credit hold – a designation you assign to a customer record when you do not want orders from the customer to be processed without full payment.

credit limit – a monetary cap you assign to a credit record allowing customers to place orders without payment up to a certain limit.

credit memo – an entry that lets you reimburse charges previously applied.

Customers – a Blackbaud module in Accounts Receivable where you establish individual records for your customers. Each customer record maintains name, address, phone and contact information, as well as miscellaneous items such as tax, credit, statement, and discount information.

D

database validation – a procedure that scans and verifies the accuracy of your database. The program generates an error message if a discrepancy exists.

debit – an expense or deduction from a revenue, net worth, or liability account.

debit memo - an entry that lets you increase a customer’s balance, such as finance charges, membership dues, and non-sufficient fund checks.
deduction – an amount subtracted from an employee’s gross wages for a designated purpose, such as health insurance.

Delete – a Global Change function that allows you to delete all of the values in a specific field.

directory – the location on a drive where you store the names and locations of files.

documentation – written explanations about program functions accompanying Blackbaud software. This can include a user’s guide, an online user’s guide, and online Help.

Does Not Begin With – a Query and Export criteria operator, which selects records that do not begin with your defined entry. For example, if you choose Vendor Name Does Not Begin With Bel, vendors whose Vendor Name does not have “Bel” at the beginning are selected. You can use wildcard characters with this operator.

Does Not Contain – a Query and Export criteria operator, which selects records without your defined entry anywhere in the field. For example, if you define criteria for Vendor Name Does Not Contain Z, only records without a “Z” anywhere in the vendor name field are selected. You can use wildcard characters with this operator.

Does Not Equal – a Query and Export criteria operator, which selects only the records with entries that do not match the defined criteria. For example, if you choose City Does Not Equal Charleston, the program selects every record that does not have “Charleston” entered as the city.

dunning letters – automatically generated requests for past due payment. You set up these letters in the Mail module of Blackbaud programs.

dynamic query – a query type that automatically refreshes and updates results each time the query is used, providing the most current results.

electronic funds transfer (EFT) – a general banking system in which transactions, such as deposits and bill payments, are made through computer databases and electronic files. Money does not physically change hands; it transfers electronically from the payer’s account into the payee’s account. This is often referred to as EFT or direct deposit. Blackbaud’s Electronic Funds Transfer module adds fields and options to modules in Accounts Payable and Payroll.

electronic reconciliation – a process that lets you compare your bank’s Quicken Interchange Format (.QIF) with your Blackbaud file and then reconcile your account based on matches between the two.

employee – under the common-law rule, an individual who performs services subject to the will and control of an employer.

Employees – a Blackbaud module found in Payroll where you enter biographical, wage, and tax information for employees as well as track attendance. In addition, this program lets you store information concerning an employee’s off-site activities, such as attending seminars and conferences

employer – a person or organization for whom a worker performs a service as an employee.

Employer’s Quarterly Federal Tax Return – the name of the Form 941 filed quarterly, reconciling the federal income tax and the FICA taxes withheld and paid.

Equals – a Query and Export criteria operator. When you choose Equals as your operator, records selected for the query must have the exact entry you define.

Excel – a spreadsheet program by Microsoft.

exception query – a query that contains all files that could not be incorporated into the function (report, etc.) because they did not meet all criteria.

exempt employee – an executive, administrative, professional, or outside sales person who is exempt from or not subject to the overtime and minimum wage provisions of the Fair Labor Standards Act, as amended.

expense – any cost incurred in the production, selling, and distribution of goods and services; expenses are deducted from revenues on the income statement to arrive at a net income.

export – to send to another program, such as Microsoft Excel.

Export (module) – see Query and Export module.
Family and Medical Leave Act of 1993 (FMLA) – a federal law requiring employers with 50 or more employees to grant up to 12 weeks of unpaid leave to employees for the birth or adoption of a child; the care of a seriously ill child, spouse, or parent; or for their own serious illness.

FAS 117 – This stands for Financial Accounting Standard No. 117. It is a standard for nonprofit fund accounting financial statements as published by the Financial Accounting Standards Board.

Fee schedules – a tool to automate the billing process for standard fees such as tuition, room and board, and other standard tuition related fees.


Filters – a search and display feature that lets you control the amount of information appearing on grid screens. For example, Bank Account Reconciliation filters let you display bank account information based on Blackbaud program, transaction type, and transaction status.


Fixed asset – permanent, long-life assets of a business: (i.e., land, buildings, equipment, and vehicles).

Fixed Assets – Blackbaud’s asset management program. This program provides everything an organization needs to manage its assets, including the ability to enter or import asset information, generate depreciation transactions automatically following IRS rules, and record the disposal of assets.

Flat rate method – a formula used to calculate the federal tax due, using the rate of 28 percent.

Form 4562 Depreciation Summary Report – provides summary depreciation information to help prepare IRS Form 4562-Depreciation and Amortization.

Fund – a self-balancing set of accounts that represents a separate legal entity. Examples of funds include unrestricted, restricted, plant, and endowment. Funds must be added to General Ledger before you can enter accounts.

Fund code – the first segment of an account number when General Ledger is configured for fund accounting.


garnish – to attach, such as money due, from a debtor while it is in the hands of a third party.

garnishee – a person or business served with a garnishment.

garnishment – a court order served on a person or firm as the result of a lawsuit to require that employer to withhold money from an employee’s pay and disperse according to the court’s direction.

general journal batch – a compiled group of debit and credit transactions that you can post to your ledger accounts.

general ledger – the primary ledger, when used with subsidiary ledgers containing all balance sheet and income statement accounts. The general ledger is used as a central reference or index for transaction posting.

General Ledger – a Blackbaud program designed to enhance the efficiency of your general ledger and improve the organization of your business office.

GL interface files – files that enable General Ledger to interact with Blackbaud DOS systems and The Raiser’s Edge. By creating interface files, you assign the General Ledger accounts an alternate account number that other programs can recognize.

Global Change – a shared module within Blackbaud programs that allows you to change multiple fields at once using various change parameters.

global change functions – add, replace, partial replace, move, swap, delete, increase/decrease, copy.

Greater Than – a Query and Export operator. If you select Greater Than as your operator, you indicate that records selected must have a value greater than the one you define.

Greater Than or Equal To – Query and Export operator. Selecting Greater Than or Equal To as your operator limits the records selected to those that have a value greater than or equal to the one you define.

gross earnings – grand total of all regular, overtime, and other compensation paid to an employee before any deductions for taxes, etc.

Group – multiple users with the same access rights to a Blackbaud program as defined by the Supervisor in the program’s Security module.
**group consolidation management** – a procedure in General Ledger that makes the association between ledger accounts and one or more consolidations easy.

**H**

**header accounts** – one of three types of entries displayed in the General Ledger Chart of Accounts. Header accounts are designated by an “H” at the end of the account number. They are used for description purposes only. Activity cannot be posted to a header account. For example, there could be a header account called “Investments” followed by a listing of regular accounts, which contain investments.

**Help files** – a type of online help that lets you access information from your computer about the program in which you are working.

**hyperlink** – text or graphic in a Help file or web page that, when clicked, moves the user to a specific location. For example, the notepad graphic is a hyperlink found with procedures in the Bank Account Reconciliation Help files. When you click the notepad, it moves you to a blank page where you can type notes about the procedure.

**I**

**icon** – a picture that represents a particular object, command file, or group of files.

**import** – a type of file conversion that lets you load a file from a format other than the application program’s original format. For example, you can import batches from The Raiser's Edge into Bank Account Reconciliation.

**Import** – a shared Blackbaud module that lets you import various file types into Fixed Assets, Accounts Payable, Accounts Receivable, Miscellaneous Cash Receipts, Payroll, and Student Billing.

**inactive (entries)** – entries that have been defined, but cannot be used in tables. You make entries active or inactive from the Tables tab in Configuration.

**Increase/Decrease** – Global Change function that can be used for fields containing a numeric value. You can increase/decrease values by an exact amount or by a percentage.

**installation guide** – a written explanation accompanying your software that helps you load your new software.

**Interest Income Allocation** – a Blackbaud optional module used with General Ledger and Project, Grant, and Endowment Management to define “pools” of projects for investment purposes.

**interfund** – a balancing entry between funds. This procedure automates the creation of General Ledger transactions to transfer money between funds. This is accomplished through Interest Income Allocation with Project, Grant and Endowment Management. Both are Blackbaud optional modules.

**involuntary deduction** – pay withheld from an employee’s paycheck at the request of someone other than the employee. For example, child support.

**IRS** – Internal Revenue Service.

**Is Not Blank** – a Query and Export criteria operator, which selects any record with anything in your defined entry. For example, if you select the criteria Alias Is Not Blank, the program selects records with an entry in the Alias field.

**J**

**Journal Entry** – a Blackbaud module in General Ledger where you create batches of transactions for posting to your General Ledger accounts. Through Journal Entry, you can create, import, validate, delete, reverse, display, print, and post batches.

**journal reference** – transaction identification numbers used during the posting process.

**L**

**legend** – an explanatory list of colors found on screens. For example, the Bank Account Reconciliation legend lets you select the color of specific bank account references.

**Less Than** – a Query and Export criteria operator. When you select Less Than as your operator, you limit the records selected to ones that have an entry less than the value you are defining.

**Less Than or Equal To** – a Query and Export criteria operator. When Less Than or Equal To is selected as the operator, the records selected must have an entry either equal to or less than the value you define.

**leveling** – a process in General Ledger that lets you determine how an account should total within a given category (e.g. asset, liability, fund balance, revenue, expense, gift, or transfer).
Like – a *Query and Export* criteria operator. The Like operator allows you to use wildcards (special characters) to replace a character or set of characters in a field.

**M**

MACRS – a depreciation method used for assets placed in service after 1986. MACRS consists of two systems GDS (the main one) and ACRS.

MACRS ADS – a Straight Line depreciation method used for the following: tangible property used outside the United States, tax-exempt property, tax-exempt bond-financed property, imported property covered by executive order, or farming property under some circumstances. This depreciation method can only be used for assets placed in service after 1986.

Mail – a shared module within Blackbaud programs where you can specify mailing parameters for labels, forms, envelopes, letters and cards.

mandatory deductions – deductions required or mandated by law, such as federal income tax.

media – any stored information related to an asset record (i.e., an article, warranty information, demonstration video, etc.)

menu bar – a horizontal strip of selections found under the title bar at the top of a window.

merge – to combine or join two queries to make a third query.

merge operators – AND, OR, XOR, and SUB. These operators allow you to determine how queries merge.

Microsoft Windows – an operating system required to run Blackbaud programs.

minimum wage – lowest legal amount an employer may pay an employee per hour.

Miscellaneous Cash Receipts – a Blackbaud program designed to complement *General Ledger for Windows* by handling the small details that can clutter a ledger. It helps you identify where small cash amounts originate, produce a detailed profile of each transaction, and print a deposit ticket.

module – a component of a program. A module is created separately and then combined with other modules to form a program. For example, the Security module is a shared component of all Blackbaud programs.

Move – a *Global Change* function that places the entire value from the source field into the target field and deletes the value from the source field.

**N**

NACHA – National Automated Clearing House Association. This is the national umbrella organization for regional automated clearinghouses.

net pay – the total earnings of the employee minus all the deductions. This is also known as take-home pay.

Not Between – a *Query and Export* criteria operator. Choosing Not Between as the operator allows you to select a range of entries that records must not have to be included in the query. For example, if you select Amount is Between $50 and $100, records of invoices that fall within this amount range are selected.

Not Blank – a *Query and Export* operator. The Not Blank operator selects any record with anything in the entry you define.

Not Like – a *Query and Export* operator. The Not Like operator selects records that do not have the entry you define. You can use wildcard characters with this operator.

Not One Of – a *Query and Export* operator. Choosing Not One Of as the operator means records selected must not have one of the entries you define.

O

OFLT – Worker’s Compensation Old Fund Liability Tax.

on the fly – adding an entry to a table when it does not appear on the Tables tab in *Configuration*. There are several places in Blackbaud programs where you can add information directly into a field instead of selecting a pre-defined value from the drop-down list. When you do this, the program asks you if you want to create a table entry. Click *Yes* to add the entry to the table.

One of – a *Query and Export* criteria operator. Choosing One of as the operator means records selected must have one of the entries you define.

online help – information accessed from a computer about the program in which you are working.

online manual (user’s guide) – the manual in a PDF format, which you can open and read via Adobe Acrobat Reader. It is accessible from your CD-ROM or by selecting Help, Online Documentation.
open item – a system configuration that lets you select a specific charge item when applying a payment. Payments can be applied automatically based on user-defined criteria.

Optional (O) – used in the reference section to signify that the information referenced in the field is optional. It does not have to be entered in the program.

OR – a Query and Export operator that joins two queries to make one. All records in both queries are included; however, records that appear in both queries are not duplicated.

Or (button) – a Query and Export criteria operator. Clicking Or tells the program that any output information can meet either criteria to be used.

output query – a query that lists the results of a function.

overtime – hours worked in excess of the prescribed maximum weekly (or in some states, daily) requirements.

Parameter file – an established set of criteria, which you can save and use over and over to perform a specific function.

Parenthesis ( ) – a combining operator used in Query and Export to separate a portion of the criteria formula.

Partial replace – a Global Change function that searches for records containing at least part of the value. You cannot leave the Replace field blank for partial replaces, but you can use standard wildcards (such as ? and *). This function is not available for code table fields.

Password – a secret sequence of typed characters required to use a computer program. This prevents unauthorized users from entering a program.

payer-based processing – a processing method that focuses billing activity on the individuals and organizations responsible for paying a student’s charges.

Payroll – a Blackbaud program that simplifies your payroll and human resource management, saving you time and making in-house payroll processing a cost effective alternative to outsourcing.

payroll period – periods of service for which an employer usually pays wages.

payroll register – term used to describe a multicolumn form used in assembling and summarizing the data needed at the end of each payroll period. It lists all employees who earned remuneration, the amount of remuneration, the deductions, and the net amount paid.

Percentage Method of Withholding – a procedure for calculating the amount of tax withheld, using mathematical formulas and usually intended for use by employers with computerized payroll systems. May also be computed using the charts and tables in the Circular E.

per diem – daily allowance, usually for travel, entertainment, or miscellaneous out-of-pocket expenses while conducting a business transaction.

Portable Document File (PDF) – a document that maintains its formatting and displays correctly on any output device. For example, the Blackbaud user’s guides are saved in a PDF format and displayed in the Help files. This format also allows users to click on hyperlinks and jump from topic to topic.

Post – the process of entering a transaction into Blackbaud’s General Ledger and updating your account balances.

Post – a Blackbaud module in General Ledger where you can post both general journal batches and batches from other Blackbaud programs to General Ledger.

Preferences – computer program settings that offer individual customization. For example, Preferences in Bank Accounts let you select grid colors and lines.

Prenote Authorization File – an electronic test record sent to a bank to ensure correct transmission of coding, amounts, account numbers, etc. Banks often require a prenote authorization file before accepting electronic funds transfers (EFTs).

Pre-purge Report – creates a report for your records before any data is actually purged.

Preview – an advance look at a document before printing.

Procedure – a series of steps that explains how to perform a task within a computer program.

Program – a software system. Blackbaud’s programs are composed of modules.

Project, Grant, and Endowment Management – an optional module in Blackbaud’s General Ledger designed to track details of subsidiary funds. When used with Bank Accounts, a Projects grid appears at the bottom of the New Adjustment screen.
**Purchase Orders** – an optional module in Blackbaud’s *Accounts Payable* program that allows you to process purchase orders and receipts for your organization.

**purge** – to erase information from your database. We recommend always making a backup copy of your database before purging. Purged files cannot be recovered.

**Purge Asset Control Report** – a report listing the assets that were purged.

**Q**

**.QIF** – an abbreviation for Quicken Interchange Format. This popular format is used by banks to electronically store bank account statements.

**query** – to question the database for specific information. Or, a set of defined criteria used to select and export records. When you create a query, you create a definition for the records you want to include. When you run a procedure using the query, your Blackbaud program processes only those records matching the query definition. You can also extract information from the records in the query by defining the output fields of the query. For example, you can create a query of deposits for electronic funds transfer (EFT) payments only.

**Query and Export** – a shared module within Blackbaud programs where you can create, open, run, and delete queries. Other options include refreshing, merging, and exporting queries.

**query criteria operators** – data field requirements used to narrow and focus a search within filtered information. When you define a query, you establish a set of values, or requirements, that a record must meet to be included. Query criteria operators include: Equals, Does Not Equal, Blank, Not Blank, and <Ask>.

**R**

**The Raiser’s Edge** – Blackbaud’s fund-raising software designed to enhance your fund-raising efforts and improve the organization of your development office. You can import and view batches from *The Raiser’s Edge* into *Bank Account Reconciliation*.

**reconciliation** – a function in *Bank Account Reconciliation* by which your account becomes balanced once you enter preliminary data.

**reversing invoices** – a procedure to convert any invoice transaction to a credit memo or sales return.

**row** – a single horizontal section in a table or grid.

**salary** – a fixed compensation paid to an employee for regular work or services.

**sales tax codes** – a way to designate the federal tax, state tax, and local option sales tax to use as part of a customer record or invoice transaction. You can specify the tax rate and whether or not it is compounded.

**salvage value** – the estimated value of the property at the end of its useful life. This must be less than the depreciation basis.

**SDI** – State Disability Insurance.

**Security** – a shared module within Blackbaud programs where you establish access rights for groups of users.
security groups – a collection of users with the same access privileges within a Blackbaud program.

security users – Individuals given access privileges within a Blackbaud program based on security group membership.

semimonthly payroll – paid 24 times per year.

separator character – the symbol that appears between your General Ledger account number segments. From Utilities and Housekeeping, select Change Separator Character, and choose from dash, comma, slash, backslash, semicolon, or period.

shared module – a component of a program that is created separately and then combined with other modules to form a program. For example, the Security module is a shared component of all Blackbaud programs.

shift differential – rate adjustment paid to employees working certain shifts.

shortcut keys – tools to speed data entry. Function keys are the primary source for shortcuts. When a function key is available, the status bar at the bottom of the open window tells you which key to press.

shortcut menu – a menu displayed when you place your cursor in a field or grid, and then click the right mouse button. A shortcut menu lets you access commonly used commands.

Sounds Like – a Query and Export criteria operator. The Sounds Like operator can be used when you want to select records based on a field for which you do not know the exact spelling.

source codes – a code used to define the origin of a transaction. Some examples are accounts payable, accounts receivable, cash receipts, general journal, adjustments, fixed assets, purchase orders, and gifts. Source codes are added on the Tables tab in Configuration.

statement codes – a code used to define the frequency with which customers receive invoices, such as weekly, monthly, quarterly and annually. By defining these codes you create a statement cycle.

static query – a type of query that provides a record of the information you select at the time you establish the query. If you run a report two months later using the same query, the system uses the list of records stored in the original query.

status bar – displays important messages across the bottom of the screen to assist you in the program. For example, when the cursor is in a field with a Table Lookup available, the message “Press F7 for Table Lookup” displays in the status bar.

Straight Line Depreciation – depreciation method that expenses an asset value in equal amounts over its useful life.

Students – a module in Blackbaud’s Student Billing program where you create and maintain records containing information about students, parents/guardians, and organizations. This is where you set up billing schedules and payment distributions. You also enter charges, credits, and refunds.

student-based processing – a processing method that focuses billing activity on the student record. While anyone can make payments, all transaction activity is recorded on the student record.

Student Billing – a Blackbaud program designed to simplify the production of billing statements, while offering the capacity for storing detailed information about students, parent/guardians, and organizations.

SUB – the order of the queries is important when using SUB to merge queries, because the merged query contains only those records that are exclusively in the first (primary) query. All records that appear only in the second (secondary) query and records that appear in both queries are eliminated.

SUI – State Unemployment Insurance.

Sum of Years Digits – accelerated depreciation method. Under this method, depreciation is determined by multiplying the asset’s cost less salvage value by a fraction in which the sum of the year’s digits is the denominator and the number of years remaining in the asset’s life is the numerator.

supervisor – a user with the password who can enter the computer program. The supervisor establishes access rights for all users through Security, a shared module.

supplemental wages – items paid in addition to regular wages. Examples of supplemental wages include: awards, bonuses, retroactive wage increases, and tips.

SUTA – State Unemployment Tax.

Swap – Global Change function that allows you to place the entire value from the source field to the target field and the original value of the target field in the source field.
system – the internal computer operating component that runs the programs a user installs. In this manual “program” is used instead of “system.”

Systems Basics – the name of a chapter in most manuals where you learn about the screens and functions available in the program or optional module.

T

table lookup – a feature that lets you select and enter information into fields by pressing F7. This can save typing time.
tabs – an organizational device that holds specific information within pages on a screen. For example, the Add a Group screen in Security includes multiple tabs.
term discounts – a way to define whether customers can receive price reductions based on early payment.
title bar – a horizontal strip identifying a program or file and located at the top of a screen. For example, the title bar on Security displays a lock and key icon and the module name.
toolbar – a horizontal strip with buttons that, when clicked, perform specific tasks. It is located under the title bar at the top of a screen. For example, the Bank Account Reconciliation toolbar has buttons for New, Bank Account List, Reconcile, Reconciliation Setup, Bank Summary, and more.
total accounts – one of three types of entries displayed in the General Ledger Chart of Accounts. Total accounts are designated by a “T” at the end of the account number. These accounts provide sub-totals on financial statements for the balances of regular accounts.

U

UHIC – Unemployment Health Insurance Contribution.
useful life – the period of time that a business asset is determined to have commercial value for depreciation purposes; the IRS determines useful life depreciation periods.
user preferences – preferences you can create in Configuration that are unique to your user id.
user’s guide – a published manual that explains how to use a Blackbaud program.

Users in System Form – used in Utilities and Housekeeping to show how many users are logged into a Blackbaud program. There are several processes in Utilities and Housekeeping that require all users to exit the system before you can perform the process.

utilities – a command found on the Bank Accounts main screen where you can initiate Post to General Ledger, Purge Voided Checks, Reconciliation History, and Raiser’s Edge Import.

Utilities and Housekeeping – a shared module within Blackbaud programs where you perform general database tasks such as viewing system statistics.

V

Validate Database – a procedure used in Utilities and Housekeeping that analyzes your database to determine data corruption or any inconsistencies.

Vendors – a module in Blackbaud's Accounts Payable where you establish individual records for your vendors.
vertical truncation report – a report that details where information on labels will be cut off vertically.
voluntary deductions – amounts withheld from an employee's pay at the request of the employee, such as health insurance premiums or union dues.

W

W-2 form – Income and Tax Statement. A six-part combined federal/state form given to employees and furnished to the Social Security Administration by January 31 of each year. It shows total wages and other compensation paid, as well as taxes withheld and other requested amounts.

W-3 form – Transmittal of Income and Tax Statements. Used to summarize and transmit the paper W-2 forms submitted to the SSA.

W-4 form – Withholding certificate used to determine the correct withholding tax on the federal level. Completed by the employee and used by the employer.

wildcard criteria operator – a special character or a series of characters (such as ?, *, and %) used to define the conditions a record must meet to be selected.
**wizard** – a utility that collects specific information from the user and creates a unique file. This unique file may be used as a template. For example, Bank Account Reconciliation requires users to run a Setup Wizard for each bank account. This creates a template of the account for use in all future reconciliations.

**worker’s compensation** – benefits paid to employees who suffer work-related injuries or illness.

**workweek** – a fixed and regularly recurring period of 168 consecutive hours, such as seven consecutive 24-hour periods.

**X**

**XOR** – determines the final query, which contains all records that appear in either query, but excludes any records that appear in both queries.

**Y**

**year-to-date depreciation** – the depreciation that has occurred from the beginning of the year until the current date.

**Year-to-Date Depreciation Report** – lists depreciable basis, prior year’s depreciation, and year-to-date depreciation expense for selected assets.
Index

A
accessing customer records 103
account distributions, adding 67
account management, Bank Accounts 199
account preferences, Bank Accounts 199
account summary
printing 118
view for customer record 117
Accounting for Nonprofits Administrator’s Guide 6, 7
Accounting Queue 4, 291
Accounts Receivable
Bank Accounts 192
Cash Receipts 166
Configuration 30
credit and debit memos 148
Customers 98
database validation 90, 94
finance and late charges 188
Global Change 430
Import 384
introduction 2
invoices 122
Mail 240
modules 3
navigating 14
overview 2
Query and Export 212
Reports 291
sales returns 160
Security 74
system basics 14
toolbar buttons 15
Utilities and Housekeeping 90
accounts receivable distribution tab 128
Customers 112
debit memos 155
recurring invoices 140
accounts receivable tab, Security 77
activity, customer 116
add a group screen, Security 75
add line item screen 125
address
customer bill to 115
customer ship to 115
address tab for receipts in Mail 276
adjustment types tab, Bank Accounts 196
advanced tab, query preferences 232
aging information tab
Configuration 46
aging periods, defining 47
aging tab for letters in Mail 261
annotating records 101
application, edit payment receipt 175
applications tab 130
Cash Receipts 172
receipts 172
applying payments/credits, debit memos 157
AR source code, defining 62
attribute tables, adding 41
Attributes 39
attributes
adding to customer record 108
defining 40
editing customer record 108
processing in Mail 241
attributes tab
Configuration 39
credit memos 150
debit memos 155
for cards in Mail 256
for credit memos in Mail 281
for debit memos in Mail 285
for envelopes in Mail 252
for invoices in Mail 266
for labels in Mail 246
for letters in Mail 262
for receipts in Mail 277
for statements in Mail 271
sales return 162
auto-apply 130
credit memos 150
payment receipt in Cash Receipts 176
sales returns 163
auto-apply, sales returns 161
B
Bank Account Reconciliation 5
adjustments in Bank Accounts 202
Bank Accounts 196
bank account tab, Bank Accounts 194
Bank Accounts 192
accessing accounts 193
account adjustments 202
account display 203
account management 199
account preferences 199
adding an account 194
adjustment types tab 196
adjustments, creating new 202
Bank Account Reconciliation 196, 202
bank account tab 194
Blackbaud systems tab 195
cash account 195
deleting a bank account 199
discounts taken account 195, 196
editing bank account 198
find transaction in bank record 207
interfund entries tab 197
making account inactive 198
notes tab 198
setting preferences 200
sort account transactions 208
suspense account 195
utilities 208
view account transaction summary 204
view bank account information 206
view bank account list 203
view bank register legend 207
Blackbaud on the Web 10
Blackbaud systems tab, Bank Accounts 195
bookmarks 101
bookmarks, setting in Customers 101
buttons, standard screen 18
buttons, toolbar 15

calculating
  balances in Mail 240
  finance/late charges 99
calculator, using the 22
calendar, using the 23
cards
  attributes tab 256
  fields to include tab 257
  format tab 258
  general tab 256
  label types 255
  printing 255
cash account, Bank Accounts 195
Cash Receipts 166
  add AR payment screen 171
  adding deposits 167
  adding payments 170
  applications tab 172
  apply payment receipt 175
  attributes/notes tab 173
  auto-apply payment receipt 176
  delete payment receipt 174
  deleting a deposit 170
  deposit tab 167
  deposits 166
  deposits tab 179
  edit payment receipt 173, 175
  editing a deposit 169
  format tab 180
  payment methods 171
  preferences 184
  preferences defaults/tab settings 185
  print deposit tickets 177
  receipt defaults tab 168
  receipts 170
  receipts tab 169
  select deposit screen 171
  unapply application of payment 176
code names, import field 419
code tables, printing 37
common screens 19
Configuration
  aging information tab 46
  attributes tab 39
default account tab 70
distributions tab 66
general ledger tab 61
interfund tab 53
international tab 65
organization settings 30
preferences 31
sales tax tab 50
statements tab 47
table entries 34, 35
tables 34
tables tab 34
terms tab 49
credit memos 148
  adding 148
  applying 152
  attributes tab 150
  attributes tab in Mail 281
  auto-apply 150
  defaults 153
deleting 151
deleting application of 152
editing 151
format tab in Mail 282
from reversed invoice 134
general tab in Mail 280
generating in Mail 279
notes tab 151
project distribution 149
required import fields 417
revenue account distribution tab 149
types of 148
criteria operators 215
  applied to query 213
  begins with 214
  between 214
  blank 215
  contains 215
does not begin with 214
does not contain 215
does not equal 214
equals 214
greater than 214
greater than or equal to 214
less than 214
less than or equal to 214
like 215
not between 214
not blank 215
not like 215
not one of 214
one of 214
criteria tab, Query and Export 218
Crystal Reports 2
currency tab, query preferences 232
customer activity 116
customer records
accessing 103
activity tab 116
add a customer screen 115
adding 113
adding payments 129
adding/editing notes 109
bill to address 115
billing cycle 119
creating defaults 105
credit hold 119
credit limit 119
defaults 119
editing attributes 108
editing defaults 107
finance options 120
line items 124
miscellaneous tab 116, 118
recurring tab 120
searching for 104
ship to address 115
tax information 118
transaction line items 109
view account summary 117
viewing properties 105
Customers
accessing records 103
accounts receivable distribution tab 112
activity tab 116
add a customer screen 115
add invoice from customer record 122
adding line items 109
adding records 113
annotating records 101
attributes and notes 107
bill to address 115
bookmarks 101
calculate finance charges screen 188
calculating charges 188
calculating finance/late charges 99
cash receipts 166
creating record defaults 105
credit memos 148
default account tab
adding default receivables account 71
Configuration 70
default receivables account
adding 71
defining 70
defaults
creating for customer records 105
default memo for finance/late charges 189
deleting files 107
editing files 107
loading recurring invoice 145
miscellaneous for customer record 119
sales return 160, 164
setting in Customers 100
deposit and payment reports 292
deposit tab
Cash Receipts 167
printing account summary 118
recurring tab 120
required import fields 416
revenue account distribution tab 111
sales returns 160
setting defaults 100
setting preferences 101
ship to address 115
transaction line items 109
viewing account summary 117
viewing properties 100
customers
including all for mailing 242
selecting for mailing 242
database validation
control report 95
Utilities and Housekeeping 94
date fields 23
date tab, query preferences 234
dates, selecting 23
debit memos 153
accounts receivable distribution tab 155
adding 153
applying payments/credits 157
attributes tab 155
attributes tab in Mail 285
deleting 156
editing 156
format tab in Mail 286
general tab in Mail 284
generating in Mail 283
notes tab 156
project distribution 155
required import fields 417
revenue account distribution tab 154
types 153
default account tab
adding default receivables account 71
Configuration 70
default receivables account
adding 71
defining 70
defaults
creating for customer records 105
default memo for finance/late charges 189
deleting files 107
editing files 107
loading recurring invoice 145
miscellaneous for customer record 119
sales return 160, 164
setting in Customers 100
deposit and payment reports 292
deposit tab
Cash Receipts 167
printing account summary 118
recurring tab 120
required import fields 416
revenue account distribution tab 111
sales returns 160
setting defaults 100
setting preferences 101
ship to address 115
transaction line items 109
viewing account summary 117
viewing properties 100
customers
including all for mailing 242
selecting for mailing 242
database validation
control report 95
Utilities and Housekeeping 94
date fields 23
date tab, query preferences 234
dates, selecting 23
debit memos 153
accounts receivable distribution tab 155
adding 153
applying payments/credits 157
attributes tab 155
attributes tab in Mail 285
deleting 156
editing 156
format tab in Mail 286
general tab in Mail 284
generating in Mail 283
notes tab 156
project distribution 155
required import fields 417
revenue account distribution tab 154
types 153
default account tab
adding default receivables account 71
Configuration 70
default receivables account
adding 71
defining 70
defaults
creating for customer records 105
default memo for finance/late charges 189
deleting files 107
editing files 107
loading recurring invoice 145
miscellaneous for customer record 119
sales return 160, 164
setting in Customers 100
deposit and payment reports 292
deposit tab
Cash Receipts 167
printing account summary 118
recurring tab 120
required import fields 416
revenue account distribution tab 111
sales returns 160
setting defaults 100
setting preferences 101
ship to address 115
transaction line items 109
viewing account summary 117
viewing properties 100
customers
including all for mailing 242
selecting for mailing 242
database validation
control report 95
Utilities and Housekeeping 94
date fields 23
date tab, query preferences 234
dates, selecting 23
debit memos 153
accounts receivable distribution tab 155
adding 153
applying payments/credits 157
attributes tab 155
attributes tab in Mail 285
deleting 156
editing 156
format tab in Mail 286
general tab in Mail 284
generating in Mail 283
notes tab 156
project distribution 155
required import fields 417
revenue account distribution tab 154
types 153
default account tab
adding default receivables account 71
Configuration 70
default receivables account
adding 71
defining 70
defaults
creating for customer records 105
default memo for finance/late charges 189
deleting files 107
editing files 107
loading recurring invoice 145
miscellaneous for customer record 119
sales return 160, 164
setting in Customers 100
deposit and payment reports 292
deposit tab
Cash Receipts 167
printing account summary 118
recurring tab 120
required import fields 416
revenue account distribution tab 111
sales returns 160
setting defaults 100
setting preferences 101
ship to address 115
transaction line items 109
viewing account summary 117
viewing properties 100
customers
including all for mailing 242
selecting for mailing 242
database validation
control report 95
Utilities and Housekeeping 94
date fields 23
date tab, query preferences 234
dates, selecting 23
debit memos 153
accounts receivable distribution tab 155
adding 153
applying payments/credits 157
attributes tab 155
attributes tab in Mail 285
deleting 156
editing 156
format tab in Mail 286
general tab in Mail 284
generating in Mail 283
notes tab 156
project distribution 155
required import fields 417
revenue account distribution tab 154
types 153
default account tab
adding default receivables account 71
Configuration 70
default receivables account
adding 71
defining 70
defaults
creating for customer records 105
default memo for finance/late charges 189
deleting files 107
editing files 107
loading recurring invoice 145
miscellaneous for customer record 119
sales return 160, 164
setting in Customers 100
deposit and payment reports 292
deposit tab
Cash Receipts 167
printing account summary 118
recurring tab 120
required import fields 416
revenue account distribution tab 111
sales returns 160
setting defaults 100
setting preferences 101
ship to address 115
transaction line items 109
viewing account summary 117
viewing properties 100
customers
including all for mailing 242
selecting for mailing 242
database validation
control report 95
Utilities and Housekeeping 94
date fields 23
date tab, query preferences 234
dates, selecting 23
debit memos 153
accounts receivable distribution tab 155
adding 153
applying payments/credits 157
attributes tab 155
attributes tab in Mail 285
deleting 156
editing 156
format tab in Mail 286
general tab in Mail 284
generating in Mail 283
notes tab 156
project distribution 155
required import fields 417
revenue account distribution tab 154
types 153
default account tab
adding default receivables account 71
Configuration 70
default receivables account
adding 71
defining 70
defaults
creating for customer records 105
default memo for finance/late charges 189
deleting files 107
editing files 107
loading recurring invoice 145
miscellaneous for customer record 119
sales return 160, 164
setting in Customers 100
deposit and payment reports 292
deposit tab
Cash Receipts 167
deposit tickets
  format options 180
  format tab 180
preview report 183
print 177
printing 177
deposits
  adding in Cash Receipts 167
  Cash Receipts 166
deleting in Cash Receipts 170
ingoing in Cash Receipts 169
printing tickets in Cash Receipts 177
select in Cash Receipts 175
deposits tab
  Cash Receipts 179
discount terms
  adding 49
deleting 50
  editing 50
discounts taken account
  Bank Accounts 195, 196
distributions tab
  adding a project distribution 69
  adding an account distribution 67
  Configuration 66
document and cash journal references, defining 63
document reports 292
documentation 6
  Accounting for Nonprofits Administrator’s Guide 7
  help 7
  online manual 7
dynamic query format 213

E
envelopes
  attributes tab 252
  format tab 254
genral tab 251
  printing in Mail 251
Excel, exporting to 25
export
  creating file for dunning letters 260
  exporting a query 227
  exporting to Excel 25

F
field code names, import 419
fields tab
  for letters in Mail 263
fields to include tab
  cards 257
  envelopes 253
  labels 247
fields, date 23
file format tab, Import 395
file formats, Import diagram 385
finance/late charges
  calculating 99, 188
  debit memo defaults 189
  finance charge method 189
  verification screen 190
fixed width import file
  creating 394
  overview 393
font options 294
format
  chapter 7
text 8
User’s Guide 7
format options
deposit tickets 180
format tab
  Cash Receipts 180
  for cards in Mail 258
  for credit memos in Mail 282
  for debit memos in Mail 286
  for envelopes in Mail 254
  for invoices in Mail 267
  for labels in Mail 248
  for letters in Mail 263
  for receipts in Mail 278
  for statements in Mail 272
frequency
  change recurring invoice 136
  recurring invoice 136, 141
function keys, special 8

G
General Ledger 3
general ledger accounts tab, user security 81
General Ledger import
  Bank Account utilities 209
general ledger tab
  Configuration 61
general tab
  for cards in Mail 256
  for credit memos in Mail 280
  for debit memos in Mail 284
  for envelopes in Mail 252
  for invoices in Mail 265
  for labels in Mail 245
  for receipts in Mail 276
  for statements in Mail 269
query preferences 231
generating invoices 142
  from recurring invoices 142
generating recurring invoices 98
Global Change 430
  add parameter value 430
change parameters 430
copy parameter value 432
delete parameter value 431
described 4
functions 430
increase/decrease parameter value 431
move parameter value 432
partial replace parameter value 431
performing a 432
preferences 437
replace parameter value 431
swap parameter value 432
group profile report, previewing and printing 79
group security
accounts receivable tab 77
adding 75
deleting a group 80
editing 78
shared components tab for 76
shared tables tab for 76

H
header record
import file containing 385, 400
import file with a separate 385, 406
help 7

I
Import 384
fields tab 390
file format tab 389
import field code names 419
main screen 385
parameter files 386
summary tab 391
import
viewing a data file 413
import field codes 419
import fields
credit memos 417
customers 416
debit memos 417
invoices 416
payments 418
recurring invoices 416
required 415
sales returns 418
import file
containing a header record 400
fields tab 396, 403
file format tab 402, 408
file layout tab 396
fixed width, without field names 393
format diagram 385
header record, containing 400
header record, separate 406
separated, without field names 387
summary screen 404, 410
summary tab 397
view data screen 398, 404
import file containing a header record
steps to create 385
import file with a separate header record
steps to create 385
import file without field names, fixed width
steps to create 394
import file without field names, separated
steps to create 387
Import tabs
file format tab 395
options tab 394
inactive account, Bank Accounts 198
interfund entries
adding 57
creating reverse 59
deleting 60
editing 59
locating 60
sorting 61
viewing reverse 58
interfund entries tab, Bank Accounts 197
interfund set
adding 54
Blackbaud systems tab 55
copying 57
deleting 56
editing 55
interfund tab, Configuration 53
international tab
adding a country 65
Configuration 65
deleting a country 66
editing a country 66
invoices 122
accounts receivable distribution tab 128
add line item screen 125
adding from customer record 122
adding payment from customer record 129
adding recurring 135
applications tab 130
applying payments/credits 129
attributes tab in Mail 266
auto-apply 130
editing from customer record 123
format tab in Mail 267
general tab in Mail 267
generating 142
generating in Mail 265
generating recurring 98
in Mail 264
line items 124
payments 129
INDEX

payments/credits tab 131
project distribution 127
recurring 134
recurring frequency 136
recurring invoice frequency 141
required import fields 416
revenue account distribution tab 127
reversing as credit memo 134
reversing as sales return 132
reversing invoices 132
invoices/debits tab
sales returns 161

J
journal references, defining 63

K
keyboard, special keys used on 8
keys, special function 8

L
labels
changing format 249
editing fields to include 249
printing 245
printing truncation report 250
labels, Mail 244
letters 259
aging tab 261
attributes tab 262
dunning 259
fields tab 263
format tab 263
line item number 125
line item tab, Customers 110
line items 124
accounts receivable distribution tab 112
adding new to customer record 109
adding to an invoice 124
editing 113
payments/credits tab 113
revenue account distribution tab 111
transaction for customer record 109
line items tab
recurring invoice 137
sales return 161

M
Mail 240
accessing 243

Accounting Queue 240
address tab for receipts 276
aging period for dunning letters 259
aging tab for letters 261
attributes tab for cards 256
attributes tab for credit memos 281
attributes tab for debit memos 285
attributes tab for envelopes 252
attributes tab for invoices 266
attributes tab for labels 246
attributes tab for letters 262
attributes tab for receipts 277
attributes tab for statements 277
calculating balances 240
cards 255
changing label format 249
creating output query 243
credit memos 279
debit memos 283
envelopes 251
export dunning letters 260
fields tab for letters 263
fields to include tab 247
fields to include tab for cards 257
fields to include tab for envelopes 253
format tab for cards 258
format tab for credit memos 282
format tab for debit memos 286
format tab for envelopes 254
format tab for invoices 267
format tab for labels 248
format tab for letters 263
format tab for receipts 278
format tab for statements 272
genre tab for cards 256
general tab for credit memos 280
genre tab for debit memos 284
genre tab for envelopes 251
genre tab for invoices 265
genre tab for labels 245
genre tab for receipts 275
genre tab for statements 269
generating invoices 265
including all customers 242
including one customer 242
including select customers 242
invoices 264
label truncation report 250
labels 244
letters 259
printing cards 255
printing labels 245
processing attributes 241
receipts 274
statement cycle tab 270
statements 268
viewing/editing preferences 241
main screen
Reports 293
menu bar 15
menus, shortcut 19
merging queries, Query and Export 215
merging two queries 226
miscellaneous tab, customer record 116, 118
modules
Bank Accounts 3
Cash Receipts 3
Configuration 3
Customers 4
Global Change 4
Import 4
in Accounts Receivable 3
Mail 4
optional 4
Query and Export 4
Reports 4
Security 4
Utilities and Housekeeping 4
months, selecting 23

N
notes tab
Bank Accounts 198
credit memos 151
debit memos 156
sales return 162
notes, adding/editing for customer record 109
number tab, query preferences 233

O
online manual 7
opening 10
optional modules 4
Accounting Queue 4
Bank Account Reconciliation 5
Budget Management 5
General Ledger 5
Interest Income Allocation 6
Project, Grant, and Endowment Management 5
options tab, Import 394
organization settings 30–31
output tab, Query and Export 219

P
parameter files, Import 386
parameters, change in Global Change 430
password
changing from other modules 86
changing supervisor 84
Security 84
payment methods tab, report parameters 371
payments 129
add accounts receivable payment screen 171
adding from customer record 129
adding in Cash Receipts 170
applications tab 130
auto-apply 130
auto-apply from an invoice 131
deleting applied 131
payments/credits tab 131
receipts in Cash Receipts 170
required import fields 418
unapplying 131, 176
payments/credits tab 113, 131
post to General Ledger
Bank Accounts utilities 208
posting method 91
Utilities and Housekeeping 91
posting options
Utilities and Housekeeping 91
Preferences 31
preferences
account search mask 32
Cash Receipts 184
Configuration 31
defaults/tab settings tab in Cash Receipts 185
establishing user and system in Configuration 32
Global Change 437
Query and Export 230
setting for customer records 101
setting in Bank Accounts 200
setting in Global Change 438
setting in reports 294
viewing/editing in Mail 241
preview report, deposit tickets 183
print
cards in Mail 255
envelopes in Mail 251
label truncation report in Mail 250
labels 245
list of queries 228
query results 228
print deposit tickets
in Cash Receipts 177
procedures, quick startup 11
product category 44
product reports 292
products
accounts receivable info tab 44
adding new 42
deleting 46
editing 45
revenue distribution tab 45
products tab 372
report parameter tabs 372
project distribution
adding 69
credit memo 149
debit memo 155
recurring invoices 139
project, default receivables 71
Project, Grant, and Endowment Management 3
properties
viewing in Customers 100
viewing query 228
purge voided checks, Bank Accounts 208

Q

queries
adding to favorites 230
creating output from Mail 243
deleting 224
editing 222
editing options 223
exporting 227
finding 221
merging two 226
organizing list of favorites 230
printing list of 228
printing results 228
properties 228
refreshing more than one 225
refreshing one 225
running 224
setting general preferences 230
using 221
Query and Export 212
accessing 216
creating new queries 217
criteria operators 214
criteria tab 218
dynamic query 213
editing query options 223
exporting queries 227
favorites 230
merging queries 215
merging two queries 226
output tab 219
preferences 230
printing list of queries 228
printing query results 228
properties 228
query criteria operators 213
query format 213
query types 213
results tab 220
save static query screen 226
sort tab 220
static query 213
using queries 221
query format
dynamic 213
static 213
query preferences
advanced tab 232
currency tab 232
date tab 234
general tab 231
number tab 233
setting specific 235
tables tab 234
yes/no tab 235
query records, grouping 27
quick startup 11

R

Raiser’s Edge import, Bank Accounts utilities 208
receipt defaults tab, Cash Receipts 168
receipts 170
address tab in Mail 276
applications tab 172
apply payment receipt 175
attributes tab in Mail 277
attributes/notes tab 173
auto-apply payment 176
delete payment receipt 174
edit payment application 175
editing payment receipt 173
format tab in Mail 278
general tab in Mail 275
generating in Mail 274
payment methods 171
select a deposit screen 171
reconciliations reports 292
records, accessing customer 103
recurring invoices 134
adding 135
changing frequency 141
frequency 136, 141
generating 98, 144
generating invoices from 142
line items tab 137
loading defaults 145
project distribution 139
required import fields 416
revenue account distribution tab 139, 140
recurring tab 120
report parameter record
saving 356
report parameter tabs
payment methods tab 371
products tab 372
sales tax entities tabs 373
salespersons tab 373
statement cycles tab 374
transaction criteria tab 375
transaction types tab 375
report, database validation control 95
Reports 291
Accounting Queue 291
deposit and payment 292
document reports 292
main screen 291
printing 357
printing reports 358
procedures 293
product reports 292
reconciliation reports 292
reports
deposit and payment 292
document 292
font options 294
previewing in Reports 357
printing in Reports 358
product 292
reconciliation 292
setting preferences 294
required import fields
credit memos 417
customers 416
debit memos 417
invoices 416
overview 415
payments 418
recurring invoices 416
sales returns 418
results tab, Query and Export 220
revenue account distribution tab 127
credit memos 149
customer record 111
debit memos 154
recurring invoices 139
reversing invoices 132

S
sales returns 160
  adding 160
  applying 163
attributes tab 162
auto-apply 161, 163
defaults 160, 164
deleting 163
deleting application 164
editing 162
editing application 163
from reversed invoice 132
invoices/debits tab 161
line items tab 161
notes tab 162
required import fields 418
sales tax code
  adding 51
  deleting 52
  editing 52
sales tax entities tab, report parameter tabs 373
sales tax tab
  Configuration 50
salespersons tab, report parameter tabs 373
save/close 18
save/new 18
screens
  change password 20
  common 19
  print setup 20
  search 21
  select a directory 21
  tabs 25
search screen, customer records 104
Security
  accounts receivable tab 77
  add a group screen 75
  adding a group 75
  adding a user 81
  changing password from other modules 86
  changing user password 86
  deleting a group 80
  deleting a user 84
  editing a group 78
  editing a user 82
  general ledger accounts tab 81
  passwords 84
  previewing group profile 79
  previewing user profile 83
  printing group profile 79
  printing user profile 83
  shared components tab for groups 76
  shared tables tab for groups 76
  users 80
security for groups 75
security groups
  shared components tab 76
Security, access to 74
separated import file, without field names
  creating 387
  overview 387
setting bookmarks 101
setting defaults in Customers 100
settings, organization 30
shared components tab, group security 76
shared tables tab, group security 76
shortcut menus 19
sort tab, Query and Export 220
sorting grid information 28
source code, posting to General Ledger 91
startup, quick 11
statement cycle tab, Mail 270
statement cycles tab, report parameter tabs 374
statement descriptions, defining 48
statements
  attributes tab 271
  format tab 272
genral tab in Mail 269
  generating in Mail 268
statement cycle tab 270
statements tab, Configuration 47
static query format 213
status bar 15
suspense account, Bank Accounts 195
system statistics 90
  screen 90
  view 90

T

table entries
  adding in Configuration 35
  automatically complete 32
  Configuration 34, 35
deleting 36
inserting 36
sorting 37

tables tab
  Configuration 34
  query preferences 234

tables, Configuration 34
tabs 25
terms tab
  Configuration 49
title bar 14
toolbar 15
toolbar buttons 15
  with drop-down menus 17
transaction criteria tab, report parameter tabs 375
transaction types tab, report parameter tabs 375

U

unapply application of payment 176
user password, changing in Security 86
user security
  adding 81
  changing password 86
  changing password from other modules 86
deleting a user 84
  editing 82
  general ledger accounts tab 81
  previewing and printing profile 83
users, Security 80
utilities
  General Ledger import from Bank Accounts 209
  post to General Ledger from Bank Accounts 208
  purge voided checks in Bank Accounts 208
  Raiser’s Edge import from Bank Accounts 208
Utilities and Housekeeping
  database validation 94
database validation control report 95
  post to General Ledger 91
  posting options 91
  posting source code 91

V

viewing properties 100

W

web page, Blackbaud 10

Y

years, selecting 23
yes/no tab, query preferences 235